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QUICK TOUR OF QUICKBOOKS

QuickBooks accounting software provides an easy way to collect and summarize accounting

information. In addition, the user can create many different reports that are useful when
managing a business.

The objective of an accounting system is to collect, summarize, and communicate information
to decision makers. Accounting information is used to:

e Prepare tax returns for federal and state tax agencies.
e Prepare financial statements for banks and investors.
e Prepare reportfs for managers and owners to use when making decisions.

RESTORE COMPANY FILE

You will find the following files in your Student files for UNIT 01.

e UOlal Rock Castle Constfruction
e UOla2 Larrys Landscaping
e UNIT_O1_Reports

To complete the first lesson exercises, RESTORE the uOlal Rock Castle Consfruction
company file from the UNIT 01 folder (Refer to page 3 of Appendix A).

UNIT 01 QUICKBOOKS NAVIGATION

After you have followed the instructions to restore your data files, you will find the company file
you have restored contfains sample data for a company called Rock Castle Constfruction. Your
first activity is fo personalize that name to meet your needs. Follow these instructions:

Sample Yo
Step 1. From the Menu bar, select Company (o= Customers Vendors Employees B:

Sfep 2. Select MY COMPANY Home Page
Company Snapshot
Step 3. Select EDIT Calendar
4. Update the C Name Field fo: poeuments ’
Siep . pdaare e Company Name rie (O Lead Center
YourName Rock Castle —— > Wy Company
H ice Administration. ..
COﬂStrUC“Oﬂ Set Up Users and Passwords 3
Step 5. CLICK on OK Qustomgr Credit Card Protection... ‘
Step 6. Close the My Company window. Set Closing Date. -

NOTE: The process fo rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.
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Take a few minutfes fo familiarize yourself with the QuickBooks navigation screens. The following
illustration summarizes some of the common areas of the program:

G Sample Your Name Chapter 1 Rock Castle Construction - QuickBooks Pro Plus 2014 - [Home ] - %
= File Edit View Lists Favorites Company Cusiomers Vendors Employees Banking Reports Window Help LA0@| - =& x
Search Company or Help o] T \ -
& - —
‘You are using a sample @ @

company file Purchase Receive Enter Bills
Orders Inventory Against Menu qu

Create a new company file Inventory
My Shortcuts @ %

2

It Get Financing
Enter Bills Pay Bills Services
M Home
#8 My Company m
CUSTOMERS
- Web and Calendar
Bl Calendar Mobile Apps
Create Sales
@ Ssnapshots & Receipts
Accept

s -~ ~ Credit Cards

m Customers

= vend Home Page

Vendors =
= & =
ra Employees Estimates Create Receive Record Reconcile
Invoices Payments Deposits
A Repors
B Docs & B 4
Statement Finance Statements Refunds W Check
= Charges Charges & Credits rite e
Checks Register

[ My Shortcuts

EMPLOYEES

‘ W Run Favorite Reports

B open windows é % K @ = Q} - ﬁ =

Print Enter Credit
Payroll Enter Pay Pay Process HR Essentials Checks Card Charges
Center Time Employees Liabilities Payroll and Insurance

Forms

= Go Mad for Payroll in March!
Be a winner and save 50% offl
Get instant paychecks, free direct depost, and pre-filed
tax forms.

Save on Payrol

Icon Bar

HOME PAGE

To view the QuickBooks Home page, click the HOME icon in the Icon bar. The Home page
contains the main categories of fransactions and tasks:

Customer or sales fransactions
Vendor or purchase fransactions
Employee or payroll fransactions
Banking transactions

Company tasks

A S
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CUSTOMERS

The Customers section is a flowchart of the main activities associated with sales and customers.
From the Customers flowchart, you user can do the following:

1. Create Estimates

2. Create Invoices

3. Record Refunds and Credits

4. Record Payments (cash, check, and credit card payments).

VENDORS

From the Vendors flowchart, you can record all of these types of fransactions:

Purchase Orders

1.

2. Inventory Received

3. BillsReceived

4. BillsPaid

5. Sales Tax Paid
EMPLOYEES

From the Employees flowchart, you will find the following options:

1. Enter Time Worked

2. Pay Employees

3. Pay Payroll Tax Liabilities
4. Process Payroll Forms

BANKING

From the Banking section you can perform the following opftions:

Record Deposits
Write Checks

1.
2.
3. Reconcile Your Bank Statement
4, Open Your Check Register

COMPANY

The company section is used to access the following:

1. Chart of Accounts — A list of accounts a company uses to frack accounting information

2. Items and Services — A list of items and services that a company buys and/or sells

3. QuickBooks Web and Mobile Apps — A QuickBooks service that permits you to connect
your mobile devices (iOS and Android OS) to your QuickBooks data.

4. Calendar - View a personalized to do list with reminders in calendar form.
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ICON BAR

]
The QuickBooks Icon bar with My Shortcutsis a toolbar that can be
customized for frequently used activities. The lcon bar can be
displayed either beneath the Menu bar or on the left side of the # Home
QuickBooks windows. 4® My company

My Shoricuts

Calendar

If the Icon bar does not appear on your screen, follow these steps:

Snapshots

Step 1. Click View
Step 2. Select Left Icon Bar

Customers

T&] vendors

The Icon bar can be customized to display the tasks that you use most Bl Employees
frequently. To customize the Icon bar, follow these steps:

Step 3. Click Customize Shortcuts
Step 4. The lIcon Bar Content should
include the following:
e Home

Customize Shoriculs

After completing steps
1-5, Youricon bar
¢ My Company should look like the

e Calendar image fo the right.
e Snhapshots

e Customers # My Shortcuts

E view Balances

b Vendors I Run Fawvorite Reports
o Employees B open wingows
e Reports
° Docs
Step 5. Delete the items that are not on this list.

MY SHORTCUTS

The following activities are to familiarize you with the menus. We will cover each item in defail
later in this book. To use My Shortcuts for each of the items featured next to the steps:

Step 1. Select My Company on the Icon bar.

Step 2. Select Edit fto make changes fo the My Company window.
Step 3. Close the My Company windows

Step 4. Select | Calendar on the Icon Bar

Step 5. To add a task to the calendar, select Add To Do for today.

December 15, 2022

w TRANSACTIONS ENTERED (40)

DUE DATE /A'mmm ;
W Add To Do

Step 6. CLICK on December 15, 2022
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Step 7. Add the following fask on your company calendar:
Learn QuickBooks Shortcuts and Navigation

Step 8. Select Snapshots to display a digital dashboard

Step 9. To customize the dashboard, select How do | customize this page?

| 9

Search |

How dg | customize this page? | Print
0. S — =

* X Customers Who Owe Monev - >,

How do | customize this page?

Snapshofts provides an overview, summarizing important company information
such as:

e Customers Who Owe Money

e Vendors to Pay

¢ Account Balances

e Reminders of Due Dates and Amounfs

Step 10.  Click Customers on the Icon bar.

] Customer Information L2

Each Tab displays additional
customer information

Noes  SentEmal

oo
1451000
151000

00

B 00
Baker s om
“ramiy Room 00
»Garage Fap 00
Bl s 00
ity Sna oo
oo creath

e
Menu shows detailed
information about each

[ TR ot customer and all customer iz
o Sues naioes . rarl
0 Estimsl StatemertCaarges transactions by customer At400
o Sutss . S2es Raca ~05703
) wonTzsze a0 s e 125300

oRepats 0o

S s lE2T e sE_Emm
Step 11.  Toggle between customer and fransaction information. The Customer Center

summarizes information about customers, jobs, and customer fransactions. The
information can be printed or exported fo Excel or Word.

Step 12.  Click ial Vendors ) Vendors on the Icon bar.

& preve. = 5 resgmeaama v & pmiy [t Bt B

v ECREEN Vendor Information

o b

HEEEEEEEEEEEE R HEE R 1R

Step 13.  Toggle between vendor and transaction information. The Vendor Center
summarizes information about vendors and vendor transactions. The information
can be printed or exported to Excel.
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Step 14.

Step 15.

Step 16.

Step 17.

Step 18.

Step 19.

Step 20.

Step 21.

Step 22.

Step 23.

Step 24.
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Click Employees on the Icon bar.

I (4] Employees

From the Employee Center you can toggle between employee, fransaction, and
payroll information.

Click Reports on the Icon bar.

I E Reports

You can select from Standard, Memorized, Favorites, Recent, or Conftributed
reports.

Click Docs on the Icon bar.
Use the Doc Center to add a document from your computer orscan a

document intfo QuickBooks. You can even attach the document, such as a
receipt, to aspecific transaction.

Use the Menu Bar to CLICK on the VIEW option

Select Open Window List. This will enable a view of all the open windows. You
may use this feature when you need to switch back and forth between open
windows quickly.

CLICK on the MY SHORTCUTS option at the bottom of the icon bar fo view the
shortcuts you created.

CLICK on REPORTS from the shortcut menu. This menu shows an image view of
that are builtinto QuickBooks.

Types of Reports by 1 fevic’
category 3 =

P

-
g
=1
5
?
z
b

v

!\A~4/\ A iy 2 R A Bty DA

EPAPE ) SRR SV P P R I e T o

Close all open windows except the Home page. To save fime when working in
QuickBooks, you can organize and arrange My Shorfcuts on the Icon bar fo suit
your specific QuickBooks needs.
i. CLICK on Windows from the top menu bar. You will see the open
windows open. You can now close each one individually.




QUICKBOOKS MENUS

You can also access tasks using the Menu bar across the top of the QuickBooks window.

|| = FEile Edit View Lists Favorites Company Customers Vendors Employees Banking Reports Window Help
Each menu item has an additional drop-down menu with options that can be performed. Many
of these menus work the same as those on the Icon bar yet each has various unique options as

well.

‘ These options are available in QuickBooks Premier Accountant. The optionis not available
QuickBooks Pro or Pro Plus.

Step 1.

tasks including the following:

New Company...

x.

New Company from Existing ¢

Open or Restore Company...

Open Previous Company

2.

Open Second Company

Page | 16

New Company - Used to create a new
QuickBooks company file.

New company from Existing Company
File - This option can be used to create
a new company that has a similar chart
of accounts, memorized reports etc.

Open or Restore Company - This option
can be used to restore a backup file or
a current company that has not been

opened on this computer or not shown

in the previous company area of
QuickBooks.

Open Previous Company — QuickBooks
remembers the names and locations of
recently opened company files fo make it
easy fo switch between files. You can fell

QuickBooks how many recently opened files

File

Click onthe Eile File option. From the File drop-down menu, you can perform

Edit View Lists Favorites Accountant

New Company..

New Company from Existing Company File...
Open or Restore Company...

Open Previous Company

Open Second Company

Back Up Company

Create Copy...

Close Company

Switch to Multi-user Mode
Utilities
Set Up Intuit Sync Manager

Accountant's Copy

Print Eorms
Printer Setup...
Send Forms...
Shipping

Update Web Services
Toggle to Another Edition...

Exit Alt+F4

Figure 1: File Menu Options

to display in the Open Previous Company list orin the No Company Open

window.

Open Second Company — You can open 2 company files at the same time
in the same year of QuickBooks Accountant, QuickBooks Professional
Bookkeeper, and QuickBooks Enterprise Solutions. The first file you open is
labeled Primary and has a few limitations. The second file is labeled
Secondary and has more limitations. If you close the primary file when 2
companies are open, the secondary file now becomes the primary file.

Note: This only applies to QuickBooks company files within the same year. You can have
two company files open in two separate years of QuickBooks without the

Primary/Secondary file restrictions.

1
>




¢ Back Up Company - This opfion will walk you through creating a backup
file. The backup file (.gbb) contains copies of all the data you need to
recreate your company file (.gbw) and QuickBooks environment, including
your supporting files (such as templates, letters, images, and so on).

Back Up Company

e Create Copy - With this opfion, you are given the prompt to create a

Backup Copy, Portable Company file or an Accountant’s copy. The

Create Copy... K . X
following summarizes each of these opftions:

v Backup (.QBB)—A QuickBooks Backup files should be created at
regular intervals in case your .QBW file fails oris destroyed. The
.QBB file version is a compressed file and cannot be opened
directly. Furthermore, you cannot enter fransactions directly info a
.QBB file. Instead, you must unzip the file first by restoring the file
intfo a .QBW file version.

v' Portable or Mobile (.QBM)—A QuickBooks Mobile file, also called a
QuickBooks Portable fie, is used to move a QuickBooks file to
another computer Like the .QBB backup file version, the .QBM file
version is compressed and must be unzipped and restored into a
.QBW file version before it can be used to enter data.

v' Accountant (.QBX)—A QuickBooks Accountant Copy isidentified
with a .QBX extension. This version of the company file is given fo
the accountant. The accountant can make changes, such as
adjusting entries, to the .QBX version of the company file while the
.QBW company files are used fo continue entering fransactions.

Note: Before creating an accountant’s copy, check with your bookkeeper or
accountant to insure they do indeed have an Accountant or Bookkeeper copy of
QuickBooks. They will not be able to open your file if they are using Pro or Pro Plus.

e Close Company - This option closes the current company file and prompts

- the user to open, create orrestore another QuickBooks file.
Close Company

e Multi-user Mode - This opftionis available when QuickBooksis used on a

network. If an additional QuickBooks license has been purchased, it

Switch to Multi-user Mode . .
enables the users to work on the same company file simultaneously.

o Utilities — In this area the user can perform such opfions as importing and

exporting company data to another file format. The option contains various
utilities to perform maintenance activities as well.

Utilities

SEND COMPANY FILE

B

.=

.=

.=

.=

.=

&

o Accountant’'s Copy - The accountant can make adjustments and
changes to the Accountant’s Copy. Then the Accountant’'s Copy is
merged with the original company data. This permits the enfrepreneur to

Accountant's Copy
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confinue using QuickBooks to record fransactions at the same time the
accountant reviews and makes changes to the records.

grm'nvo;ch Curl+P e Output Tasks — Print, Save as PDF, Print Forms, Printer Setup, Send Forms,

Pl Eonr ’ Shipping. Note: The Print option may not appear to be activated in your file
rinter Setu

Send Forms menu. This is because you need to have a function open to activate the

i - menu. The menu fo the left is showing because the user opened the

Invoice option.

In QuickBooks Accountant Edition, the File menu displays Toggle to Another Edition. This
command allows you to switch to another QuickBooks edition, such as QuickBooks Pro. To
remove the File drop-down menu from the screen, click anywhere outside the drop-down menu
or press the Esc (Escape) key.

Step 2. Click Edit Edit on the Menu bar. From the Edit drop-down menu, you can perform
tasks including the following:

L] Undo (=8 View Lists Favorites

e Revert !

e Cut

e Copy

e Paste

e Copy lLine

e Paste Line Use Register  Ctrl+R

e Use Register Use Calculator

e Use Calculator giSSEeh___ Ctr‘;f;

[ Find Preferences...

e Search

o Preferences - QuickBookscan be customized using QuickBooks
preferences.

The Edit Menu changes based upon which windows are open.

Step 3. CLICK the Home icon fo | eRi I Gisolay the Home page

Step 4. CLICK the Purchase Orders icon in the Vendors section fo display the purchase order
form.
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Step 5. CLICK Edit g4z menu. Now the Edit menu will appear as follows:
3 View Lists Favorites Accountant |
[ ]
I Clear !
The EdIt menu now contains: i
New Purchase order, Duplicate » '
Purchase Order, Memorize '] New Purchase Order CirkeN
! Duplicate Purchase Crder
Purchase Order, and Chdnge Memorize Purchase Order Ctrl+M
a Ch A t Color...
Account Color, Memorize i | a”sel*jw“” e
se Calculator
Purchase Order' and Chonge : Eind Purchase Orders Ctri+F  *
Account Color Search._ F3
Preferences..
Step 6. Click Lists Lists ©ON the Menu bar to display the following dropdown menu:

I!! Favorites Company Customers WV

| Chart of Accounts Ctrl+A
I .

I temn List

| Fixed Asset ltem List

U/M Set List

Note: Each company file is Price Level List

. . Sales Tax Code List
different; therefore, the lists for . Payroll tem List
that company may vary. Payroll Schedule List

- v v i Class List

Workers Comp List

Other Names List
Customer & Vendor Profile Lists 3
Templates

Memorized Transaction List Ctrl+T

Add/Edit Multiple List Entries

From the Lists drop-down menu, you can access various lists of information.
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Chart of Accounts — A list of accounts used to record transactions.

Item List — A list of inventory items that you buy and sell, or alist of services provided fo
customers.

Payroll Item List— A list of ifems related to payroll checks and company payroll
expense such as salary, hourly wages, federal and state withholding, unemployment
taxes, Medicare, and Social Security.

Templates — A list of templates for business forms, such as invoices and purchase
orders.

Memorized Transaction List — A list of recurring tfransactions that are memorized or
saved. For example, if your company pays $200 in rent each month, then the rent
payment fransaction can be memorized to eliminate the need to reenter it each
month.




Step 7.

Step 8.

Page | 20

CLICK Accountant on the Menu bar to display the drop-down menu. NOTE: This
option is not available in Pro or Pro Plus

From the Accountant drop-down menu, you can access features accountants use
for client services.

e Accountant Center — A central location to organize accountant toolsin
QuickBooks.

e Chart of Accounts — A list of accounts used to record fransactions.

¢ Client Data Review - This fool streamlines client file cleanup tasks.

e Make General Journal Entries — An onscreen journal for the accountant to
make correcting and adjusting entfries.

e Reconcile - The accountant can reconcile client bank statement.

e Working Trial Balance — The accountant can use this fo review beginning
balances, adjustments, and ending balances.

e Set Closing Date — The accountant can set the closing date for the
accounting period.

e Condense Data - This feature permits the accountant to create a period
copy of a client’s QuickBooks files. For example, an accountant might
create a period copy of a client’s 2014 accounting year to provide to the
IRS.

e View Conversation List — QuickBooks 2014 infroduces a Client Collaborator
feature tfo facilitate accountant and client communication

e Remote Access - This service permits accountants to remotely access
clients’ QuickBooks files.

e Online Accountant Resources — QuickBooks offers m———
Customers Vendors Employees Be

desktop and online accounting solutions. Home Page
Cempany Snapshot
Calendar
Documents

CLICK Company Company on the Menu bar to display the

Lead Center

drop_down menu. Cempany Information
§ Advanced Service Administration
Set Up Users and Passwords
From the Company menu, you can access the following J e S a preecten.
TOSKS Planning & Budgeting
€ ToDolList

Reminders

e Company Information — Access company information . 2700

1t Maintenance Alerts

and for example, change the company name. {

«  Chart of Accounts Ctrl+A

e Set up Users and Passwords — Setup users and restrict  #  Make SeneralJoumal Entries.

Manage Currency

access to certain parts of QuickBooks. Change Enter Vehicle Mileage
QuickBooks account passwords (administrators) {_ Frepare Lefters with Envelopes g
" R Export Company file to QuickBooks Online
¢ Planning and Budgeting — Set up budgets and use Aucoun: Last e

planning decision tools.

e To Do List and Reminders— Create a To Do List and Reminders

e Chart of Accounts — The Chart of Accounts is a list of accounts and account
numbers. A company uses accounts to record fransactions in the
accounting system. Accounts (such as the Cash account or Inventory
account) permit you to sort and track information.




Make General Journal Entries — As fransactions information is entered into
QuickBooks, the program automatically converts the fransactions into
journal enfries. Adjustments to these enfries can be made in this area.

Enter Vehicle Mileage — QuickBooks will produce a mileage report for all
vehicles that have been used for business.

Export Company file to QuickBooks Online — Set up mobile access to access
your QuickBooks data online on your mobile device.

Step 9.  The next fouritems on the Menu bar display drop-down menus listing various activities
related to the four major types of fransactions for a company:

Customers ~ Customers
Vendor Vendars
Employee  _Employees
Banking Banking

Some of the frequently used activities on these drop-down menus can also be
accessed from the Home page.

Reports  Step 10. Click Reports on the Menu bar to display the list of

reports that QuickBooks can create for your company. These reports can also be
accessed from the Report Center by selecting Reports on the Icon bar.

Step 11. CLICK

Window Help
Report Center
Memorized Reports 3
Company Snapshot
Process Multiple Reports @
Profit & Loss Standard
Customers & Receivables +  Profit & Loss Detail
Sales v Profit & Loss YTD Comparison
Jobs, Time & Mileage v Profit & Loss Prev Year Comparison
Vendors & Payables v Profit & Loss by Job
Purchases »  Profit & Loss by Class
Inventory v Profit & Loss Unclassified
Employees & Payroll »  Income by Customer Summary
Banking »  Income by Customer Detail
Accountant & Taxes +  Expenses by Vendor Summary
Budgets +  Expenses by Vendor Detall
List »  Income & Expense Graph
Cantributed Reports v Balance Sheet Standard
Gustom Reports | Balance Sheet Detail

Balance Sheet Summary
Balance Sheet Prey Year Comparison
Transaction History Net Worth Graph

Transaction Journal
Statement of Cash Flows

Cash Flow Forecast

e

window ~ Window on the Menu bar to display the drop-down menu. From this

menu you can swifch between windows to display onscreen.
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o Previously in this exercise you
opened the Create Purchase Orders

option. If it shows in your window, LT E Help
select it. Arrange lcons
o Close the Create Purchase Orders Close All
window by clicking the & in the _
upper right corner of the Create Tile Vertically
Purchase Orders windows Tile Horizontally
© Cascade
L]
v 1 Home

2 Create Invoices

Windows currently open

QUICKBOOKS REPORTS
.

QuickBooks offers many different types of reports that can be customized to meet business
needs. To prepare a QuickBooks frial balance report for Rock Castle Construction, follow these
steps:

TRIAL BALANCE REPORT (CH1 TB)

R

e

e

e e e o B R
e e -

e PR R R

Step 1: In the My Shortcuts section of the Icon bar, select Reports B Reports

Step 2: Select Accountant & Taxes from the report categories on the left of the window.
Step 3: Select Carousel View.

Step 4: Select Trial Balance report.

Step 5: Select the date range: 11/01/2022 to 11/30/2022

Step 6: Select the Runicon

Total Debits equal $ 1,061,566.46

Step 7: With the Trial Balance report displayed on your screen, select Excel.
Step 8: Select Create new Worksheet
Customize Report Share Template Memerize Print | E-mail * Excel ¥ Hide Header llapse
Dates [EETTLCHNN - rom 03012014 & To
1:08 AM Cent
Step 9: When the Send Report to Excel window appears, select Replace an existing
worksheet.

Step 10:  Click the Browse button
In the UNIT O1 folder, SELECT the Excel file named UNIT_01_REPORTS.

Page | 22




Step 11:  From the drop-down list, select the sheet: CH1 TB.

Send Report to Excel

WHAT WOULD YOU LIKE TO DO WITH THIS REPORT?

© Create new worksheet
© Update an existing warksheet How it works

® Replace an existing worksheet

Select workbook

C:\Users\Owner\Desktop\QuickBooks\QB-REPO... Browse...

CH1TB =

) Create a comma separated values (_.csv) file

Advanced...

Step 12:  Click the Advanced button.

Step 13: Uncheck Space between columns.

Step 14:  Uncheck Include QuickBooks Export Guide worksheet with helpful advice

Step 15:  Select On printed report and screen

Step 16:  Click OK

Step 17:  Click Export

Step 18:  When the following Export Report Alert window appears, select Do not display this
message in the future.

Step 19:  Select Yes

Step 20:  Review the report exported to Excel.
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Step 21:  Save and close the Excel File. You will use it again.

Advanced Excel Options

QuickBooks Options:
Keep the following format options from QuickBooks:

Space between columns

+ Colors ¥ Row height

Excel Options:
Turn on the following Excel features:

+ AutoFit (set column width to display all data)

¥ Freeze panes (keep headers and labels visible)

¥ Show Gridlines

Auto Qutline (allows collapsing / expanding)

Auto Filtering (allows custom data filtering)

Include QuickBooks Export Guide worksheet with helpful advice

Create backup worksheet during update

Printing options:

Show report header:

' On printed report only

® On printed report and screen

¥ Repeat row labels on each page

Cancel

NOTE: The process to export reports to Excel is found in Appendix C and will be repeated

throughout all the activities in the text.
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PROFIT AND LOSS STATEMENTS (CH1 PL ST, CH1 PL DT)

R

e

e

e

e e

&

The profit and loss (P&L) statement is a financial statement that summarizes the revenues, costs
and expenses incurred during a specified period, usually a fiscal quarter oryear. The P&L
statement is synonymous with the income statement. These records provide information about a
company's ability or inability to generate profit by increasing revenue, reducing costs or both.
Some refer to the P&L statement as a statement of profit and loss, income statement, statement
of operations, statement of financial results or income, earnings statement or expense
statement.

CH1 PL ST

Use the Icon Bar Option
Step 1: In the My Shortcuts section of the Icon bar, select Reports
Step 2: Select Company & Financial from the report categories on the left of the window.

Step 3: Select List View.

Step 4: Select Profit & Loss Standard report.

Step 5: Select the date range: 10/01/2022 to 12/31/2022
Step 6: Select the Runicon

v' Total Income equals $181,251.91
v' Total Expense equals $42,054.21
v Net Income equals $40,490.94

Step 7: With the Profit & Loss Standard report displayed on your screen, Select Excel
Step 8: Select Create New Worksheet

Customize Report Memorize Print | E-mail * Excel = Hide Header  Collapse

Dates [EETELCHN - | From 03012014 & To 7

1:08 AM Cent

Step 9: If your settings were correct in the Trial Balance report (pages 14-15), you should
have the same settings for this export. Double check the advanced seffings to
make sure the appropriate areas have been checked. Remember to Replace
Existing Worksheet.

Step 10: From the drop-down list, select the sheet: CH1 PL ST.

Step 11:  CLICK on the EXPORT opfion

Step 12:  Save the Excel File

CH1 PL DT

Use the Menu Bar Option Reports

Step 1: CLICK on Reports from the Menu bar
Step 2: Select Company & Financial from the report categories drop-down menu
Step 3: Select the Profit & Loss Detail report.
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Step 4: Make the following selections:
» Dates: Last Fiscal Quarter - This setting should automatically change your
date range to 07/01/2022 to 09/30/2022
» Report Basis: Accrual —Try clicking on cash basis. Nofice that the numbers
and the totals foreach category change. This difference will be discussed in
detail in a later chapter. Click back on Accrual and then follow the next step.

v' Total Design Income equals $10, 256.76
v Total Subcontracted Labor equals $19,328.40
v' Total Automobile Expense equals $1,800.56

Step 5: With the Profit & Loss Detail report displayed on your screen, Select Excel
Step 6: Select Create New Worksheet

| Customize Report Memeorize Print | E-majl * Excel » Hide Header Collapse

Dates [EETTLCN - rom 03012014 = To

1:08 AM Cent

Step 7: If your settings were correct in the Trial Balance report (pages 14-15), you should
have the same settings for this export. Double check the advanced settings to
make sure the appropriate areas have been checked. Remember to Replace
Existing Worksheet.

Step 8: From the drop-down list, select the sheet: CH1 PL DT. If prompted fo replace an
existing worksheet, with new data, click yes to contfinue (you can check the
opftion to not see this message in the future).

Step 9: CLICK on the EXPORT opfion. This is a larger report. It may require that you wait a
few minutes.

Step 10: Review the result you have just exported. Your name should be in cell AT along
with the details containing the name and dates of the report in cells A2 and A3.
If this information is not showing, you need to go back to QuickBooks and make
sure the correct settings have been applied to your export. These are the
advanced seftings described on pages 14-15 of this unitf.

Step 11:  Save the Excel File

BALANCE SHEET REPORTS (CH1 BS ST, CH1 BS DT)

R

e

e

e

e e e

e PR R R R R R

The balance sheet classifications allow the reader fo easily compute the amount of a
company's working capital and to determine if a company is highly leveraged.

ASSETS that are reported on the balance sheet are the company's resources such as

cash, accounfs receivable, inventory, investments, land, buildings, equipment, some intangible
assets. Generally assets are reported at their cost or a lower amount due to the cost

principle, depreciatfion, and conservatism. The cost principle also means that some very
valuable aspects of the company are not listed as assets. For example, a company's
outstanding reputation, its effective management team, and its amazing brand recognition are
not reported as assets if they were not acquired in a fransaction involving another party or
entity.
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LIABILITIES are a company's obligations as of the balance sheet date and will include loans
payable, accounts payable, accrued expenses not yet recorded in accounts payable,
warranty obligations, faxes payable, and more.

STOCKHOLDERS' EQUITY or OWNER'S EQUITY reports the amounts that were invested by the

owners plus the company's earnings that the owners chose not to withdraw as dividends or
drawings.

CH1 BS ST

Use the Icon Bar Option

Step 12:  In the My Shortcuts section of the Icon bar, select Reports

Step 13:  Select Company & Financial from the report categories on the left of the window.

Step 14:  Select Carousel View.

Step 15:  Select Balance Sheet Standard report. There are many reports to scroll through.
The Balance Sheet reports in the second half of the list of reports. You can use
the scroll bar at the bottom of the Carousel view to quickly advance through the
list. When you find the correct report, follow the next step.

Step 16:  Select the date range: 11/01/2022 to 12/31/2022

Step 17:  Select the Runicon

v Total Assets equals $635,033.93
v Total Liabilities equals $420,442.73
v' Total Equity equals $214,591.20

Step 18: With the Balance Sheet Standard report displayed on your screen, Select Excel
Step 19:  Select Create New Worksheet

Customize Report Memorize Print | E-mail * Excel = Hide Header  Collapse
Create New Worksheet =

Dates [EEMIG] From 03/01/2014 B To Update Existing Worksheet
1:08 AM Cent

Step 20:  If your seftings were correct in the Trial Balance report (pages 14-15), you should
have the same settings for this export. Double check the advanced settings to
make sure the appropriate areas have been checked. Remember to Replace
Existing Worksheet.

Step 21:  From the drop-down list, select the sheet: CH1 BS ST. If prompfed to replace an
existing worksheet, with new data, click yes to contfinue (you can check the
option to not see this message in the future).

Step 22:  CLICK on the EXPORT option

Step 23: Review the result you have just exported. Your name should be in cell A1 along
with the details containing the name and dates of the report in cells A2 and A3.
If this information is not showing, you need fo go back to QuickBooks and make
sure the correct seftings have been applied to your export. These are the
advanced settings described on pages 14-15 of this unit.

Step 24:  Save the Excel File

CH1 BS DT
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Use the Menu Bar Option

Step 25:
Step 26:
Step 27:
Step 28:

Step 29:
Step 30:

Step 31:

Step 32:

Step 33:

Step 34:

Step 35:

Reports

CLICK on Reports from the Menu bar

Select Company & Financial from the report categories drop-down menu

Select the Balance Sheet Detail report.

Make the following selections:

» Dates: Last Week- This setfing should automatically change your date range
to 12/04/2022 to 12/10/2022

» Report Basis: Accrual —Try clicking on cash basis. Nofice that the numbers
and the totals foreach category change. This difference will be discussed in
detail in a later chapter. Click back on Accrual and then follow the next step.

v' Total Current Assets equals $208,757.85

v' Total Assets equals $643,696.16
v Total Liabilities & Equity equals $643,696.16

With the Profit & Loss Detail report displayed on your screen, Select Excel
Se cT Cret Ng Wrsht

| Customize Report Memorize Print | E-mail v Excel ¥ Hide Header  Collapse
Create New Worksheet =

Dates [EEMIG] From 03/01/2014 B To Update Existing Worksheet
1:08 AM Cent

If your seftings were correct in the Trial Balance report (pages 14-15), you should
have the same settings for this export. Double check the advanced settings to
make sure the appropriate areas have been checked. Remember to Replace
Existing Worksheet.

From the drop-down list, select the sheet: CH1 BS DT. If prompted to replace an
existing worksheet, with new data, click yes to contfinue (you can check the
opftion to not see this message in the future).

CLICK on the EXPORT option. This is a larger report. It may require that you wait a
few minutes.

Review the result you have just exported. Your name should be in cell A1 along
with the details containing the name and dates of the report in cells A2 and A3.
If this information is not showing, you need o go back to QuickBooks and make
sure the correct seftings have been applied to your export. These are the
advanced settings described on pages 14-15 of this unit.

Save the Excel File

THE HELP MENU

QuickBooks has several Help features to assist you in using QuickBooks software. Click Help on
the Menu bar to display the drop-down menu of Help features.
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Help features of QuickBooksinclude:

e QuickBooks Desktop Help - Search
relevant topics and online forum

e New Features — The 2020 version has
updates to explore. You can view
these updates after you have installed
the program on your computer.
Follow the New Features submenu by
clicking on the right arrow. Take the
New Features Tour.

e Support - Online QuickBooks support
and resource centers

¢ Year-End Guide - Assistance in closing
the accounting period

e App Center: Find More Business

Solutions — A website containing small
business software applications.

If QuickBooks Help is selected from the Help
menu, the Have a Questiong window
appears. At the top of the window, you can
type in your question. There are several
viewing options to choose from.

In the next activity, you will use QuickBooks

Search to search for informatfion about exporting QuickBooks

reports to Excel software.

F

QuickBooks Desktop Help F1

(15

Mew Features 2

Support
Find ALocal QuickBooks Deskiop Expert

Send Feedback Online y E

Internet Connection Setup
Year-End Guide

Add QuickBooks Services

App Center:Find More Business Solutions

Update QuickBooks Desktop...

Manage My License 3
Buy QuiickBooks Premier Edition... '
Buy QuickBooks Desktop Premier

Reset Intuit ID Settings...

QuickBooks Desktop Privacy Statement
About Automatic Update b

About QuickBooks Desktop Pro 2019...

Figure 2: Help Menu

Step 1: Click QuickBooks Help from the Help menu, 5
and the “Have a Question2” window will Click to view your
appear. results
Step 2: In the Search field, type: export to Excel A
Step 3: Click the search icon to view the results. ShilekBonls
Step 4: Read about how to export QuickBooks reports
to Excel. _
Step 5: In the Search field, type: email invoice e
Step 6: Click the search icon fo view the results.
Step 7: Read abut how to setup your email service in
QuickBooks. |22bp QuiciBookotpaieand ]
Step 8: Open the Excel Unit_01_Reports file and answer the questions listed on the

CHI1 HELP worksheet.

TYPES OF COMPANY FILES
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The two most common QuickBooks files you will use are the following:

v .QBW File - This is referred fo as the QuickBooks working file in which you can enter
accounting data and fransactions.

v .QBB File — The QuickBooks backup file used to move a QuickBooks file to another
computer orif the working file (.QBW) fails. The data files provided for you with this text
.QBB files. These files have been restored to the .QBW format for your convenience.
Unlike Excel files, .QBB files cannot be opened by clicking on the file. Because .QBB files
are compressed, the .QBB file must be restored (unzipped) using the QuickBooks
software.

The .QBW file is the only QuickBooks file in which you can entfer data and fransactions. When
you enfter fransactions info a .QBW file, the information is automatically saved. The typical
workflow for a business is fo use the .QBW file to record fransactions and periodically back up to
a .QBB (backup) file.

A sound disaster recovery planincludes a backup system. For example, a good backup system
is to have a different backup for each business day: Monday backup, Tuesday backup,
Wednesday backup, and so on. Then it is necessary to use the backup file and the Wednesday
backup, for example fails, the company has a Tuesday backup to use. Furthermore, itis
recommended that a business store at least one backup at a remote location.

Typically, the backup file is used only if the company’'s working file (.QBW) fails. Then the backup
file (.QBB) can be restored and used. It is important that the backup copy is as up to date as
possible in case it must be used to replace lost company data. The backup file (.QBB) is
compressed and must be restored to a working file (.QBW) before you can use it to enter data
or fransactions.

BACKUP YOUR QUICKBOOKS COMPANY FILE

B

.=

.=

.=

.= .=

&

When closing your company file, it is a good habit to always run a backup. This regular process
will help eliminate the possibility of accidental data loss. A backup of your QuickBooks

company file contains everything you need to re-create your company file on another
computer. It includes all templates, letters, logos and images related to your company.

When you create a backup of your company file, you save a copy of the file to a location you
specify. You can select a file hosting service (such as DropBox), or a flash drive or other
removable media to save backups somewhere other than your main local drive in case of a
system failure.

As you set up your backup, you can also set up backup reminders that prompt you to back up
when you close your company file a specified number of times or create a schedule of regular
backups.

Step 1: With your QuickBooks file (*.QBW) open, click File
Step 2: Select Back Up Company
Step 3: Select Create Local Backup
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Step 4:

B

When the following windows appears, Select Local backup

Create Backup

Make a backup copy of everything you need to recreate your company file in case of
accidental loss or damage to your data.

Do you want to save your backup copy online or locally?

© Online backup

Get automatic, online backup for your QuickBooks data and other important documents
using Intuit’s online backup solution (fees may apply).

Try now or learn more

a folder on your network.

Options Click Options to change your current backup settings.

m Finish Help Cancel

Figure 3: Backup Options

Step 5:
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Step 6: BROWSE to the UNIT 01 BACKUPS folder

o ainst

oo T eTTTeTT
Sale a Lt A ctiviti

Backup Options x|

BaCkupS fOlderS are Use this window to set default options for your manual and automatic backups.
in each unit LOCAL BACKUP ONLY

Option

Tell us where to save your backup copies (required)

F\Documents 2015\School\Cuesta\Credit Courses\ACCT 252 Q1. Browse...
LUNIT 01 BATSEES

& Student Lesson Files +| Add the date and time of the backup to the file name (recggeended)

Unit 01 +| Limit the number of backup copies in this fol dge® 3

Restored_Project 01_Files

LINIT 01 BACKUPS
Uit 02 l ONLINE AND LOCAL BACKUP
Unit 03 - !
Unit 04 ¥ Remind me to back up 4 close my company file every 4 times.

i’
Unit 05 Select an option tg that your company data is OK (thatis, not corrupted) when
Unit 06 v 4 you Save.
-« O -
o plete verification (recommended)
OK. ] [ Cancel Quicker verification

| ) No verification

Help me choose

Browse to the Backups | i =
folder for this unit  EEINEEEY - A

Cages Cage

Step 7: CLICK on the OK option

Step 8: If the QuickBooks warning window appears, select Use this Location.

Step 9: CHECK the Save it now option

Step 10:  CLICK the NEXT option

Step 11:  Notice that QuickBooks has dated, and time stamped the backup file you are
creating. CLICK on SAVE

NOTE: The process to backup and restore company files is found in Appendix A and will be
repeated throughout all the activities in the text.

UNIT 01 PROJECT (ON-YOUR-OWN)

For this project, you will be restoring the backup file created for the unit. The QuickBooks
company file for Larry-s Landscaping has already been created and fransactions have been
entered. Your assignment is to complete the following steps to export reports to Excel:

RESTORE THE UNIT O1 STARTER FILE

o
e

o
=

o
e

o
e

o

o o
e e

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u01a2 Larrys Landscaping. This file is in your UNIT 01 folder.

Step 1: RESTORE the u01a2 Larrys Landcapaing.QBB file
Step 2: Make sure you SAVE to the UNIT 01 FOLDER
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UPDATE THE COMPANY NAME

Y Y Y Y Y Yy,
B R e e e e e e e B e e e e e S S S S i i S A A A A A i e e S A A e S S A S A S w8 S8 S e

Follow the instructions in Appendix B to change the company name to YourName Larry’s
Landscaping

Step 3: Update the Company name to: YourName Larry’s Landsaping

PREPARE THE PROFIT AND LOSS REPORTS

PR1 PL ST

Step 4: In the Larry’'s Landscaping file, use one of the methods you have learned on
page 18-19 to generate the company Profit & Loss Standard report.

Step 5: Dates: Last Fiscal Year (10/01/2021 to 09/30/2022)

Step 6: Report Basis: Accrual

Step 7: Export the file to EXCEL using the UNIT_01_REPORTS file used for this unit.

Step 8: REPLACE the worksheet called PR1 PL ST

When Exporting to Excel, remember to Select Create New; Replace Existing and the
Advanced options. If you have questions, reference Appendix C (Exporting Reports to
an Excel Template)

Step 9: In the Excel (PR1 PL ST) worksheet, Highlight the single largest expense
item
Step 10:  SAVE the Excel file

PR1 PL DT

step 11:  Export to Excel (UNIT_01_REPORTS) the company Profit & Loss Detail
report

Step 12:  Dates: This Fiscal Year-to-date (10/01/2022 to 12/15/2022)

Step 13:  Report Basis: Accrual

Step 14:  Export the file to EXCEL using the UNIT_01_REPORTS file used for this unit.

Step 15: REPLACE the worksheet called PR1 PL DT

When Exporting to Excel, remember to Select Create New; Replace Existing and the

Advanced options. If you have questions, reference Appendix C (Exporting Reports to
an Excel Template)

Step 16:  Which type of landscaping service produces more revenue for Larry’s:
Installation or Maintenance & Repairs?

Step 17:  In the Excel worksheet (PR1 PL DT), Highlight your answer.
Step 18:  SAVE the Excel file
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PREPARE THE BALANCE SHEET REPORTS

PR1 BS ST

Step 1: In the Larry’s Landscaping file, use one of the methods you have learned to
generate the company Balance Sheet Standard report.

Step 2: Dates: Last Fiscal Year

Step 3: Ending: 9/30/2023

Step 4: Report Basis: Accrual

Step 5: Export the file to EXCEL using the UNIT_01_REPORTS file used for this unit.
Step 6: REPLACE the worksheet called PR1 BS ST

Step 7: In the Excel worksheet (PR1 BS ST), Highlight the largest single liability.
Step 8: SAVE the Excel file

PR1 BS DT

Step 1: In the Larry’'s Landscaping file, use one of the methods you have learned fo
generate the company Balance Sheet Detail report.

Step 2: Dates: Last Fiscal Year

Step 3: Ending: 9/30/2023

Step 4: Report Basis: Accrual

Step 5: Export the file to EXCEL using the UNIT_01_REPORTS file used for this unit.

Step 6: REPLACE the worksheet called PR1 BS DT

Step 7: In the Excel worksheet (PR1 BS DT), Highlight the largest assetf.

Step 8: SAVE the Excel file

BACKUP YOUR COMPANY FILE

Use the instructions in Appendix A to backup your company file. Make sure your backup file is
saved in the designated folder of this unit (UNIT 01 BACKUPS).

TAKE THE QUIZ

The reading in the unit along with the Excel reports you have generated have provided answer
fo the quiz for this unit. Take the UNIT_01 QUIZ in your Canvas account

SUBMIT THE UNIT REPORTS

After you have taken the quiz using the answers you have already recorded in the reports you
extracted from Excel, UPLOAD the Excel file (UNIT_O1_REPORTS), to the UNIT_O1 assignment area
of your Canvas account.
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ASSETS LIABILITIES OWNER'S EQUITY INCOME EXPENSES

i £
CHECKING ACCOUNT iCash} OWNER'S INVESTED FUNDS SALES OF GOODS AKD SERVICES ADVERTISING

v

INVENTORY MORTGAGE RETAINED EARNINGS OFFICE SUPPLIES

+

EQUIPMENT SALES TAX PAYABLE PAYROLL

UNIT 02 - CHART OF ACCOUNTS
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The Chart of Accounts is a list of accounts and account numbers. A company uses accounts to

record transactions in the accounting system. Accounts (such as the Cash account or Inventory
account) permit you o sort and fract information.

When you setup a new company, QuickBooks automatically creates alist of suggested
accounts foryour company type. Once the initial Chart of Accounts is created, you may
customize the list by adding, deleting, or revising the account information to meet your
individual company needs. QuickBooks also permits you to use subaccounts.

CHART OF ACCOUNTS
| Profit and Loss accounts ‘ | Balance Sheet accounts ‘
: i l : i I
B 2ote= " supplies || Bank account r s g Col
| Detivery ees | Rem [l Aooous | redit cards [ e
R interest 1 Utilities B Equipment J Sales tax paysble
J Loans

GENERAL LEDGER

A ledger (general ledger) is the complete collection of all the accounts of a company. The
ledger may be inloose-leaf form, in a bound volume, orin computer memory.

Accounts fallintfo two general groups:

(1) balance sheet accounts (assets, liabilities, and stockholders' equity)
(2) income statement accounts (revenues and expenses). The terms real accounts and
permanent accounts also refer to balance sheet accounts.

Balance sheet accounts are real accounts because they are not subclassifications or
subdivisions of any other account. They are permanent accounts because their balances are
noft fransferred (or closed) fo any other account at the end of the accounting period. Income
statement accounts and the Dividends account are nominal accounts because they are merely
subclassifications of the stockholders' equity accounts.

Nominal literally means "in name only". Nominal accounts are also called temporary accounts
because they temporarily contain revenue, expense, and dividend information that is
transferred (or closed) to the Retained Earnings account at the end of the accounting period.
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The chart of accounts isa complete listing of the fitles and numbers of all the accounts in the
ledger. The chart of accounts can be compared to a table of contents. The groups of accounts
usually appear in this order:

o Assets

e Liabilities

e stockholders' equity
e dividends

e revenues

o  expenses.

Individual accounts are in sequence in the ledger. Each account typically has an idenfification
number and a fitle to help locate accounts when recording data.

BALANCE SHEET ACCOUNTS

The Balance Sheet is a financial statement that summarizes what a company owns and what it

owes. Balance Sheet accounts are accounts that appear on the company’s Balance Sheet.
There are three types of accounts that appear on a Balance Sheet:

v Assets
v Liabilities Assets = Liabilities + Owners’ Equity
v Owner's (or Stockholders’) Equity

ASSETS

B
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Assets are resources that a company owns. These resources are expected to have future
benefit. This list would include the following:

v Cash

v Accounts Receivable — amounts to be received from customers in the future

v" Inventory assets are goods oritems of value that a company plans to sell for profit. These
items include any raw production materials, merchandise, and products that are either
finished or unfinished.

Why inventory and fixed assets are important

Managing your inventory is critical to hit profit targets. For many companies, turning over
inventory, by selling it or using it in production, is a primary revenue source. Having too
much inventory for long periods can be risky, as products can spoil, become damaged
over the time you store and don't sell them, or simply become obsolete. However, by
having too little inventory, you may not have enough products to sell if market demand is
up and you could risk your business losing sales and market share. Meanwhile, your fixed
assets have afinite life and are always depreciating, like how the value on a commercial
vehicle you've purchase depreciates over time due to wear and tear. EqQuipment used
to keep the business going, like computers and maintenance on printers, can be freated
as a fixed asset. However, things like stationery or consumables can be considered a part
of inventory as they are quick moving. It is important to understand the difference
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between the two and also to frack them so you have accurate numbers on your
financial statements come tax time.

v' Other Current Assets — assets likely to be converted to cash or consumed within one year
v" Fixed Assets — property used in the operations of a business, such as equipment,
buildings, and land

Depreciation of Fixed Assets

Of course, things grow old, wear out, or fall out of use. As a business buys and puts a
fixed asset into use, they begin the countdown on its useful life. Through accounting
methods, they can depreciate the tangible item overits lifetime. A company will
depreciate assets for both tax deductions and accounting reasons. When the item has a
resell or market value that isless than the value on the company's balance sheet it
becomes an impaired asset

v" Intangible Assets — copyrights, patents, trademarks, and franchises fall into this category.

LIABILITIES
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Liabilities are dollar amounts a company owes fo others. Liabilities are obligations. For example,
if acompany borrows $10,000 from the bank, the company has an obligation to repay the
$10,000 to the bank. Thus, the $10,000 obligationis shown as a liability on the company’s
Balance Sheet. This is a list of liability account types:

Accounts Payable — amounts that are owed and will be paid to suppliers in the future.
Sales Taxes Payable — sales tax owed and to be paidin the future

Interest Payable - interest owed and to be paid in the future

Other Current Liabilities - liabilities due within one year

Loan Payable — also referred to as notes payable.

Mortgage Payable

Other Long-term Liabilities — liabilities due after one year.

AN N N N R NN

Liabilities are often confused with expenses. But they are quite different.

Liabilities are the money owed by a business. For example, if a company takes aloan from a
financial institution, the loan is a liability and not an expense.

On the other hand, the phone charges a company pays fo connect with their prospective
clients are expenses and not liabilities. Expenses are the on-going charges the company pays to
enable revenue generation.

However, certain expenditure can be treated as a liability. For example, outstanding rent is
freated as a liability. Why2 Because outstanding rent denotes that space has been ufilized for
the year, but the actual money is yet to be paid. As the money forrent is yet to be paid, we will
assume it fo be “outstanding rent” and record it under the “liability” head of a balance sheet.
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OWNERS’ EQUITY
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Owners’ equity accounts (stockholders’ equity for a corporation) represent the net worth of a
business. Equity is calculated as assets (resources owned minus liabilities (amounts owned).

Different types of business ownership include:

v" Sole Proprietorship — an unincorporated business with one owner
v" Partnership — an unincorporated business with more than one owner
v" Corporation — an incorporated business with one or more owners

INCREASE OWNERS EQUITY

Owners' equity is increased by:

v" Investments by Owners — For a corporation, owners invest by buying stock
v Net Profits -- The business retains their net profits rather than distribute the profits to the
owners.

DECREASE OWNERS EQUITY

Owners’ equity is decreased by:

v Withdrawals — Amounts paid to owners as areturn for their investment. For a sole
proprietorship or partnership, these are called
withdrawals. For a corporation, they are

called dividends. Owners’ Equity = Assets-Liabilities

v Losses — Losses incurred by the business.

Balance Sheet accounts are referred to as permanent accounts. Balances in permanent
accounts are carried forward from year fo year. Thus, for a Balance Sheet account, such as

Cash, the balance at December 31 is carried forward and becomes the opening balance in
January 1 of the next year.

OPEN BALANCE EQuUITY
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An Opening Balance Equity account is created the first time you enter an opening balance for
a Balance Sheet account. As you enter the opening balances, QuickBooks Online records the

amounts in the Opening Balance Equity account. This ensures that you have a correct balance
sheet for your company, even before you have entered all your company's assets and liabilities.

An example of this is when you first add a bank account to QuickBooks Online. Since
QuickBooks Online uses double entry accounting, each fransaction requires atf least two
accounts be used. So, the balance that you entered for the newly-added bank will show in two
accounts, the bank and Opening Balance Equity accounts.

After you have entered all your opening balances, you might want to move the amount in
Opening Balance Equity to other accounts. Consult your accountant for advice.
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OPERATING EXPENSES
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There is a section of the income statement which focuses on the operating expenses that arise
during the ordinary course of running a business. Operating expenses include everything from
employee salaries to the foilet paper in the office restrooms; research and development o
electricity bills; copy paper to corporate phone lines and high-speed Internet.

General Rule of Thumb

The general rule of thumb: If an expense doesn't qualify as a cost of goods sold, meaning it isn't
directly related to producing or manufacturing a good or service, it goes under the operating
expense section of the income statement. There are several categories, the biggest of which is
known as Selling, General, and Administrative Expense.

If expenses are reported as assets, liabilities and their related expenses are omitted from the
financial statements, or reported revenues are recorded prematurely or do not really exist, the
financial statements are misleading. The financial statements are only useful and meaningful if
they are fair and clearly represent the business events of the company.

RESTORE THE STARTER FILE
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You will find the following files in your Student files for UNIT 02.

e UO2al Rock Castle Construction
e U02a2 Larrys Landscaping
e UNIT_02_Reports

To complete the first lesson exercises, RESTORE the u02al Rock Castle Consfruction
company file from the UNIT 02 folder.

NOTE: The process to restore a backup isfound in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY
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After you have followed the instructions to restore your data files, you will find the company file

you have restored contains sample data fora company called Rock Castle Construction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 7. From the Menu bar, select Company m Customers Vendors Employees B:

Step 8. Select MY COMPANY %er:zxggnapsmt
Step 9. Select EDIT Calendar
Step 10. Update the Company Name Field to: f:::::::: ’
YourName Rock Castle > 1y Compary
Construction St Up Veers and Passwords |
Step 11. CLICK on OK Customer Credit Card Protection. .
Step 12.  Close the My Company window. Set Closing Date.
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NOTE: The process tfo rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

CUSTOMIZE CHART OF ACCOUNTS

]
When you setup a new company, QuickBooks automatically creates a Chart of Accounts. Then

you can customize the Chart of Accounts to surety your specific needs by adding, deleting, and
editing accounts.

You can display the Chart of Accounts in two different ways:

1. Menu—Company menu option
2. Home Page—Company sectfion of the Home Page

To view the Chart of Accounts in for Rock Castle Construction from the Home page, complete

the following steps: COMPANY
Step 1: Click the Chart of Accounts icon in the
Chart of
Company section Acc%ur?ts Activities
Step 2: For each account, the account name, type of _
account, and the balance of the account are Lo o
. ltems & Get Financing
listed. Services
The account button at the boftom of the window )
displays a drop-down menu for Web and Calendar

Mabile Apps

adding, editing, and
deleting accounts. Or

- Checking

you can right-click in +10300 - Savings ¢ Bank 17,910.19 I
the Chart of Accounts +10400 - Petty Cash Bank 500.00
. d d d | + 11000 - Accounts Receivable Accounts Receivable 93,007.93
wincow ao dispiay a + 12000 - Undeposited Funds Other Current Asset 2,440.00
pop-up menu to add 12100 - Inventory Asset Other Current Asset 30,683.38
and edit accounts. +12800 - Employee Advances Other Current Asset 832.00
+ 13100 - Pre-paid Insurance Other Current Asset 4,050.00
+13400 - Retainage Receivable Other Current Asset 3,703.02
+ 15000 - Furniture and Equipment Fixed Asset 34,326.00
015100 Vehicles Fixed Asset 78,936.91
DISPLAY ACCOUNT NUMBERS l !
= ur o 2 Account ¥ Activities ¥ Reports ¥ Attach Include inactive

Account numbers are used to
uniquely identify accounts. Usually account numbers are used as a coding system fo also

idenftify the account type. For example, a typical numbering system for accounts might be as
follows:

10000 - 19999 Assets

20000 - 29999 Liabilities

30000 - 39999 Equity

40000 - 49999 Income or Revenue

50000 - 59999 Job Costs/Cost of Goods Sold
60000 - 69999 Overhead Costs or Expenses
70000 - 79999 OtherIncome

80000 - 89999 Other Expense
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The five digits provide some growing room when new accounts need fo be sandwiched into the
list in the right order. The five digits are used as follows:

v' First Digit—the first digitis the high-level account type (asset, liability, etc.)
v Second Digit—the second two digits are used in account numbering
v Last Two Digits—the last two digits are used in subaccount numbering

You can sfill override the standard numbering system to any system you'd like or avoid account
numbers altogether.

To display account numbers:

Step 1: Select Edit menu

Step 2: Select Preferences

Step 3: In the left scroll bar, click Accounting

Step 4: Select the Company Preferences tab

Step 5: Select Use account numbers fo display the account numbers in the Chart of
Accounts

Step 6: Then click OK

¥ Accounting Company Preferences
% Bills —— —— Sancs
il calendar ¥ Use acgiunt numbers ¥ Require accounts
Help
= Checking Show lowest subaccount only
" Deskiop View Default
CLASS =
Finance Charge Ve das backing for ransadt
@
& ool se class tracking for transactions Also See:
Prompt to assign classes

20 integrated Applications General
& tems & Inventory
B Payroll and

“ Jobs & Estimates “ Automatically assign general journal entry number Employees
& Muliple Currencies ¥ Warn when posting a transaction to Retained Earnings
B Payments DATE WARNINGS
g Payroll & Employees Warn if transactions are 90 day(s)inthe past
@ Reminders

Wan if transactions are 30 day(s)inthe future
all Reports & Graphs
B sales & customers CLOSING DATE
B Sales Tax Date through which books are closed: (not set)
P seacn Set Date/Password
53 Send Forms
@ Senice Connection
Spelling
v
. o
Step 7: If the Chart of Accounts does not appear on your screen, click Window menu >

Chart of Accounts

The Chart of Accounts should now list account number preceding the account name. If the
account numbers were already listed you can fry the exercise again by unchecking the
account numbers, viewing the Chart of Accounts without the numbers and then returning fo the

Accounting preferences and check the optfion again. Many of the opftions in the preferences
menu can be turned off and on just that easily.

CH2 COA.01

QuickBooks provides an Account Listing report that lists the Chart of Accounts plus the account
balances.
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To review the Account Listing report for Rock Castle Construction:

Step 1. Display the Chart of Accounts window.
Step 2. Select the Account button > Re-sort List > OK
Step 3. Click the Reports button atf the bottom of the Chart of Accounts window.

Step 4. Select Account Listing on the drop-down menu.
+ 16900 - Land Fixed Asset 90,000.00
+ 17000 - Accumulated Depreciation Fixed Asset -110,344 .60
» 18700 - Security Deposits Other Asset 1,720.00
+ 20000 - Accounts Payable Accounts Payable 26,636.92

Account * A Reports ¥ | Attach Include inactive

Ime loyee QuickReport: 10100 - Checking Ctri+Q and Insurance
Income Tax Preparation
Reports on All Accounts b
q O ———————————— ey

Step 5. To export the Account Listing report to Excel, at the top of the Account Listing
window select Excel.

Step 6. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_02_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CH2 COA.01.

Step 8. Review the exported report

Step 9. Save and close the Excel file.

ADD NEW ACCOUNTS

o
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The Chart of Accounts can be customized by adding deleting and editing accounts as needed
to meet your company’s specific and changing needs.

For the next activity, we will be using the Rock Castle Construction company account to add an
advertising expense account to the Chart of Accounts.

Step 1: Click the Account button at the bottom of the Chart of Accounts window to
display the menu.

Step 2: Select New
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Step 3:

Step 4:

Step 5:
Step 6:
Step 7:
Step 8:

Step 9:
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Chart of Accounts

$ ' TYPE BALANCE ATTACH

10700 Gheckrs e emu ]
210300 - Savings ¢ Bank 17,910.19
210400 - Petty Cash Bank 500.00
< 11000 - Accounts Receivable Accounts Receivable 93,007.93
+ 12000 - Undeposited Funds Other Current Asset 2,440.00
< 12100 - Inventory Asset Other Current Asset 30,683.38
12800 - Employee Advances Other Current Asset 832.00
New Ctrl+N Other Current Asset 4,050.00
Edit Account Ctri+E
®  Delete Account Ctri+D Other Current Asset 3,703.02
° Make Account Inactive Frziles S4B
< Show Inactive Accounts Fixed Asset 78,936.91
o v Hierarchical View nts Fixed Asset 325,000.00
Flat View
*  Customize Columns._. Fixed Asset 15,300.00
o Fixed Asset 90,000.00
Import from Excel .
+  Use Ctrl+lJ N Fixed Asset -110,344.60
o Find Transactions in... Other Asset 1,720.00
o PrintList. Crl+P Accounts Payable 26,636.92
| Re-sort List v
Account ¥ Activities ¥ Reports ¥ Attach Include inactive

Tima Frmnlnvasc Tiahiltioc Pavrnll and Inciranca

Select Account Type: Expense

Click Continue.

% Choose one account type and click Continue

Categorize money your business eams or spends

) Income Expense Account

3 @ Expense Categorizes money spent in the course
of normal business operations, such as:
Or, track the value of your assets and liabilities

« Advertising and promotion

© Fixed Asset (major purchases) « Office supplies

* Insurance
) Bank * Legal fees
oL + Charitable contributions
oan *Rent
© Credit Card
© Equity More .

© Other Account Types <select=

Help me choose the right account type.

In the Add New Account window, verify the Account Type: Expense.

Enter the new Account Number: 60400.
Enter the Account Name: Advertising Expense.

Leave Subaccount unchecked. Sub accounts are subcategories of an account.

For example, Rock Castle Construction has an Automobile Expense account
(Account No. 60100) with three Automobile Expense subaccounts:

v" Fuel (Account No. 60110)

v Insurance (Account No. 60120)

v" Repairs and Maintenance (Account No. 60130)
Select Tax-Line Mapping: Deductions: Advertising. This indicates the Advertising
expense account balance will appear as a deduction on Rock Castle
construction’s tax return.




Step 10:  Click Save & Close fo save the changes and close the Add New Account
window.

Account Type

Expense

Number 60400

Accougt Name | Advertising Expense

Subaccount of bt

Description

Note

Tax-Line Mapping (SIS e o ] ~  How do | choose the right tax line?

Track reimbursed expenses in Income Acct.

» | Save & Close } Save & New Cancel

Notice that Account 60400 Advertising expense now appears on the Chart of Accounts.

If the new account had been a Balance Sheet account (an asset, liability or equity account),
QuickBooks would ask you for the opening account balance as of your QuickBooks start date.
Since Advertising Expense is an Expense account that appears on the Income Statement and
not the Balance Sheet, QuickBooks did not ask for the opening balance.

DELETE ACCOUNTS
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Occasionally you may want to delete unused accounts from the Chart of Accounts. You can
only delete accounts that are not being used. For example, if an account has been used to

record a fransaction and has a balance, it cannot be deleted. If an account has subaccounts
associated with if, that account cannot be deleted.

Rock Castle Construction would like fo delete an account it does not plan fo use, the Prinfing
and Reproduction Expense account.

Step 1: Display the Chart of Accounts window.

Step 2: Select the account fo delete. In this case click 63300 Printing and Reproduction.
Step 3: Click the Account button at the bottom of the Chart of Accounts window.

Step 4: Click Delete Account

Step 5: Click OK to confirm that you want to delete the account.

EDIT ACCOUNTS
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Next, you will edit an account. Rock Castle Consfruction would like to change the name of the
Advertising Expense account to Selling Expense.

Step 1: From the Chart of Accounts window, select the account to edit: 60400
Advertising Expense.

Step 2: Click the Account button in the lower left corner of the Chart of Accounts
window orright-click the mouse to display the pop-up menu.

Step 3: From the pop-up menu, select Edit Account to open the Edit Account window.

Step 4: Make changes to the account information. In this case, change Account Name
to: Selling Expense

Step 5: Click Save & Close to save the changes. Advertising Expense should now appear

as Selling Expense in the Chart of Accounts window.

CH2 COA.02

QuickBooks provides an Account Listing report that lists the Chart of Accounts plus the account
balances.

To review the Account Listing report for Rock Castle Construction:

Step 1. Display the Chart of Accounts window.
Step 2. Select the Account button > Re-sort List > OK
Step 3. Click the Reports button at the bottom of the Chart of Accounts window.

Step 4. Select Account Listing on the drop-down menu.
» 16900 - Land Fixed Asset 90,000.00
+ 17000 - Accumulated Depreciation Fixed Asset -110,344.60
+ 18700 - Security Deposits Other Asset 1,720.00
+ 20000 - Accounts Payable Accounts Payable 26,636.92

Account * A Reports ¥ Attach Include inactive

Ime loyee QuickReport: 10100 - Checking Ctrl+Q and Insurance

Income Tax Preparation
Account Listing

Reports on All Accounts b
«  ———

Step 5. To export the Account Listing report to Excel, at the top of the Account Listing
window select Excel.

Step 6. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_02_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CH2 COA.02.

Step 8. Review the exported report

Step 9. HIGHLIGHT the changes you have made to the chart of accounts

Step 10.  Save and close the Excel file.

ADD SUBACCOUNT

In this activity, you will be adding Advertising as a subaccount of the Selling Expense account.
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Step 1: Click the Account button at the boftom of the Chart of Accounts window, then
select New to open the New Account window.

Step 2: Select Account Type: Expense.

Step 3: Click Continue.

Step 4: Enter Account Number: 60410

Step 5: Enter Account Name: Advertising Expense

Step 6: Check the boxin front of the Subaccount field

Step 7: From the drop-down list, select subaccount of: 60400 Selling Expense

Step 8: From the drop-down list for Tax-line Mapping, select Deductions: Advertising

Step 9: Click Save & New

ADD SUBACCOUNT

Follow the guidelines in the previous activity fo add the Promotion Expense subaccount to the
Selling Expense account.

Step 1: Add the sub account: 60420 Promotion Expense
Step 2: Click Save & Close

CH2 COA.03

QuickBooks provides an Account Listing report that lists the Chart of Accounts plus the account
balances.

To review the Account Listing report for Rock Castle Construction:

Step 1. Display the Chart of Accounts window.
Step 2. Select the Account button > Re-sort List > OK
Step 3. Click the Reports button at the bottom of the Chart of Accounts window.

Step 4. Select Account Listing on the drop-down menu.
+ 16900 - Land Fixed Asset 90,000.00
+ 17000 - Accumulated Depreciation Fixed Asset -110,344 60
+ 18700 - Security Deposits Other Asset 1,720.00
» 20000 - Accounts Paygble Accounts Payable 26,636.92

Account ¥ A Reports ¥ Attach Include inactive

Ime loyee QuickReport: 10100 - Checking Ctri+Q and Insurance

Income Tax Preparation
Account Listing

Reports on All Accounts 3
4 . _________________________________________________________________________________________________]
Step 5. To export the Account Listing report to Excel, at the top of the Account Listing
window select Excel.
Step 6. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_02_REPORTS Excel file.
Step 7. From the drop-down list, select the sheet: CH2 COA.03.
Step 8. Review the exported report
Step 9. HIGHLIGHT the changes you have made to the chart of accounts
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Step 10.  Save and close the Excel file.

CUSTOMIZE QUICKBOOKS SECURITY

I ————
QuickBooks permits a company to conveniently collect accounting information and sfore itin a

single file. Much of the accounting information stored in QuickBooks is confidential, however,
and a company often wants to limit employee access.

Password protection can be used to customize and limit access to company data and improve
security and conftrol.

Two ways fo restrict access to accounting information stored in a QuickBooks company data file
are:

1. Password protect the company file so individuals must enter a user ID and password to
open the company file.
2. Limit access to selected areas of the company’s accounting data. For example, a user

may access accounts receivable to view customer balances but not be able to access
payroll or check wrifing.

Only the QuickBooks Administrator can add users with passwords and grant user access fo
selected areas of QuickBooks. The QuickBooks Administrator is an individual who has access to
all areas of QuickBooks.

To add a new user and password protection to your company file follow these steps:

Step 1. Select Company menu

Step 2. Select Set Up Users and Passwords

Step 3. Select Set Up Users

Step 4. First setfup a QuickBooks Administrator who has access to all areas of QuickBooks.

The Administrator can then add new users. To add the Administrator password,
form the User List window, select Admin.

Step 5. Select Edit User

Step 6. On the Change user password and access window, enter and confirm a
Password of your choice. Write the password on the inside cover of your text.
Remember | password is case sensitive. | suggest using something simple
like Cuesta123; otherwise, 1 will not be able to help you retrieve your password.

Step 7. Select a Challenge Question

Step 8. Enter your Challenge Answer

Step 9. Click Next

Step 10.  Click Finish

Step 11.  Only the QuickBooks Administrator can add new users. To add another user, click
Add User

Step 12.  In the following Setup user password and access window, enter YourName in the
Username field

Step 13. At this point, if you were adding another employee as a user, you would ask the
employee to enter and confirm his or her password. In this instance enter and
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confirm a password of your choice. Write the password on the inside cover of

your book.

Step 14.  Click Next.

Step 15.  In the following window, you can restrict user access to selected areas of
QuickBooks or give the user access to all areas of QuickBooks. Select: All areas of
QuickBooks.

Step 16.  Click Next

Step 17.  Select Yes to confirm that you want to give access to all areas of QuickBooks.

Step 18.  The next window summarizes the user's access for each QuickBooks areq,
indicating access to create documents, print, and view reports. Click Finish.

Step 19.  If you receive a warning message about Intuit Sync Manager, click OK.

Step 20.  Two names (Admin and YourName) should appear on the User List. Click Close to
close the User List window.

Now whenever you open the company file for Rock Castle Construction, you will be asked to
enter yourusername and password.

CUSTOMIZE QUICKBOOKS SNAPSHOTS

|
The QuickBooks Snapshofts provides a digital dashboard for your company. Snapshofs gives you
an overview of key information for your company and lets you perform key fasks.

Customize QuickBooks by using Snapshofts to:

Choose which accounts to view
Track accounts receivable owed fo you

Receive payments
Select which reminders to see

AN NN

A vital aspect of maintaining an accounting system is fracking due dates for tax and vendor
payments. In addition, billing and collections of customer payments must be scheduled ina
timely manner to ensure adequate cash flows to operate the business. QuickBooks had four
different features to assist in fracking fasks:

1. Reminders — Shows only those tasks that are currently due, including fasks from the To Do
List.

2. To Do List — Tracks all tasks to be completed. You can add items to the To Do List, mark
items complete, and print the list.

3. Alerts Manager — Lists fasks and due dates related to taxes and regulations. These alerts
will appear as Reminders as they become due.

4, Calendar - The Calendar feature permits you to track tasks and due dates in a calendar
format.

If you are responsible for maintaining an accounting system, you can view Reminders or the
Calendar feature regularly to see what accounting tasks require your attention.

Next, you will learn how o customize Snapshots to display Reminders to assist you in fracking
tasks.
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Sample Your Name Chapter 1 Rock Caste Construction - QuickBeoks Pro Plus 2014

Step 1. To open the :
' Customers Vendors Empoyees Banking Reports Window Help

Compd ny 5] Company Snapshot -ox
Snopshof WindOW, Compeny  Payments  Customer

Add Contentv Resfore Default Fow do | custemize this page? Prin; v
from the My | ELE

. Add content to your Company Snapshot

Shortcuts section of
the Icon bar, select e vy 2 Ventars oy Renidas
Snapshots. = e — —

Step 2. To customize || = = Epma] L [ aseo
Snapshots, select
Add Content 9420f1;

Step 3. Use the Voot o ¥ X Cusnrs oowe ey

C Yeary CUSTOM=R DUEDATE &

arrows fo You may need fo 70 Allad, Robet W 1451000

scroll 159 o Wackeys Nrsery nd Ga. | 1047013 1390000

Th h Use These Grrows 1-o 700.00 40 Pretell Real Estate 111092013 502650

roug : . 21610 Cosk, Eien LT IER R Ik

flnd The deSIred 120000 o Hendro Riyzdi 111812013 422300

Th e H 9194 o Vitton, David 1113012013 70000

100 = .

CO nTen_I_ 133000 - I Tsschnw.Aﬁnun Wi/WS"ZUWS 56595

. 1.250.00 0 w15 e o e B 2 Rnb.snn Darci 1‘/16’2019 1242098
OVO”Oble C.U. Electic 12/30/2019 75000 v Mekon, Johnny 12/2072019 861864 v
payeils W Pror Yearls) I Curren:Yezr Recaive Payments

Sfep 4. Add Vendors 1‘0 Income and Expense Trend X Top Custamars by Saes vx Prev Year Expense Comparison v X
qu $i11000s “his year-to-date - Thisyeardo date iR v Yearly -

0 §in1000s
Step 5. Add Reminders ¢ -
Step 6. Select Done ‘ ok ®
20 Ili ili i Pratell Real Estate 150
12 . Meme. Jeanette ﬂ;z X || v
CUSTOMIZE QUICKBOOKS CALENDAR
The QuickBooks Calendar provides a user-friendly way to track v
tasks and due dates.
Step 1 T ickBooks Calendar, f the H
ep 1. o0 open QuickBooks Ca en. ar, from the Home Chart of inventory
page, select the Calendar icon onthe Company Accounts Activities
section.

Step 2. In the Calendar window, select December 15. A 75 a2
list of fransactions due and entered for the date ggmg‘s Get Financing
selected appears below the calendar.

Step 3. You can customize your QuickBooks Calendar to m

. B
suit your preferences. For example, at the top of
. Web Calendar
the calendar is a Today button. Select the Today Mobile Apps
button fo view just the current day.

Step 4. Also at the top of the calendar are three icons that permit you fo view the
calendar in a daily, weekly, or monthly format. Select the Weekly icon to view
only one week. Then select the Monthly icon fo return to the monthly calendar
view.

Step 5. At the top of the calendar, you can also select which fransactions fo show.
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Select the drop-down list fo view the different fransactions that can be selected

fo show on your calendar. Select All Transactions.




To the right of the calendar is a list of red-flagged past due items including any

pany Customers Vendgrs Employees Banking Repors Window Help

@ & December 2018  Today [0 ]688] [seiect a cate e | sHow [an Transactions  ~
A ATURDA ™ Upcoming: Next 7 dg

1 Entered (27) ~ TO DO (0) i
* TRANSACTIONS (0) Deys

¥ Due: Past 60 days (0)

2 Entered (9) 5 Ente 6 Entered (1) 7 Entered (7) 8 Entered (6)
¥ TO DO (0) Days
~ TRANSACTIONS (0) Days
g Entered (4) 4( Entered (17) 41 Entered (11) 42 Entered (18) 43 Entered (1)
16 17 18 19 20
23 24 25 26 27 28 29
v
30 31
December 15, 2018 AddToDo A
w TRANSACTIONS ENTERED (40) -
v BILS A 4 [ TAT
Keswick Insulation -670.00 Paid 1213072019
Cal Gas & Eleciric 12268 12/03 UnPaid 121302019
Sergeant Insurance -4,050.00 UnPaid 1/14/2020
Thomas Kitchen & Bath 58500 8058 UnPaid 1/14/2020
u Gontracting 1,250.00 UnPaid 121302019
w BILLPAYMENTS (14 N N
Wheeler's Tile Ete. 62500 501
Daigle Lighting 64092 502
Patton Hardware Supplies 75450 503
Perry Windows & Doors 6,03575 504
Lew Plumbing 4500 505
East Bayshore Tool & Supply 163152 506
Timberloft Lumber 135800 507
East Bayshore Tool & Supply 147623 508
Hopkins Construction Rentals 45000 509
Timberloft Lumbe 88600 510

East Bayshore Tool & Supply 80652 5
Patton Hardware Supplies 40000 512

items on your To Do list.
Step 6. Close the QuickBooks Calendar.

STATEMENT OF CASH FLOWS

|
Imagine that you have graduated from college without taking an accounting course. You are
employed by a company as a salesperson, and you eventually become the sales manager of a
territory. While aftending a sales managers' meeting, financial results are reviewed by the Vice
President of Sales and terms such as gross margin percentage, cash flows from operating
activities, and LIFO inventory methods are being discussed. The Vice President eventually asks

you to discuss these topics as they relate to your territory. You try to do so, but it is obvious to
everyone in the meeting that you do not know what you are talking about.

Accounting principles courses teach you the "language of business" so you understand terms
and concepts used in business decisions. If you understand how accounting information is
prepared, you will be in an even stronger position when faced with a management decision
based on accounting information.

The importance of fransactions analysis and proper recording of transactions has clearly been
demonstrated in some of the recent business failures that have been reported in the press. If the
financial statements of an enterprise are to properly represent the results of operations and the
financial condition of the company, the fransactions must be analyzed and recorded in the
accounts following generally accepted accounting principles. The debits and credits are
important not only to accounting majors but also to those entering or engaged in a business
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career to become managers because the ultimate effects of these journal entries are reflected
in the financial statements.

If expenses are reported as assets, liabilities and their related expenses are omitted from the
financial statements, or reported revenues are recorded prematurely or do not really exist, the

financial statements are misleading. The financial statements are only useful and meaningful if
they are fair and clearly represent the business events of the company.

Although accounting information plays a significant role in reducing uncertainty within the
organization, it also provides financial data for persons outside the company. This information
tells how management has discharged its responsibility for protecting and managing the
company's resources. Stockholders have the right to know how a company is managing its
investments. In fulfilling this obligation, accountants prepare financial statements such as an
income statement, a statement of retained earnings, a balance sheet, and a statement of cash
flows. In addition, they prepare tax returns for federal and state governments, as well as fulfill
other governmental filing requirements.

Accounting is often confused with bookkeeping. Bookkeeping is a mechanical process that
records the routine economic activities of a business. Accounting includes bookkeeping but
goes well beyond it in scope. Accountants analyze and interpret financial information, prepare

financial statements, conduct audits, design accounting systems, prepare special business and
financial studies, prepare forecasts and budgets, and provide tax services.

CH2 SCF

The statement of cash flows shows the cash inflows and outflows for a company over a period of
time. The headings and elements of each statement are similar from company to company.

Export the Statement of Cash Flows for Rock Castle by following these steps:

Step 1: Click Reports in the Navigation bar or Menu Bar

Step 2: Select type of report: Company & Financial

Step 3: Select report: Statement of Cash Flows

Step 4: Select the date range: Last Month. The Dates field will now be: 11/01/2022 to
11/30/2022. If you used the Navigation Bar click on Run. The menu bar method
may require a refresh (no run option available)

Step 5: Use the instructions in Appendix C to export your report for this activity to the
Excel file for the Unit 02_Reports.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6: From the drop-down list, select the sheet: CH2 SCF.
Step 7: CLICK on the EXPORT option
Step 8: Save the Excel File

Page | 52




BACKUP YOUR COMPANY FILE

Y Y Y Y Y Yy,
B R e e e e e e e B e e e e e S S S S i i S A A A A A i e e S A A e S S A S A S w8 S8 S e

Use the instructions in Appendix A to back up your company file. Make sure your backup file is
saved in the designated folder of this unit (UNIT 02 BACKUPS).

UNIT 02 PROJECT (ON-YOUR-OWN)

For this project, you will be restoring the backup file created for the unit. The QuickBooks
company file for Larry-s Landscaping has already been created and transactions have been
entered. Your assignment is to complete the following steps to export reports to Excel:

RESTORE THE UNIT 02 STARTER FILE
.

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u02a2 Larrys Landscaping. This file is in your UNIT 02 folder.

Step 19:  RESTORE the u02a2 Larrys Landcapaing.QBB file
Step 20:  Make sure you SAVE to the UNIT 02 FOLDER

EDIT COMPANY NAME AND PREFERENCES
.

Step 1: Update the Company Name to: Your Name Larry’s Landscaping

Step 2: Using the preferences option located in your QuickBooks Edit Menu

Step 3: Select the Use the last date entered date as default

Step 4: In the Accounting section, select Use account numbers fo display account

numbers in the Chart of Accounts.

CUSTOMIZE THE CHART OF ACCOUNTS
.

Enter the following accounts:

Account Supplies

Account No. 7310

Account Type Expense

Account Description Cleaning Supplies

Tax Line Schedule C: Supplies (not from COGS)
Account Computer Supplies
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Account No.

7320

Account Type

Expense

Account Description

Computer Supplies

Tax Line Schedule C: Supplies (not from COGS)
Account Professional Design Fees

Account No. 7430

Account Type Expense

Account Description

Professional Design Fees

Subaccount of

7400 Professional Fees

Tax Line Schedule C: Legal and Professional Fees
Account Section 179

Account No. 6710

Account Type Expense

Account Description Section 179

Subaccount of

6700 Depreciation

Tax Line

Schedule C: Other business expenses

Account

Internet Provider

Account No.

7754
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Account Type Expense

Account Description Internet Provider
Subaccount of 7750 Utilities
Tax Line Schedule C: Office expenses

P2 COA

QuickBooks provides an Account Listing report that lists the Chart of Accounts plus the account

balances.

To review the Account Listing report for Larry’s Landscaping:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Step 6.

Display the Chart of Accounts window.

Select the Account button > Re-sort List > OK

Click the Reports button at the bottom of the Chart of Accounts window.
Select Account Listing on the drop-down menu.

To export the Account Listing report to Excel, at the top of the Account Listing
window select Excel.

Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_02_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 7. From the drop-down list, select the sheet: P2 COA
Step 8. Review the exported report
Step 9. Highlight the accounts you added
Step 10.  Save and close the Excel file.
P2 SCF

The statement of cash flows shows the cash inflows and outflows for a company over a specific
recording period. The headings and elements of each statement are similar from company to

company.

Export the Statement of Cash Flows for Larry’s Landscaping by following these steps:

Step 1:
Step 2:
Step 3:
Step 4:

Step 5:
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Click Reports in the Navigation bar or Menu Bar

Select type ofreport: Company & Financial

Select report: Statement of Cash Flows

Select the date range: 10/01/2021 to 09/30/2023. If you used the Navigation Bar
click on Run. The menu bar method may require a refresh (no run option
available)

Use the instructions in Appendix C fo export your report for this activity to.




NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6: From the drop-down list, select the sheet: P2 SCF.

Step 7: CLICK on the EXPORT option

Step 8: Highlight any item on the statement that you might classify differently than shown
on the report

Step 9: Save the Excel File

BACKUP YOUR COMPANY FILE

Use the instructions in Appendix A fo back up your company file. Make sure your backup file is
saved in the designated folder of this unit (UNIT 02 BACKUPS).

TAKE THE QUIZ

The reading in the unit along with the Excel reports you have generated have provided answer
fo the quiz for this unit. Take the UNIT_02 QUIZ in your Canvas account

SUBMIT THE UNIT REPORTS

After you have taken the quiz using the answers you have already recorded in the reports you
extracted from Excel, UPLOAD the Excel file (UNIT_02_REPORTS), to the UNIT_02 assignment area
of your Canvas account.
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UNIT 03 — LISTS AND BANKING TRANSACTIONS
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QuickBooks offers several methods for tfracking and reporting on your accounting data so you
can review how your business is doing financially. As a company conducts business operations,

the company enters into fransactions with customers, vendors, and employees. Before entering
these fransactions in QuickBooks, it is important fo make sure the lists are up fo date.

The lists in QuickBooks provide a time-saving feature. Once the detailed data has been
entered, it does not need to be entered a second time. The list collects information that will be
reused throughout all fransactions.

QuickBooks Lists Include:

v' Customer List — Provides information about customer (email, contact, credit limits, etc.)

v" Vendor List - Provides details regarding vendors (account settings, contacts, payment
settings, etc.)

v Employee List — Contains full payroll database that includes employee SS#s and
important information.

v Item List — Provides information about the items or services sold to customers or
purchased from vendors.

v' Payroll Item List — Tracks detailed information about payroll, such as payroll taxes and
payroll deductions. The Payroll ltem List permits the use of a single or limited number of
payroll accounts while more detailed information is fracked using the item List for
payroll.

v' Class List - Permits income to be fracked according to the specific source (class) of
income. An example of a class might be a department, store location, business
segment, or product line.

Lists are used so that information can be entered once in a list and then reused as needed. For
example, information about a customer, such as addresses, can be enfered in the Customer List.
The customer information then automatically appears on the customer invoice.

RESTORE THE STARTER FILE

You will find the following files in your Student files for UNIT 03.

e UO3al Rock Castle Construction
e U03a2 Larry’'s Landscaping
e UNIT_03_Reports

To complete the first lesson exercises, RESTORE the u03al Rock Castle Consfruction
company file from the UNIT 03 folder.

NOTE: The process to restore a backup is found in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY
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After you have followed the instructions fo restore your data files, you will find the company file

you have restored contains sample data fora company called Rock Castle Construction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 13.  From the Menu bar, select Company

Step 14. Select MY COMPANY

Step 15.  Select EDIT

Step 16.  Update the Company Name Field to: YourName Rock Castle
Construction

Step 17. CLICK on OK
Step 18. Close the My Company window.

NOTE: The process fo rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

VIEW QUICKBOOKS LISTS

To view each of the lists described follow these steps:

= File Edt View Il Favorites Accountant gumpin, Customers Vendors Emplogess Banking Reports Window Help S il oq ,
List Menu &
= a
' a Clicking on any one of these
= : S tabs will display the list for
— = the category it represents
s
& B
Step 1. Select Customers on the Navigation Bar to view the Customers List
Step 2. Select Vendors on the Navigation Bar to view the Vendors list
Step 3. Select Employees on the Navigation Bar to view the Employees List
Step 4. Select the Items & Services icon in the Company section of the Home Page fo
view the ltems & Services List
Step 5. Select the Chart of Accounts icon in the Company section of the Home Page to
view the Chart of Accounts list of accounts.
Step 6. Select the Lists Menu fo view other QuickBooks lists, such as the Payroll ltem List or

the Class List.
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CH3 CB DT

For this section of the assignment we will pull the Customer Balance Detail report to view how
the QuickBooks displays the customers and jobs.

Step 1. Click on the Reports section of the menu bar or the icon bar
Step 2. Click on Customers & Receivables
Step 3. Click on Customer Balance Detail. If you choose the menu bar opftion, you will

need to select the Run option.

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_03_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6. From the drop-down list, select the sheet: C3 CB DT
Step 7. Save and close the Excel file.

CH3 EMP WH

The report for this activity will provide a view of the Employee Withholding.

Step 1. Click on the Reports section of the menu bar or the icon bar

Step 2. Click on Employees & Payroll

Step 3. Click on Employee Withholding

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O3_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6. From the drop-down list, select the sheet: C3 EMP WH

Step 7. Save and close the Excel file.

ONSCREEN FORM OR JOURNAL ENTRIES

QuickBooks offers two different ways to enter transaction information by using the Onscreen
Journal or Onscreen Forms.

ONSCREEN JOURNAL

B

.=

.=

.=

.=

.=

&

We can make debit and credit enfries in an onscreen Journal. The onscreen Journal is often
used to make adjusting enftries at year end to bring accounts up to date before preparing
financial statements. (To have a better understanding of how debits and credits work, refer to
the chart in Appendix D). The following example is of a journal entry.

Step 1. Click on Company from the menu bar
Step 2. Click Make General Journal Entries
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Step 3. Click on the enfry numbered FAM2010 fo bring it info view

= ke General Joumal Entries LI
Main | Reporis E
«» B B R Bowstescory @ = 1] =] =

Fnd  MNew Save Delele @hmemorize Reverse  Pinl  Alach | Hde | Send
b Fil List ClEs

pwe 12312021 B evmvno | FAM2010 B ADJUSTING ENTR

60900 - Depraciation Expense Record 2010 Depraciation

17000 - Accumulated Depreciation

4443591 Record 2010 Depreciation

Expense

: Asset
(increase)

(decrease)

Totals 4443591 4443591

List of Selected General Journal Entiés. | Last Fiscal Year -

1273172021

62100 - Insurance 62120 - Liabilily Insurance July allocation of prepaid rider policy

Record 2010 Depreciation
1200172021

13002021
10112021
103172021

13100 - Pre-paid Insurance
52100 - Insurance-62120 - Liability Insurance
13100 - Pre-paid Insurance

52100 - Insurance-62120 - Liabilfty Insurance

Huly allocation of prepaid rider policy

July allocation of prapaid rider policy

Save & Close

Notice in the view of the entry, the numbering system is an indication of how the

account istracked. (Appendix D has a list of the account numbering system for
your reference.)

ONSCREEN FORMS

o
=

e
——

e e
—— ——

e e
—— ——

&

We can enter information about fransactions using onscreen forms such as the following
onscreen form. When we enter information into an onscreen form, behind the screen
QuickBooks automatically converts that information into a journal entry with debits and credits.

QuickBooks maintains a list of journal enfries for all the transactions entered-whether entered
using the onscreen Journal or onscreen forms.

CH3 JUR-1

To view the Journal entry that QuickBooks created behind the screen for a fransaction entered
and saved using an onscreen form, complete the following steps:

Step 1. To view an onscreen form such as an Expense, select the Enter Bills icon in the
Vendors section of the Home Page.

Step 2. From the Enter Bills onscreen form window, select the Main tab at the top of the
window.
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)

Step 3. Click the back FIND- s, onows Cplonas Wi, o B s o L
Arrow until the bill for '
Thomas Kitchen &
Bath for 12/15/2022 in
the amount of

Reports Tab

12152022 W

$585.00 appears.

12252022 @

Step 4. Next select the
Reports tab af the
top of the Enter Bills o=
window

Step 5. Select Transaction
Journal

Step 6. Export to Excel

Step 7. Follow the instructions
in Appendix C to export the report to the Excel file named UNIT_03_REPORTS
Excel file.

$0.00 llems 5000

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8. From the drop-down list, select the sheet: C3 JUR-1

Step 9. Save and close the Excel file.

BANKING AND CREDIT CARD TRANSACTIONS
___________________________________________________________________________________________________________________________|
If necessary, click the Home icon in the Icon bar to display the Home page. From the Banking
section of the Home page, you can:

Record deposits (cash flowing in the Checking account).
Write checks (cash going out of the checking account).
Print checks

Reconcile bank statements

View Check Register

v' Enter credit card charges

NN NN

A business should establish a business checking account separate from the owner’s personal
checking account. The company’s business checking account should be used only for business
transactions, such as business insurance and mortgage payments for the company’s office

building. An owner should maintain a separate checking account for personal transactions,
such as mortgage payments for the owner’'s home.

VIEW AND PRINT CHECK REGISTER

=

e

B B e

e B B oS- S S L A S AL S S L S S S S S SR S S e S S o

CH3 REG
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The Check Register is a record of all fransactions affecting the Checking
account. The QuickBooks onscreen Check Register looks like a
checkbook register used to manually record deposits and checks.

BANKING

&l B

Record Reconcile
To view the QuickBooks Check Register: Deposits

Step 1.  Click the Check Register icon in the Banking section of the &

Home page. Chocks Register
Step 2. The following window will appear asking you to specify a

bank account. Select 10100 Checking. ] =

Print Enter Credit

Checks Card Charges

Use Register

= Elndeaell 2 210100 - Checking

Cancel

Step 3. Click OK

The Check Register window should appear on your screen. Notfice there are separate columns
for:

v Payments (checks)
v Deposits
v" Balance

Small enterprises that have strictly cash-based operations sometimes simply use the Check
Register to record all fransactions. Such enterprises record payments and deposits directly into
the Check Register using the Record button. However, most business enterprises require the

more advanced features of the QuickBooks accounting software. The next few exercises will
cover some of these techniques.
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Step 4. QuickBooks drill-down feature permifs you fo double-click some items to drill-
down and view the supporting documents. To view the check for the Sergeant
Insurance fransaction, double-click the Sergeant Insurance entry on 11/15/2022 in

the Check Register.

Sample Your Name Chapter 1 Rock Castle Construction - QuickBooks Pro Plus 2014 - [10100 - Checking]

mpany Customers ‘endors Employees Banking Reports Window Help

€ Goto.. ‘ & Print.. ‘ [ Edit Transaction BB QuickReport £ Download Transactions

funds paid to Sergeant Insurance. Close the Write Checks windows by
H clicking on the in the upper right corner of the window.
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DATE NUMBER PAYEE PAYMENT - ]
TYPE ACCOUNT MEMO

111212018 448 Patton Hardware Supplies 4810
CHK 54000 - Job Expenses54300 - Job Materials

11/14/2018 449 McClain Appliances 20000 «
BILLPMT 20000 - Accounts Payable 85-93117

11/14/2018 450 C.U. Electric 440.00 «
BILLPMT 20000 - Accounts Payable

11/14/2018 451 Larson Flooring 3,200.00
BILLPMT 20000 - Accounts Payable

11/14/2018 452 Middlefield Drywall 850.00 «

00 - Accounts Payable ROCK-0921
11/14/2018 t Bayshore Auto Mall 53297
Monthly Truck Payment

H 454 Sergeant Insurance ~ 675.00 « |Deposit
CHK -split- > Memo

11152018 455 DoMom-eascdwae Supphes— 48993 o
CHK 54000 - Job Expenses:54300 - Job Materials

11/15/2018 456 QuickBooks MasterCard 1,050.00 ~
CHK 20500 - QuickBooks Credit Card

11/15/2018 457 CalOil Company 4828
CHK 20600 - CalQil Credit Card

A11RIN12 ARQ Ctata Rnard nf Frnalizatinn 4 NOa Ad
Step 5. The check is stamped Cleared, indicating it has already cleared the bank with




(0
454
1mstAoa n
ekl Frlar arse bl AR
Sor huridined sty Sy And QOFI0F " TS T RIS R s R E R T R R R R A
- L0 L - — —_—
o
Cpromant araren 'ﬂ L I:|
P B 8257 #
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—— A R
£
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x
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A0 - insran FTEO0 R gl [ Chverhead |*(
Lol oo G Chrin et [ Choiitubnied
I e 1ol 0 Chmteacd T e

If you wantfed to double check to make certain the Sergeant Insurance bill had not been
erroneously paid twice, you can use the QuickReport feature of the Check Register to view all
payments to Sergeant Insurance.

Step 1. Display the Check Register. In the register, click on the 11/15/2022 Sergeant
Insurance payment for $675 to select it.

Step 2. Select the QuickReport button at the top of the Check Register window.
Step 3. When the Register QuickReport window appears:

v' Enter Dates: All

v Export the report to Excel

v The sheet to export o is called CH3 REG
This fiscal year's total for Sergeant Insurance is $-21,698.98.

Step 4. Close the Register QuickReport window and then the Check Register window by
clicking the in the upper right corner of each window.

e

You can record deposits and checks directly in the Check Register or use the Make
Deposits window and the Write Checks window.

MAKE DEPOSITS

.=

&

.=

.= .=

.=

B

Deposits are additions to the Checking account. Any cash coming into a business should be
recorded as a deposit fo one of the company's accounts.

QuickBooks classifies deposits into two types:
1. Payments from customers
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2. Non-sales receipts (deposits other than customer payments) such as:
v Cash received from loans
v Investments from owners
v'Interest earned
v Other income, such as rental income pannG

Payments from customers are entered using the Customers section of the &

Home page. Deposits other than customer payments are recorded using Recorg Recancile
the Banking section of the Home page. e

In the next exercise, we are assuming Mr. Castle wants fo invest an e Ck
additional $72,000 in the business by depositing his $72,000 check in Rock Checks Register
Castle Construction’s Checking account.

=)
Non-sales receipts - a deposit other than a customer payment isrecorded L Ertercreat
using the following steps: - e
Step 1. From the Banking section of the Home page, click the Record
Deposits icon.
Step 2. The following Payments to Deposit window will appear. QuickBooks uses a two-

step process to record payments received:
v Undeposited Funds — Record the payment received by not yet deposited

v' Record the deposit

The payments listed in the Payments to Deposit window are undeposited funds that have been
recorded as received but not yet deposited in the bank. Since these amounts will be deposited
at a later time, confirm that none of the payments have been selected for deposit, then click
Cancel.

SELECT VIEW
View payment method type All types ~ | What are payment method views?
Sort payments by Payment Method
SELECT PAYMENTS TO DEPOSIT
+ | DATE TIME TYPE o] PAYMENT METHOD NAME AMQU
12/15/2018 PMT Cash Roche, Diarmuid-Garage r.. 440.00|
12/14/2018 PMT 986 Check Jacobsen, Doug:Kitchen 2,000.00
0 of 2 payments selected for deposit Payments Subtotal 0.00
Select All
» oK Cancel Help

Step 3. When the following Make Deposits window appears, record Mr. Castle’s $72,000
deposit. Select Deposit To: 10100 Checking.

Step 4. Select Date: 12/15/2022
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Step 5. Click in the Received From column and type: Rock Castle. Press the Tab key.
Step 6. When prompted, select Quick Add to add the name to the Name List

Step 7. Select Name Type: Other

Step 8. Click OK

p— . ) Select which type of name to add then click OK.

i@] Rock Castle is not in the Name list.

el To automatically add Rock Castle to the Name list, click Quick © Vendor
Add. -
You can enter more detailed information later. Customer

T Employee
To enter the detailed information now, click Set Up (usually not ® Oiher
required). Qther;
6 | Quick Add ‘ SetUp Cancel . @ Cancel
Step 9. Click in the From Account column. From the drop-down list of accounts, select

30100 Capital Stock. Press Tab.
Step 10. Enter memo: Investment
Step 11.  Enfer Check No. : 555 the number of Mr. Castle’'s check).
Step 12. From the Payment Method drop-down list, select Check

Step 13.  Enfer Amount: 72000. (QuickBooks will automatically enter the comma in the
amount.)

@ previous ® Next B save & Print V‘ &2 payments & History | @l Attach

DepositTo 10100 - Checki... ~ Date 12/15/2018 @& Memo Deposit
Click Payments fo select customer payments that you have received. List any other amounts to deposit below.

RECEIVED FROM FROMACCOUNT MEMO CHKNO. ¢ PMT METH CLASS AMOUNT
Rock Castle 30100 - Capital Stock Investment 555 Check 72,000.00

Step 14. QuickBooks permits you to print a deposit slip using a QuickBooks preprinted form
and a deposit summary. To print a summary of the deposit you just recorded,
select the Print arrow at the top of the Make Deposits window.

Step 15.  Select Deposit Summary.

Select the appropriate printer or PDF printer, then click Print. DO NOT confirm the print. Click the
Print Preview option. The deposit summary should list the $72,000 check from Mr. Castle. Mr.
Castle's $72,000 investment in the company has now been recorded as a deposit in Rock Castle
Construction’s Checking account.

Step 16.  Close the Make Deposits window by clicking the Save & Close button.

WRITE CHECKS

o
=

e
——

T e e e et e e e e
i e e S i S St S B e e S S S e e oS S e B e S e S S et e e S S e e S e e S B e St St e S e e e e
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A business needs to track all cash paid out of the company’s checking account. Examples of

payments include purchases of inventory, office supplies, employee salaries, rent payments, and
insurance payments.

Supporting documents (source documents) for payments include canceled checks, receipfts,

and paid invoices. These source documents provide proof that the transaction occurred;
therefore, source documents should be kept on file for tax purposes.

QuickBooks provides two ways to pay bills:

One-Step Approach to Bill Paying BANKING
]
Record and pay the bill af the same time. When using DRecor_? Reconcile
eposits

this approach, the billis paid when it is received.

QuickBooks Journal:

LA =
;
1. Debli. — Records an Expense' Write Check
2. Credit - Reduces the checking account Checks Register
amount
&
Print Enter Credit
Checks Card Charges

Two-Step Approach to Bill Paying

Enter Bills — Record bills for services such as Pay Bills - Select Bills fo pay, then print
utilities checks

QuickBooks Journal:
3. Debit - Reduces the Liability

QuickBooks Journal:
1. Debit — Records an Expense

2. Credit - Records and obligation
(liability) to pay later

4, Credit - Reduces the Checking
account
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When NOT to Use the One-Step Approach

v Paychecks — Employees should be paid wages and salaries from the Pay Employees
section of the Home page.

v" Payroll Taxes and Liabilities — QuickBooks generates the obligation for this cost through
the employee section under Pay Liabilifies.

v Sales Taxes — From the Vendors section, use the Manage sales Tax icon and Pay sales Tax
window.

v Bills Entered - Bills that have been entered through the vendor area, must use the two-
step approach and follow through with the Pay Bills option.

The next activity will use the Write Checks window (One-Step Approach) to pay a computer
repair service bill for Rock Castle Construction.

Step 1.

Step 2.
Step 3.

Step 4.

Step 5.

Step 6.

Step 7.
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From the Banking section of the Home page, click the Write Checks icon and an
onscreen check will appear.

To enter the check information, select Bank Account: Checking
Select Date 12/15/2022.

For the Pay to Order of field, select: Kershaw Computer Services. (Select Kershaw
from the drop-down list or type the first few letters of the name.)

Enter the check amount: 300

Click the checkbox preceding Print Later so that a check mark appears. This tells
QuickBooks to both record and print the check. The Check no. field now
displays: To Print. Notice there is also an option to Pay Online.

Next, to record the payment in the correct account using the lower portion of the
Write Checks window, select the Expenses tab.




Step 8. If not already selected, select Account: 64220 Computer Repairs. Account 64200
Repairs:64220 Computer Repairs should appear in the Account column and $300
should automatically appear in the expense Amount column.

I Main Reports
& P ’ E g@ Createa Copy v | Print Later @ @ % E % O
Find New Save Delete 'ﬁmemoﬁze Zay Online Attach Select Enter Clear Recalculate Reorder
= File PO Time Splits Reminder | Order
Checks
B.—"«NEACCC» 10100 Checking ENDING BALANCE 118,969.10
I TOPRINT
12152018 &
PAY TO THE ORD» Kershaw Computer Services - 300.00

Three hundred and O0/00* * * * * * * * ¥ ¥ ¥ 5 5 5 5 5 X K K KX XXX XXX KRR XA AAARKFFR R R KRR KKK E® OOL[ARS

ADDRESS
Kershaw Computer Services
101 Main St
Bayshore CA 94326

MEMO

Expenses $300.00 ltems $0.00

ACCOUNT

AMOUNT

MEMO

‘64200 Repairs:64220 - Computer Repairs -

300.00

Note: If the payment was related to a specific customer orjob, you could enter that information
the Customer: Job column and select Billable.

To print the check, select the Print button located at the top of the Write Checks

window. (Choose the PDF printer for this option. This will give you a detailed view

Step 9.

of the actual printout)
Step 10. Enter Check No.: 517
Step 11.  Click OK
Step 12.  If you were using the

preprinted check
forms, the form would
be inserted info the
printer at this fime.
There are several
opftions that can be
used for the printer
including the

company address,
logo and signature.
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You have 1 check to print for $300.00

Settings Fonts Partial Pa...

Printer name: Adobe PDF on Documents\*.pdf > Options...

Printer type: Page-oriented (Single sheets) M

Note: To install additional printers or to change port
assignments, use the Windows Control Panel.

CHECK STYLE

© Voucher @ Standard @ Wallet

Print company name and address.
Use logo

Print Signature Image
CHECKS ON 1STPAGE

Number of checks on first page: 3

To print a partial page of checks, place it in
your printer's envelope feeder. The envelope
feeder will only be used for the first page.

Cancel
Help

Logo

Signature




THE JOURNAL

QuickBooks uses two different ways to enter information:

1. Onscreen Forms —these are forms such as the check you just completed.

2. Journal - The journal creates a list of all fransactions automatically using debits and
credits.

Sample Your Name Chapter 1 Rock Castfle Construckion - QuickBooks Pro Plus 2014
| Ele Edt Vew Lists Favontes Company Cystomers Vendgrs Employees Banking Reports Window Help

Stancard

! Memorized Favorites Recent Contributed ol 4
You are using a sample
company file o = |88
Create a new company file 12018 11/30/2018 12472018 121152018
Company & Financial 5 @ L_l @
p— Custamers & Receiva o @ o @

M Home
&

Sales
Jobs, Time & Milcage

Vendors & Payables

Transaction Detail by Account Journal

Trancaction Datad by Accosat

Purchases
e e e ot
=y :
(=1 i = mm il
= = proe b
Emplivess & Payrol = " m
Emplayees & Payrall = fio A T S e, st
5 4 S e e
Banking [ gttt 703 1B B Ok 1308, e ey o .
o =T HEE RS ) T -
il e ]
Accountant & Taxes o G um ol e e
Mt e O B Py Mo Comey O =
Tt o, S i e s -
Budgets Pres  CALY fa e Coispetd P Toame P Rl —
. Bt R e i e i m s
oo RN, B s P —— w
it ot s R W TE TR e g W
Li d ]

Dates:  This Month-to-date « Dates: Today =

1212018 12152018 12152018 12152018

| B viewBaiances O H 9O OH VPO
W Run Favorits Reports
1 Gpen Windows
Audit Trail

Voided/Deleted Transactions Summary

Do More With QuickBooks

[ES—— [T — [RT
o Tum on Fayroll s - e est
i by o
B Accept Credit Cards - p— o B
& order Checks & Supplies oot () Ammet Tt BN
-
4 Auto create expense Feports e e e

& Hassle-Free Financing

When you enter information into an onscreen from, QuickBooks automatically converts that
information info a journal entry with debits and credits.

To view the journal enfry for the check that you just recorded, follow these steps:

Step 1. Click Reports in the Icon bar to open the Report Center window.

Step 2. Select: Accountant & Taxes

Step 3. Select: Journal

Step 4. Select Dates: Today From: 12/15/2022 To: 12/15/2022

Step 5. Select Run.

Step 6. Your Journal window should appear as follows. Double-click on a journal entry, fo
drill down to the related source document. If you double-click on the journal
entry that records the computer repair, the Write Checks window appears,

displaying the onscreen check that you just prepared. Close the Write Checks
window.
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Step 7. Noftice that the journal entry to record the deposit of Mr. Castle’s $72,000 includes
a debit to the Checking account and credit to Account 30100 Capital Stock.

Customize Report Share Template Memorize Print * E-mail ¥ Excel « Hide Header Refresh
Dates Today ~ From 12/15/2018 B To 121152018 & Sort By Default -
45PN Your Name Chapter 1 Rock Castle Construction
12115118 Journal
December 15, 2018
Trans # o Type o Date ¢ Num e Name ¢ Memo @ Account @ Debit @ Credit I3
1759 Sales Tax Paym... 12/15/2018 516 State Board of Eq...  ABCD 11-23... 10100 - Checking 1,629.27 =
State Board of Eq...  ABCD 11-23... 25500 - Sales Tax Payable 54210
State Doard of Eq...  ABCD 11-23... 25500 - Sales Tax Payable 1.087.17
E 1777  Deposit 12115/2018 Deposit 10100 - Checking 72,000.00
E Rock Castle Investment 30100 - Capital Stock 72.000.00
H 72,000.00 72,000.00
E 1778 Check 12152018 517 Kershaw Compute... 10100 - Checking 300.00
f Kershaw Compute... 64220 - Computer Repairs 300.00
: 300.00 300.00
v

RECORDING DEBITS AND CREDITS
.

Five different types of accounts are listed below along with the effects that debits and credits
have on them.

Account Type Debit Credit Effect on Balance
Asset v Increase
Liability v Increase
Equity 4 Increase
Revenues (Income) v Increase
Expenses v Increase

Notice that the debit to Rock Castle Construction Checking account increased the balance.
The credit to the Capital Stock account for $72,000 increased the Capital Stock account
balance.

Account Account Type Debit Credit Effect on Balance
Checking Asset v Increase
Capital Stock Equity v Increase

Step 8. View the entfry on 12/15/2022 to record the check written to Kershaw Computers
for computer repair services. This enfry debits (increases) the balance of the

expense account, Computer Repairs, and credits (decreases) the Checking
account balance.

CH3 JUR-2

Page | 72

sesesecssscscscscscscsocsne




Step 1. With the Journal open, you will now create a report filter select Customize Report
at the top of the report window.

Step 2. Click the Filters tab
Step 3. Choose Filter: Name

Step 4. From the drop-down Name List, select: Kershaw Computer Services

Filters Header/Footer Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICES

[FILTER Name FILTER SETTO
Amount ershaw Computer Services - Date Today
Date Name Kershaw Computer Ser...
ltem
I Memo
’
Remove Selected Filter

NAME FILTER

Choose the types of names or a specific name from the
drop-down list.

Tell me more...

Revert

Step 5. Click OK to close the Modify Report: Journal window.

Step 6. Export to Excel

Step 7. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O3_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8. From the drop-down list, select the sheet: CH3 JUR-2

Step 9. Save and close the Excel file.

RECONCILE BANK STATEMENTS

Typically, once a month the bank sends a Checking account bank statement to you. The bank
statement lists each deposit, check, and withdrawal from the account during the month.

A bank reconciliation is the process of comparing, orreconciling, the bank statement with your
accounting records for the Checking account. The bank reconciliation has two objectives: (1)

to detect errors and (2) to update your accounting records for unrecorded items listed on the
bank statement (such as service charges).

Differences between the balances the bank reports on the bank statement and the balance
the company shows in its accounting records usually arise for two reasons:
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1. Errors - Either the bank errors or the company errors.

2. Timing differences - This occurs when the company records an amount before the bank
does or the bank records an amount before the company does. For example, the

company may record a deposit inits accounting records, but the bank does not record
the deposit before the company’s bank statement is prepared and mailed.

Timing differences include:

e Deposits in Transit — deposifts the company has recorded but the bank has not.

e Outstanding checks - checks the company has written and recorded but the
bank has not recorded yet.

e Unrecorded charges - charges that the bank has recorded on the bank
statement, but the company has not recorded in its accounting records yet.
Unrecorded charges include service charges, loan payments, automatic
withdrawals, and ATM withdrawals.

¢ Interest earned on the account - interest the bank has recorded as earned but
the company has notf recorded yet.

CH3 REC DT

The following bank statement lists the deposits and checks for Rock Castle Construction
according to the bank’srecords as of November 20, 2022.

BANK STATEMENT
Rock Castle Construction
1735 County Road ”_20_2.022
Checking
Bayshore, CA 94326
Previous Balance 10-20-2022 $71,452.58
+Deposits 0 0.00
-Checks 4 4,161.56
-Service Charge 10.00
+Interest Paid 0.00
Ending Balance 11-20-2022 $67,281.02
Deposits
Date Amount
0.00
Checks Paid
Date No. Amount
10-31-2022 433 712.56
10-31-2022 436 24.00
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11-14-2022 451 3,200.00
11-19-2022 460 225.00

Thank you for banking with us!

To reconcile this bank statement with Rock Castle’s QuickBooks records, complete the following

steps:

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.
Step 7.
Step 8.
Step 9.

Step 10.

Step 11.

Step 12.

Step 13.

Step 14.

Step 15.
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From the Banking section of the Home page, click

the Reconcile icon to display the Begin
Reconciliation window. R

Reconcile
Deposits
Select Account tfo Reconcile: 10100 Checking
Enter date shown on the bank statement: __
% =
11/20/2022
Write Ch_eck
Compare the amount shown in the Beginning Checks Register
Balance field with the beginning (previous)
balance of $71,452.58 on the bank statement. _
=
In the “Ending Balance” field, enter the ending Print Enter Credit
balance shown on the bank statement: $67,281.02. Checks Card Charges

In the Service Charge field, enter the bank’s service charge: $10.00.
Change the date fo 11/20/2022.

Select the Account: Bank Service Charges.

Click Continue

To mark deposits that have been recorded by the bank, simply click on the
deposit in the Deposits and Other Credits section of the Reconcile window.

To mark checks and payments that have cleared the bank, simply click on the
check in the Checks and Payments section of the reconcile window.

After marking all deposits and checks that appear on the bank statement,
compare the Ending Balance and the Cleared Balance at the botfom of the
Reconcile window (on previous page).

The Difference amount in the lower right corner of the Reconcile window should
equal $0.00.

If the difference is $0.00, click Reconcile Now. If there is a difference between the

Ending Balance and the Cleared Balance, then fry to locate the error oruse
QuickBooks Locate Discrepancies feature from the Begin Reconciliation window.

When the Select Reconciliation Report window appears, select type of
Reconciliation Report: Detail.

Export to Excel




Step 16.  Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_03_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 17. From the drop-down list, select the sheet: CH3 REC DT

Step 18.  Save and close the Excel file.

After you click Reconcile Now, you can view the Bank Reconciliation by selecting Reports menu
>Banking > Previous Reconciliation.

If you need to make changes to the bank reconciliation, you may perform any one of the
following:

1. To return to the reconciliation screen to make changes, from the Begin Reconciliation
window, click Locate Discrepancies.

2. Another way to change the status of a cleared item: Display the Check Register, then
click the Cleared Status column until the appropriate status (cleared or uncleared)
appears.

ONLINE BANKING

QuickBooks offers an online banking feature so that you can conduct banking transactions
online using the Internet. View online banking features through the Banking menu.

To setup an online banking account, you will follow these steps with your bank:

1. Checktoseeif your bank supports online banking. If yes, register for an online
account.

2. Fromthe QuickBooks Banking menu, select Bank Feeds > Set Up Bank Feed:s for
an Account.

NoTE: Go to Banking > Bank Feeds > Participating Financial Institutions.

3. Inthe Enter your Bank's name field, enter the name of your bank. Note: as you
type, QuickBooks displays possible matches.

DIRECT CONNECT

o
=

e o e
—r

e e e

it

e
—r

To setup account for Direct Connect, you must first apply for online services through
your bank. If you use more than one account, you may have to apply foreach one
separately. The bank will provide you with your login credentials once your application
is approved. Contact your Financial Institution (Fl) for details. If your bank offers Direct

Connectservice, you will be redirected to a window providing you the option to enroll
in the service.
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1. If youwant to enroll, select the enrollmentssite link and you will be redirected to
the bank’s website.

NoTtE: banks charge for Direct Connect service.

2. If you do not want to enroll, you will be given the option to manually import
transactions.

3. If you have previously enrolled in Direct Connect, select the Continue button. In
the next window, you can enter your Direct Connect login credentials.

Enter your Online Banking ID and Password.

Select Connect. QuickBooks will connect to the bank’s server.

Select the bank account you want to connect to QuickBooks.

Select Finish after the process completes. You have successfully activated

online banking.

aouoo

WEB CONNECT

e Bt e e e e e e e e e e e e e
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1. If your bank only offers Web Connect, you will be redirected to a window
providing steps to download transactions through Web Connect.

NortEe: downloading transactions from the bank’s website and importing them into
QuickBooks Desktop for the first fime automatically sets up an account for online
banking. Depending on your bank and the version of QuickBooks you're using,
you may be presented with options for Direct Connect, Web Connect or both.

2. On the Link your Accounts screen, choose which bank account(s) to add to
QuickBooks.

a. If you have multiple accounts (Savings, Checking, or Credit Card)
available to connect to QuickBooks but only need one (Checking), then
you can set up online banking just for it.

b. If the accountis notyetin QuickBooks, select the Select existing or Create
new drop-down, then choose Create New Account.
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You can access QuickBooks online banking features from the Bank menu shown next.

Step 1.
Step 2.
Step 3.

Step 4.

any Customers

Y savings

| ANYTIME Financial

~ Account endin

| ANYTIME Financial
I Account ending in ***1244

|| In QuickBooks

mple Your Name Chapter 1 Rock Castle Construction - QuickBooks Pro Plus ]

EELLOGE Reports  Window Help

Order Checks & Envelopes 3

Enter Credit Card Charges VENDORS

Use Register Ctrl+R

Make Deposits [ @
Iransfer Funds Enter Bills
Reconcile Against

Set Up Bank Feed for an Account
Participating Einancial Institutions
Import Web Connect File

Create a Message for your Bank
Change Bank Feeds Mode

Loan Manager
Other Names List

Get Financing

Select Banking from the Menu bar
Select Bank Feeds.

Select Bank Feeds Center

In the Bank Feeds window, select the Bank Account: ANYTIME Financial

Accounting ending in #**1235.

Sample Your Name Chapter 1 Rock Casfle Construction - QuickBooks Pro Plus 2014

Vendors Employees Banking Reports Window  Help

Bank Feaeds

Account Information

LAST UPDATE. Over a year ago £

ANYTIME Financial
ACCOUNT ENDING IN *1235

$5,035.66

In QuickBooks
ENDING BALANCE Chacking

$118,659.10

$17,910.19

$5,035.66

g in 1235 Over ayearago

1 EEEDEY 7 transactions are waiting to be added to QuickBooks.
~ CREDITCARD
QuickBooks Credit Card $45.00
Account ending in ***4321 Over a year ago Read messages from your bank =z
N in QuickBooks Send items to your bank g
| oo cr oy b e Online Checks (0 0f 0) Bill Payments (0 of 0) £
W Paymertingiey Responees 0 Transfers (0 of 0) Messages (0 0f 0) g
B A0 Payment Inquiries (0 of 0) Payment Cancellations (0 of 0) %I
Manage your account
S s bau Send ltems Create New =
Disable bank feeds
1

Step 5.

Step 6.
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Select: Transactions List.

In the Tell QuickBooks how to handle these bank fransactions, check the

fransaction for Anton Teschner. In the Action column, select Approve




Step 7.

Close the Transactions List window and the Bank Feeds window.

ENTER CREDIT CARD CHARGES

|
QuickBooks offers businesses the ability to enter credit card charges into QuickBooks and then to

download card charges to update and match QuickBooks records.

In the next exercise you will be entering a credit card charge for a $50.00 track pad purchased

from Kershaw Computer Services:

Step 1.

Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.
Step 8.
Step 9.
Step 10.

From the Banking sectfion of the Homepage, click the Enter Credit Card Charges

icon.

From the following Enter Credit Card Charges window, select Purchase/Charge.

Select Purchased From: Kershaw Computer Services.
Enter Date: 12/15/2022.

Enter Amount: 50.00

Enter Memo: Trackpad

Select the Expenses tab

In the Account field, enter account number: 63000 - Office Supplies

The Amount field should automatically display the amount of 50.00

Click Save & Close

Main Reports

€« B B 33 Boercacony [  Boowascauncrages Bt B

Find New Save Delete §bMemorize Attach Select Ente Clear Recalculate
e File PO 3 Splits

Credit Card Purchase/Charge

A.V-\O»éa_oo -
»TréEEbad' - - B

Expenses $50.00 [tems $0.00 Ready fo pay a credit card bill?

CREDITCARD 20500 - QuickBooks C... »Purchasafcharge © Refund/Credit ENDING BALANGCE 94.20
pumﬁw» T T Dn» T ——
REF N -]

Save & Close ‘ Save & New ‘ Clear

ACCOUNT AMOU__ ¢ MEMO CUSTOM. Bl CLASS
*3000 Office Supplies 50.00 - T

[X] WHAT'S NEW

CHALLENGE ACTIVITIES
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CH3 JUR-3
Step 1: Make Deposit

a. AMOUNT: $1,000

b. FROM: Rock Castle

c. CHECK: No. 556

d. ACCOUNT: 30100 Capital Stock
e. DATE: 12/15/2022

f.  MEMO: Invest

Step 2: Generate & Customize the Report
a. From the Accounting & Taxes section, open the Journal
b. Customize the Journal
c. Click on Filters

d. NAME: Rock Castle
Step 3: Export to Excel
Step 4: Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_O3_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 5: From the drop-down list, select the sheet: CH3 JUR-3

Step 6: Save and close the Excel file.

FIND AND EDIT CHECKS

B

.=

e
B B R SR S A S S o

CH3 REG-2

Find Check No. 470 made out to Washuta & Son Paining in the QuickBooks Check Register by
completing the following steps.

Step 1: View the Check Register. (Click Check Register icon in the Banking section of the

Home page.)

Step 2: Next, search the Check Register for Check No. 470 using the Go To feature. Click
the Goto ... bufton in the upper left corner of the Check register window.

Step 3: In the Go To window:

v'Select Which Field: Number/Ref
v Enter Search For: 470
Step 4: Click the Next button. If asked if you want to search from the beginning, click Yes.
Step 5: Check No. 470 on 11/28/2022 to Washuta & Son Painfing should appear in the
Check Register window.
Step 6: Close the Go To window
Step 7: To view Check No. 470, double-click on the Check Register entry for Washuta &
Son Painfing to drill down to the check.
Step 8: After viewing the check, CLOSE the Check window.

VoID CHECK

=

e

e
B - - S L A L AL S L i S L S S i B S B 20 S S S S AL S S L S S S S S L S S S S
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The next task is to void Check No. 470. There are two ways to remove a check amount for the
Check Register:

1. Delete the check: This removes all record of the fransaction.

2. Void the check: QuickBooks changes the amount deducted in the Check Register to
zero, but the voided check sfill appears in the Check Register, thus leaving arecord of
the fransaction, a voided check provides a better record than a deleted check.

For Check No. 470, you want fo maintain a record of the fransaction, so you want to void the
check rather than delete it. Void this check by completing the following:

Step 1: Select Check No. 470 in the Check Register.

Step 2: With your cursor over Check No 470, right-click and from the pop-up menu select
Void Bill Pmt - Check. VOID should now appear next to Check No. 470 in the
Check Register and the Payment amount should now be $0.00.

Step 3: Click the Record button in the lower right corner of the Check Register window.

Step 4: When asked if you are sure you want to record the voided check. click Yes.

Step 5: With your cursor on the voided check No 470, select QuickReport.

Step é: Export to Excel the QuickReport for Washuta & Son Painting

Step 7: Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_03_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8: From the drop-down list, select the sheet: CH3 REG-2
Step 9: Close the Check Register window.

PAY BILLS

o
=

e et e e e e e
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e
e

CHECKS 518-519.PDF

Step 1. Write checks to pay the following bills and save. If you cannot find the account in
the Chart of Accounts, you should create the account using the processes you
learned in UNIT 02.

Check No. Select: Print Later

Date 12/15/2022

Vendor Express Delivery Service
Amount $45.00

Expense Account 54520 Freight & Delivery

Check No. Select: Print Later

Date 12/15/2022

Vendor Davis Business Associates

Amount $200.00

Expense Account 60400 Advertising Expense
Step 2. Print checks in a batch as follows:
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v Click the down arrow by the Print button in the Write Checks window.
Select Batch.

v"When the Select Checks to Print window appears, select only the
preceding two checks that you entered. Your total should be $245.00.

v First Check Number is 518

v Click OK

v Select Standard check style

v'Select Print company name and address

v Click Print and save your PDF file to your UNIT 03 Folder

v'Save the file as CHECKS 518-519




BANK RECONCILIATION
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CH3 REC SUM

Reconcile the following bank statement using the methods learned in the previous tutorial.

BANK STATEMENT

Rock Castle Construction

1735 County Road géifi?g

Bayshore, CA 94326

Previous Balance 11-20-2022 $67,281.02

+Deposits 10 58,413.56

-Checks 12 15,996.28

-Service Charge 1 10.00

+Interest Paid 0.00

Ending Balance 12-20-2022 $109,688.30

Deposits

Date Amount

11-30-2022 4,135.50
12-02-2022 4,706.01
12-03-2022 1,200.00
12-05-2022 5,000.00
12-05-2022 25,000.00
12-10-2022 102.65
12-10-2022 1,000.00
12-12-2022 4,936.12
12-14-2022 4,700.00
12-15-2022 7,633.28

Checks Paid

Date No. Amount
11-28.2022 464 300.00
11-28-2022 465 500.00
11-28-2022 466 600.00
11-28-2022 467 800.0
11-28-2022 468 6,790.00
11-28-2022 469 2,000.00
11-30-2022 471 24.00
11-30-2022 472 656.23
11-30-2022 473 686.00
11-30-2022 474 218.00
11-30-2022 475 2,710.90
12-01-2022 476 711.15

Thank you for banking with us!
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Step 1. When the Select Reconciliation Report window appears, select type of
Reconciliation Report: Summary.

Step 2. Export to Excel

Step 3. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O3_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 4. From the drop-down list, select the sheet: CH3 REC SUM

Step 5. Save and close the Excel file.

BACKUP YOUR COMPANY FILE

e e e e e e e e e B e e e O

Use the instructions in Appendix A to back up your company file. Make sure your backup file
is saved in the designated folder of this unit (UNIT 03 BACKUPS).

UNIT 03 PROJECT (ON-YOUR-OWN)

For this project, you will be restoring the backup file created for the unit. The QuickBooks
company file for Larry’s Landscaping has already been created and fransactions have been
enfered. Your assignment is to complete the following steps to export reports to Excel:

RESTORE THE UNIT 03 STARTER FILE

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u03a2 Larrys Landscaping. This file is in your UNIT 03 folder.

Step 21:  RESTORE the u03a2 Larrys Landcapaing.QBB file
Step 22:  Make sure you SAVE to the UNIT 03 FOLDER

RENAME THE COMPANY

|
After you have followed the instructions to restore your data files, you will find the company file

you have restored contains sample data fora company called Larry’s Landscaping. Your first
activity is fo personalize that name fo meet your needs follow these instructions:

Step 1: From the Menu bar, select Company

Step 2: Select MY COMPANY

Step 3: Select EDIT

Step 4: Update the Company Name Field to: YourName Larry’s Landscaping

Step 5: CLICK on OK
Step 6: Close the My Company window.

NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.
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P3 REC DT

Enter the following banking fransactions for Larry’'s Landscaping:

MAKE DEPOSIT
STEP 1.

DATE

RECEIVED FROM
ACCOUNT
MEMO
AMOUNT

CASH/CHECKNO.

12/16/2023

Larry Wadford

3020 Owner’s Contributions
Investment

$1,800.00

1558

HINT: YOU WILLNEED TO ADD THIS ACCOUNT. REFERTO APPENDIX D FOR THE TYPE OF ACCOUNT.

DATE 12/16/2023
VENDOR Computer Services by DJ
STEP2. WRITE CHECKS ACCOUNT 7552 Computer !tepalrs
MEMO Computer Repair
AMOUNT $360.00
CASH/CHECKNO. 1464
DATE 12/17/2023
RECEIVED FROM Gussman'’s Nursery
ACCOUNT 4300 Other Income
MEMO Storage Rental Revenue
AMOUNT $387.00
MAKE DEPOSIT CASH/CHECKNO. Cash
STEP3. (2 ENTRIES-1
DEPOSIT) DATE 12/17/2023
RECEIVED FROM Lynne's Space (add customer)
ACCOUNT 4300 Other Income
MEMO Storage Rental Revenue
AMOUNT $648.00
CASH/CHECKNO. Check No. 2200
DATE 12/18/2023
RECEIVED FROM Conner Garden Supply
ACCOUNT 4300 Other Income
MEMO Storage Rental Revenue
AMOUNT $900.00
MAKE DEPOSIT CASH/CHECKNO. Cash
STEP4. (2 ENTRIES-1
DEPOSIT) DATE 12/18/2023
RECEIVED FROM Bank of Anycity
ACCOUNT 8000 Interest Income
MEMO Interest Revenue
AMOUNT $216.00
CASH/CHECKNO. Check No. 11818
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DATE 12/17/2023

TO Computer Services by DJ
STEP 5. WRITE CHECK ACCOUNT 7320 Computer.SuppIies

MEMO External Hard Disk

AMOUNT $153.00

CHECK NO. 1445

DATE 12/17/2023

TO Mike Scopellite

ACCOUNT 7430 Professional Design Fees
STEP6.  WRITE CHECK : . .

MEMO Professional Design Consulting

AMOUNT $342.00

CHECK NO. 1466

DATE 12/18/2023

TO Sowers Office Equipment
STEP7.  WRITE CHECK ACCOUNT 7300 Office Supplies

MEMO Special Order

AMOUNT $270.00

CHECK NO. 1467

DATE 12/18/2023

TO Nye Properties
STEPS.  WRITE CHECK ACCOUNT 7500 Rent (Expense)

MEMO Rent

AMOUNT $990.00

CHECK NO. 1468
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Reconcile the following Bank Statement for Larry’'s Landscaping Checking Account.:

BANK STATEMENT
Larry’s Landscapin
104;/ Main S‘rreef ’ ]]_30_2,022
Checking
Bayshore, CA 94326
Previous Balance 10-30-2022 $238,625.29
+Deposits 2 5,775.80
-Checks 8 2,865.51
-Service Charge 1 25.00
+Interest Paid 0.00
Ending Balance 11-30-2022 $241,510.58
Deposits
Date Amount
11-25-2022 5,000.00
11-30-2022 775.80
Checks Paid
Date No. Amount
10-22-2022 1459 24413
10-28-2022 1461 550.00
11-22-2022 1460 24413
11-28-2022 1462 550.00
11-29-2022 1112 177.25
11-30-2022 1113 125.00
11-30-2022 1114 375.00
11-30-2022 1115 600.00
Thank you for banking with us!
Step 9. When the Select Reconciliation Report window appears, select type of

Reconciliation Report: Detail.

Step 10. Export to Excel

Step 11.  Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_03_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 12.  From the drop-down list, select the sheet: P3 REC DT
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Step 13.  Save and close the Excel file.

P3 JUR
TEMPLATE Sales Receipt — Retail
DATE 12/19/2023
CUSTOMER(ADD NEW) Jean Paulny

STEP 1. SALES RECEIPT .
ITEM Pump (Fountain Pump)
QUANTITY 3
PAYMENT Cash
DATE 12/21/2023

STEP4 MAKE DEPOSIT CUSTOMER Jean Paulny

) ACCOUNT (Transferred from Undeposited Funds)

AMOUNT $239.63
DATE 12/23/2023
VENDOR (ADD NEW) Carole Design Media

STEP 5. ENTERBILL ACCOUNT 6000 Advertising Expense
TERMS Net 30
AMOUNT DUE $324.00
DATE 12/23/2023

STEP 6. PAY BILL VENDOR Carole Design Media
ACCOUNT $324.00

Step 7. From the Navigation Bar, Select Reports > Accountant & Taxes > Journal

Step 8. Select Dates: 12/16/2023 to 12/23/2023
Step 9. Export 1o Excel

Step 10.  Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_03_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 11. From the drop-down list, select the sheet: P3 JUR

Step 12.  Save and close the Excel file.

P3 JUR-2

Step 1. From the Navigation Bar, Select Reports > Accountant & Taxes > Journal
Step 2. Select Dates: 12/23/2023 To 12/23/2023

Step 3. Customize the report to add a filter for amount equal to $324.00

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_O3_REPORTS Excel file.
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NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6. From the drop-down list, select the sheet: P3 JUR-2
Step 7. Save and close the Excel file.

BACKUP YOUR COMPANY FILE

Use the instructions in Appendix A to back up your company file. Make sure your backup file is
saved in the designated folder of this unit (UNIT 03 BACKUPS).

TAKE THE QUIZ

The reading in the unit along with the Excel reports you have generated have provided answer
to the quiz for this unit. Take the UNIT_03 QUIZ in your Canvas account

SUBMIT THE UNIT REPORTS

After you have taken the quiz using the answers you have already recorded in the reports you
exiracted from Excel, UPLOAD the following files o the UNIT_03 assignment area of your Canvas
account:

v' The Excel file - UNIT_03_REPORTS
v The PDF file— CHECKS 518-519
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THE IMPORTANCE OF SETTING UP CUSTOMERS IN QUICKBOOKS

If you invoice customers, then you want to set up profiles for your customers in QuickBooks. By
setting this information up ahead of time, you will save time later when you need fo create an

invoice or sales receipt because you will be able to select each customer from a drop-down
menu, and most of the fields will automatically populate sales forms for you.

Sefting up your customers will allow you fo do the following:

1. Expedite Customer Billing — Quickly create invoices for your customers. All of your
customer data, like billing address, shipping address, and due date, will automatically
populate from the customer profile.

2. Track Sales by Customer - Tracking items purchased by your customers is a great way to
get to know what your customers like so you can market to them strategically.

RESTORE THE STARTER FILE

R

You will find the following files in your Student files for UNIT 04.

e

e

Y L Y LY Y Y Y Y.
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e UO4al Rock Castle Construction
e UO0402 Larry's Landscaping
e UNIT_04_Reports
To complete the first lesson exercises, RESTORE the u04al Rock Castle Consfruction

company file from the UNIT 04 folder.

NOTE: The process to restore a backup is found in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY

R

e

e

e

e

e

&

After you have followed the instructions to restore your data files, you will find the company file
you have restored contains sample data fora company called Rock Castle Construction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 19.  From the Menu bar, select Company

Step 20. Select MY COMPANY

Step 21.  Select EDIT

Step 22. Update the Company Name Field to: YourName Rock Castle

Construction

Step 23. CLICK on OK
Step 24. Close the My Company window.

NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

CUSTOMER NAVIGATION
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If necessary, click the Home icon in the icon bar to display the Home page.

il

i
AT W

Invoices:

Customer buys on credit
and then pays later

The Customers section of the Home page is a flowchart of customer transactions. Asthe chart
indicates, Rock Castle Construction can record a customer sale in two different ways:

Sales Receipts:

Customer pays with cash, check or
credit card at time of sale

1. Create Sales Receipts — The customer pays when Rock Castle Construction provides the

good or service to the customer. The customer pays with cash, check or credit card atf

the time of sale. The sales | recorded on a sales receipt.

2. Create Invoices/Receive Payments — The sale is recorded on an invoice when the good
orservice is provided to the customer. The customer promises to pay later. These
customer promises are called accounts receivable — amounts that Rock Castle

Construction expects to receive in the future. The customer may pay its account with
cash, check, credit card, or online payment.

Other QuickBooks features available from the Customers section include:

v Finance Charges — Add finance charges to customer bills whenever bills are not paid by

the due dafte.

v Statements - Prepare billing statements to send to customers.
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v" Refunds and Credits — Record refunds and credits forreturned or damaged
merchandise.
v Accept Credit Cards — Accept customer credit cards n payment for products and
services.
The first step in working with customer transactions isto enter customer information in the
Customer list.

CUSTOMER LIST

The Customer List contains customer information such as address, telephone number, and credit
terms. Once customer information is entered in the Customer List, QuickBooks automatically
transfers the customer information to the appropriate forms, such as sales invoices and sales
returns. This feature enables you to enter customer information only once instead of entering the
customer information each time a form is prepared.

The Customer List in QuickBooks also fracks projects (jobs) for each customer. For example, Rock
Castle Construction is working on two projects for Brian Cook:

v' Job 1: 2nd Story Addition
v Job 2: Kitchen

VIEW CUSTOMER LIST

o
=

o
e

o
e

o
e
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To view the Customer List for Rock Castle Construction:

Step 1. Click Customers in the Icon bar.
Step 2. The following Customer Center window appears, listing customers and jobs.
Noftice the two jobs listed for Brian Cook:

e 2nd Story Addition _
. » Kitchen .
Customers & Jobs m ] &
Activa Customars. - >
ca 15-555-2248
= M. Bien K. Cook 0z20
T Residerial kisarmplename
| =2nd story addion 0.00 = e Het 20 psho
«Bristol, Somva 0.00 s Bian K Cack
| =Repairs 0.00 Middifiekd CA9HB2 .
<Utility Shad 0.00
|+Burch. Jason 1.005.00 Transactions  Conlacls To Do's Heles Sent Email
sRoom Addition 1.005.00 ] - o _ = I e
< Campbel, Healher 13.900.00 sHow  AllTraess. - FLERSY Al - | oet= [This Feesl Year - | 01/01/2018 - 120332018
[ eRemodel 13.900 00 . o - . "
‘-Ca"‘b Pia Shop 0.00 Invoice 1098 121162018 41000 - Accounts Receivable 1635669
=Remede! 0.00 Imvoice FCG 1211112018 11000 - Accounts Receivable 5.95
fCa'-v"‘"U F'Ulw 0.00 Imvoice 1080 11/25/2018 11000 - Accounts Receivable 1.636.69
waa_l-f Hnmduw g gg Payment 117252018 12000 - Undeposited Funds 2,580.00
«LUtilty Ruorm " Imoice 1081 117252018 11000 - Accounts Receivable 5.416.00
L oot ] Payment 111262018 12000 - Undenositad Funds 4,085.30
I 5:418.00 Payment 11/2502018 10100 - Checking 4.225.41
3.878.33 Estimate &0 11/17/2018 20200 - Estimates 4.225.41
- 0.00) Faymant 9065 111152016 12000 - Undepasited Funds 10,000.00
| 0.00 Imvoice 1075 111152016 11000 - Accounts Receivable 4.225.41
| o D 0.00 Imvoice 1072 10202018 11000 - Accounts Receivable 14.085.30

The Customers & Job List displays:

v Customer name
v Job name
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v Balance foreach job
To view additional information about a customer, click the customer or job name. The
Customer/Job Information window displays:

N NI NN

Customer address and contact information

Transactions information for the customer

Estimate information (if an estimate for the job was prepared)
Notes about the job

ADD NEW CUSTOMER

The next step activity will be to add a new customer, Tom Whalen, to the Customer List.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.
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Click the New Customer & Job
Mew Cust &Job ¥ o N
button at the top of the _fﬁ New Lustomer & Jo f]  New

Customer Center. | NewCustomer |
Click New Customer on the Add Job
drop-down menu Add Multiple Customer:Jobs

A blank New Customer window should appear. Select the Address Info tab. Enter
the following information in the New Customer: Address Info window.

Customer name Whalen, Tom
Mr./Ms./... Mr.

First Name Tom

Last Name Whalen

Main Phone 415-555-1234
Mobile 415-555-5678
Addresses Bill To 100 Sunset Drive

Bayshore, CA 94326
To enter the payment information for the customer, click the Payment Settings
tab. Enter the following information in the Payment Settings fields:

Account No. 7890

Credit Limit 50,000
Payment Terms Net 30
Preferred payment Check

To enter sales tax information for the customer, click the Sales Tax Settings tab.
Enter the following information in the Sales Tax Settings fields:

Tax Code Tax

Tax ltem San Tomas
Click the Additional Info tab to display another customer information window.

Enter the following information the Additional Info field.

Customer Type Residential




Click OK to add the new customer to Rock Castle
Construction’s Customer List.
To sort the Customer List, with your cursor over the
Customer List:

v'Right-click to display the pop-up menu

v’ Select: Re-sort List.

Step 7.

Step 8.

ADD ADDITIONAL CUSTOMERS

=

e

e

e

Now that you have added one customer, start adding additional
customers by following the same process as you previously
entered.

ADDRESS INFORMATION
CUSTOMER NAME

Kari, Tracey

FIRST NAME Tracey
LAST NAME Kari
MAIN PHONE 415-555-1234

MOBILE PHONE

415-555-9999

ADDRESS BILL TO/SHIP TO

99 Reyka Drive

Bayshore, CA 94326

MAIN EMAIL KTracey@tracey.com
CC EMAIL KT-Account@iracey.com
WEBSITE www.tracey.com
OTHER 1

PAYMENT SETTINGS

ACCOUNT INFO 7890

PAYMENT TERMS NET 30

PREFERRED DELIVERY MENTHOD | E-MAIL

PREFERREED PAYMENT METHOD | Check

CREDIT LIMIT 50,000.00

PRICE LEVEL

SALES TAX SETTINGS

TAX CODE Tax

TAX ITEM San Tomas

RESALE NUMBER

ADDITIONAL INFORMATION

CUSTOMER TYPE Residential

REP

CONTRACT #

B-DAY

SPOUSE'S NAME
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Find

Use Ctrl+U

Edit Customer-Job

New Customer

Delete Customer-Job

Add/Edit Multiple Customer.Jobs

Add Job
Make Customer:Job Inactive
Re-sort List
v Hierarchical View
Flat View
Customize Columns
Show Full Customer List Only

Create Invoices

Create Estimales

Show Estimates

Receive Payments

Make Deposits

Enter Sales Receipts

Enter Statement Charges
Create Credit Memos/Refunds
Create Statements

Assess Finance Charges
Use Register

QuickReport: Whalen, Tom
Open Balance: Whalen, Tom
Attach




EDIT CUSTOMER INFORMATION

R

e

e

YN
e e PR R R R R R

Enter the e-mail address for Tom Whalen by editing the customer information as follows:

Step 1.
Step 2.

Step 3.

Step 4.

ADD A JOB

R

e

Select Tom Whalen in the Customers & Jobs window.
Click Edit Customer icon in the Customer Information window.

pint v [{ Excel v [ Word v & Income Tracker

Customer Information

pany Name Mamn Phone  415-555-1234

& MewCustomer&Job ¥ &5 NewImnsactions v &

Active Customers - >

Full Name  Mr. Tom Whalen Mobile 415-555-5678
omer Type  Residential

0‘00 A Account No.

1 ShmienTom 7890
+ Abercrombie, Kristy 0.00 erms  Net 30
<Family Room 0.00 il Ta  Tom Whalen
sKitchen 0.00 dliluscalici
+Remodel Bathroom 0.00 Transactions  Confacts ToDo's Noles Sent Email
o Allard, Robert 14,510.00
eRemodel 14.510.00 All Transactions = FureRey Al ~| ose |ThisFiscalYear - 01/01/2018-12/3172
+ Babcock's Music Shop 0.00
sRemodel 0.00
¢ Pakes Chiis L There are no transactions of type "All Transactions”, filtered by "All", in date range "This Fiscal Year”

000
000

+Family Room
+Garage Repair

When the Edit Customer window appears, enter orrevise the customer orjob
information as needed. In this instance, click the Address Info tab. Then enter the
Main E-mail: twhalen@www.com.

Click OK to record the new information and close the Edit Customer window.

- T Y.
e e RR R R e e e e S R e e R

To add a Screen Porch job for Tom Whalen, complete the following steps:

Step 1.

Step 2.

Step 3.
Step 4.

Step 5.

Step 6.
Step 7.

Step 8.
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Click on the customer, Tom Whalen, in the
Customers & Jobs window.

Click the New Customer & Job button at the
top of the Customer Center window.

Select Add Job form the drop-down menu.

In the New Job window, enter the Job Name:

& MewCustomer&Job ¥ 5  New Transactions

| New Customer

Add Multiple Customer-Jobs
Active Customers - >

Screen POI’Ch o Abercrombie, Kristy 0.00 '
Enfer the Opening Balance: 0.00 oFamily Room 000
Click the Job Info tab. “Remde! Batoom 000
Enter the following information in the Job Info oAllard, Robert 14,51000
. +Remodel 14,510.00
fields: » Babcock's Music Shop 0.00
L <Remodel 0.00
Job Description Screen Porch «Baker, Chris 000
+Family Room 0.00
Job Type Remodel - - e
Job Status Pending
Start Date 02/01/2022
Projected End Date 03/15/2022

Click OK to close the New Job window.




ADD AN ADDITIONAL JOB FOR TOM WHALEN

B

.=

Step 1.

Step 2.
Step 3.

Step 4.
Step 5.

Step 6.
Step 7.

.=

.=

Click on customer, Tom Whalen, in the Customers

and Jobs window.
Right-click > Add Job

e B R
RS RSS

=

gh New Customer & Job ¥ % Mew Transactions

Active Customers ~ >

In the Job Name field at the top of the New Job o
windows, enter: Exterior Door

NAME BALANCE ATT
y YN B L

Enter Opening Balance: 0.00. e * Find_
Click the Job Info tab, then enter the following ey 2 cut

iﬂformoﬂon. +Kitchg Edit Customer.Job

Job Description

Replace Exterior Door

+Remo

New Customer
eAllard, RC  pelete Customer-Job

*Remo  Add/Edit Multiple Customer-Jobs
« Bab¥ 'Add Job
°ReM0  hake Customer-Job Inactive

Job Type Repairs
Job Status Awarded " e . v
+Garag Flat View
Start Date 12/15/2022 JBaiak | Customize Cotumns..
«Utility | Show Full Customer List Only
Projected End 12/18/2022 A e et leniane

Click OK fo record the new job and close the New Job window.
As shown below, Rock Castle

Construction’s Customer List should NAME BALANCE . i ATT.. |
now list two jobs for Tom Whalen: m- |
Exterior Door and Screen Porch. Close || °Rep|ace Exterior Door 0.00 '
the Customer Center window. eScreen Porch 0.00

ADD AN EXTERIOR DOOR JOB FOR TRACEY KARI

B

.=

.=

.=

.=

o
A

Step 1. Click on the customer, Tracey Kari, in the Customers & Jobs window.
Step 2. Click the New Customer & Job button at the top of the Customer Center window.
Step 3. Select Add Job form the drop-down menu.
Step 4. In the New Job window, enter the Job Name: Exterior Door
Step 5. Enter the Opening Balance: 0.00
Step 6. Click the Job Info tab.
Step 7. Entfer the following information in the Job Info fields:
Job Description Exterior Door
Job Type Remodel
Job Status Pending
Start Date 04/01/2023
Projected End Date 06/15/2023
Step 8. Click OK fo close the New Job window.
CH4 CClL

Page | 97




For this section of the assignment we will pull the Customer Balance Detail report to view how
the QuickBooks displays the customers and jobs.

Step 8. Click on the Reports section of the menu bar or the icon bar

Step 9. Click on Customers & Receivables

Step 10.  Click on Customer Contact List. If you choose the menu bar option, you will need
to select the Run option.

Step 11. Export to Excel

Step 12. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 13. From the drop-down list, select the sheet: CH4 CCL

Step 14.  In the C4 CCL sheet, highlight the customers and jobs you have just added fo the
company file.

Step 15. Save and close the Excel file.

NOTE: The jobs show as a colon after the customer name and then the job is listed

RECORDING SALES IN QUICKBOOKS

How to record a sale in QuickBooks depends upon how the customer pays for the goods or
services. There are three possible ways for a customer to pay for goods and services:

v Cash Sale — Customer pays case (or check) at the time of sale.
v' Credit Sale — Customer promises fo pay later
v' Credit Card Sale — Customer pays using a credit card.

CASH SALES

o
=

o
e

e e e
e

When a customer pays for goods or services at the time the good orservice is provided, it is
typically called a cash sale.

o o
e e

o
e

Recording a cash sale in QuickBooks requires two steps:

1. Create Sales Receipts — Create a sales receipt to record the case sale
2. Record Deposits — Record the bank deposit

>

||
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In the next scenario, one of the Rock Castle Construction customers, Ernesto Natiello, wants to
purchase some cabinet pullsin a cash sale. Record the sale using the following steps:

Step 1. From the Customers section of the Home page, click Create Sales Receipts o

display the Enter Sales Receipts window. If asked if you would like to complete
the Payment Interview, select No.

Step 2. In the Enter Sales Receipts window, enter Customer: Natiello, Ernesto

Main  Formating  Send/Ship  Reporls  Payments

er B B R Boowon @
Find Mark.

[
New Save Delete @bMemorize

- =

Print  Email

Email Later

SOLD T

Sales Receipt Natie[[oj Ernesto Emasto W Natiello

82022 B 376 Pine St #5E
o I=—] vaster SALENO. Bayshore CA84326
creorr 3009
cag | check | SREDT | cueck | o

Cabinets:Cabin... » Cabinet Pulls

=

1000 = ho.00 Tax -

5

Customer Message

Step 3. Select Date: 12/15/2022
Step 4. Select Payment Method: Cash
Step 5. Select Item: Cabinet Pulls
Step 6. Select Quantity: 1
Step 7. Enter Rate: 10.00
Step 8. Select Customer Message: It's been a pleasure working with you!
Step 9. Select Print Later checkbox.
Step 10.  Select Print > Preview. If the company name does not print properly on the
invoice or sales receipt, reduce the font size as follows:
v' Customize Data Layout > Basic Customization
v Select Change Font for: Company Name > Change Font
v Select font size 10 .
v' Close the customization windows.

CASH SALES - NATIELLO.PDF

Step 1. Print the sales receipt
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Step 2. Click the Print button at fop of the Enter Sales Receipts window.

Step 3. Select Print on: Blank paper

Step 4. If necessary, uncheck: Do not print lines around each field

Step 5. Select the PDF printer as your printer of choice, then click Print

Step 6. Save the PDF copy to the UNIT 04

Step 7. Save as CASH SALES-Natiello.PDF

Step 8. Click Save & Close to record the cash sale and close the Enter Sales Receipts
window.

IMPORTANT NOTE: QuickBooks will record the $10.78 as undeposited funds. Later, you will record
this as a bank deposit to rock Castle’'s Checking account.

C4 JUR

To view the journal entry that QuickBooks created behind the screen for the sales receipt
enfered and saved using the Enter Sales Receipt onscreen form complete the following steps.

Step 1. Display the Natiello sales receipt just entered.

Step 2. Select the Reports tab

Step 3. Select the Transaction Journal icon

Step 4. Export the Transaction Journal report to Excel

Step 5. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_O4_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6. From the drop-down list, select the sheet: C4 JUR
Step 7. Save and close the Excel file.

CUSTOMER INVOICES
|
If products orservices are given to the customer will pay later, then we use an Invoice instead of
a Sales Receipt to record the sales fransaction.

When a customer will pay later after receiving the product or service, these are often called
credit sales. Credit sales occur when Rock Castle Construction provides goods and services fo
customers and in exchange receives. The money collected isreferred to as an account
receivable.

An account receivable isthe amount due from a customer for goods or services already
provided. The company has alegal right to collect from the customer in the future. Accounting
recognizes such claims as assets.

CREDIT SALES

R

e

e

e
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Creating a credit sale in QuickBooks requires three steps:

v' Create Invoices — Create an invoice to bill the customer for the product orservice
provided. QuickBooks records accounts receivable and the sales amount.

v Receive Payments — Receive payment from the customer. QuickBooksreduces accounts
receivable and increases undeposited funds.
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v Record Deposits — Deposit the customer’'s payment in the bank.

CREATE INVOICE

=

e

e

e

e

e

An invoice is a document prepared by the seller of merchandise and sent to the buyer. The
invoice contains the details of a sale, such as the number of units sold, unit price, total price
billed, terms of sale, and manner of shipment.

A retail company prepares the invoice at the point of sale. A wholesale company, which
supplies goods to retailers, prepares the invoice after the shipping department notifies the
accounting department that it has shipped the goods to the retailer.

Using the invoice as the source document, a wholesale company records the revenue from the
sale at the time of the sale for the following reasons:

v The seller has passed legal tifle of the goods to the buyer, and the goods are now the
responsibility and property of the buyer.

v The seller has established the selling price of the goods.

v The seller has completed its obligation.

v The seller has exchanged the goods for another asset, such as cash or accounts

receivable.
v The seller can determine the costs incurred in selling the goods.

Use the following steps to create an invoice for Kari, Tracey: Exterior Door:

Step 1. In the Customers section of the Home Page, click the Create Invoices icon to
display the Create Invoices window

Step 2. From the Create Invoices window, select the template: Rock Castle Invoice
Step 3. Enter the following information for the invoice:

CUSTOMER:JOB Kari, Tracey: Exterior Door

CLASS

TEMPLATE Rock Castle Invoice

DATE 12/15/2022

INVOICE # 1100

TERMS Net 30

DUE DATE 1/14/2023

ITEM Repairs

DESCRIPTION Repair work

QUANTITY 1

U/M

RATE $35.00

AMOUNT

TAX Non-Taxable Sales

CUSTOMER TAX CODE Tax

CUSTOMER MESSAGE Itis a pleasure working with you!

Page | 101

&




NOTE: The bill to information should automatically fill when you choose the customer job. If it

does not fill with the correct information, you should adjust the information in the customer
center.

C4 JUR-2
Step 1. From the Create Invoices onscreen form, select the Reports tab
Step 2. Select the Transaction Journal icon
Step 3. Export the Transaction Journal report to Excel
Step 4. Follow the insfructions in Appendix C fo export the report to the Excel file named

UNIT_04_REPORTS Excel file.
NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 5. From the drop-down list, select the sheet: C4 JUR-2
Step 6. Save and close the Excel file.

UPDATE EXISTING INVOICE
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If Invoice number 1100 is not already displayed on your screen, follow these steps to display it
again:

Step 1. Click the Create Invoices Icon
Step 2. Click Find
Step 3. Enter Invoice no.: 1100
Step 4. Click Find
Step 5. Enter the following items as new lineitems onInvoice No 1100 for the Kari exterior
Doorjob:
ITEM Exterior wood door
DESCRIPTION Exterior wood door
QUANTITY 1
U/M
RATE $120
AMOUNT
TAX Taxable Sales
ITEM Repairs
DESCRIPTION Repair work
QUANTITY 4
U/M
RATE $35
AMOUNT
TAX Non-Taxable Sales
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NOTE: If we wanted to email the invoice to the customer, we would select the Email icon;
however, the company file you are using is not setup to send email at this time.

Step 6. Select Save and leave the Invoice displayed. If you receive a message stating
you have changed the fransaction and asking if you want to record your
changes, select Yes.

CREATE A PENDING INVOICE
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Step 1. In the customers section the Home page, click the Create Invoices icon to display
the Create Invoices window.

Step 2. Select the Template: Rock Castle Invoice

Step 3. Enter the Customer: Job by selecting Whalen, Tom: Screen Porch from the drop-

down Customer & Job list. Make certain to select the customer name and
correct job: Screen Porch.
Step 4. Select Date: 12/30/2022
Step 5. Enfer charges for the service provided the customer. Enter lfem: Repairs. Press
Tab. Description should automatically display: Repair work
Step 6. Enter Quantity: 2 (hour).
v' The Rate should automatically display $35.00.
v The Amount should automatically display $70.00
Step 7. From the drop-down list customer tax code, select Tax: Non-Taxable Sales.
Step 8. You will wait until the job is complete to print the invoice. In the meantime, mark
the invoice as pending:
v Right-click to display the pop-up menu
v Select: Mark As Pending.

Home

Create Tnvc;fces
Main Formatting Send/Ship Reports

& P a E 2@ Create a Copy E = Print Later @ B Add Time/Costs [} Create a Batch

Find Wew  Save Delste a Memorize Mark As mail Email Later Attach | & Apply Credits Receive B Refund/Credit
& = Pending File Paymenis

Mark As Pending

Step 9. If you choose to enter another invoice, you would click Save & New. Instead, click
Save & Close fo close the Create Invoices window.
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Accountant Company Cystomers Vendgrs Employees Banking Reports Window Help }
Main Formatting Send/Ship Reports

&« s E i@ B Create a Copy <Q - = Print Laler a R Add TimeiCasts (] 8l Create a Baich

Find New Save Delete @BMemoize Mark As Pront  Emai Email Later Amach A Receve B Refund/Credit
ad = Final ief o File Payments

I (SRS =Ty Whalen, Tom:Screen Porch - CLASS _ Rt PS8 Rock Castle Invoice -

| nV0|Ce 12302022 @ | Tom whalen

PENDING r— 100 Sunset Drive
© ENer . Bay Shore, CA94326
101 B
TERMS DUE DATE
hot 20 ~ 0tzoz023 W
2 35.00 70.00 Non .

Repairs Repair work

Later in the day on December 30, 2022, one of the Rock Castle Construction crews located a
patio door and finished installing the screen porch at the Whalen residence. The following
additional products and services were used:

Patio door | 1 @ $200 Taxable Sales

Framing Labor | 4 hours Non-Taxable Sales

Step 1. To display the invoice for the Screen Porch job again:
v' Click the Create Invoices icon
v When the Create Invoices window appears, click Find.
v' Enfer Invoice No.: 1101
v" Click Find

Main Formatting Send/Ship Reports

@« P ﬁ E 2@ Create aCopy 4§ E = Print Later @ %Aun Time/Casis B @createasaen

Find New Save Delete €Memorize Mark As Print  Email Email Later Attach | @ Apply Credits Receive B Refund/Credit
E 2 Pending b J File Payments

~ BSYURSSl Rock Castle Invoice

L= NS Whalen, Tom:Screen Porch

DAE BILTO SHIP TO

Invoice s T

100 Sunset Drive

phikuide Bay Shore, CA94326
o1
TERMS DUE DATE
Net 20 * |01/29/2023 @
ITEM DESCRIFTION QUANTITY uim RATE AMOUNT TAX
Repairs Repair work 2 35.00 70.00 Non A
Patio Door Patio Door 1 200.00 200.00 Tax
Framing Framing labor 4 55.00 220.00 Non
“Your customer can't pay this invoice online T4 8an Tomas v | (7.75%) 16.50
Turn on OTAL 50550
CUSTOMER MESSAGE 0.00
Thank you for your business 505.50
MEMO - Save & Close Clear
Step 2. Enter the screen porch and additional repair labor as new line items on Invoice

No. 1101 for the Whalen Screen Porch job.
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Step 3. Customer Message: Thank you for your business
Step 4. Mark the invoice as final as follows:

v Right-click to display the pop-up menu

v Select: Mark As Final

Main Formatting Send/Ship Reports
& » a E 2@ Create a Copy o g

Print Later @ | Ead Timercosts -]} Create a Batch

Fimd Mew  Save Delete QMemmize Mark As T Email Email Later Altach A A Receive @Refundf(}redit
2 b Final File Paymenis

Mark As Final

Step 5. Select Print Preview. If the company name does not display properly on the
invoice, reduce the font size.

INVOICE 1101.PDF

With Invoice No. 1101 displayed, print the invoice as follows:

Step 1. Click the Print icon. If you are asked if you want to record your changes, select
Yes.

Step 2. Select Print on: Blank paper

Step 3. If necessary, uncheck: Do not print lines around each field

Step 4. Select the PDF printer as your printer of choice, then click Print

Step 5. Save the PDF copy fo the UNIT 04 folder.
Step 6. Save as Invoice 1101.PDF
Step 7. Click Save & Close to close the Create Invoices window.

QuickBooks will record the sale and record an account receivable for the amount fo be
received from the customer in the future.

The invoice total is $505.50. Notice that the Screen Porch is a taxable item and QuickBooks
automatically calculates and adds sales tax of $15.50 for the door.

CREATE REMINDER STATEMENTS
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Reminder statements are sent to remind customers to pay their bills. A reminder statement
summarizes invoice charges and provides an account history for the customer. It does not
provide the detailed information that an invoice provides.

If a company wants to provide a customer with detailed information about charges, a copy of
the invoice should be sent instead of areminder statement.

Reminder statements summarize:
v' Previous Account Balance
v Charges for Sales during the period
v Payments received from the customer
v The customer’s ending account balance

To print a QuickBooks reminder statement for the Whalen Screen Porch job, follow these steps:
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Step 1. Click the Statements icon in the Customers section of the Home page fo display
the create Statements window.

Step 2. Select Template: Intuit Standard Statement

Step 3. Select Statement Date: 12/30/2022

Step 4. Select Statement Period From: 11/17/2022 To: 12/30/2022

Step 5. In the Select Customers section, select One Customer. From the drop-down list,
select Whalen, Tom

Step 6. In the Select Additional Options section, select Create One Statement: Per Job.

Step 7. Click All open transactions as of Statement date

7~ APEREF N SELECT ADDITIONAL OPTIONS
Statement Date 12/30/2022 Q' (I'emplate _\
~ Statement Period From To Intuit Standard Statement = Customize
@ All open transactions as of Statement Date: Create One Statement  Per Job T
Include only transactions over days past due date Show invoice itern details on statements
k J Print statements by billing address zip code
SELECT CUSTOMERS + Print due date on transactions

0 All Customers

7 Multiple Customers with a zero balance
® One Customer  Whalen, Tom - with a balance less than
" Customers of Type with no account activity

7 Preferred Send Method

View Selected Customers... Assess Finance Charges...

\

Preview Print E-mail Close Help

R Y P N “‘\\._"’j

WHALEN STATEMENT.PDF

Step 8. Check Print due date on transactions.
Step 9. Select the PDF printer as your printer of choice, then click Print
Step 10. Save the PDF copy to the UNIT 04 folder

Step 11.  Save as Whalen Statement.PDF
Step 12. Click Save & Close

RECEIVE PAYMENT
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Recall that when recording credit sales in QuickBooks, you first create an invoice and then
record the customer’s payment. When a credit sale is recorded on an invoice, QuickBooks
records (debifs) an Account Receivable —an amount fo be received from the customer in the

future. When the customer’s payment is received, the Account Receivable account is reduced
(credited).
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Customers may pay in the following ways:

1. Credit card — Cards such as Visa, MasterCard, American Express, or Diners Club, over the
phone, in person, or by mail. Using QuickBooks' Merchant Account service, you can
obftain online authorization and then download payments directly info QuickBooks.

2. Online Payments— Online transactions can be by credit card or bank account fransfer.
3. Customer check - Checks may be delivered in person or by mail

To record customer's payment by check for the Exterior Door job, complete the following steps:

Step 1. Click the Receive Payments icon in the Customers section of the Home page to
display the Receive Payments window.

Step 2. In the Received from area type Whal . This will automatically bring Whalen, Tom
info view.

Step 3. Select Invoice Number 1101 when it appears. QuickBooks will automatically enter

the selected invoice amount of $505.50 into the Amount field.
Step 4. Select Date: 01/05/2023

Step 5. Select: Pmt. Method: Check
Step 6. Enter Check no. 1005

Step 7. Click Save & Close to record the payment and close the Receive Payments
window.

Main  Repors P

ayments
«» B 8 &

= @ & = o
Find New Delele Print Emas Aftach Look up Un-Apply Disc A ol
2 27 File Customerfinvoice | Paymeni  Credits Add Credit Card
Processing
Customer Payment w0550
RECEIVE 0 Whalen, Tom
=
— e =
EEEE CHEGK | 'pegy
" 01/05/2023 ,- N
N
- 1005\! v Plﬁ“l"w;:} .
oz I8

« (1283072022 Screen Porch o1 505.50 505.50 505.50

Totals 505.50 505.50 505.50

AMOUNTS FOR SELECTED INVOICES

Save & Close Clear

QuickBooks will increase (debit) cash or undeposited funds and decrease (credit) the
customer’s account receivable.

C4 JUR-3

Review the payment you just recorded. You can do this by following these instructions:

Step 1. Open the Customer Center (Click Customers on the Icon bar).
Step 2. Click on Whalen, Tom

Step 3. Click on the Transactions tab

Step 4. SHOw: All Transactions

Step 5. FILTER: All
Step 6. DATE: All
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Step 7. Double-click the 1005 Payment

Wi Bnone 415-555-1234 No note avallable
oble 4155565678

Customer Information T[T — Z
S CUSTOM

REPORTS FOR THI
ngin Emai twhalen@www com

Quick

Transactions | Contacls ToDo's Notes Sent Email

o Ml Transactions > | Foerer Al > | o A

12000 - Undeposited Funds
11000 - Accounts Receivable

010512023
123072022

Payment 1005
Invaice 101

Double-click the payment

Step 8. With the payment in view, Click the Reports Tab

Step 9. Click the Transaction Journal

Step 10.  Export to Excel

Step 11.  Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 12.  From the drop-down list, select the sheet: C4 JUR-3
Step 13.  Save and close the Excel file.

RECORD BANK DEPOSITS
.

After recording a customer’'s payment in the Receive Payments window, the next step is to
indicate which payments to deposit in which bank accounts.

To select customer payments to deposit:

Step 1. Click the Record Deposits icon in the Banking section of the Home page fo
display the Payments to Deposit window. The Payments to deposit window lists
undeposited funds that have been received but not yet deposited in the bank.

Step 2. Select the two payments that were

added fo undeposited funds in this
section.
i. $10.78 cash receipt from
Ernesto Natiello on 12/15/2022
ii. $505.50 check payment from
Tom Whalen on 01/05/2023 et

to deposit
for this
transaction

Cash Roche, Diarmuid Garag 440.00
10.78
Check Jacobsen_Doug Kitchen 2,000, DO‘
Check Whalen, Tom 505,504

Undeposited Funds
Window

By Click OK
Seloct All sqf when
finished Cancel =

Cash back amoe ‘,’f
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Step 3. Click OK fo display the following Make Deposits window.
Step 4. Select Deposit To: Checking
Step 5. Select Date: 01/08/2023

@ Previous ® Ned [ Save () Print ml & Payments @) History [ Journal | @ Attach j
DepositTo 10100 Chec.. ~| Date (01082023 M| Nemo [Deposit

Cllck Payments to selact customer payments tnat you have recalved. List any other amounts to depost below.

Natiello, Emesto 12000 Undeposited Funds Cash mu(
Whalen, Tom 12000 - Undeposited Funds 1005 Check 505.50

To get cash back from this depasi, enter he amount below. Inicate the account
where you want this money to go, such as your Petty Cash account

Account is Automatically Undeposited Funds

Cash back goes fo Cash back memo Cash back amount

WW
Step 6. Click the Save & Close

DEPOSIT01-08-2023.PDF

Step 7. Click Save to record the deposit

Step 8. Click the Print drop down menu

Step 9. Select Deposit Summary

Step 10.  Select the PDF printer as your printer of choice, then click Print
Step 11.  Save the PDF copy to the UNIT 04 folder

Step 12. Save as Deposit 01-08-2023.PDF

PRINT JOURNAL ENTRIES

As you entered fransaction information info QuickBooks; on screen forms, QuickBooks
automatically converted the fransaction information into journal enfries.

C4 JUR-4

To print the journal entries for the fransaction you entered:

Step 1. Click Reports in the Icon bar to display the Report Center window

Step 2. Select the List View in the upper right corner of the window.

Step 3. Select: Accountant & Taxes

Step 4. Select: Journal

Step 5. Select Dates From: 12/30/2022 To: 01/08/2023

Step 6. Select Run

Step 7. Click: OK

Step 8. Export to Excel

Step 9. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 10.  From the drop-down list, select the sheet: C4 JUR-4
Step 11.  Save and close the Excel file.
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CUSTOMER REPORTS

There are many different customer reports that a business may fine useful. QuickBooks creates
reports fo answer the following questions:

Which customers owe us money?
Which customers have overdue balances?
Which customers are profitable?
v Which jobs are profitable?
Customer reports can be accessed in QuickBooksin several different ways:

ARNIN

1. Report Center - Permits you to locate reports by type of report (Click Reports icon, then
click Customers & Receivabiles.)
2. Reports Menu - Reports listed on the Reports menu are grouped by type of report. (From
the Reports menu, click Customers & Receivables.)
3. Memorized Customer Reports — Selected customer reports are memorized for
convenience (From Reports menu, select Memorized Reports, Customers.)
In this activity, you will use the report Center to access customer reports.

In this activity, you will use the report Center to access customer reports.

Step 1. To display the Report Center, click Reports on the Icon bar.
Step 2. Select the List View icon.

Step 3. Select: Customers & Receivables to display customer reports that can be
accessed in QuickBooks.
Step 4. Notice that the customer reports are divided into three categories:

i. Accounts Receivable Agingreports
ii. Customer Balance reports
iii. List reports

ACCOUNTS RECEIVABLE REPORT
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CH4 AR AG

The Accounts Receivable Aging Summary report provides information about the age of
customer accounts. This report lists the age of the accounts receiving balance. In general, the

older an account, the less likely the customer will pay the bill. Therefore, it isimportant to monitor
the age of accounts receivable and take action to collect old accounts.

To print the Accounts Receivable Aging Summary follow these steps:

Step 1. From the Report Center, select Customers & Receivables.
Step 2. Select A/R Aging Summary

Step 3. Select Date: Today

Step 4. Select: Run

Step 5. In the A/R Aging Summary window, select Sort by: Total
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Step 6. Sort in Descending (Z to A) order. If necessary, adjust the column widths by
clicking and dragging.

Step 7. Export 1o Excel

Step 8. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 9. From the drop-down list, select the sheet: C4 AR AG
Step 10. Save and close the Excel file.

OPEN INVOICES REPORT
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Customers with open invoices are those who have an unbilled or unpaid balance. It isimportant
to track the status of open accounts to determine:

v Are these amounts unbilled2 The sooner the balances are billed, the sooner your
company receives cash to pay your bills.
v Are these amounts billed but not yet due?

v Are these amounts billed and overdue? These accounts should be monitored closely
with an action plan for collecting the accounts.

CH4 INV

The Open Invoices report lists all customers with open balances and can be printed as follows:

Step 1. From the Customers & Receivables section of the Report Center, click Open
Invoices

Step 2. Select Date: 01/10/2023

Step 3. Select: Run

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6. From the drop-down list, select the sheet: C4 INV
Step 7. Save and close the Excel file.

COLLECTIONS REPORT
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When reviewing the age of accounts receivable, a business should monitor overdue accounts
closely and maintain ongoing collection efforts to collect its overdue accounts.

The Collections report lists customers with overdue account balances. In addition, the

Collections Report includes a contact phone number for convenience in contacting the
customer.

C4 COolL
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To print the Collections Report summarizing information for all customers with overdue balances:

Step 1. From the Customers & Receivables section of the Report Center, select:
Collections Report

Step 2. Select: Today

Step 3. Select: Run. No customers have overdue balances, so it appears that you are
doing a good job collecting customer payments on accounts.

Step 4. Change criteria of the report by changing the date. The new date should be
1/10/2024

Step 5. Click the Refresh option

Step 6. Export to Excel

Step 7. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8. From the drop-down list, select the sheet: C4 COL
Step 9. Save and close the Excel file.

The Collections Report provides the information necessary to monitor and contact overdue
accounts and should be prepared and reviewed on a regular basis.

PROFIT AND LOSS BY CUSTOMER
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To improve profitability in the future, a business should evaluate which customers and jobs have
been profitable in the past. This information permits a business to improve profitability by:

v'Increasing business in profitable areas
v Improving performance in unprofitable areas
v' Disconfinuing unprofitable areas
The following QuickBooks reports provide information about customer and job profitability:

Income by Customer Summary
Income by Customer Detail
Job Profitability Summary

Job Profitability Detail

AN RN

INCOME BY CUSTOMER SUMMARY REPORT
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To determine which customers are generating the most profit for your business, it is necessary to
look at both the sales for the customer and associated costs. To print the Income by Customer
Summary Report, follow these steps:

C4 CUSINC
Step 1. From the Report Cenfer, select Company & Financial > Income by Customer
Summary
Step 2. Select: This Fiscal Year-to-date

Step 3. Select: Run
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Step 4. In the Income by Customer Summary window, select Sort by: Total
Step 5. Sort in Descending (Z to A) order. If necessary, adjust the column widths by
clicking and dragging.

Step 6. Export to Excel
Step 7. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8.
Step 9.

From the drop-down list, select the sheet: C4 CUS INC
Save and close the Excel file.

ADD NEw CUSTOMER & JOB
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Add Mrs. Beneficio as a new customer
ADDRESS INFO:

CUSTOMER NAME
MR./Ms./...
FIRSTNAME

M.1.

LASTNAME
MAINPHONE
MOBILE
ADDRESSES:
BILLTO

Beneficio, Katrina
Mrs.

Katrina

L

Beneficio
415-555-1818
415-555-3636

10 Pico Bivd
Bayshore, CA 94326

PAYMENT SETTINGS:

ACCOUNTNO. 12736
PAYMENT TERMS Net 30
PREFERRED DELIVERY METHOD E-mail
PREFERRED PAYMENT METHOD VISA
CREDIT LIMIT 10,000
Sales Tax Settings:
TAX CODE Tax
TAXITEM San Tomas
Additional Info:
CUSTOMER TYPE Residential
Step 2. Close the New Customer window
Step 3. Add a new job for Katrina Beneficio

JOB INFORMATION:

JOB NAME Door Replacement

JOB DESCRIPTION Interior Door Replacement
JOBTYPE Repairs

JOB STATUS Closed

STARTDATE 12/17/2022

PROJECTED END 12/17/2022
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END DATE 12/17/2022

Step 4. Sort the Customer List (Hint: Right-click > Re-sort List.)

CREATE INVOICE
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Step 1. Create aninvoice for an interior doorreplacement using the following
information (Invoice Total = $214.91):
INVOICE INFORMATION:

.=

.=

.=

e B
R RS S

CUSTOMER: JOB Beneficio, Katrina: Door Replacement
CUSTOMER TEMPLATE Rock Castle Invoice

DATE 12/17/2022

INVOICENO. 1102

ITEMS 1 Wood Door: Interior @ $72.00

1 Hardware: Standard Doorknob @ 30.00
Installation Labor: 3 hours

Step 2. Save and close the Invoice

RECORD CUSTOMER CREDIT
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This activity is assuming that the standard doorknob was returned and later replaced with a
locking doorknob.

Step 1. Click the Refunds and Credits icon in the Customers section of the Home page.
Step 2. Select Customer and Job: Beneficio, Katrina: Door Replacement

Step 3. Select Template: Custom Credit Memo. Credit No. 1103

Step 4. Select date: 12/20/2022

Step 5. Select Item: Hardware Standard Doorknobs

Step 6. Enfer Quantity: 1

Step 7. Select Use credit to apply to invoice

Step 8. Select Yes if asked if you want to record changes

Step 9. When the following Apply Credif to Invoices window appears, select Invoice No.
1102.

Step 10.  Click Done to confirm your selection ofinvoice 1102
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Step 11.  Click Save & Close to finish the fransaction

[T

=

Credit Memo T
]
e

Harwara__|Slandara Dovmots 7 3000 000 Tar

The Credit Memo no. 1102 totals $-32.33 ($30.00 plus $2.33 tax)

CREATE INVOICE
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This is the replacement invoice for the doorknob that was returned in the previous activity.

Step 1.  Create anew invoice (Invoice No. 1104) for Katrina Beneficio: Door Replacement
on 12/17/2022

INVOICE INFORMATION:

CUSTOMER: JOB Beneficio, Katrina: Door Replacement
CUSTOMER TEMPLATE Rock Castle Invoice

DATE 12/17/2022

INVOICENO. 1104

[TEMS 1 Hardware: Lk Doorknobs (Locking Interior

doorknobs) @ 38.00

Invoice No. 1104 totals $40.95

RECEIVE PAYMENT
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Step 1. Record Mrs. Beneficio's payment for the doorreplacement by VISA credit card
for $223.53 on 12/20/2022.
v ' Card no.: 4444-5555-6666-7777
v Exp. Date: 07/2023
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Enter Card Information

PAYMENT CARD MUMBER EXP DATE :

VISA v JOO0O00D0C0000NT 777 07 !|2023|
Can | save the card = I
security code ? ance

Step 2. Click on Done to confirm the credit card transaction

Step 3. Click on Save & Close

If you have completed this activity correctly, your job information for the Beneficio, Katrina:
Door Replacement looks like this:

JoB NAvE[Door Replacement } custover | Beneficio, Katrina = |

CURRENT EALANCE 0.00 How do | adjust the current balance?

Address Info

JCB DESCRIFTICN | Interior Door Replacement

Payment Settings
JoETYFE  Repairs b4
Additional Info
JoBstaTus  Closed -
Job Info
START DATE | 1217/2022 E
PROJECTED END DaTE | 1201712022 E
END DATE | 12/17/2022
Actual End Date has

been entered in the
Customer Job Info

Job is inactive

RECORD BANK DEPOSIT

— ]
Step 1. Record the deposit for $223.53 on 12/20/2022

Check the ending balance of your check register. The correct balance is $47,708.91

CASH BASIS ACCOUNTING VS. ACCRUAL ACCOUNTING

|
The difference between cash and accrual accounting liesin the timing of when sales and
purchases are recorded in your accounts. Cash accounting recognizes revenue and expenses

only when money changes hands, but accrual accounting recognizes revenue when it's
earned, and expenses when they're billed (but not paid).

CASH BASIS ACCOUNTING

B .=
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The cash basis of accounting recognizes revenues when cash isreceived, and expenses when
they are paid. This method does not recognize accounts receivable or accounts payable.

Many small businesses opt to use the cash basis of accounting because it is simple to maintain.
It's easy to determine when a fransaction has occurred (the money is in the bank or out of the
bank) and there is no need to track receivables or payables.

The cash method is also beneficial in terms of tracking how much cash the business actually has
at any given time; you can look at your bank balance and understand the exact resources at
your disposal.

Also, since fransactions aren't recorded until the cash isreceived or paid, the business's income
isn't taxed until it's in the bank.

ACCRUAL BASIS ACCOUNTING
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Accrual accounting is a method of accounting where revenues and expenses are recorded
when they are earned, regardless of when the money is actually received or paid. For example,
you wouldrecord revenue when a project is complete, rather than when you get paid. This
method is more commonly used than the cash method.

The upside is that the accrual basis gives a more realistic idea of income and expenses during a
period of time, therefore providing along-term picture of the business that cash accounting
can't provide.

The downside is that accrual accounting doesn’t provide any awareness of cash flow; a
business can appear to be very profitable while in reality it has empty bank accounts. Accrual
basis accounting without careful monitoring of cash flow can have potentially devastating
consequences.

Cash Basis Accounting vs. Accrual Accounting

CASH ACCURAL
Pros e Yourincome isn't taxed untilitis | © You get better financial insights, with
in the bank more accurate reporting
Cons e You don't know how much e Yourbank account doesn’'t match your

books.

e You might get taxed on money you
don't have yet,

e Best opfionif you are dealing with large
businesses and don't get paid quickly

accounts receivable you have

Company e Best if you have a lot of
Choice fransactions and deal directly
with consumers.
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ACCOUNTS RECEIVABLE

Most large companies use the accrual basis of accounting since it better reflects the actual
results of the operations of a business. Under the accrual basis, a merchandising company that
extends credit records revenue when it makes a sale because at this time it has earned and
realized the revenue. The company has earned the revenue because it has completed the
seller's part of the sales contract by delivering the goods. The company has realized the revenue
because it has received the customer's promise to pay in exchange for the goods. This promise
to pay by the customer is an account receivable to the seller. Accounts receivable are amounts
that customers owe a company for goods sold and services rendered on account. Frequently,
these receivables resulting from credit sales of goods and services are called trade receivables.

When a company sells goods on account, customers do not sign formal, written promises to pay,
but they agree to abide by the company's customary credit ferms. However, customers may
sign a sales invoice to acknowledge purchase of goods. Payment terms for sales on account
typically run from 30 to 60 days. Companies usually do not charge interest on amounts owed,
except onsome past-due amounts.

Because customers do not always keep their promises o pay, companies must provide for these
uncollectible accounts in their records. Companies use two methods for handling uncollectible
accounts. The allowance method providesin advance for uncollectible accounts. The direct
write-off method recognizes bad accounts as an expense at the point when judged to be
uncollectible and is the required method for federal income tax purposes. The allowance
method represents the accrual basis of accounting and is the accepted method fo record
uncollectible accounts for financial accounting purposes.

After credit has been extended a business needs to frack accounts receivable to determine if
accounts are being collected in a timely manner. The following reports provide information
useful in fracking accounts receivable.

Accounts Receivable Aging Summary (age of amounts due you by customers)
Accounts Receivable Aging Detail

Customers with Open Invoices (invoices not yet paid)

Collections Report (overdue customer accounts with contact information)

N N NN

ACCOUNTS RECEIVABLE AGING SUMMARY REPORT
.

The accounts Receivable Aging Summary report provides informatfion about the age of
customer accounts. This report lists the age of accounts receivable balances. In general, the
older an account, the less likely the customer will pay the bill. Therefore, it is important to monitor
the age of accounts receivable and take action to collect old accounts.

C4 AR AG

Step 1. From the Report Center or Report menu, select Customers & Receivables
Step 2. Select A/R Aging Summary

DATES Today
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INTERVAL (DAYS) 30

THROUGH (DAYS PAST DUE) 90
SORTBY Total
SORTIN Descending Order
Step 3. Export to Excel
Step 4. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_O4_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 5. From the drop-down list, select the sheet: C4 AR AG
Step 6. Save and close the Excel file.

BACKUP YOUR COMPANY FILE

Y Y Y Y Y Yy,
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Use the instructions in Appendix A to back up your Rock Castle Construction company file.
Make sure your backup file is saved in the designated folder of this unit (UNIT 04 BACKUPS).

UNIT 04 PROJECT (OWN-YOUR-OWN ACTIVITY)

RESTORE THE UNIT 04 STARTER FILE

Follow the instructions in Appendix A (Backup & Resfore QuickBooks Files) to restore the starter
file for u04a2 Larrys Landscaping. This file is in your UNIT 04 folder.

Step 23:  RESTORE the u04a2 Larrys Landcapaing.QBB file
Step 24:  Make sure you SAVE to the UNIT 04 FOLDER

RENAME THE COMPANY

After you have followed the instructions fo restore your data files, you will find the company file
you have restored contfains sample data for a company called Larry’s Landscaping. Your first
activity is to personalize that name to meet your needs follow these instructions:

Step 7: From the Menu bar, select Company

Step 8: Select MY COMPANY

Step 9: Select EDIT

Step 10:  Update the Company Name Field to: YourName Larry’s Landscaping

Step 11: CLICK on OK
Step 12:  Close the My Company window.

NOTE: The process fo rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

Enter the following Transactions for purchases:

| SALES RECEIPT TEMPLATE Sales Receipt - Retail
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DATE 12/20/2023
CUSTOMER Dave Perry
ITEM Fertilizer (Lawn & Garden)
QUANTITY 27
PAYMENT Check (no. 622)
TEMPLATE Sales Receipt - Retail
DATE 12/21/2023
CUSTOMER Jean Paulney
SALES RECEIPT
ITEM Rocks (Garden Rocks)
QUANTITY 13
PAYMENT Cash
DATE 12/21/2023
CUSTOMER Anne Loomis
ITEM Pest Control Service
INVOICE
QUANTITY 3
PRICEEA $60.00
TAX Non
DATE 12/22/2023
CUSTOMER Russell Chiropractic
ITEM Weekly Gardening Services
INVOICE
QUANTITY 2
PRICEEA $75.00
TAX Non
DATE 12/22/2023
CUSTOMER Gwen Price
ITEM Tree Removal
INVOICE
QUANTITY 5
PRICEEA $90.00
TAX Non
DATE 12/19/2023
CUSTOMER Susie Rummens
PAYMENT INVOICENO. No. 128
AMOUNT $1438.56
PAYMENT METHOD Check (No. 321)
DATE 12/20/2023
CUSTOMER Bob Heldt
PAYMENT INVOICENO. No. 142
AMOUNT $102.36
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PAYMENTMETHOD | Check (No. 823)

DATE 12/21/2023

CUSTOMER Mike Balak
PAYMENT INVOICENO. No. 116

AMOUNT $180

PAYMENT METHOD Check (No. 1281)

COMBINE THESE TRANSACTIONS INTO ONE DEPOSIT

=
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DATE 12/22/2023
DEPOSIT FROM

CUSTOMER Jean Paulney
UNDEPOSITED FUNDS

AMOUNT $134.99

DATE 12/22/2023
DEPOSIT FROM "

CUSTOMER Susie Rummens
UNDEPOSITED FUNDS

AMOUNT $1,438.56

DATE 12/22/2023
DEPOSIT FROM

CUSTOMER Bob Heldt
UNDEPOSITED FUNDS

AMOUNT $102.36

DATE 12/22/2023
DEPOSIT FROM

CUSTOMER Dave Perry
UNDEPOSITED FUNDS

AMOUNT $54.35

DATE 12/22/2023
DEPOSIT FROM -
T es T Fs CUSTOMER Mike Balak

AMOUNT $180.00

Step 1. Save the Deposit

P4 JUR

Step 2. While in the Deposit Window, Display the Journal for this transaction

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 5. From the drop-down list, select the sheet: P4 JUR

Step 6. Save and close the Excel file.
P4 CUST SUM
Step 1. From the Reports menu, Select Customers & Receivables
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Step 2.

Select Customer Balance Summary

Step 3. From: 12/23/2023 To: 12/23/2023

Step 4. Click Refresh

Step 5. Export to Excel

Step 6. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 7. From the drop-down list, select the sheet: P4 CUST SUM
Step 8. Save and close the Excel file.
P4 INV
Step 1. From the Customers & Receivables section of the Report Center, click Open
Invoices
Step 2. Select Date: 01/10/2023
Step 3. Select: Run
Step 4. Export to Excel
Step 5. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_04_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 6.
Step 7.

From the drop-down list, select the sheet: P4 INV
Save and close the Excel file.

TAKE THE QUIZ

The reading in the unit along with the Excel reports you have generated have provided answer
fo the quiz for this unit. Take the UNIT_04 QUIZ in your Canvas account

SUBMIT THE UNIT REPORTS

After you have taken the quiz using the answers you have already recorded in the reports you
extracted from Excel, UPLOAD the following files to the UNIT_04 assignment area of your Canvas

account:

The Excel file - UNIT_04_REPORTS
The following PDF files:
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VENDOR NAVIGATION

The Vendor List contains information for each 5

& devedr. v @ NewIwwstes v & ot v H Bl v B Wou ¥

vendor, such as address, telephone number, and entr Vendor Information ¢ ¢ ...
credit terms. Vendor information is entered in the P S
vendor List and then QuickBooks automatically
transfers the vendor information to the
appropriate forms, such as purchase orders and
checks. This feafure enables you to enter vendor
information only once in QuickBooks instead of
entering the vendorinformation each time a
form is prepared.

Purciaso Order 3:500.00
| BillFmtCheck  |757 -2.000.00
Bil 2,000.00

i 01208 0
BilPrt Check 248 01312018 350000
Bil 012012018 ayable 200000
Bill 010212018 20000 - Actourts Payable 1500.00

RESTORE THE STARTER FILE
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e

You will find the following files in your Student files for UNIT 05.

e UO5al Rock Castle Construction
e U0502 Larry's Landscaping
e UNIT_05_Reports

To complete the first lesson exercises, RESTORE the u05al Rock Castle Construction company file
from the UNIT 05 folder.

NOTE: The process to restore a backup isfound in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY
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After you have followed the instructions fo restore your data files, you will find the company file

you have restored contains sample data fora company called Rock Castle Construction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 25.  From the Menu bar, select Company

Step 26. Select MY COMPANY

Step 27.  Select EDIT

Step 28. Update the Company Name Field to: YourName Rock Castle
Construction

Step 29. CLICK on OK
Step 30. Close the My Company window.

NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

The QuickBooks Home Page contains a Vendors section that displays icons used for vendor
functions. If necessary, click the Home icon in the Navigation Bar to display the Home Page.
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The Vendors section of the Home Page is a flowchart of vendor transactions. In this unit we will
focus on the following types of fransactions:

i ar = = = = = =

VENDORS

=] Create Sales
Receipts
Accept
Credit Cards
. g (-]
] &2 &
Estimat Receive Record Reconcil
I Payments Deposits
e ™
=) B & s 4 =
Statement Finance Statements Refunds » =
Charges Charges & Cradits b e R;';;‘;
EMPLOYEES
. s . 7] &
= & L= i, = a8 .

it Enter Credit
Process HR Essentials Checks Card Charges
Payroll and Insurance
Forms

v' Enter Bills. Use the Enter Bills windows to record bills for services received. Examples
include rent, utilities expense, insurance expense, and accounting and professional
services. QuickBooks will record an obligation (accounts payable liability) fo pay the bill
later.

v' Pay Bills. Use the Pay Bills windows to select the bills that are due and you are ready to

pay.
To view the Vendor List, follow these steps:

Step 1. Click Vendors in the Icon bar

Step 2. Click the Vendors tab.

Step 3. To view addifional information about a vendor, click the vendor’'s name and
Vendor Information will appear on the right side of the Vendor Center.

ADD NEW VENDOR

.=
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B

Rock Castle Construction plans to add the following new vendorinformation:

.= .=

Step 1. Click the New Vendor button af the fop of the vendor Center

Step 2. Select New Vendor from the drop-down menu.
Step 3. Select the Address info tab in the New Vendor window. Enter the following
information:
Vendor Name Kolbe Window & Door
Company Name Kolbe Window & Door
Full Name John Kolbe
Main Phone 415-555-1958
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Mobile 415-555-1985

Main E-mail Kolbe@windowdoor.com
Address 58 Charles
Bayshore, CA 94326
Step 4. Select the Payment Settings tab and enter the following information
Payment Settings
Account No. 58101
Payment Terms Net 15
Print on Check as Kolbe Window & Door
Step 5. Select the Tax Seftings tab and enter the following information.

Tax Settings:
Vendor Tax ID 37-1958101
Vendor eligible for 1099  Yes

Step 6. Select Additional Info fab and enter the following information
Additional Info:

Vendor Type Materials

venDoR NanE Kolbe Window & Door
OPENING BALANCE ASOF | 12/15/2018 #  How do | determine the opening balance?
Address Info company NAME | Kolbe Window & Door
Payment Settings FULLNAME | M John M1 Kolbe
. JOBTITLE
Tax Settings
Main Phone ~ | |415-555-1958 Main Email - Kolbe@windowdoor.com
REECTIEE Work Phone - CC Email
Additional Info Mobile - 415-555-1985 Website
Fax ~ Other 1
ADDRESS DETAILS
BILLED FROM SHIPPED FROM
Kolbe Window & Door
John Kolbe ~ ~
58 Charles Copy >>
Bayshore, CA 94326
Vendor is inactive I OK Cancel Help

ADD ANOTHER NEW VENDOR
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Rock Castle Construction plans to add the following new vendor information:

Step 1. Click the New Vendor button at the top of the vendor Center

- T Y.
RR R R e e e e S R e e R

Step 2. Select New Vendor from the drop-down menu.
Step 3. Select the Address info fab in the New Vendor window. Enfer the following
information:
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Vendor Name Andre Window & Door

Company Name Andre Window & Door
Full Name Andre LaFortune
Main Phone 415-555-1958
Mobile 415-555-1985
Main E-mail andre@windoor.com
Address 57 Beach Street
Bayshore, CA 94326
Step 4. Select the Payment Settings tab and enter the following information

Payment Settings

Account No. 58102
Payment Terms Net 15
Print on Check as Andre Window & Door
Step 5. Select the Tax Seftings tab and enter the following information.

Tax Settings:
Vendor Tax ID 37-1857201
Vendor eligible for 1099  Yes

Step 6. Select Additional Info tab and enter the following information

Additional Info:
Vendor Type Materials
Step 7. Click OK

EXPORT VENDOR LIST

o
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e
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The Vendor List can be both imported and exported into QuickBooks. You can export
Customer, Vendor, Payroll lists and transactions, as well as Items list into an Excel
spreadsheet. If you need to change a report’s appearance or contents in ways that
are not available in QuickBooks, you can also export reports and customize it in Excel
without affecting your QuickBooks data.

C5 VEN

Export the Vendor List as follows:
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Step 1. From the Vendor Center, select Excel

]

E New Vendor.. ¥ ;% New Iransactions ¥ :i‘; Print ¥ Excel ¥ Word ¥ @ Bill Tracker }

Vendors Transactions Vend nfo rm atlon
Active Vendors v >
Company Ni
D Full Hame I}
. Billed From AR}

N X .

i Adobe Creative Cloud 0.00 '

%Albertsons 0.00 Transactions Contacts ToDo's MNotes Sent Email

;Amazan 0.00 sHow  |All Transactions * | FuTEREY |All * | oatE Al

| american Greeting Cards 0.00 £ u g

0.00,

Step 2. Export to Excel
Step 3. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O5_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 4. From the drop-down list, select the sheet: CH5 VEN

Step 5. Highlight the new vendors you have added
Step 6. Save and close the Excel file.

VENDOR TRANSACTIONS

___________________________________________________________________________________________________________________________|
After creating a Vendor List, you are ready to enter vendor transactions. There are two basic
ways fo enter vendor transactions using QuickBooks:

1. Enter Bills > Pay Bills
2. Enter Purchase Orders > Receive Inventory - Enter Bills Against Inventory -2 Pay Bills

Notice that both flow chart options enter in the pay bills screen. It willdepend on the option you
initially choose to determine the flow of the fransactions. This unit covers optfion number 1.

ENTER BILLS
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Recording your payables in QuickBooks Desktop is easy with Enter Bills. You can readily record
fransactions that you will pay at a future date, including expenses incurred, materials
purchased, or services provided by a vendor.

To record services instead of inventory received, use the Enter Billsicon. Expense that can be
recorded using the Enter Bills windows include utilifies, insurance, and rent.

Step 1. Click the Enter Bills icon in the Vendors section of the Home Page
Step 2. Click the Expenses tab
Step 3. Enter the following Information:

VENDOR: Bayshore Water
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DATE: 12/24/2022
AMOUNT DUE: $54.00
TERMS: Net 30
ACCOUNT: 65130: Water
Step 4. Select Save and leave the Enter Bills window open
Inventory Against Options Sales ?
Inventory Tax
CF
Enter Bills
Reports
— -
Main Report!
«» B B XBowscow @ § B O B B &
Find Mew Sage Delete QMemnze Print Attach Select  Enter Clear Recalculate Pay
e e File PO Time: Splits Bill
: Vendor
Bil N
VENDCR  Bayshore Water - DATE 12/24/2022 E SUMMARY.
W Phone 415-555-0111
ADDRESS Egysé‘s;eﬁ%m' =l Open balance 0.00 i
Bayshore CA 34326 ANDUTELE, |54.00 POs to be received 0
LL DUE 01/23/2023 B
TERMS Net 30 - DISCOUNT DATE
DM RECENT TRANSACTION @
Expenses $54.0 s $0.00
11430122 Check 2400
ACCOUNT AMOUNT NEMO IS R OREEIOs B CEASS 10/31/22 Check 24.00
85100 - ummes_ﬁﬁlm - Water 5400 09730122 Check 2400
| i b * 08/31/22 Check 24.00
07131122 Check 2400
v NOTES '
saeacoss (ETIERN  cer ls )
C5 JUR
Step 5. From the Enter Bills onscreen form, select the Reports Tab
Step 6. Select the Transaction Journal icon
Step 7. Export the Transaction Journal report to Excel or print the report. Nofice that the
enfry shows a debit (increase) to Water Expense and a credit (increase) to
Accounts Payable for the entered bill.
Step 8. Export to Excel
Step 9. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_05_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 10.  From the drop-down list, select the sheet: CH5 JUR
Step 11.  Save and close the Excel file.
PAY BILLS

B

Page | 129

e
B R R A B R A8 S




After recording what you owe in QuickBooks Desktop, you can use Pay Bills to seftle your

payables for different vendors. You can also easily apply the corresponding discount or credit
for each payment you make.

To select the bills to pay follow these steps:

Step 1. Click the Pay Bills icon in the vendors section of the Home Page
Step 2. Select show bills: Show all bills
Step 3. Select the bills you want to pay. Typically, you would select the bills that are due

first. Inthis case, however, select bill that you just recorded for Bayshore Water for
$54.00. If necessary, scroll down to view this bill. In the payment section enter the
following information:

DATE 12/24/2022
METHOD Check
TO BE PRINTED / ASSIGN CHECKNUMBER | To be printed
ACCOUNT Checking
Step 4. Click Pay Selected Bills
Step 5. When the Payment Summary windows displayed if we wanted to print the

checks. In this case, select DONE.

PAY MORE BILLS
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To select the bills to pay follow these steps:

Step 1. Click the Pay Bills icon in the vendors section of the Home Page
Step 2. Select show bills: Show all bills
Step 3. Check the following bills to pay:

DUE DATE VENDOR REF. NO. | AMT.DUE | AMT.TOPAY
12/30/2023 C.U. Electric 500.00 250.00
12/30/2023 Cal Gas & Electric 12/03 122.68 122.68
12/20/2023 Hopkins Construction Rental 550.00 550.00

NOTE: QuickBooks assumes you plan to pay in full. In the case of the C.U. Electric bill that you
are partially paying, you must enter the amount you plan to pay.

Step 4. Click Pay Selected Bills

DATE 12/24/2022
METHOD Check
TO BE PRINTED / ASSIGN CHECK NUMBER To be printed
ACCOUNT Checking
Step 5. When the Payment Summary windows displayed if we wanted to print the

checks. In this case, select DONE.
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C5 JUR-2

Step 1. From the Navigation Bar, select Reports
Step 2. Select Accountant & Taxes

Step 3. Select Journal

Step 4. From: 12/24/2022 to 12/24/2022

Step 5. Click Refresh

Noftice that the first journal enfry records the expense with a debit and records an account

payable of $54.00 with a credit. The second journal entry records paying the bill with a debit
(decreases) Accounts Payable and credit (decreases) the Checking account for $54.00.

Customize Report  Comment on Report Memorize  Prmt ¥ Emal Y| Excel [T | HideHeader | Refresh

baes custom - Fom ea2 B To 1224202 B sotsy Dt

Show Filters

YourName Rock Castle Construction
Journal

zzzzzz

December 24, 2022
tate M Name Memo

20000 - Accaurts Payable 5400 ¢

12002022 Bayshors Water 10100 - Checking
Bayshors Water 20000 Accaunts Payable 54.00

12242022 a0 TOTOT=CREmT T

20000 - Accaunis Payable 25000

£
H
| '
E W W W N e W, WA

Hoplins Construct. 20000 - Accaurts Payabl: 55000

NOTE: If you are still having trouble understanding the journal processes and why items are
recorded in a specific column, please refer to the illustrations and tables in Appendix D.

Step 6.
Step 7.

Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O5_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8. From the drop-down list, select the sheet: CH5 JUR-2

Step 9. Highlight the fransaction recorded in the Expense Category (hint refer to
Appendix D account numbers)

Step 10.  Save and close the Excel file.

VENDOR REPORTS

|
The QuickBooks Vendors & Payables Reports give you data about how much money your
company owes. These QuickBooks reports will help you manage your payables to ensure that
you pay your vendors timely, forecast your cash outflows and determine which vendors cost you
the most money for the goods and services they provide to your company. You will find a list of

QuickBooks Vendors & Payables Reports with a description of the information contained in the
report below.
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VENDORS & PAYABLES
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QuickBooks Vendors & Payables Reports will give you more information about how
much your company owes to its vendors.

v A/P Aging Summary - The A/P Aging Summary Report will show you how much
you owe each vendor.

v' A/P Aging Detail-The A/P Aging Detail Report will show you all the invoices you
have received from vendors along with the total amount you owe.

v' Accounts Payable Graph - The AccountsPayable Graph will show you the A/P
Aging Summary Reportin a pie graph format.

VENDOR BALANCES
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QuickBooks VendorBalancesReports will show you your vendor balances and unpaid
bills.

v Vendor Balances Summary - The Vendor Balances Summary Report will show you
your company'’s current balance with each vendor.

v' Vendor Balance Detail - The Vendor Balance Detail Report will show you what
fransaction make up your current balance with each vendor.

v" Unpaid Bills Detail - The Unpaid Bills Detail Report will show you how much your company
owes each vendor and whether there are any invoices that are past due.

v' Transaction List by Vendor - The Transaction List by Vendor shows the fransactions that
you have with each vendor.

CHS5 VBS

Step 1. Select: Reports

Step 2. Select: Vendors & Payables

Step 3. Select: Vendor Balance Summary

Step 4. Dates: All

Step 5. Export to Excel

Step 6. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_05_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 7. From the drop-down list, select the sheet: CH5 VBS

Step 8. Highlight the largest balance due
Step 9. Save and close the Excel file.

CHS5 VBD

Step 10.  Select: Reports
Step 11.  Select: Vendors & Payables
Step 12.  Select: Vendor Balance Detail
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Step 13. Customize the Report

a. Filter > Name: Hamlin Metal
Step 14. Dates: All
Step 15.  Export to Excel

Step 16. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O5_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 17.  From the drop-down list, select the sheet: CH5 VBD

Step 18.  Highlight the bill that is sfill outstanding for Hamlin Metal
Step 19.  Save and close the Excel file.

CHS5 UPD

Step 1. Select: Reports

Step 2. Select: Vendors & Payables

Step 3. Select: Unpaid Bills Detail

Step 4. Customize the Report
a. Filter > Amount: >=2000

Step 5. Dates: Today

Step 6. Export to Excel

Step 7. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_05_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 8. From the drop-down list, select the sheet: CH5 UPD

Step 9. Highlight the bill that is sfill outstanding for Sergeant Insurance
Step 10. Save and close the Excel file.

CH5 VEN TRANS

Step 1. Select: Reports

Step 2. Select: Vendors & Payables

Step 3. Select: Transaction List by Vendor

Step 4. Sort By: Credit

Step 5. Sort: Ascending

Step 6. Dates: This Week

Step 7. Export to Excel

Step 8. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_05_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 9. From the drop-down list, select the sheet: CH5 VEN TRANS

Step 10.  Highlight the transaction for the highest amount of money.
Step 11.  Save and close the Excel file.
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CH5 AP AGING

Step 1. Select: Reports

Step 2. Select: Vendors & Payables

Step 3. Select: A/P Aging Summary

Step 4. Date: 12/24/2022

Step 5. Export to Excel

Step 6. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_O5_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 7. From the drop-down list, select the sheet: CH5 AP AGING

Step 8. Highlight the vendors and amounts of any past due accounts payable
Step 9. Save and close the Excel file.

ACCOUNTS PAYABLE

Accounts payable consists of amounts that the business is obligated to pay in the future. When
a business makes purchases on credit, the company is promising to pay that amount in the
future. When a purchase is made and recorded as a bill, accounts payable isincreased by a
credit. When the billis paid, the accounts payable is decreased by a debit.

Some fransactions affect only balance sheet items: assets (such as cash, accounts receivable,
and equipment), liabilities (such as accounts payable and notes payable), and stockholders’
equity (capital stock). Other transactions affect both balance sheet items and income
statement items (revenues, expenses, and eventually retained earnings).

TRACKING ACCOUNTS PAYABLE
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Accounts payable reports provide information to tfrack amounts the company owes vendors. An
Accounts Payable Aging report summarizes accounts payable balances by the age of the
account. This report helps us fo frack how much we owe vendors and when amounts are due,
including the age of past due bills.

PREPARING 1099s
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The IRS Form 1099 must be completed for sole proprietorships and partnerships that are paid

$600 or more for services in ayear. The vendor's Tax ID No. isrequired to complete the 1099.
QuickBooks can assist in fracking amounts and preparing 1099s for appropriate vendors.

ENTER AND PAY BILLS

C5 JUR-3

Step 1. Enter the following Bill:
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VENDOR: Cal Telephone
DATE: 12/26/2022
AMOUNT DUE: $63.00
ACCOUNT: 65120:Telephone
Step 2. Select the Saveicon at the top of the Enter Bills window
Step 3. Select the Reports tab
Step 4. Select the Transaction Journal icon
Step 5. Export the Transaction Journal report to Excel
Step 6. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_O05_REPORTS Excel file.

NOTE: Make sure you have used all the advanced settings outlined in Appendix C.

Step 7. From the drop-down list, select the sheet: CH5 JUR-3
Step 8. Save and close the Excel file.

C5 CHECKS 10080-10084.PDF

Step 1. Pay the Cal Telephone Bill

VENDOR: Cal Telephone
DATE: 12/26/2022
AMOUNTTO PAY: $63.00

METHOD: Check
ACCOUNT: 10100 Checking
TO BE PRINTED/ASSIGN CHECK NUMBER To be printed

Step 2. Click Pay Selected Bills
Step 3. Click Done

Step 4. Click the File option
Step 5. Select Print Forms

Step 6. Click Checks

Step 7. Enter 10080 as the first ErTY W ' -
check number
Step 8. You will see a list of all .

the bill payment checks marked to print. Once you click on OK, you will be
directed the print dialog box. Use the following specifications for the printer:

ter first check number

Orger Checks

5400
25000
12288
5000

PRINTER NAME: Adobe PDF or Microsoft Print to PDF
PAPER TYPE: Page-oriented (Single sheets)
CHECK STYLE: Standard

SELECTIONS: Print Company name and address
NUMBER OF CHECKS ONFIRSTPAGE: | 3

Step 9. Click Print
Step 10.  Save the PDF copy in the UNIT 05 folder
Step 11.  Save as C5 Checks 10080-10084
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Step 12.  When the print checks confirmation window appears, click OK to complefe the
checks in the register.

C5 CKD

To review the fransactions entered, you will export a check detail report to Excel.

Step 1. From the report menu, Select Banking
Step 2. Select Check Detail

DATES: This Month-to-date
FROM: 12/24/2022

To: 12/26/2022
Step 3. Click Refresh
Step 4. Export the report to Excel NOTE: Make sure you have used all
Step 5. Follow the instructions in Appendix C to export the advanced settings outlined in
the report to the Excel file named Appendix C.

UNIT_O5_REPORTS Excel file.
Step 6. From the drop-down list, select the sheet: CH5 CKD
Step 7. Save and close the Excel file.

CH5 AP AGING-2

The Accounts Payable Aging report summarizes accounts payable balances by the age of the
account. Follow these steps to obtaining the report:

Step 1. From the Reports section, select Vendors & Payables
Step 2. Select A/P Aging Detail
Step 3. Date: 12/26/2022

Step 4. Click Run or Refresh depending on which
section you choose to refrieve the reports.
Export to Excel

NOTE: Make sure you have used all
the advanced settings outlined in

Step 5. Follow the instructions in Appendix C to

export the report o the Excel file named UNIT_05_REPORTS Excel file.
Step 6. From the drop-down list, select the sheet: CH5 AP AGING-2
Step 7. Highlight the vendors and amounts of any past due accounts payable
Step 8. Save and close the Excel file.

UNIT 05 PROJECT (ON-YOUR-OWN ACTIVITY)

Follow the instructions in Appendix A (Backup & Resfore QuickBooks Files) to restore the starter
file for u05a2 Larrys Landscaping. This file is in your UNIT 05 folder.

Step 1: RESTORE the u05a2 Larrys Landscaping.QBB file
Step 2: Make sure you SAVE to the UNIT 05 FOLDER

RENAME THE COMPANY
.
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After you have followed the instructions fo restore your data files, you will find the company file

you have restored contains sample data fora company called Larry’s Landscaping. Your first
activity is to personalize that name to meet your needs follow these instructions:

Step 13: From the Menu bar, select Company

Step 14:  Select MY COMPANY NOTE: The process to rename the

Step 15:  Select EDIT company is found in Appendix B

Step 16:  Update the Company Name Field to: and will be repeated throughout
YourName Larry’s Landscaping all the activities in the text.

Step 17  CLICK on OK

Step 18:  Close the My Company window.

ENTER TRANSACTIONS
I —

DATE: 12/23/2023
Bill VENDOR: Carole Design Media
Add Vendor | ACCOUNT: 6000 Advertising Expense
if necessary | TERMS: Net 30
AMOUNT DUE: $225.00
DATE: 12/23/2023
Bill VENDOR: Brown Equipment Rental
Add Vendor | ACCOUNT: 7120 Equipment Rental
if necessary | TERMS: Net 15
AMOUNT DUE: $630.00
DATE: 12/23/2023
Bill VENDOR: Campion Patrick, CPA
Add Vendor | ACCOUNT: 7410 Accounting Expense
if necessary TERMS: Net 30
AMOUNT DUE: $324.00
Bill DATE: 12/23/2023
Add Vendor | VENDOR: Townley Insurance Agency
if necessary | ACCOUNT: 6900 Insurance
TERMS: Net 30
AMOUNT DUE: $427.62
Bill DATE: 12/23/2023
Add Vendor | VENDOR: Great Statewide Bank
if necessary | ACCOUNT: 7020 Interest on Loan
TERMS: Net 15
AMOUNT DUE: $699.12
DATE: 12/23/2023
VENDOR: Brown Equipment Rental
Pay Bill AMOUNT DUE: $630.00
in full METHOD: Check
TO BE PRINTED/ASSIGN CHECK To be Printed
NUMBER
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DATE: 12/23/2023
VENDOR: Carole Design Media
Pay Bill AMOUNT DUE: $225.00
in full METHOD: Check
TO BE PRINTED/ASSIGN CHECK To be Printed
NUMBER
DATE: 12/23/2023
VENDOR: Campion, Patrick CPA
Pay Bill AMOUNT DUE: $324.00
in full METHOD: Check
TO BE PRINTED/ASSIGN CHECK To be Printed
NUMBER
DATE: 12/23/2023
VENDOR: Townley Insurance Agency
Pay Bill AMOUNT DUE: $427.62
in full METHOD: Check
TO BE PRINTED/ASSIGN CHECK To be Printed
NUMBER
DATE: 12/23/2023
VENDOR: Great Statewide Bank
Pay Bill AMOUNT DUE: $699.12
in full METHOD: Check
TO BE PRINTED/ASSIGN CHECK To be Printed
NUMBER
P5 JUR
Step 1. From the Reports menu, Select Accountant &
Taxes NOTE: Make sure you have used all
Step 2. Click on Journal the advanced settings outlined in
Step 3. Select Date: 12/23/2023 Appendix C.
Step 4. Export to Excel
Step 5. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_05_REPORTS Excel file.
Step 6. From the drop-down list, select the sheet: P5 JUR
Step 7. Save and close the Excel file.
P5 UPD
Step 1. Open the Unpaid Bills Detail for Larry’s
Landscaping NOTE: Make sure you have used all
Step 2. Select Date: 12/23/2023 the advanced settings outlined in
Step 3. Export to Excel Appendix C.
Step 4. Follow the instructions in Appendix C to export
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Step 5.

From the drop-down list, select the sheet: P5 UPD

Step 6. Save and close the Excel file.
P5 CKD
Step 1. Open the Check Detail Report for Larry’s Landscaping
Step 2. Select Date: 12/23/2023
zzep 2 EXﬁor’r IE E)_(CTI i A dix C 1 ; NOTE: Make sure you have used all
ep % oflowihe Iinsiructions ”T ppendix . 1o expor the advanced settings outlined in
the report to the Excel f|I'e named Appendix C.
UNIT_O5_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: P5 CKD
Step 6. Save and close the Excel file.
P5 AP AGING
Step 1. Open the Accounts Payable Aging Detail
for Larry’s Landscaping NOTE: Make sure you have used all
Step 2. Select Date: 12/23/2023 the advanced settings outlined in
Step 3. Export to Excel Appendix C.
Step 4. Follow the instructions in Appendix C to
export the report to the Excel file named UNIT_05_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: P5 AP AGING
Step 6. Save and close the Excel file.

P5 CHECKS 1569-1616

Step 1.

Step 2.
Step 3.
Step 4.
Step 5.
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You will see a list of all the bill payment checks marked fo print. Once you click

on OK, you will be directed the print dialog box. Use the following specifications
for the printer:

PRINTER NAME: Adobe PDF or Microsoft Print to PDF
PAPER TYPE: Page-oriented (Single sheets)
CHECK STYLE: Standard

SELECTIONS: Print Company name and address
NUMBER OF CHECKS ONFIRSTPAGE: | 3

Click Print
Save the PDF copy in the UNIT 05 folder
Save as P5 Checks 1569-1616

When the print checks confirmation window appears, click OK fo complete the
checks in the register.




BACKUP YOUR COMPANY FILE

Y Y Y Y Y Yy,
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Step 1.  Use the instructionsin Appendix A to back up your company file. Make
sure your backup file is saved in the designated folder of this unit (UNIT 05

BACKUPS).

TAKE THE QUIZ
I ————————————————

The reading in the unit along with the Excel reports you have generated have provided answer
to the quiz for this unit. Take the UNIT_04 QUIZ in your Canvas account

SUBMIT THE UNIT REPORTS
I EEEEEEEEEEEEEEEE—————————————————

After you have taken the quiz using the answers you have already recorded in the reports you
exiracted from Excel, UPLOAD the following files to the UNIT_05 assignment area of your Canvas
account:

The Excel file - UNIT_05_REPORTS
The following PDF files:

e C5 Checks 10080-10084.PDF
e P5 Checks 1569-1616.PDF
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New ltem

Inventory Part » | Useforgoods you purchase, track as inventory, and resell.
Cancel
Next
Itern Name/MNumber [7] Subitem of Manufacturer's Part Number
— = Notes
PURCHASE INFORMATION SALES INFORMATION Custom Fields
Description on Purchase Transactions Description on Sales Transactions
Spelling
Cost 0.00 Sales Price
COGS Account 4500 - Costof Goods ... =
Preferred Vendor - Income Account -
[ ltem is irtictive
INVENTORY INFORMATION .
Reorder Point
AssetAccount (Min) On Hand Total Value As of
1120 - Inventory Asset - | 0.00 0.00 09/13/2019 E
New ltem

Use for services you charge for or purchase, like

specialized labor, consulting hours, or professional Cancel
fees.
Inventary Part Next
'E Mon-inventory Part W HLE 04 Notes
-
Other Charge
Custom Fields
[ Subtotal :mblies or is performed by a subcontractor or partner
Group Spelling
O Rate
S
Fayment Account

] ltem is inactive

BTG

UNIT 06 — ITEMS AND SERVICES
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RESTORE THE STARTER FILE

Y Y Y Y Y Yy,
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Y ou will find the following files in your Student files for UNIT 06.

e UO6al Rock Castle Construction

e U06a2 Larry’s Landscaping

e UNIT 06 Reports
To complete the first lesson exercises, RESTORE the ull6al Rock Castle Construction
company file from the UNIT 06 tolder.
NOTE: The process to restore a backup is found in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY

it e et e e e e e e e e e e e e e e e e e e e e e

After you have followed the instructions to restore your data files, you will find the company file
you have restored contains sample data for a company called Rock Castle Construction. Y our
first activity is to personalize that name to meet your needs follow these instructions:

Step 31. From the Menu bar, select Company

Step 32.  Select MY COMPANY

Step 33. Select EDIT

Step 34.  Update the Company Name Field to: YourName Rock Castle Construction
Step 35. CLICK on OK

Step 36. Close the My Company window.
NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

VENDOR AND CUSTOMER TRANSACTIONS

QuickBooks inventory is tracked both in the Customer and Vendor databases. The following
table summarizes how specific activities are dispersed and recorded:

Record Using Type Activity

Vendor List Vendor @ Record Vendor information

Record inventory information: Set up inventory records to track
the quantity and cost of items purchased
Order goods: Use purchase orders (POs) to order goods from

Item List Vendor

Purchase Orders Vendor

vendors

Receive Items Vendor | Receive goods: Record goods received as inventory

Enter Bills Vendor Receive bill: Record an obligation to pay a bill later (Account
Payable)

Pay Bills Vendor | Pay for goods: Pay bills for the goodsreceived

Customer List Customer Record customer information

Invoice Customer Sell goods and bill customers: Record Customer’s promise to pay

later (Account Receivable)

Receive customer payment: Record cash collected and reduce
customer’s Account Receivable

Deposit Customer Deposit customers’ payments in bank account.

Receive Payments = Customer
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ITEMS

I ————
ltems are what you sell or buy and are used on all customer fransactions and optionally on
purchase transactions. Items provide a quick means for data entry. However, a more important
role foritems is to handle the behind-the-scenes accounting while fracking product- or service-
specific costs and revenue detail.

SERVICE ITEMS

Service items can be services that are purchased or sold. For example, service items include
services you buy from vendors, such as cleaning services and services you sell to customers,
such as installation services.

INVENTORY ITEMS

Inventory items are products that a business purchases, holds as inventory, and then resells to
customers. QuickBooks traces the quantity and cost of inventory items in stock.

For consistency, the same inventory item is used when recording sales and purchases.
QuickBooks has the capability to track both the cost and the sales price for inventory items. For
example, in Unit 04, we recorded the sale of an inventory item, an interior door. When the
interior door was recorded on a sales invoice, QuickBooks automatically updated the inventory
records by reducing the quantity of doors on hand. If we purchased an interior door, then the
inventory would increase once the dooris received. The purchase order uses the door cost while
the invoice using the door selling price.

NON-INVENTORY ITEMS

Non-inventory items are products that a business purchases, but QuickBooks does not track the
quantity on hand for non-inventory items. Non-inventory items include but are not limited to the
following:

» ltems purchased for a specific customer job, such as a custom countertop

> ltems purchased and used by your company instead of resold o customers, such as
office supplies or carpentry tools

» Items purchased and resold (if the quantity on hand does not need to be fracked)

ITEMS AND SERVICES LIST

o
=

e
——

e
——

e
——

ST
"

The Items and Services List (Item List summarizes information 6
about items (inventory items, non-inventory items, and service Chart of Inventory
. Accounts Activities
items) that a company purchase or sells.
To view the Item List in QuickBooks follow these steps: E &
ltems & Get Financing
. . . . Services
Step 1. Click the Items & Services icon in the Company
section of the Home pcdge
Step 2. Notice the Item List contains the following ¥y
information: Web and Calendar
: Mobile Apps

v’ ltem name
v ltem description

Page | 143




v ltem type (service, inventory, non-inventory, other charge, discount, sales tax

item).
v Account used
v" Quantity on hand
v' Price ofitem

QuickBooks classifies products and services purchased and sold into three different categories of

items:

ADD NEW ITEM

o
=

e
——

e
——

e
——

To add an inventory items fo the Item
List, follow these steps:

Step 1.

Step 2.

From the item List
window, right-click to
display the following
pop-up menu. Select
New

In the New Iltem

=
Look for in Allfields
(AME : DESCRIPTION TYPE
+Blue Service
« Blue... Blueprints Service
+ Con... Foundation slab - prep and pouring  Service
+Floo... Floor plans Service

Fra... |Framing labor Find...

Item List

ACCO_.: TOTAL QUANTITY
40100 ..
40100 ...
40100 ...

40100

[=]

T e e e e e e e e
i S eSS e St e S S e S St S i S S i e S S S S e St e S S i e

=

Reset Search

ATTACH
0.00
0.00
0.00
0.00
3500
0.00

window that appears,
enter information
about the bifold door
inventory item. From
the type drop-down
list, select Inventory
Part.

Then enter the
following information in
the New ltem window.

=
TYPE
Inventory Part

+Subs Subcontractec
.- Install carpetin
+D.. Install drywall
.. Heating & Air
.. Electrical work
Install insulatio
oM.. Metal Work
.. Painting

ltem ¥ Activities

New Item

.| Use for goods you purchase, track as inventory, and resell.

«lnst_. Instaliaaon lab

« Labor

sRe... boi Edit tem
Duplicate ltem

*Rep... Repalr work Delete ltem

Add/Edit Multiple tems

Make ltem Inactive
Customize Columns.

Create Invoices

Enter Sales Receipt

Change Prices

Altach

Create Purchase Orders...
Receive ltems & Enter Bill_..
Receive ltems...

Enter Bill for Received tems_.
Adjust Quantity/Value On Hand.

Cancel

Next

Item Name/Number
Bifold Doors

UNIT OF MEASURE

« Subitem of
Wood Door

Manufacturer's Part Number
BD42

Notes

Custom Fields

35.00
35.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

(=T = R =l = = = = B~ = = R = = ]

[T Include inactive

- >

Charges

o x

EMPLOYEES

UM Set - Edit... Spelling

PURCHASE INFORMATION SALES INFORMATION
Description on Purchase Transactions Description on Sales Transactions

Bifold interior door Bifold interior door
Cost 4500 Sales Price 70.00 ltem is inactive
COGS Account 50100 - Costof Goods S... - Tax Code Tax =
Preferred Vendor | Kolbe Window & Door - |ncome Account 40100 - ConstructionInc_ ~
INVENTORY INFORMATION

Reorder Point

Asset Account (Min) Max On Hand Total Value As of

12100 - Inventory... =~ 2 0 0.00 12/15/2018Q-]

TYPE Inventory Part

.
ITEM NAME/NUMBER Bifold Doors
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Step 3.

Step 4.

SUBITEM OF

MANUFACTURER’S PART NUMBER

UNIT OF MEASURE

DESCRIPTION ON PURCHASETRANSACTIONS
DESCRIPTION ON SALES TRANSACTIONS
Cost

COGS ACCOUNT

PREFERRED VENDOR

SALES PRICE

TAX CODE

INCOME ACCOUNT

ASSET ACCOUNT

REORDER POINT

ON HAND

TOTALVALUE

AS OF

Wood Door

BD42

(leave blank)

Bifold interior door
Bifold interior door
45.00

50100 - Cost of Goods Sold
Andre Window & Door
72.00

Tax

40140 Materials Income
12100 - Inventory Asset
2

0

0.00

12/15/2022

Click Next to record this inventory item and clear the field fo record another

inventory item.

Enter bifold door knobs as an inventory part in the Item List using the following

information:
TY[E
ITEM NAME/NUMBER
SUBITEM OF
MANUFACTURER'S PART NUMBER
DESCRIPTION ON PURCHASETRANSACTIONS
DESCRIPTION ONSALES TRANSACTIONS

Inventory Part

Bifold Knobs
Hardware

BK3é

Bifold door hardware
Bifold door hardware

Cost 6.00
COGS ACCOUNT 50100 - Cost of Goods Sold
PREFERRED VENDOR Patton Hardware Supplies
SALES PRICE 13.00
TAX CODE Tax
INCOME ACCOUNT 40140 Materials Income
ASSET ACCOUNT 12100 - Inventory Asset
REORDER POINT 2
ON HAND 0
TOTALVALUE 0.00
AS OF 12/15/2022
Step 5. Click OK to record the item and close the New ltem window.
CH6 ITM

Prepare the item List as follows:

Step 1.
Step 2.

Step 3.
Step 4.

Step 5.
Step 6.
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Sort the Item List by selecting Item button >

Re-sort List.

Click the Reports button at the botfom of the
Item List window. Selecting Item Listing.

Export to Excel

NOTE: Make sure you have used all

the advanced settings outlinedin
Appendix C.

Follow the instructions in Appendix C to
export the report to the Excel file named UNIT_06_REPORTS Excel file.
From the drop-down list, select the sheet: CH6 ITM

Save and close the Excel file.




CREATE PURCHASE ORDERS

R

e

e

e

e

e
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A purchase order is a record of an order to purchase inventory from a vendor. The following
activity demonstrates how to create a purchase order for Rock Castle Construction:

Step 1. Click the Purchase Orders icon in the vendors section of the Home page.
Step 2. From the drop-down Vendor List, select the vendor name: Andre Window & Door.
Step 3. Select Template: Custom Purchase Order

Step 4. Enter the Purchase Order date: 12/20/2022

Step 5. Select item Ordered: Wood Door: Bifold Doors ($45.00 now appear in the Rate
column.)

Step 6. Enter Quantity: 6. ($270.00 should now appear in the Amount column.)

PO 6238 -ANDRE WINDOW & DOOR.PDF

Step 7. Print the Purchase Order

Step 8. Click the Print button at top of the Purchase Order window.
Step 9. Select Print on: Blank paper

Step 10. Ifnecessary, uncheck: Do not print lines around each field

Step 11. Select the PDF printer asyour printer of choice, then click Print

Step 12. Save the PDF copy to the UNIT 06 folder

Step 13. Saveas PO 6238 -Andre Window & Door.PDF

Step 14. Click Save & Close to record the Purchase Order and close the Purchase Order window.

PO 6239 - PATTON HARDWARE.PDF

Step 1. Click the Purchase Orders icon in the vendors section of the Home page.
Step 2. From the drop-down Vendor List, select the vendor name: Patton Hardware
Supplies.

Step 3. Select Template: Custom Purchase Order

Vendor Patton hardware Supplies

Template Custom Purchase Order

Date 12/20/2022

ltem Hardware: Bifold Knolbs

Qty 6

The purchase order total for bifold door hardware is $3é

Step 4. Print the Purchase Order

Step S. Click the Print button at top of the Purchase Order window.

Step 6. Select Print on: Blank paper

Step 7. Ifnecessary, uncheck: Do not print lines around each field

Step 8. Select the PDF printer asyour printer of choice, then click Print

Step 9. Savethe PDF copy to the UNIT 06 folder

Step 10. Saveas PO #6239 — Patton Hardware.PDF

Step 11. Click Save & Close to record the Purchase Order and close the Purchase Order window.

CH6 TRANS JUR
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In the following steps you will be retrieving the Patton Hardware

purchase order to view the Transaction Journal created for the Bl tiew Voncor, (5] New Transactons + %
order. ErE AT
Step 1. Open the Vendor Center pLSL Transactions
Step 2. In the Search box type Patton to view all Vendors with the P = :
word Patton in their name. Notice that once you click the
search option Patton Hardware is the only Vendor that [Patton {
appears. <
Step 3. Inthe Transactionstab, select SHOW: Purchase Orders

NOTE: The Filter by option automatically changes to All

Vendor Information —
Company Hame  Patton Hardware Supplies Main Phone 415-555-1370
FullHame Fax 4155551371 REPORTS FOR THIS VENDOR
Vendor Type  Materials i
Account o, RC 93 QuickReport
Terms et 30 Open Balance
Biled From  Patton Hardware Supplies
4872 County Rd
Bayshore CA94326
Order 1099 Forms
Map | Directions P h O d OrderCharks
Transactions Contacts
show  Purchase Orders * | FwTERey  All Purchase Orders pate (Al
NUM DATE ~ DELIVERY DATE AMOUNT
6228 1113012022 11/30/2022 3,459 ZUE
6225 11126/2022 1112642022 13,695.00]
6207 07/23/2022 07/2312022 754 50;
17,944.70;

Purchase Orders

Step 4. Double Click on PO number 6239 to open and view the purchase.

Step S. Click the Reports Tab

Step 6. Click the Transaction Journal option

Step 7.  Export to Excel

Step 8.  Follow the instructions in Appendix C to export the report to the Excel file
named UNIT_06_REPORTS Excel file.

Step 9.  From the drop-down list, select the sheet: CH6 TRANS JUR

Step 10. Save and close the Excel file.

RECEIVE INVENTORY

=

e e e

e

e

&

To record inventory items received on 12/22/2022 ordered from the vendor, Andre Window &
Door, complete the following steps:

Step 1. Click the Receive Inventory iconin the Vendors section of the Home page.

NOTE: Make sure you have used all
the advanced settings outlinedin
Appendix C.
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Step 2. Select: Receive Inventory without Bill.

= |
»
Purchase

VENDORS

i Receive Inventory with Bill @

Receive Inventory without Bill ter Bills Manage
Orders ry Against Sales
Inventory Tax
Enter Bills Pay Bills
Step 3. In the Create Iltem Receipts window, select vendor: Andre Window & Door
Step 4. If a purchase order for Open POs Exist

the item exists,
QuickBooks will display Open purchase orders exist for this vendor. Do you want to
the Open POs Exist receive against one or more of these orders?

window. Click Yes.

Step 5. When the Open No
Purchase Orders

Main Reporis

«*» B B X Bekicw @ g B O B

Find New Save Delete &b Memorize Print Atiach | Select Enler Clear Recalculate
@ = File PO Tme | Spis

" Bil Received

ltem Receipt

VENDOR [AﬂdreWiﬂdow&Doar ,] DATE 12152022 H

REF. MO.

Open Purchase Orders x
Yendor | Andre Window & Door - “

Select a Purchase Order to receive

ME] Cancel

I i patE PO NO, MEMO

\“; JETTI LA, PPttt s, M‘.J\A/
window appears, select the purchase order for the items received.

Step 6. Click OK
Step 7. The Create Item Receipts window will appear with a total of $270. If necessary,
change the Date to: 12/22/2022
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Step 8. Although Rock Castle Construction ordered 6 bifold doors, only 5 were received.
Change the quantity from 6 to 5.

Create ltem Receipts

Main Reports
s B H R Beeeacw @ 0 B O B B

Find New Save Delete &bMemorize Print | Aftach | Select Enter Clear Recalculale

* o File PO Time Splits
S Date Merchandise was
ltem Receipt recieved
VENDOR  pndre Window &Door v DATE. 1202212022 HE
Change the Quantity to the

vevo  Racened ems (il Talon) correct amount received

Expenses $0.00 Items $225.00

VE:;I‘Door:B\foldDoors Bi::\:r‘w:rirdum - o 225.00 e =
[ v v - é

Wmmmi

Step 9. To record expenses associated with the items received, such as freight charges:
v Click the Expenses tab in the Create item Receipts window.
v" To record $35.00 in freight charges on the bifold doorsreceived, select
Account: 54520 Freight & Delivery.
v' Enter Amount: $35.00
v' Click the Recalculate button.

Main Reports H
«» B B X Beeeoew F g B & B B
Find Mew  Save Delste al'u'[emorize Print Aftach Select  Enter Clear Recalculafs
ot i Filz PO Time Splits

[ Bill Received

Recalculate
ltem Receipt

VENDOR  [Ardre Window & Door o DATE 12222022 B

REF. NO.

TOTAL 260.00

MEMO Received items (bill to follow)

Expenses $35.00 Items $225.00
ACCOUNT ! AMOUNT ! MEMO

54000 - Job Expenses: 54520 - Freight & Delivery

Add Expense

The Total on the Create Item Receipts window is now $260.00
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CH6 TRANS JUR-2

Step 1. In the Item Receipt window for Andre Window & Door, Click the Reports tab
Step 2. Select the Transaction Journal icon
Step 3. Export the Transaction Journalreport to Excel

Step 4.  Follow the instructions in Appendix C to export the report to the Excel file
named UNIT_06_REPORTS Excel file.

Step 5.  From the drop-down list, select the sheet: CH6 TRANS JUR-2

Step 6.  Save and close the Excel file.

RECEIVE MORE INVENTORY

o
=

o
e

o
e

o
e

o
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Step 1. Click Save & New to record the bifold doors received and clear the window.
Step 2. Record the receipt without a bill of the bifold door hardware using the following
information:

Vendor Patton Hardware Supplies

Date 12/22/2022

PO No. 6239

ltem Bifold door hardware

Qty 6
Step 3. Click Save & Close to record the items received and close the Create Item

Receipts window.

CH6 TRANS JUR-3

Step 1. In the Item Receipt window for Patton Hardware Supplies, Click the Reports tab
Step 2. Select the Transaction Journal icon
Step 3. Export the Transaction Journalreport to Excel

Step 4.  Follow the instructions in Appendix C to export the report to the Excel file
named UNIT_06_REPORTS Excel file.

Step 5.  From the drop-down list, select the sheet: CH6 TRANS JUR-3

Step 6.  Save and close the Excel file.

RECEIVE BILLS

B
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You may receive bills at three different times:

RECEIVE BILL. . . RECORD USING . ..

1. Youreceive a bill forservices and no inventory
items will be received, as for example, if the bill is Enter Bills
for security services.

2. Youreceive a bill at the same time you receive
inventory items

3. Youreceive inventory without a bill, and you
receive the bill later

Receive Inventory with Bill

1. Receive Inventory without Bill

2. Enter bills Against Inventory

ENTER BILLS AGAINST INVENTORY
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To enter a bill received after inventory items are received follow these steps:
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Step 1. Click the Enter Bills Against Inventory icon on the Vendors section of the Home

page.
Step 2. When the select Item Receipt window appears, select Vendor: Andre Window &
VENDORS

= ® =
Purchase Receive Enter Bills Manage

Orders Inventory Against Sales

Inventory Tax

Enter Bills Pay Bills

Door. If necessary, press Tab.
Step 3. Select the Item Receipt that corresponds to the bill

Inuantar T2

Select ltem Receipt x

Cancel

Use item receipt date for the bill date

Choose the ltem Receipt which corresponds to your bill Help

| DATE REF NO

Received items (bill fo fol...

Step 4. Click OK
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Step 5. The following Enter Bills window will appear. Notice that the Enter Bills window is
the same as the Create ltem Receipts window except:
v Bill Received in the upper right corner is checked
v The Title of the form changes from ltem Receipt to Bill.
v The window name changes from Create ltem Receipts to Enter Bills

Main Reports

“s BB RQoeew 5 9 B OB B G

Find New Save Delete @@bMemorize Print Attach Select  Enter Clear Recalculate
Z = File

Bill

VENDOR  Andre Window & Door - DATE 121222022 |

Check Bill
Received
spoRess | Andre Window & Door
Andre LaFortune

e ey AMOUNT DUE  |260.00
Bayshore, CA94326
S\ niezEn Amount Due
TERMS Net 15 - DISCOUNT DATE
Purchase Order
Expenses $3500 Items $225.00

Wood Door.Bifold Doors Bifold interior 5 45.00 225.00 6238 |
doar

Step 6. At this point, you can make any changes necessary, such as:
v Change the date if the bill is received on a date different from the date
the item was received. The date should be 12/22/2022
v Terms
v'Ref. No.
v'"Memo
v Expenses, such as freight charges
Step 7. The Amount due of $260.00 should agree with the amount shown in the vendor’s
bill.

SEARCH FOR ITEM RECEIPT

=

e

e
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Step 1. From the Vendor Center, search for Patton Hardware

Step 2. Show All Transactions, Filter by All, Date All

Step 3. Double-click the Item Receipt created for P.O. #6239. This will open the item
receipt window.

Step 4. Check Bill Received

Step 5. Notice the window automatically changes the bill option from the item receipt
window. Click Save and Close

e i B
B SRS 8 SRS S8 S

When you enter a bill, QuickBooks automatically adds the bill amount to your Accounts Payable
account balance.

CH6 UNPAID BILLS

Step 1. In one of the reports options, select Vendors & Payables
Step 2. Click on the Unpaid Bills Detail Report
Step 3. DATES: 12/31/2022
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Step 4.
Step S.

Step 6.

Step 7.

PAY BILLS

Export to Excel

Follow the instructions in Appendix C to
export the report to the Excel file named :
UNIT_06_REPORTS Excel file. CPIRETERS .

NOTE: Make sure you have used all
the advanced settings outlined in

From the drop-down list, select the sheet:
CH6 UNPAID BILLS
Save and close the Excel file.

it e et e e e e e e e e e e e e e e e e e e e e e

After receiving the items and entering the bill the next step is to pay the bill.

To select the bills to pay follow these steps:

Step 1.
Step 2.
Step 3.

Step 4.
Step 5.
Step 6.
Step 7.
Step 8.

Click the Pay Bills icon in the Vendors sectfion of the Home page.
Select Show bills: Show all bills
Select the bill you want to pay. Typically, you would select the bills that are due
first. In this case, however, select bills that you just recorded for:
v" Andre Window and Door for $260.00
v" Patton Hardware Supplies for $36.00

NOTE: It may be necessary fo scroll down to view the two bills.

In the Payment section, select: Date: 12/23/2022
Select Method: Check

Select: To be printed

Select Account: Checking

Click Pay Selected Bills

Bills selected for payment total $294.00

CHECKS 520-523.PDF

To print the checks, when the Payment Summary window appears:

Step 1.
Step 2.

Step 3.
Step 4.

Step 9.

Step 10.
Step 11.
Step 12.
Step 13.

Review the information to verify it is correct. Click Print Checks.
When the Select Checks to Print window appears, select Bank Account:
Checking
Select First Check Number: 520
Select the four checks waiting fo be printed:
v' 12/23/2022 Andre Window & Door for $260.00
v' 12/23/2022 Patton Hardware Supplies for $36.00
v'  12/24/2022 Bayshore Water $54.00
v 12/26/2022 Cal Telephone $63.00
Click OK
Select Check Style Standard. Select Print company name and address
Select the PDF printer asyour printer of choice, then click Print
Save the PDF copy to the UNIT 06 folder
Saveas CHECKS 520-523

RECEIVE INVENTORY WITH BILL

i e R et e e e e e e e e e e e e e i e e e e e e e e e e e e e e e e e
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If you receive the inventory item and the bill at the same fime, record both the items and the
related bill by completing the following steps:

Step 1. Click the Receive Inventory
icon in the Vendors section of gﬁ p . - -
the Home page. _ -
Step 2. Select: Receive Inventory with ~ Receiv  Receive Inventory without Bill E
Bill Inventory
Step 3. In the Enter Bills window, enter !

Vendor: Wheeler's Tile Etc.
Step 4. If the Open POs Exist window appears, select Yes.
Step 5. Select the open

purchase order that

ms $0.00

corresponds fo the bill Vendor |Wneelers Tile £tc - @
received in PO no. 6234 Select a Purchase Order to receive
S i S Cancel
Step 6. Click OK Ao — =
Step 7 If necessary, change the e o =
' ' _nonoo o 3

date to: 12/23/2022
Step 8. Verify the Amount Due:
712.80
Step 9. Click Save & Close to
close the Enter Bills
window.

ENTER BILLS

B

.=

.=

.=

When you received inventory items from vendors, you recorded those items using either the

Receive Inventory with Bill option or the Receive Inventory without Bill option, entering the bill
later.

To record services instead of inventory received, use the Enter Billsicon. Expense that can be
recorded using the Enter Bills window include ufilities, insurance, and rent.

Recording bills for services, such as utilities, in QuickBooks requires two steps:

1. Enter Bills — Record billsreceived for services
2. Pay Bills - Select bills fo pay

In the next activity, you will be entering bills for expenses:

Step 1. Click the Enter Bills icon in the Vendors section of the Home page.
Step 2. When the Enfer Bills window appears click the Expenses tab.
Step 3. Enter the following information for Rock Cast’'s water bill in the Enter Bills window.
Vendor Bayshore water
Date 12/24/2022
Amount Due $36.00
Terms Net 30
Account 65130: Water
Step 4. Click Save & Close to close the Enter Bills window

The next time you pay billsin QuickBooks, the water bill will appear on the list of bills to pay.

CH6 JUR
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Step 1. In one of the reports options, select Accountant & Taxes

Step 2. Select Journal

Step 3. Select Date: 12/22/2022-12/23/2022

Step 4. Export to Excel NOTE: Make sure you have used all
Step 5. Follow the instructions in Appendix C to exportthe

the advanced settings outlined in

report to the Excel file named Appendix C

UNIT_06_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: CH6 JUR
Step 7. Save and close the Excel file.

PAY SALES TAX
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QuickBooks fracks the sales tax that you collect from customers and must remit to governmental
agencies. When anew company is setup in QuickBooks, you identify which items and
customers are subject to sales tax. In addition, you must specify the appropriate sales tax rate.

Then whenever you prepare sales invoices, QuickBooks automatically calculates and adds sales
tax to the invoices.

QuickBooks uses a two-step process to remit sales tax:

1. Pay Sales Tax — The Manage Sales Tax window lists the sales taxes owed and allows you
to select the individual sales tax items you want to pay.
2. Print Checks - Print the check fo pay the sales tax.

To select the sales tax to pay follow these steps:
Step 1. Click the Manage Sales Tax icon in the Vendors section of the Home page.

Step 2. When the Manage Sales Tax window appears, in the Pay Sales Tax section of the
window, click the Pay Sales Tax button.

VENDORS

= =1 Manage Sales Tax -0 x

Purchase This window will help you manage common sales tax tasks. Manage
Orders SETUP SALES TAX Sales
Tax
Sales Tax Preferences...
PAY SALES TAX @

Pay Bills
Prepare state sales tax forms

Run the following reports to help fill out your state sales tax forms.
Sales Tax Liability Sales Tax Revenue Summary

Pay your sales tax vendors in QuickBooks
» Pay Sales Tax...

Related Tasks
% View Sales Tax ltems

Open Sales Tax Code List

Estimates
Adjust Sales Tax Due

Close Help
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Step 3. When the Pay Sales Tax window appears, select Pay From Account: Checking
Step 4. Select Check Date: 12/31/2022

Step 5.  Show sales tax due through: 12/31/2022

Step 6. Check To be printed

Step 7. Select: Pay all Tax

Step 8. Click OK

Step 9. Click Close to close the Manage Sales Tax window.

‘Pay Sales Tax

Pay From Account Check Date Show sales tax due through Starting Check Mo.

10100 - Checking - 12/31/2022 @ 1213112022 E

for
el F ITEM VENDOR AMT. DUE AMT. PAID
East Bayshore City of East Bayshare 0.29 0.00 &
u San Domingo State Board of Equalization 114.19 0.00
v San Tomas State Board of Equalization 862.53 0.00
v
Totals 977.01 0.00
i\ Pay All Tax Adjust Ending Bank Balance 47 105.48
e
u
Wy

CHECKS 524-525.PDF

To print the check to pay sales tax to a governmental agency follow these steps:

Step 1. Click the Print Checks icon in the Banking sectfion of the Home Page

Step 2. When the following Select Checks to Print window appears, select City of East
Bayshore and State Board of Equalization

Step 3. Select Bank Account: Checking

Step 4. Select First Check Number: 524

Step 5. CHECK STYLE: Voucher

Step 6. Print Company Name and Address on the checks

Step 7. Click OK

Step 8. Select the PDF printer asyour printer of choice, then click Print
Step 9. Savethe PDF copy to the UNIT 06 folder

Step 10. Saveas CHECKS 524-525

VENDOR REPORTS
.

QuickBooks provides vendor reports to answer the following questions:
v" How much do we owe? (Accounts Payable reports)

v" How much have we purchased? (Purchase reports)
v How much inventory do we have? (Inventory reports)

There are several different ways to access vendor reports:

v" Vendor Center — Summarizes vendor information in one location
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v Report Center — Permits you to locate reports by type of report
v Report Menu - Reports are grouped by type of report

VENDOR CENTER

=
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e

e

e

e

&

The Vendor Center summarizes vendor information in one convenient location. Display the
Vendor Center as follows:

CH6 VEN

Step 1. From the Icon bar, select Vendors
Step 2. Select Vendor: Andre Window & Door

The Vendor Information section summarizes information about the vendor
selected, including a list of the transactions for the specific vendor. In this case,
you recorded three fransactions for Andre Window & Door.

1. Purchase order on 12/20/2022

2. Billreceived on 12/22/2022

3. Bill paid on 12/23/2022

Step 3. Double-click Bill Pmt-Check on 12/23/2022 to drill-down and view the check to

pay Andre Window & Door. After viewing, close the window.

Step 4. With the cursor over the Vendor Information
Vendor Transactions section | ... wsunsorson
of the window, right-click i R
to display the pop-up =
menu. Select View as a i -
Report. This will display all
report of all fransactions for
Andre Window & Door onsacions | Conlas | ToDos | Wawy | SomEpal
Step 5.  Export to Excel e e s
Step 6.  Follow the instructions in
Appendix C to export the | o
report to the Excel file f
named

Customize Columns

UNIT _06 REPORTS
Excel file.
Step 7. From the drop-down list,
select the sheet: CH6 VEN
Step 8.  Save and close the Excel
file.

Right-Click
to view
options

Click View as a Report

PURCHASE ORDERS
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Purchase reports provide information about purchases by item, by vendor, or by open purchase
orders. Purchase reports include the following:

1. Open Purchase Orders
2. Purchases by Vendor Summary
3. Purchases by ltem Summary

CH6 OPEN PO
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To prepare the Open Purchase Orders report, follow these steps:

Step 1. From the Report or Menu option, select: Purchases
Step 2. Select: Open Purchase Orders
Step 3. Select Dates: All. If you are using the report
center, Click Run
Step 4. Export to Excel NOTE: Make sure you have used all
Step 5. Follow the instructions in Appendix C fo the advanced settings outlinedin
export the report to the Excel file named Appendix C.
UNIT_06_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: CH6 OPEN PO
Step 7. Save and close the Excel file.

INVENTORY STOCK STATUS BY ITEM
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Inventory reports list the amount and status of inventory. Inventory reports include:

1. Inventory Stock Status by Item
2. Physical Inventory Worksheet

CH6 INV

To print the Inventory Stock Status by Item report, follow these steps:

Step 1. From the Report Center, select: Inventory
Step 2. Select: Inventory Stock Status by Item

Step 3. Enter Date: From 12/22/2022 To: 12/22/2022
Step 4. Click Run

Step 5.  Export to Excel

Step 6.  Follow the instructions in Appendix C to export the report to the Excel file
named UNIT_06_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CH6 INV

Step 8.  Save and close the Excel file.

On 12/22/2022, 5 bifold wood doors are on hand and 1 more is on order.

PHYSICAL INVENTORY WORKSHEET

B
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The Physical Inventory Worksheet is used when taking a physical count of inventory on hand.
The worksheet lists the quantity of inventory items on hand and provides a blank column in which

to enfer the quantity counted during a physical inventory count. This worksheet permits you to
compare your physical inventory count with your QuickBooks records.

CH6 PHY INV

To prepare the Physical Inventory Worksheet follow these steps:

Step 1. From the Report Center, select: Inventory
Step 2. Select: Physical Inventory Worksheet.
Step 3. Use Date: 12/31/2022
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Step 4.
Step 5.
Step 9.

Step 6.
Step 7.
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Select: Run

Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file
named UNIT_06 REPORTS Excel file.

From the drop-down list, select the sheet: CH6 PHY INV
Save and close the Excel file.




Rock CASTLE TRANSACTIONS
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The following is a list of transactions for Rock Castle that will be used to complete this unit. If
you have questions on how to complete the activities. Please refer to the previous exercises in
the unit. The data given here is to use for that completion:

VENDOR: Kelly's Closets

COMPANY NAME: Kelly's Closets

FULL NAME: Mr. Jack Kelly

ADDRESS: 13 Rheims Road
ADD NEW Bayshore, CA 94326
VENDOR MAIN PHONE: 415-555-5813

ACCOUNTNO. 58127

PAYMENT TERMS Net 30

VENDOR 1099 No

VENDORTYPE: Materials

ITEMTYPE: Inventory Part

ITEM NAME: Closet Materials
ADD NEW ITEM DESCRIPTION: Closet Materials
INVENTORY COGS ACCOUNT: 50100 - Cost of Goods Sold
ITEM INCOME ACCOUNT: 40140 - Materials Income

ASSET ACCOUNT: 12100 - Inventory Asset

TAX CODE: Tax

ITEM TYPE: Inventory Part
[0 ITEM NAME: 6’ Closet Shelving
Sub-item of | ., pescriprion: 6’ Closet Shelving
ﬁt):;:als Cosr: $22.00

SALES PRICE: $30.00

ITEM TYPE: Inventory Part
Iz ITEM NAME: 12’ Closet Shelving
Sub-item of | ;5\ pESCRIPTION: | 12 Closet Shelving
’C\ZA:):;:GIS COST: $36.00

SALES PRICE: $50.00
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ITEM TYPE: Inventory Part
Inventory ITEM NAME: Closet Install Kit
Sub-item of | ;104 pEsCRIPTION: | Closet Installation Kit
Sl COST: $10.00
Materials ' :
SALES PRICE: $16.00
CH6 ITM-2
Step 1. Sort the Item List by selecting Item button >
Re-sort List. NOTE: Make sure you have used all
Step 2. Click the Reports button at the bottom of the the advanced settings outlined in
l[tem List window. Selecting Item Listing. Appendix C.
Step 3. Export to Excel
Step 4. Follow the instructions in Appendix C fo
export the report fo the Excel fle named UNIT_06_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: CHé ITM-2
Step 6. Highlight the inventory items added to the list.
Step 7. Save and close the Excel file.

Use the Vendors section of the Home Page to record the following:

Purchase
Order
#6240

VENDOR: Kelly’s Closets

TEMPLATE: Custom Purchase Order

DATE: 12/23/2022

ITEM: 12’ Closet Shelving QTY: | 6
6’ Closet Shelving 6
Closet Install Kit 6

CH6 TRANS JUR-4

Step 8.
Step 9.
Step 10.

Step 11.
Step 12.

In the Purchase Order window for Kelly’s Closets, Click the Reports tab
Select the Transaction Journal icon. Export the Transaction Journalreport to Excel

Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_06_REPORTS Excel file.

From the drop-down list, select the sheet: CH6 TRANS JUR-4.
Save and close the Excel file.

CH6 TRANS JUR-5

Step 1.

Step 2.
Step 3.
Step 4.
Step 5.

Step 6.
Step 7.

On 12/24/2022, receive without g bill, the closet inventory items ordered on
12/23/2022. There are no freight Charges.

Select the Save icon at the top of the Create Item Receipts window

Select the Reports tab

Select the Transaction Journal icon. Export the Transaction Journal report to Excel
Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_06_REPORTS Excel file.

From the drop-down list, select the sheet: CH6 TRANS JUR-5.

Save and close the Excel file.

CH6 TRANS JUR-6
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Step 1.

On 12/27/2022, Record the receipt of the bill for the closet items

Step 2. Select the Save icon at the fop of the Create Item Receipts window

Step 3. Select the Reports tab

Step 4. Select the Transaction Journal icon. Export the Transaction Journal report to Excel

Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_06_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: CHé TRANS JUR-6.

Step 7. Save and close the Excel file.

CH6 JUR-2

Step 1. On 12/28/2022, Pay the bill for the closet materials ordered from Kelly's Closet

Step 2. In one of the reports opftions, select Accountant & Taxes

Step 3. Select Journal

Step 4. Select Date: 12/28/2022

Step 5. Export to Excel NOTE: Make sure you have used all

Step 6. Follow the instructions in Appendix C fo the advanced settings outlined in
export the report to the Excel file named Appendix C.
UNIT_06_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CHé JUR-2

Step 8. Save and close the Excel file.

CH6 OPEN PO-2

Step 1. From the Report or Menu option, select: Purchases

Step 2. Select: Open Purchase Orders

Step 3. Select Dates: 12/1/2022 TO 12/31/2022. If you are using the report center, Click
Run

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_06_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: CH6 OPEN PO-2

Step 7. Save and close the Excel file.

CH6 INV-2

Step 1. From the Report Center, select: Inventory

Step 2. Select: Inventory Stock Status by ltem

Step 3. Enter Date: From 12/31/2022 To: 12/31/2022

Step 4. Click Run

Step 5. Export to Excel

Step 6. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_06_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CH6 INV-2

Step 8. Highlight the closet inventory items on the Inventory Stock Status printout.

Step 9. Save and close the Excel file.

CUSTOMER TRANSACTIONS
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JOB NAME: Closet Shelving
Rafael, Sofia Jos DescripToN: Replace Closet Shelving

JOB TYPE: Repairs

JOB STATUS: Closed
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Add Job

Invoice

STARTDATE: 12/27/2022

PROJECTED END DATE: 12/27/2022

END DATE: 12/27/2022

CUSTOMER: JOB Rafael, Sofia: Closet Shelving
CUSTOM TEMPLATE: Rock Castle Invoice

DATE: 12/27/2022

INVOICENO. 1104

ITEMS AND QUANTITIES: 12’ Closet Shelving

6’ Closet Shelving
Closet Installation Kit

w = NN

Installation Labor

CH6 TRANS J

UR-7

Step 1. Save Invoice 1104 for the Closet Shelving job.
Step 2. Select the Reports tab
Step 3. Select the Transaction Journal icon.
Step 4. Customize the report
a. Add the Debit & Credit Columns
Step 5. Export the Transaction Journal report to Excel
Step 6. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_06_REPORTS Excel file.
Step 7. From the drop-down list, select the sheet: CH6 TRANS JUR-7.
Step 8. Save and close the Excel file.
CUSTOMER: Rafael, Sophia
Customer P AYMENT AMOUNT: Full Amount Due
Paymeni DATE: 12/29/2022
CHECK #: 625
DATE: 12/29/2022
Make PAYMENTSTO DEPOSIT: Roche, Diarmuid: Garage Repairs
Deposit Jacobsen, Doug: Kitchen

Rafael, Sofia: Closet Shelving

CH6 DEP DET

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Step 6.

Step 7.
Step 8.
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In one of the reports options, select Banking

Deposit Detail

Date: 12/29/2022-12/31/2022

Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_06_REPORTS Excel file.

From the drop-down list, select the sheet: CHé DEP DET

Highlight the check for the Closet Shelving job

Save and close the Excel file.




BAckurP THE COMPANY
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Use the instructions in Appendix A to back up your company file. Make sure your backup file is saved
in the designated folder of this unit (UNIT 06 BACKUPS).

UNIT 06 PROJECT (ON-YOUR-OWN)

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u0éa2 Larrys Landscaping. This file is in your UNIT 06 folder.

Step 1: RESTORE the v0é6a2 Larrys Landscaping.QBB file

Step 2: Make sure you SAVE to the UNIT 06 FOLDER

RENAME THE COMPANY
T BLLLLLAAA,,VVVVBAAAAVBBBBLAALLLLLLALALAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA
After you have followed the instructions to restore your data files, you will find the company file

you have restored contains sample data fora company called Larry’s Landscaping. Your first
activity is to personalize that name to meet your needs
follow these instructions:

NOTE: The process to rename the

Step 1: From the Menu bar, select Company

Step 2: Select MY COMPANY company isfound in Appendix B
Step 3: Select EDIT and will be repeated throughout
Step 4: Update the Company Name Field to: all the activities in the text.

YourName Larry’s Landscaping
Step 5: CLICK on OK
Step 6: Close the My Company window.

ENTER TRANSACTIONS FOR LARRY’S LANDSCAPING

it e et e e e e e e e e e e e e e e e e e e e e e

NOTE: Make sure you are looking at the item descriptions. There is no need to add any items
for this activity.

DATE: 12/23/2023
VENDOR: Conner Garden Supplies
2";‘:““59 P.O. NO. 1500
el ITEM: 2" Vinyl Irrigation Line
QUANTITY: 300
DATE: 12/23/2023
Purchase \P/ESDI:D(E: :\ISOOI::n Hardware and Supplies
Order ITEM: Plastic Sprinkler Piping
QUANTITY: 500
DATE: 12/23/2023
VENDOR: Willis Orchards
E)U;chase P.O. NO. 1502
2l ITEM: Soil (2 cubic foot bag)
QUANTITY: 72

P6 OPEN PO DET
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Step 1. In one of the reports options, select Purchases

Step 2. Open Purchase Orders Detail

Step 3. Date: All

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_06é_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: P4 OPEN PO DET

Step 7. Highlight the PO# 1500, 1501, 1502

Step 8. Save and close the Excel file.
Received DATE: 12/23/2023
Inventory VENDOR: Nolan Hardware Supplies
withoutBill ~ T:O-No. A —
ITEM: Sprinkler Piping
QUANTITY 36
When a PO is not received in full, you can delete the empty lines by following these steps:
Step 1. Select the line you plan to remove
Step 2. Hold down your CTRL key
Step 3. Hit the Del key on your keyboard. This action will delete a line of text but it will not delete the
Purchased item.
DATE: 12/23/2023
Received VENDOR: Conner Garden Supplies
Inventory P.O. No. 1500
without Bill ITEM: 1%” Vinyl Irrigation Line
QUANTITY: 300
DATE: 12/23/2023
VENDOR: Gussman’s Nursery
Received P.O. No. 1505
Inventory with  ITEM: Lemon Tree, Citrus
Bill QUANTITY: 1
[TEM: Fruit Tree — Arizona Sweet
QUANTITY 1
Received DATE: 12/23/2023
Ir!venfory with  VENDOR: Nolan Hardware and Supplies
Bill P.O. NOS. 13 and 1501
[TEM: Plastic Sprinkler Piping
QUANTITY: 550
P6 UPD
Step 1. In one of the reports options, select Vendors & Payables
Step 2. Click on the Unpaid Bills Detail Report
Step 3. DATES: 12/31/2023
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Step 4.  Export to Excel

Step 5.  Follow the instructions in Appendix C to
export the report to the Excel file named
UNIT_06_REPORTS Excel file.

Step 6.  From the drop-down list, select the sheet:

NOTE: Make sure you have used all
the advanced settings outlined in
Appendix C.

P6 UNPAID BILLS
Step 7.  Save and close the Excel file.
DATE: 12/23/2023
VENDOR: Nolan Hardware Supplies
DATES: 12/05/2020, 12/22/2023, 12/23/2023
CHECK: Use Item receipt date for the bill
date
Enter Bills Against NOTE: You will need to select each date fo represented.
Inventory ﬁhck OK after each entry untfil all the bills for Nolan
ardware are entered.
DATE: 12/23/2023
Enter Bills Against VENDOR: Conner Garden Supplies
Inventory P.O. No. 1500
AMOUNT DUE: 36
VENDOR: Gussman’s Nursery
AMOUNT DUE: 101.00
VENDOR: Conner Garden Supplies
AMOUNT DUE: 36.00
VENDOR: Conner Garden Supplies
AMOUNT DUE: 127.20
ey LAl VENDOR: Nolan Hardware Supplies
Total = 2.799.00 AMOUNT DUE: 336.00
VENDOR: Nolan Hardware Supplies
AMOUNT DUE: 1,155.00
VENDOR: Nolan Hardware Supplies
AMOUNT DUE: 610.00
VENDOR: Nolan Hardware Supplies
AMOUNT DUE: 358.20
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VENDOR: Nolan Hardware Supplies
AMOUNT DUE: 75.60

CHECKS 600-645.PDF

Step 5. Review the information fo verify it is correct. Click Print Checks.

Step 6. When the Select Checks to Print window appears, select Bank Account:
Checking

Step 7. Select First Check Number: 600

Step 8. Select all checks to be printed

Step 14.  Click OK

Step 15. Select Check Style Standard. Select Print company name and address

Step 16. Select the PDF printer asyour printer of choice, then click Print

Step 17. Save the PDF copy to the UNIT 06 folder

Step 18. Saveas CHECKS 600-645

P6 CKD

Step 1. From the Report or Menu option, select: Banking

Step 2. Select: Check Detail

Step 3. Select Dates: 10/01/2023 TO 12/31/2023. If you are using the report cenfer, Click
Run

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_06_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: P6 CKD

Step 7. Save and close the Excel file.

P6 APD

Step 1. From the Report or Menu option, select: Vendors & Payables

Step 2. Select: A/P Aging Detail

Step 3. Select Date: 12/31/2023. If you are using the report center, Click Run

Step 4. Export to Excel

Step 5. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_0é_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: Pé APD

Step 7. Save and close the Excel file.

BACKUP YOUR COMPANY FILE

R

e

Use the instructions in Appendix A to back up your company file. Make sure your backup file is saved

e

e

e

e

in the designated folder of this unit (UNIT 06 BACKUPS).
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STUDENT LESSON FILES

You will find the following files in your Student files for UNIT 07.

e UO7al Rock Castle Construction

e U0702 Larry’'s Landscaping

e UNIT_O7_Reports
To complete the first lesson exercises, RESTORE the u07al Rock Castle Consfruction company file
from the UNIT 07 folder.

NOTE: The process to restore a backup is found in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY

o
=

e
—r

e
—r

e
—r

it

e e
—r —r

After you have followed the instructions to restore your data files, you will find the company file
you have restored contfains sample data for a company called Rock Castle Constfruction. Your
first activity is fo personalize that name to meet your needs follow these instructions:

Step 37. From the Menu bar, select Company

Step 38. Select MY COMPANY

Step 39.  Select EDIT

Step 40. Update the Company Name Field to: YourName Rock Castle Construction
Step 41.  CLICK on OK

Step 42.  Close the My Company window.

NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the fext.

QUICKBOOKS PAYROLL SERVICES AND FEATURES FOR DESKTOP

I ————
A QuickBooks Payroll Service is a subscription you activate to enable the payroll features in

your QuickBooks Desktop Software. Depending on the featfures you need, you can choose from
Basic, Enhanced or Assisted Payroll.

QuickBooks Payroll service does not work with QuickBooks Mac. Mac users use Intuit Online
Payroll as their payroll add-on. As a standalone software, Intuit Online Payroll only exports
fransactions to QuickBooks Desktop and QuickBooks Online (without QuickBooks Online Payroll).

If you choose not to subscribe to any of the QuickBooks Desktop Payroll Services, you can set up
manual payroll in QuickBooks. QuickBooks Desktop won't calculate your payroll taxes or provide
payroll fax forms. You must manually calculate your payroll tax figures and enter them for each
paycheck. You may use the QuickBooks free online Paycheck Calculator.

QuickBoOKS PAYROLL SERVICE COMPARISON TABLE FOR QUICKBOOKS DESKTOP

R

e

e

e

e

YN
PR R R R R R
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Payroll Updates v v v v

Create Paychecks

Direct Deposit for
Employees

Direct Deposit for 1099
Contractors

View My Paycheck
Federal Forms v
State Forms

E-File and E-Pay

Intuit Workers’ Comp Pay v v
Service

Intuit files and pays taxes for

you

No Penalties guaranteed

E-mail subscription for v v v
critical notices

Free expert support 4 v v

ENENIENE NN
RN NN
NENENIENE NN

After-the-fact payroll

Create taxforms for clients
on Standard or Basic Payroll

Clientready payrolireports
Filing as a Reporting Agent

Auto-Fill option for Paid
Preparer information

N N N N N N NN

AN N N N N

Annual pricing for the services ranges from $420--$260 per year. The payroll subscriptions
currently offered do not limit you on the number of employees that you can add in QuickBooks.
However, some subscriptions may charge additional fees. The first year of service, QuickBooks
usually gives incentive pricing.

ADDITIONAL FEES:

e e e e e s e e ey e e e B e e e

e Basic - $2.00/ employee per month

¢ Standard - no charge for adding employees

e Enhanced - $2.00/ employee per month

¢ Enhanced for Accountants - no charge for adding employees
e Assisted - $2.00/ employee per payroll

NOTE: Though there is no limit fo the number of employees that you can add, QuickBooks is
designed to handle small businesses. You may start experiencing performance issues if you have
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added 800 or more employees. The subscription price for each plan varies depending on the
plan.

PAYROLL SETUP

o
=

e
—ar

e e e
R e

e e e

The Payroll setup requires the following in the preferences menu (Edit > Preferences):

Company Preferences: Full Payroll
Payroll & Expenses
Check preferred options for paychecks issued

Company Preferences: Track Time
Time & Expenses
Check preferred options for your company

Setup Employees Employees Menu - Employee List

PAYROLL PROCESSING

R

e

e

e R e B B e B By e

e R R R R S e S S R A A S S

Payroll processing consists of the following four main types of tasks:

1. Enter Time. QuickBooks permits us to track employee time worked to use in processing
payroll and billing customers.

2. Pay Employees. Select employees to pay and create their paychecks.

3. Pay Payroll Liabilities. Pay payroll tax liabilities due governmental agencies such as the
IRS. Payroll tax liabilities include federal income taxes withheld, stafe income taxes
withheld, FICA (Social security and Medicare), and unemployment taxes.

4. Process Payroll Forms. Process payroll forms including Forms, 940, 941, W-2, and W-3 that
must be submifted to governmental agencies.

TURN ON QUICKBOOKS PAYROLL & TIME TRACKING

The Rock Castle Sample company file has the Payroll & Time activated. This is the process to turn
both applications on when you are activating a new company setup:

Step 1. Select Employees
Step 2. Select Payroll Setup. Note that
the QuickBooks Payroll Setup

QuickBooks
Payroll Setup Welcome to QuickBooks Payroll Setup

window summarizes the steps fo e Setup Window

setup QuickBooks Payroll and h  Summarizes the

Time Tracking. : Steps to Follow
Step 3. Because this is already setup for S

the sample company, Click

Finish Later. e For Sample company, Finish Later
Step 4. Select the Edit Menu
Step 5. Select Preferences
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Step 6. When the Preferences
window appears, select Time

Preferences

B coenoer - My Company “
& Expenses > Company B2 Chectng

=R pescop v =94 Company Preferences —
Preferences e e, o -
General S Default
Step 7. Select Do you track time? Yes : [e—— BieiDaoiWorkWeok [Nensey -
fems & inventory @ Markal Also See:
Step 8. Select First Day of Work Week: [ & wseee B Payroll & Employees -
Monda B o el
Y B, Set S Erei. % Track eimbursed expenses as income o
Step 9. Leove The Preferences :Sl}ll :::;TG"W- ¥ Mark all expenses as billable =
WlndOWS Opeﬂ ; Sales. & Customers Default Markup Percentage  0.0%
o e Defauit Markup Account 40100 Constuct. =
Step 10.  From the Preferences Sl
window, click on the Payroll & = Time & Expenses
B e
Employees - Company
Preferences

Step 11.  Select QuickBooks Payroll
Features: Full Payroll

Step 12.  Select Display Employee List by: Last Name

Step 13.  Click the Employee Defaults button fo select payroll defaults.

Step 14.  Select the checkbox: Use time data to create paychecks. Now QuickBooks will
automatically use tracked time to calculate payroll.

Preferences

$ Checking QUICKBOOKS DESKTOP PAYROLL FEATURES  SET PREFERENCES FOR Cancel
" Deskiop view @ Full payrol Pay Stub & Voucher Printing o
Finance Charge [ Manual Payroll lelp
© No payroll

@ General - o pay Default
*f Online payrall

Integrated Applications: =
® ¢ What's the difference’
gl tems & nventory Aiso See:
% Jsovs aEstimates S era
S Mutipe Currencies [ Copy eamings details from previous paycheck
B rayments [ Recall quantity field on paychecks % Recall hourfield on paychecks TEEi099)

= Payroll & Employees [# Job Costing, Class and ltem tracking for paycheck expenses Employee Defaults

@ Reming EARNINGS NN,
i ; Payroll -
Al Repor LaSt Name pn one class per @ Entire paycheck ) Eamings item ITEM NAME i HOURLY/ANNUAL RATE Schedule
B saes o A Regular Pay *  PayFrequency |Biweekly - cancel
he employee name display preferences will cause all QuickBooks
ﬁ Sales Tax = adows to close. Please finish paying your employees before you do this
p Search DISPLAY EMPLU TS BY: Y.

5 sendForms © FirstName @ LastName Employee Defaults... ¥ Use time datato create paychafk__s?

Clags - Help

What s a payroll schedule?

: = ADI UCTION
% Service Connection 7] Mark new employees as sales reps
Speling [ Display employee social o in headers on reports

Use Time data to Create
Paychecks

B rax 1038
© resepese Employee Defaults

(7] Employee is covered by a gualified pension plan

Step 15.  Click OK to close the Employee Defaults window
Step 16.  Click OK again to close the Preferences windows

VIEW EMPLOYEE LIST

R

e

e e e e

&

The Employee List contains employee information such as address, telephone, salary or wage
rate, and Social Security number.

To view the Employees List for Rock Castle Construction, follow these steps:
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Step 1. Click Employees on the Navigation Bar or click the Employees buttfon on the
Home Page to display the Employee Center.

Step 2. Click the Employees tab fo display a list of employees

Step 3. Double-click the employee’s name

nnnnnn

Address & Contact

Additional Info

Payroll Info

ADDITIONS, AND COMPANY

Employment Info 4 Sl s L

. g \ 4
ot cons _ W Each of the tabs represents

unique information regarding
the employee

Use time data to create paychecks Employee is covered by a qualified pension plan
0
[ 01
01
o1

Employee is inactive @ Cancel Lol z:

NS P W N S NV N e—

Step 4. Scroll through the tabs for the employee 1o see the data entered in each defail
regarding the employee you have chosen.

ADD NEW EMPLOYEE

Y Y Y Y Y Yy,
B R e e e e e e e B e e e e e S S S S i i S A A A A A i e e S A A e S S A S A S w8 S8 S e

Step 1. Click the New Employee button in the Employee Center

Step 2. Enter the following information:
| PAYROLLTAB FIELD HEADING INFO TO ENTER
FIRST NAME: [Enter your first name]
LAST NAME: [Enter your last name]
SOCIAL SECURITY NO: 555-66-7895
(GENDER: [Enter gender]
Personal DATE OF BIRTH: [Enter afictitious date of
birth]
MARITAL STATUS: Married
U.S.CiTizeN Yes
ADDRESS: 666 MountainView Lane
Address & Contact Bayshore, CA 94326
MAIN EMAIL: [Enter your email address]
ege EMPLOYEE ID 200-30-400
Additionallnfo B-DAY [Enter afictious birth date]
P Il Inf EARNINGS NAME Regular Pay
ayrollinfo HOURLY/ANNUAL RATE 10.00
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| PAYROLLTAB FIELD HEADING INFO TO ENTER

USE TIME DATA TO CREATE Yes
PAYCHECKS
PAY SCHEDULE: Biweekly
DEDUCTIONS: Health Insurance
AMOUNT: -25.00
LIMIT: -1200.00
Payroll Info Federal: FILINGSTATUS: Married
v Taxes Tab ALLOWANCES FOR FEDERAL: 1
State: FILING STATUS: Married (twoincomes)
ALLOWANCES STATE: 1

Step 3. Click OK fo close the Taxes Window

Step 4. Click OK again to close the New Employee window and add your name to the
Rock Castle Construction Employee List
Step 5. When asked if you want to set up payroll information for sick leave and vacation,
click Leave as Is fo use the employee default information for these items
Step 6. Leave the Employee Center window
CH7 EMP

Follow these steps to export the current employee list:

Step 1. Open the employee center
Step 2. Click the Name bar to sort the employee names in alphabetical order by last
name
Employees Transactions Employee Informatlon
Active Employees - >
FullMame Last Name, First Name
% | NAME ATTACH Account No.  200-30-400

Address First Name Last Mame
666 Mountain View Lane
Bayshore, CA 94326

Last Mame, First Mame
Mason, Elizabeth M.
Miller, Dan T.

Schneider, Gregg 0. ap | Directions

Name Bar

Step 3. At the top of the Employee Center select Excel

Step 4. Export > Employee List

Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_07_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: CH7 EMP
Step 7. Save and close the Excel file.
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EMPLOYEE & PAYROLL CENTER

QuickBooks has an Employee Center and a Payroll Center to help manage employee and
payroll information.

EMPLOYEE CENTER

B

.=

.=

.=

.=

The Employee Center can be accessed from the Navigation bar. It contains the Employee List
with the employee information, such as Social Security Number.

.=

&

Payroll Center

Employee

EMPLOYEES

Payroll
Center

&
Enter Pay Pay Process HR Essentials

Time Employees Liabilities Payroll and Insurance
Forms

PAYROLL CENTER

The Payroll Center is part of the Employee Center is used to manage payroll and tax information,
including information about wages, benefits, and withholding. The Payroll Center can be

accessed by clicking the Payroll Center icon in the Employees section of the Home Page or by
selecting the Payroll tab from the Employee Center.

TIME TRACKING

=

e

e

e

e

e

&

QuickBooks permits you to frack time worked on various jobs. When employees use fime
tracking, the employee records the time worked on each job. The time data is then used to:

1. Prepare paychecks
2. Bill customers for time worked on specific jobs.

QuickBooks Pro and QuickBooks Premier provide three different ways to track time.

1. Time Single Activity — Use the Stopwatch to fime an activity and entfer the time data.
QuickBooks automatically records the time on the employee’s weekly fimesheet.

2. Weekly Timesheet - Use the weekly times sheet to enter time worked by each employee
on various jobs during the week.

3. Online Timesheets — Enter billable hours from an Internet connected computer.
Download the timesheets into QuickBooks to process paychecks.

TIME SINGLE ACTIVITY

o
=

e
—r

e
—r

e
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Use the QuickBooks Stopwatch feature to time how long it takes you to complete the payroll
activities in this unit.

e
—r

Step 1. From the Employees section of the Home Page, select the Enter Time icon
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Step 2. Select Time/Enter Single Activity

Step 3. When the Time/Enter Single Activity window appears, select Date: 12/15/2022.
The Stopwatch can be used to fime activities for today’s date; however, for this
activity use the programmed date for the sample company: 12/15/2022

Step 4. From the Name drop-down list, select your name

Step 5. If the work was for a specific job or customer, itis possible to enter the job or
customer name and the service item, then click Billable. In this case, your fime is
not billable to a customer’s job, so uncheck Billable.

Step 6. Select Payroll Item: Regular Pay

Step 7. Enter Note: Process payroll
Step 8. Click the Start button to start the stopwatch
Step 9. Leave the window open while you complete the following payroll activities.

Time/Enter Single Activity
@ Previous ® Next | Spelling [ Timesheet

DATE 12/15/2022 B8 PAYROLL TEM Regular Pay - @ NOT BILLED
MAME Last Mame, First Name - WC CODE Billable:
CUSTOMER:J0B Payroll Ite
SERVICE ITEM
DURATION

HWOTES  Pprocess Payroll

© 00:00.:

Save & Close j.§ave illﬂew |

TIMESHEET

o
=

e
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e
—r

e
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If time is billable to a specific customer or job, this isindicated on the weekly timesheet. For
example, this first fimecard is for you. Pull your name in the time sheet windows and follow these

steps:

Step 1. In the Employees section of the Home Page, Select Enter Time

Step 2. Select Use Weekly Timesheet.

Step 3. Select Week of: Dec 12 - Dec 18, 2022

Step 4. Payroll Item: Regular Pay

Step 5. Uncheck: Billable (These charges will not be transferred to an invoice)
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STUDENT TIME SHEET INFORMATION

Y Y Y Y Y Yy,
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Company Customers Vendors Employees Banking Reports Window Help O |- = x

Timesheet e [Gutvars rrivond P E————— m
E— Sheet Tots o ) I I T R
Copy Last Sheet Save & Close Clear
‘ Week Day Hours Action
Worked Worked
12/12/2022- 12/16 6 Click the Next button to advance to the
12/18/2022 next week for the same person
12/19/2022- 12/19 6 Click Next
12/25/2022 12/20 6 Select Copy Last Sheet
12/21 6
12/22 6
12/23 6
12/26/2022- 12/26 [ Click Next
01/01/2023 12/27 6 Select Copy Last Sheet
12/28 6 Delete hours from Friday, Dec 30
12/29 6
Step 6. Click Save & New fo record your hours and display a new fimesheet

Step 7. At this point, your single time activity for December 15 should sfill be open. Click
on the Window > .
Step 8. Save & Close

CH7 TIME

Step 1. From the Navigation Bar, select Reports = Jobs, Time & Mileage
Step 2. Select Time by Name
Step 3. Select Dates: 12/16/2022 to 12/29/2022

Step 4. Select Run or Refresh

Step 5. Export fo Excel NOTE: Make sure you have used all the

Step 6. Follow the instructions in Appendix C to ’ i o i
export the report to the Excel file named advanced settings outlined in Appendix C.

UNIT_07_REPORTS Excel file.
Step 7. From the drop-down list, select the sheet: CH7 TIME
Step 8. Save and close the Excel file.

Page | 177




ELIZABETH N. MASON’S WEEKLY TIMESHEET:

Y Y Y Y Y Yy,
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Step 9. Select Employee Name: Mason, Elizabeth N. (be careful, make sure you have
selected the employee name Elizabeth N. Mason)
Step 10.  Click the Previous button in the upper left corner of the Weekly Timesheet window
to change the time sheet dates to Dec 12 to Dec 18, 2022
Step 11.  To record time billable to a specific customer:
v' Select Customer: Job: Teschner, Anton: Sun Room
v Select Service ltem: Framing

Day Hours Job & Service ltem Action
Worked Worked Teschner, Anton:Sun
Room
12/12/2022- 12/16 8 Framing Check Billable
12/18/2022 Click the Next

button to advance
fo the next week
for the same

person
12/19/2022- 12/19 2 Framing Check Billable
12/25/2022 12/19 [ Installation Click Next
12/20 8 Installation
12/21 8 Installation
12/22 8 Installation
12/23 8 Installation
12/26/2022- 12/26 8 Framing Check Billable
01/01/2023 12/27 8 Framing Save & New
12/28 8 Framing
12/29 é Framing

Step 12. Make sure that everything is marked as billable. Save & Close

CH7 TIME-2

Step 1. From the Navigation Bar, select Reports = Jobs, Time & Mileage
Step 2. Select Time by Name

Step 3. Select Dates: 12/16/2022 to 12/29/2022

Step 4. Select Run or Refresh

Step 5. Export to Excel
Step 6. Follow the insfructions in Appendix C o
export the report fo the Excel file named

NOTE: Make sure you have used all the
advanced settings outlined in Appendix C.

UNIT_07_REPORTS Excel file.
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Step 7.
Step 8.

From the drop-down list, select the sheet: CH7 TIME-2
Save and close the Excel file.

PAY EMPLOYEES
C__________________________________________________________________________|

The QuickBooks payroll service is active for the sample company file. To create paychecks for
Rock Castle Construction, follow these steps:

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.
Step 6.
Step 7.
Step 8.
Step 9.

Step 10.
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Click the Pay Employees icon to display the Employee Center: Payroll Center
windows.
In the Pay Employees section, select: Start Unscheduled Payroll. It is possible to
schedule payroll to run at specific infervals (every week, bi-weekly, monthly, etfc.).
It this case we are selecting unscheduled payroll.
When the Enter Payroll Information window appears, notice there are three steps
listed at the top of the window:

i. Enter Payroll Information

ii. Review & Create Paychecks

iii. Print & Distribute Paychecks
Select Pay Period Ends: 12/29/2022. This is the last day of this pay period. If the
Pay Period Change window appears, click No to change the date without
updating the hours worked.
Select Check Date: 12/29/2022
Select Bank Account: 10100 Checking
Select Employee: Elizabeth N. Mason
Click Continue
When the review and Create Paychecks window appears, nofice that the tax
withholding amounts appear automatically because Rock Castle uses a payroll
service. If we were calculating payroll taxes manually, we must enter the
withholding amounts manually.

B Time Trasing 8 Pamod Upostes (5] Pawolltems 35 Paor Seup (B Prerences € Suspen § Ralp

ePan seves
cmoines | esicans I

PayLisies File Formg.

Create Paychecks:

& Samplo Ao 1212002007 |overse O pieery 2182007 - 12202007 2292007

Detail .
Mason, Elizabeth N.

B Taxes calculated
automatically

118000 w0 he
I

Other Payroll tems

Company Summary

et g
1 Jecember T ——
g ) [ st J
— Awexrcoounr [ TOW00- Checking =
Paycheck 1 e o s oot s et SartUnscheduled Payiol | Stat Scheduied Payroll
: e f
e o
e 5 " T e g
s

Select Open Paycheck Detail. Noftice in the Preview Paycheck window that
QuickBooks payroll service automatically calculated the payroll amounts. If a




direct deposit was used for employee paychecks, we would select Use Direct
Deposit.

Step 11.  Select Save & Close. If we wanted to create the paycheck, we would select
Create Paychecks. In this case select Finish Later.

PAY PAYROLL LIABILITIES
I ————————————————

Payroll liabilities include the money you pay your employees for services rendered, the
withholding you take from their paychecks and your payroll expenses as an employer.
Withholding comes out of your employees’ gross wages; however, it is part of your liability as an
employer. You submit the respective liabilities to the appropriate institutions and document them
in your company’s financial journal.

Employee compensation includes regular wages and salaries. Supplemental wages, such as
overtime pay, refroactive pay, back pay, severance pay, awards, bonuses, commissions, prizes
and accumulated sick leave pay, are forms of employee compensation. When assessing your
payroll liabilities include fringe benefits that you provide your employees, such as health
insurance, refirement plans and paid vacation and personal days (Ferguson, 2019).

WITHHOLDING

o
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The mandatory withholding you take from youremployees’ paychecks
remains a liability until you submit the payment to the respective agency. Such
withholding includes federal, and, if applicable, state and local income tax;
Social Security and Medicare taxes; and, if applicable, wage garnishments
and state unemployment and disability insurance. Employee contributions for
voluntary benefits, such as for health, life and disability insurance; retrement
plans; adoption assistance; and flexible spending accounts remain as liabilities
until you pay the money to the appropriate vendor.

o
e

o
e

o
e

EMPLOYER TAXES AND INSURANCE
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e
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Your share of liabilities includes Social Security and Medicare taxes and
federal and state unemployment taxes. Depending on your location, the state
and local government may require that you pay additional taxes, such as job
training tax and local payroll tax. The state might also mandate that you carry
workers’ compensation. Your portion of taxes and insurance remains a liability
unftil you pay them to the required agency.

.=

.=

PAYMENT

o
=
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e
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The remittance process for liabilities varies. For example, you pay your
employees’ federal income tax and Medicare and Social Security withholding

e e e =

e
——
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plus your share of Medicare and Social Security taxes, together, directly to the
Internal Revenue Service. You pay state, and in some cases local, income tax
withholding to the state revenue service. You make federal unemployment
insurance payments to the IRS and state unemployment insurance payments
to the state workforce agency. You must also file periodic tax reports with
these agencies to report your liabilities. You submit payments for voluntary
deductions to the respective vendorbased on its schedule.

FILE PAYROLL TAX FORMS

[ My Payroll Senice [ Time Tracking # Payroll Updates g Payrollltems 3% Payroll Setup /@ Preferences & Support P Help

Pay Liabilities

Payroll @ PayEmployees Pay Liabjlities
Pay Taxes & Other Liabilities
|/  DUE DATE STATUS
' Sample Account CAWitholding and Disabilty Insurance Dec 2022
Federal 94119441943 Dec2022
I Healtn Insurance Q42022 150.00
CAUI and Employment Training Tax Q42022 110.00
Federal 040 Q42022 100.00
¥ 4 December2022 *
123
alsl87(ale | Total Selecied ltems:0.00 ViewrPay
11 12 13 14 L3 16 17
18 19 20 21 %23 24 Edysent Histoey
2512827 28203031 All Payments | E-Payments
1200712022 Check Complete |47 113012022 Employment Develop... | GA- Disability Employee Checking 29498 &
et 1200712022 Check (Complete |ss8 11302022 Great Statewide Bank  Advance Eamed Inco... |Checking 214278 '
1200712022 Check Complete |489 113012022 Sergeantinsurance | Health Insuran co Checking 75.00
1200712022 Chack Complete 490 113012022 State Fund Workers C: on|Checking 20583
1[2|a|as]e[7 110772022 Check Complete 444 103172022 Employment Develop... |CA- Disabilty Employeel Checking 29104
8 9 1011 12 1314 1100712022 Check Complete |45 103112022 Greal Statewide Bank  Advance Eamed Inco... |Checking 212850
15 16 17 18 19 20 21 11072022 Check Complete |48 103172022 Sergeantinswiance | Health Insuran ce Checking 125.00
22 23 24125 26 27 28 110712022 Check Complete ‘447 10/31/2022 State Fund |Workers Compensation| Checking 804.16
29 30 10/07/2022 Check (Complete 410 08/30/2022 Employment Develop . |CA- Disability Employee Checking 28311
1010712022 Check Complete an 00/30/2022 Great Statewide Bank  Advance Eamed Inco... |Checking 209178
100712022 Chack Complete |a12 00/3012022 Sergeantinswiance | Health Insurance Checking 125.00
1000712022 Check Complete |a13 08/30/2022 State Fund Workers Compensalion| Checking 50080
v
Quick Guides Other Activities Reports.

Step 1. Inthe Employee Center: Payroll Center, select the Pay Liabilities
tab.

In the Pay Taxes & Other Liabilities section, you can view the upcoming scheduled payment for
payroll liabilities. If any payments were due, you would select the payroll liabilities to pay, then

click View/Pay. In the Due Date column, you can see that no payments are currently due for
Rock Castle Construction.

Step 2. Leave the Employee Center: Payroll Center window open
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Notice that the third section of the Payroll center is File Forms. Basically, payroll forms summarize
the amount of payroll withholdings that have been collected and remitted.

FEDERAL FORM 940

o
=

e
—r

e
—r

e
—r

Employer’'s Annual Federal Unemployment (FUTA) Tax Return. Use Form 940 to report your annual
Federal Unemployment Tax Act (FUTA) tax. Together with state unemployment tax systems, the

FUTA tax provides funds for paying unemployment compensation to workers who have lost their
jobs.

e
—r

Most employers pay both a federal and a state unemployment tax. Only employers pay FUTA
tax. Do not collect or deduct FUTA tax from your employees' wages.

FEDERAL FORM 941

B
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Employers use Form 941 to report income taxes, social security tax, or Medicare tax withheld

from employee's paychecks. The employers include this portion of social security or Medicare
tax.

FEDERAL FORM 944
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&

Form 944 is designed so the smallest employers (those whose annual liability for social security,

Medicare, and withheld federal income taxes is $1,000 or less) will file and pay these taxes only
once a year instead of every quarter.

FORM W-2

=

e

e

e

e

Every employer engaged in a frade or business who pays remuneration, including noncash
payments of $600 or more for the year (all amounts if any income, social security, or Medicare

tax was withheld) for services performed by an employee must file a Form W-2 for each
employee (even if the employee isrelated to the employer) from whom:

e

&

v Income, social security, or Medicare tax was withheld.

v Income tax would have been withheld if the employee had claimed no more than one
withholding allowance or had not claimed exemption from withholding on Form W-4,
Employee's Withholding Allowance Cerfificate.

FORM W-3

R

e

e

e

e

e

&

This is referred to a Transmittal of Wage and Tax Statements. The form is filed with the Social
Security Administration. It contains a summary of all an employer’'s W-2 forms created.

Step 3. Close the Employee Center: Payroll Center window.

TRANSFER TIME TO SALES INVOICE
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Billable time can be fransferred to a specific customer’s invoice, as shown in the Home Page by
an arrow going from the Enter Time icon to Create Invoices icon.

First, you must enter time worked, then open the Create Invoices window for the customer, and
select the time billable fo that customer. For the Teschner sun room job, you have already

entered Elizabeth Mason’s time. To fransfer billable time to the Teschner invoice follow these
steps:

Step 1. Open the Create Invoices window by clicking the Create Invoices icon in the
Customers section of the Home page.

Step 2. From the Create Invoices window, select he customer job to be billed. In this
instance, select Customer: Job: Teschner, Anton: Sun Room

Step 3. If the following Billable Time/Costs window appears, select: Select the outstanding

billable time and costs to add to this invoice.

DI DNe =AW

The customer ar job you've selected has outstanding billable time and/or costs.

Do you want to:

» ® Select the outstanding billable time and costs to add to this invoice?

~. Exclude outstanding billable time and costs at this time? (You may add these later by
clicking the Add Time/Costs button at the top of the invoice.)

Save this as a preference. @ Help

Step 4. Click OK

Step 5. When the Choose Billable Time and Costs window appears, click the Time tab.
Step 6. Click the Select All button to select all the billable times listed for the Teschner sun
room job.

You can fransfer time to aninvoice in three different ways:

1. Combine All- Combine all the selected times and costs info one entry on
the invoice

2. Subftotal Items - List a subtotal for each service item on the invoice

3. Separate line ltems — List a separate invoice line item for each activity you
check

Step 7. In this instance, you will list a separate invoice line item for each activity you
check, so uncheck Print selected time and cost as one invoice item in the lower
left corner of the Choose Billable Time and Costs window.
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Step 8. Select Options

Step 9. When the Options menu
opens select: Enter a Tmem  sercooe (B 5000 Mieags w0 pams w08
sepqrqfe line on the Clear a1 Serthpbieptoilblordes bl

invoice for each activity " T e o

» T2420.. Mason EimaethM.  Removat  §00

Time and Costs For: Teschaer, ABlon:Sun Room

280.00 Removal labar
440.00 Framing labor

330.00 Framing labor
- " Options fo

» V2520 Mason ElzabethN.  Framing | 800

Step 10.  Choose: Transfer item > et s e i (7050
descriptions ettt sl e

Step 11.  Click OK to close the * ian
Options for fransferring
billable time window. i

Step 12.  Click OK to close the S——— — traig?;fi‘;‘fﬁm;;on
Choose Billable Time to the invoice
and Costs window and
add the labor cost to the Teschner invoice.

Step 13.  Select Template: Rock Castle Invoice

Step 14.  Select Invoice Date: 12/27/2022

Step 15.  Uncheck Email Later.

2 2

"When bansferring billable time 1o an imvoice

@ Erfler 8 separaie kne on 1he invaice faf 89ch acthity

O Transfor acthity noles

@ Transter fem descriptions

«.
.
g
856G S

2 Transh

notes and descrptions
© Combing acthities with he same senice iems

NOTE: some of the billable time was done November and early December. You entered only
the new information. The invoice is for all the time spent on the entire job for Teschner, Anton:
Sun Room

Total billable time is $9,370

Step 16.  Select Save. Do not close.

INV 1100.PDF

Step 17.  Select Print to print the Teschner, Anton: Sun Room invoice #1100
Step 18.  Select Invoice

Step 19.  Select Print on: Blank paper

Step 20.  If necessary, uncheck: Do not print lines around each field

Step 21.  Select the PDF printer as your printer of choice, then click Print
Step 22. Save the PDF copy fo the UNIT 07 folder

Step 23. Save asINV1100.PDF
Step 24. Click Save & Close to record the cash sale and close the Enter Sales Receipts
window.

PAYROLL REPORTS
.

In addition to aiding with filing payroll tax forms with federal, state, and local governmental
agencies, QuickBooks provides payroll reports for owners and managers fo use to answer various
questions:

1. How much did we pay our employees and pay in payroll taxes2 (Payroll reports)
2. How much fime did we spend classified by employee and job? (Project reports)

Payroll reports can be access in the following ways:
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v Employee Center. Employees = Reporfs for this Employee
v Report Center: Reports > Employees & Payroll
v" Reports Menu: Reports Menu - Employees & Payroll

CH7 PAY SUM

To view the Payroll Summary Report, follow these instructions:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.

Step 7.
Step 8.

Step 9.
Step 10.

Select Reports

Select Employees & Payroll

Select Payroll Summary

Dates: This Month

From: 12/01/2022 To: 12/31/2022

Select Run or Refresh depending on the menu you choose to use.

Export to Excel
Follow the insfructions in Appendix C fo
export the report fo the Excel file named

NOTE: Make sure you have used all the
advanced settings outlined in Appendix C.

UNIT_07_REPORTS Excel file.

From the drop-down list, select the sheet: CH7 PAY SUM
Save and close the Excel file.

CH7 PAY TRANS DET

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.
Step 8.

Step 9.
Step 10.

Select Reports

Select Employees & Payroll

Select Payroll Transaction Detail

Dates: This Month

From: 12/01/2022 To: 12/31/2022

Select Run or Refresh depending on the menu you choose to use.
Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_07_REPORTS Excel file.

From the drop-down list, select the sheet: CH7 PAY TRANS DET
Save and close the Excel file.

PROJECT REPORTS

There are four different project reports available in QuickBooks:

1. Time by Job Summary Report. Lists time spent on each job.

2. Time by Job Detail Report. Lists time by category spent on each job.

3. Time by Name Report. Lists amount of time worked by each employee.
4. Time by Item Report. Lists time worked on a job by service category.

CH7 JOB SUM

To export the Time by Job Summary report, follow these steps:
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Step 1. Select Reports

Step 2. Select Jobs, Time & Mileage - Time by Job Summary
Step 3. Dates: This Month

Step 4. From: 12/01/2022 To: 12/31/2022

Step 5. Select Run or Refresh depending on the menu you choose to use.
Step 6. Export to Excel
Step 7. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_07_REPORTS Excel file.
Step 8. From the drop-down list, select the sheet: CH7 JOB SUM
Step 9. Highlight the job requiring the most time for December 2022
Step 10. Save and close the Excel file.

ENTER TIME
C__________________________________________________________________________|

DAN T. MILLER TIME SHEET

e e e e e ey e e e e e e
B B e e e S e A S e S R e SR e

(be careful, make sure you have selected the employee name Dan T. Miller)

Week Day Hours Job ltem
Worked Worked

12/12/2022- 12/16 8 Cook: 2 Story Installation

12/18/2022

12/19/2022- 12/19 8 Pretell: 75 Sunset Framing

12/25/2022 12/20 8 Pretell: 75 Sunset Framing
12/21 7 Pretell: 75 Sunset Framing
12/22 4 Pretell: 75 Sunset Framing
12/23 8 Pretell: 75 Sunset Framing
12/22 4 Cook: 2d Story Installation

12/26/2022- 12/26 8 Pretell: 75 Sunset Framing

01/01/2023 12/27 8 Pretell: 75 Sunset Framing
12/28 8 Pretell: 75 Sunset Framing
12/29 3 Pretell: 75 Sunset Framing
12/29 5 Pretell: 75 Sunset Installation

GREGG O. SCHNEIDER TIME SHEET

Y Y Y Y Y Yy,
B R R e e e e e e e e e e e e B e e e e e A A A S o e e e e e e S S S e

12/12/2022- 12/16 6 Cook: 2 Story Installation
12/18/2022
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12/19/2022- 12/19 2 Pretell: 75 Sunset Framing

12/25/2022 12/20 8 Pretell: 75 Sunset Framing
12/21 6 Pretell: 75 Sunset Framing
12/22 8 Pretell: 75 Sunset Framing
12/23 8 Pretell: 75 Sunset Framing
12/19 8 Cook: 2 Story Installation

12/26/2022- 12/26 8 Pretell: 75 Sunset Framing

01/01/2023 12/27 8 Pretell: 75 Sunset Framing
12/28 8 Pretell: 75 Sunset Framing
12/29 8 Pretell: 75 Sunset Installation

CH7 TIME-3
Step 1. From the Navigation Bar, select Reports 2> Jobs, Time & Mileage

Step 2.
Step 3.
Step 4.
Step 5.
Step 6.

Step 7.
Step 8.

Select Time by Name

Select Dates: 12/16/2022 to 12/29/2022 NOTE: Make sure you have used all the

Select Run or Refresh
Export to Excel

advanced settings outlined in Appendix C.

Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_O07_REPORTS Excel file.

From the drop-down list, select the sheet: CH7 TIME-3
Save and close the Excel file.

CH7 PAY LIAB

To pay the payroll tax liability related to federal Form 941/944 follow these steps:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.
Step 8.
Step 9.
Step 10.
Step 11.
Step 12.
Step 13.

Step 14.
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Select the Pay Liabilities icon in the Employees section of the Home Page

In the Employee Center: Payroll Center window, select the Pay Liabilities tab
In the Other Activities section, select Create Custom Payments

Select Dates: 12/01/2022 through 12/31/2022

Select OK

In the Pay Liabilities windows, select To be printed

Select Bank Account: Checking

Select Check Date: 12/15/2022

Select: Review liability check to enter expenses/penalties
Select: All Payroll Iltems Except Health Insurance

Select: Payroll Liabilities Report.

Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_O7_REPORTS Excel file.

From the drop-down list, select the sheet: CH7 PAY LIAB




Step 15.

Save and close the Excel file.

CH7 PAY TRANS

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Step 6.
Step 7.

Use the previous instructions to export the Payroll fransactions by Payee report
Dates: This Calendar Year

From: 01/01/2022 To: 12/31/2022

Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_07_REPORTS Excel file.

From the drop-down list, select the sheet: CH7 PAY TRANS

Save and close the Excel file.

TRANSFER TIME TO SALES INVOICES

Transfer time worked to the related Jacobsen Kitchen sales Invoice as follows:

Step 1.
Step 2.

Step 3.

Step 4.

From the Customers sectfion of the Home Page, click the Create Invoices icon
Transfer billable time and items to sales invoice dated 12/22/2022 for the
Jacobsen Kitchen job

From the Choose Billable Time and Costs window, click the Time tab, then select
the Select All button to fransfer employee time worked to the invoice. Select

Options button > Combine activities with the same service item and rate.
Save the Invoice

CH7 TRANS JUR

Step 1. With the Jacobsen Kitchen invoice open, select the Reports fab
Step 2. Select the Transaction Journal icon
Step 3. Export to Excel
Step 4. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_07_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: CH7 TRANS JUR
Step 6. Save and close the Excel file.
CH7 JOB DET

To export the Time by Job Detail report, follow these steps:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.

Step 8.
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Select Reports

Select Jobs, Time & Mileage > Time by Job Detail

Dates: This Year

From: 01/01/2022 To: 12/31/2022

Select Run or Refresh depending on the menu you choose to use.

Export to Excel

Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_07_REPORTS Excel file.

From the drop-down list, select the sheet. CH7 JOB DET




Step 9. Highlight any items on the report that a billable to specific jobs, yet sfill unbilled.
Step 10.  Save and close the Excel file.

BACKUP YOUR COMPANY FILE

e e e e e e e e e B e e e O

Use the instructions in Appendix A to back up your company file. Make sure your
backup file is savedin the designated folder of this unit (UNIT 07 BACKUPS).

UNIT 07 PROJECT (ON-YOUR-OWN)

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u07a2 Larrys Landscaping. This file is in your UNIT 07 folder.

Step 3: RESTORE the u07a2 Larrys Landcapaing.QBB file
Step 4: Make sure you SAVE to the UNIT 07 FOLDER

RENAME THE COMPANY

Y Y Y Y Y Yy,
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After you have followed the instructions to restore your data files, you will find the company file
you have restored contains sample data fora company
called Larry’'s Landscaping. Your first activity is to
personalize that name to meet your needs follow these
instructions:

NOTE: The process to rename the
company isfound in Appendix B
and will be repeated throughout

Step 7: From the Menu bar, select Company QU 12 EEHVIIES I e HEnds

Step 8: Select MY COMPANY
Step 9: Select EDIT

Step 10: Update the Company Name Field to: YourName Larry’s Landscaping
Step 11:  CLICK on OK

Step 12:  Close the My Company window.

PREPARE PAYCHECKS

| Pay Period Ends Check Date Employee Paycheck Amount
12/29/2022 12/29/2022 Duncan Fisher 1,169.99
12/29/2022 12/29/2022 Jenny Miller 1308.44
12/29/2022 12/29/2022 Shane Hamby 1697.26

P7 JUR

Step 1. Open the Journal report for December 29, 2022

Step 2. Export to Excel

Step 3. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_07_REPORTS Excel file.

Step 4. From the drop-down list, select the sheet: P7 JUR

Step 5. Save and close the Excel file.

P7 PAY SUM
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Step 1.

Open the Payroll Summary report for December 16-29, 2022

Step 2. Export to Excel

Step 3. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_07_REPORTS Excel file.

Step 4. From the drop-down list, select the sheet: P7 PAY SUM

Step 5. Save and close the Excel file.

P7 PAY DET

Step 1. Open the Payroll Item Detail report for December 16-29, 2022

Step 2. Export to Excel

Step 3. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_07_REPORTS Excel file.

Step 4. From the drop-down list, select the sheet: P7 PAY DET

Step 5. Save and close the Excel file.

P7 PAY TRANS

Step 1.
Step 2.
Step 3.

Step 4.
Step 5.

Page | 190

Open the Payroll Transaction by Payee report for December 16-29, 2022

Export to Excel

Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_07_REPORTS Excel file.

From the drop-down list, select the sheet: P7 PAY TRANS

Save and close the Excel file.




ADJUSTMENTS

UNIT 08 ADJUSTMENTS
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STUDENT LESSON FILES
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You will find the following files in your Student files for UNIT 08.

e UO8al Rock Castle Construction

e U08a2 Larry's Landscaping

e UNIT_08_Reports
To complete the first lesson exercises, RESTORE the u08al Rock Castle Consfruction company file
from the UNIT 08 folder.

NOTE: The process to restore a backup is found in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY

R
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e

e

e
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After you have followed the instructions to restore your data files, you will find the company file

you have restored contains sample data fora company called Rock Castle Construction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 43. From the Menu bar, select Company

Step 44. Select MY COMPANY

Step 45.  Select EDIT

Step 46. Update the Company Name Field to: YourName Rock Castle Construction

Step 47. CLICK on OK

Step 48. Close the My Company window.
NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

ACCOUNTING CYCLE

The accounting cycle is a series of accounting activities that a business performs each
accounting period.

INPUT PROCESSING OUTPUT

— —_— — —

General Journal General Ledger
A
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The accounting cycle usually consists of the following steps:

v' Chart of Accounts — The Chart of Accounts is a list of all accounts used to accumulate
information about assets, liabilities, owners’ equity, revenues, and expenses. In
QuickBooks, the Chart of Accounts is created when the company is created; overtime,
the accounts are edited to meet the needs of the company.

v' Transactions. During the accounting period, record fransactions with customers, vendors,
employees and owners.

v' Trial Balance. A Trial Balance lists each account and the account balance at the end of
the accounting period. Prepare a Trial Balance to verify that the accounting system is in
balance - total debits should equal total credits. An unadjusted Trial Balance is a Trial
Balance prepared before adjustments.

v Adjustments. Afthe end of the accounting period before preparing financial
statements, make any adjustments necessary to bring the accounts up fo date.
Adjustments are entered in the Journal using debits and credits.

v" Adjusted Trial Balance. Prepare an Adjusted Trial Balance (a Trial Balance after
adjustments) fo verify that the accounting system still balances. If additional account
deftail is required, Print the general ledger (the collection of all the accounts listing the
fransactions that affected the accounfs).

v" Financial Statements. Prepare financial statements for external users (Profit & Loss,
Balance Sheet, and Statement of Cash Flows). Prepare income tax summary reports and
management reports.

TRIAL BALANCE

o
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e
——

e
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A frial balance is a listing of the ledger accounts and their debit or credit balances to determine
that debits equal credits in the recording process. The accounts appear in this order: assets,
liabilities, stockholders' equity, dividends, revenues, and expenses. Within the asset’s category,
the most liquid (closest to becoming cash) asset appears first and the least liquid appears last.
Within the liabilities, those liabilities with the shortest maturities appear first.

Preparing journal entries in a computerized system is different than in a manual system. The

computer normally asks for the number of the account to be debited. After you type the
account number, the computer shows the account tifle inits proper position. The cursor then
moves to the debit column and waits for you to enter the amount of the debit. Then it asks if
there are more debits. If not, the computer prompts you for the account number of the credit.
After you type the account number, the computer supplies the account name of the credit and
enters the same amount debited as the credit. When there is more than one credit, you can
override the amount and enter the correct amount. Then you would enter the other credit in the
same way. If your debits and credits are not equal, the computer warns you and makes you
correct the error. You can supply an explanation for the entry from a standard list or type it in. As
you entfer the journal enfries, the computer automatically posts them to the ledger accounts. At
any fime, you can have the computer print a frial balance.
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CHS8 1B

Step 1. Select Reports

Step 2. Select Accountant & Taxes

Step 3. Select Trial Balance

Step 4. Select Date Ranges: This Fiscal Quarter

Step 5. From: 10/01/2022 To: 12/31/2022

Step 6. Export to Excel

Step 7. Follow the instructions in Appendix C to exportthe report to the Excel file named
UNIT_08_REPORTS Excel file.

Step 8. From the drop-down list, select the sheet: CH8 TB

Step 9. Save and close the Excel file.

ADJUSTING JOURNAL ENTRIES
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Use the QuickBooks onscreen Journal to enter adjusting enftries

Step 1. Select the Accountant Menu (only available on the Accountant Version)
Step 2. Select Make General Journal Entries
Step 3. Enter the following information:

Categor Information Amount
EETT 12/31/2022

T A DJ2022.1

| Adjusting Entry  [R=S

60900 Depreciation Expense 50,000.00

Credit Account: 17000 Accumulated 50,000.00
Depreciation

Step 4. Save

Sample YourName Rock Castle Construction - QuickBooks Accountant Desktop 2018 - [Make General Journal Entries]

B B g Bceeicn @

Hew Save Delele @BMemorize Reverse | Prinl  Attach
& File

ore ([EBEEA ®| = [ADI20221 [ ADJUSTING ENTRY
50800 Deprecaton Expensa sa0000 Adjusting Entry
KWUUU Accumulated Depreciation 50,000.00

e —— ____—w_//—“‘\-ﬁ_\_—_/—-_’-ﬁ\ — k____'_/._’—“'"" ——

3 Accountant

Totals 50,0000 50,0000

List of Selected General Joumal Entries. | LastFiscal Year

a
123112021 1018 52100 - Insurance 52120 - Liabili_. | July allocation of prepaid rider pol. 14883 l
1213112021 FAIM2010 50000 - Depr 1 Racora 2010 Depraciation 44,43591
120112021 1017 13100 - Pre- ance 57500

1030/2021 1016 52100 - Insurance:62120 - Liabill. | July allocation of prepaid rider pol 148.83
0172021 1015 13100 - Pre-paid insurance -675.00
103172021 1014 62100 - Insurance 62120 - Liabill..| July allocation of prepaid rider pol.. 14883

v

ert
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CHS8 ADJ

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

From the Make General Journal Entries window, select the Reports fab

Select Transaction Journal

Export to Excel

Follow the instructions in Appendix C to export the report fo the Excel file named
UNIT_08_REPORTS Excel file.

From the drop-down list, select the sheet: CH8 ADJ

Save and close the Excel file.

MEMORIZE ADJUSTING ENTRIES
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Adjusting journal entries can be saved as memorized transactions. This can save time. The
amounts can still be updated as needed.

Step 1. Using the open Make General Journal Enfries window, select Main 2> Memorize to
save the ADJ2022.1 adjusting journal entry.

Step 2. Enter the Template Name: Adjusting Entry Depreciation (Since the Memorized
Transactions are listed alphabetically, itis a goodidea to name the template
using a name that is easy to find).

Step 3. Select: Add to my Reminders List. Once this is done, you will be reminded to use
the entry to make the adjustment on the date given.

Step 4. Select How Often: Annually

Step 5. Enter Next Date: 12/31/2023

MName AdjustlngEntry Ijepreciation

& Add to my Reminders List Cancel

How Often  Annually

120312023

7 Do Mot Remind Me Mext Date

T Automate Transaction Entry

How Often

Transaction Name

Step 6. Select OK

TYPES OF ADJUSTING ENTRIES
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If the company uses the accrual basis of accounting to calculate profits, the following four type
of adjusting enfries may be necessary.

1. Prepaid items. Items that are prepaid, such as prepaid insurance or prepaid rent.

2. Unearned items. Items that a customer has paid us for, but we have not provided the
product orservice.

3. Accrued expenses. Expenses that are incurred but not yet paid or recorded.

4. Accrued revenues. Revenues that have been earned but not yet collected orrecorded.
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ACCUMULATED DEPRECIATION
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Accumulated depreciation is a contfra asset account fo depreciable assetfs such as buildings,
machinery, and equipment. This account shows the total depreciation taken for the
depreciable assets. On the balance sheet, companies deduct the accumulated depreciation
(as a contra asset) from ifs related asset.

PREPAID ITEM: RELATED EXPENSE AND ASSET ACCOUNTS

___________________________________________________________________________________________________________________________|
Prepaid expenses Assefs awaiting assignment to expense. Items such as rent, insurance, and

supplies that have been paid for but from which all the benefits have not yet been realized (or
consumed). Prepaid expenses are classified as current assets.

Adjusting enfries for prepaid items typically affect an Expense account and an Asset account.
Examples or related Expense and Asset accounts used for prepaid item adjusting entries are as
follows:

Prepaid Insurance Expense Prepaid

Insurance Insurance

Prepaid Rent Rent Expense Prepaid Rent

Office Supplies Office Supplies Office Supplies
Expense

Basically, we want to make certain that the amounts in the related Expense account (such as
Insurance Expense) and Asset account (Prepaid Insurance) are appropriate.

The adjusting entry is a Journal enfry recording the amount that needs to be fransferred

between the two accounts, and Expense account and an Asset account, to show the
appropriate balance in each account.

Whether a debit or credit increases or decreases an account depends upon the type of
account (Refer to Appendix D).

UNEARNED ITEMS: RELATED REVENUE AND LIABILITY ACCOUNTS

Unearned items consist of revenue that we have not earned. If a customer pays in advance of
receiving aservice, such as when a customer makes a deposit, or business has an obligation
(liability) to either provide the service in the future or refurn the customer’s money. An

adjustment may be necessary to bring the revenue account and unearned revenue (liability)
account up fo date.

| Unearned ltems Revenue Account Liability Account
Unearned Rent Rent Revenue Unearned Revenue
Revenue
App Subscription App Subscription Revenue | Unearned App Subscription
Revenue
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The adjusting entry is a Journal enfry recording the amount that needs to be transferred
between the two accounts, a Revenue account and a Liability account, to show the
appropriate balance in each account.

For example, If we need to make an adjusting enfry to increase Rent Revenue and decrease
Unearned Revenue for $2,000, we would determine whether to debit or credit the accounts as
follows:

Account Account Type Increase or Debit or Amount
Decrease? Credit?

Rent Revenue Revenue Increase Credit $2,000

Unearned Revenue Liability Decrease Debit $2,000

An example of how to record this fransaction in QuickBooks:

\ccountant Company Customers Vendors Employees Banking Reports Window Help ! OE | -

CER Y

A

Main Reporis
&« P E E % Create a Copy & E @ e =
Print

Find New Save Delete amemorize Reverse Attach Hide Send
i File List GJEs
pare 123172022 HE ENTRY M. | ADJ20223 [@ ADJUSTING ENTRY /
ACCOUNT i DEBIT i CREDIT MEMD

21 UIt-JU“- Uneamet.inl.?i.evenue 200000

———
||40600 - Rent Revenue

2,000.00

S|

)
‘J}/ AT A

Liability Account

L%

sl

Income/Revenue Account

ACCRUED EXPENSES: RELATED EXPENSE AND LIABILITY ACCOUNTS

Accrued liabilities are liabilities not yet recorded at the end of an accounting period. They
represent obligations to make payments not legally due at the balance sheet date, such as
employee salaries. At the end of the accounting period, the company recognizes these
obligations by preparing an adjusting enfry including both a liability and an expense. For this
reason, we also call these obligations accrued expenses.

| Accrued Expenses Expense Account Liability Account
Accrued InterestIncurred | Interest Expense Interest Payable
Accrued Taxes Payable Tax Expense Taxes Payable
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The adjusting entry is a Journal enfry recording the amount that needs to be transferred
between the two accounts, an Expense account and a Liability account, to show the
appropriate balance in each account.

To make an adjusting entry to increase Interest Expense and increase Interest Payable for $3,000,
we would determine whether to debit or credit the accounts as follows:

‘ Account AccountType Increase or Debit or Amount
Decrease? Credit?
Increase Expense Increase Debit $3,000
Expense
Increase Liability Increase Credit $3,000
Payable

This is an example of how this fransaction looksin QuickBooks:

wccountant Company Customers Vendors Employees Banking Reports Window Help @ﬂ = & x

Main Reporis oA
“» B X Qe ¢ & § © =

Find Mew Save Delete auemorize Reverse Print Attach Hide Send

i File List G.JEs

DATE _121'311’2022 B ENTRY NC.  [ADJ2022.4 [# ADJUSTING ENTRY

ACCOUNT : DEBIT i CREDIT i MEMO

62400 - Interest Expense 3,000.00 A
|PU3UU - Interest Payable - 2,000.00 -

\
»--I'J *"""nr'

Other Current Liability

\
ACCRUED REVENUES: RELATED REVENUE AND ASSET ACCOUNTS

Accrued assets are assets, such as interest receivable or accounts receivable, that have not
been recorded by the end of an accounting period. These assets represent rights to receive
future payments that are not due at the balance sheet date. To present an accurate picture of
the affairs of the business on the balance sheet, firms recognize these rights at the end of an
accounting period by preparing an adjusting entry to correct the account balances. To indicate

the dual nature of these adjustments, they record a related revenue in addifion to the asset. We
also call these adjustments accrued revenues because the revenues must be recorded.

| Accrued Revenues Revenue Account Asset Account
Accrued Interest Earned Interest Revenue Interest Receivable
Accrued Rent Revenue Rent Revenue Rent Receivable
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The adjusting entry is a Journal enfry recording the amount that needs to be transferred
between the two accounts, a Revenue account and an Asset accounts, to show the
appropriate balance in each account.

If it is necessary to make and adjusting entry to increase Revenue and increase Interest
Receivable for $4,000, the determination of how to create or debit the account is as follows:

Increase or Debit Amount

Decrease? or

Credit?
Interest Revenue Revenue Increase

Credit  $4,000
Interest Receivable WX =) Increase Debit $4,000

This is an example of how this fransaction may look in QuickBooks:

ccountant Company Customers Vendors Employees Banking Reports Window Help

Main Reporis

«*» B 8 X Qooescon ¢ =@ 0 Q9 =

Find New Save Delete @B Memorize Reverse  Prinl | Aftach _ Hide Send

Other Current Asset

ACCOUNT { CREDIT
11100 - Interest Receivable 4,000.00 |
70200 - Interest Income | 4,000.00

DATE EnTRY MO, |ADJ2022.5

i MEMO i NAME

Other Income

Totals 4,000.00 4,000.00

List of Selected General Journal Entries: Last Fiscal Year -

CORRECTING ENTRIES VS ADJUSTING ENTRIES
.

Corrections, or correcting entries, fix mistakes in the accounting system. A correcting entry isa
journal entry that is made in order fo fix an erroneous fransaction that had previously been
recorded in the general ledger.

Adjusting entries, are not mistakes but updates that are required to bring accounts to their
correct balance as of a certain date. Adjusting enfries are accounting journal enfries that
convert a company's accounting records fo the accrual basis of accounting. An adjusting
journal entry is typically made just prior to issuing a company's financial statements.

CORRECTION SCENARIO

o
=

Assume the Cash account should have been debited for $200.00 and the Professional Fees

Revenue account credited for $200; however, the following incorrect entry was made for
$2,000.00 instead of $200.00.

e
—r

e
—r

e
—r

e
—r

it

e
—r

‘ Incorrect Account Amount
Entry
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Debit Cash $2,000
Credit Professional Fees $2,000
Revenue

Make 2 Correcting Entries
1. Eliminate the effect of the first entry by making the opposite journal entry:

Correcting Enfry 1 Account Amount

Credit Cash $2,000

Debit Professional Fees $2,000
Revenue

2. Make the following Correcting Entry:

Incorrect Account Amount

Entry

Debit Cash $200

Credit Professional Fees $200
Revenue

CORRECTING ERRORS ON SAVED DOCUMENTS

Once a document has been saved, we can use one of three approaches to correct the error:

1. Display the document, correct the error, then save the document again.
2. Void the erroneous document, then create a new document. Voiding keeps arecord of
the document but changes the amounts to zero.

3. Delete the erroneous document, then create a new document. Deleting the document
erases the document from the system.

Typically, options 1 or 2 are preferable because we have a better audit frial showing changes.

(S5 k:3 7\ P72 nnnnaanonnnanenonanenananeaonananenananca6na0a06aa0NaEaAEaan0AEAGE0N0AGAAACNAREAANAE PREPAID ITEM

Consider the following scenario — December 31, 2022 Rock Castle Construction needs to make

an adjusting Journal entry to record $148.83 of Liability Insurance that has expired during the
month of December. Use Enfry No. ADJ2022.2. Use the following accounts fo make the adjusting
enftry:

v 13100 Prepaid Insurance

v 62120 Liability Insurance Expense
Step 1. Save the adjusting entry
Step 2. Click on the Reports tab

Step 3. Click on the Transaction Journal
Step 4. Export to Excel
Step 5. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_08_REPORTS Excel file.
Step 6. From the drop-down list, select the sheet: CH8 ADJ-2
Step 7. Save and close the Excel file

Page | 200




CHB A D3 oottt ettt ettt ettt ee s eeaiaaeaaeeeeananaaens UNEARNED REVENUE

Consider the following scenario — December 1, 2022 Rock Castle Construction received $3,000
for unused storage space it leased to a subcontractor. The entire amount was recorded in the
Checking account and as unearned rental revenue. The $3,000 payment was for three months’
rent, beginning December 1, 2022. To create the correct result for the scenario,

Step 1. Make the deposit for $3000 on December 1, 2022. To the checking account.
Step 2. Account: 2100 Unearned Credit

So, an adjusting entry is needed to bring accounts up to date at December 31, 2022 and record
the amount of rent revenue that has been earned as of December 31. Use Entry No. ADJ2022.3.
Use the following accounts to make the adjusting entry:

v 21000 Unearned Revenue

v 40600 Rent Revenue

Step 1. Save the adjusting enfry
Step 2. Click on the Reports tab

Step 3. Click on the Transaction Journal
Step 4. Export to Excel
Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_08_REPORTS Excel file.
Step 6. From the drop-down list, select the sheet: CH8 ADJ-3
Step 7. Save and close the Excel file

(O 1 K N 0 N S PP Accrued Expense

Consider the following scenario — Interest incurred but not yet paid by Rock Castle Constructions

as of December 31, 2022, was $3,000 fotal. Use Enfry No. ADJ2022.4. Use the following accounts
to make the adjusting entry:

v" 20300 Interest Payable

v' 62420 Loan Interest (Expense)
Step 1. Save the adjusting entry
Step 2. Click on the Reports tab

Step 3. Click on the Transaction Journal
Step 4. Export to Excel
Step 5. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_O8_REPORTS Excel file.

Step 6. From the drop-down list, select the sheet: CH8 ADJ-4
Step 7. Save and close the Excel file

(@8 5 = T N o 0 Accrued Revenue

Consider the following scenario —Rock Castle Constructions has earned $400 as of
December 31, 2022. This interest has been earned but not recorded orreceived. Interest of $400
needs to be recorded as an accrued revenue and Interest Receivable, an asset, recorded for
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the amount that Rock Castle Consfruction will receive in the future. Use Entry No. ADJ2022.5. Use
the following accounts to make the adjusting entry:

v 11100 Interest Receivable

v' 70200 Interest Income

Step 1. Save the adjusting entry
Step 2. Click on the Reports tab

Step 3. Click on the Transaction Journal
Step 4. Export to Excel
Step 5. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_08_REPORTS Excel file.
Step 6. From the drop-down list, select the sheet: CH8 ADJ-5

Step 7. Save and close the Excel file
CH8 ADJ TB
Step 1. From the Report Center, select Accountant & Taxes > Adjusted Trial Balance

Step 2. Select Date: This Month 12/01/2022 to 12/31/2022

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_08_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet: CH8 ADJ TB

Step 6. Highlight the adjusted frial balance account balances that changed as a result of
adjustments.
Step 7. Save and close the Excel file

UNIT 08 PROJECT (ON-YOUR-OWN)

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u08a2 Larrys Landscaping. This file is in your UNIT 08 folder.

Step 1: RESTORE the u08a2 Larrys Landcapaing.QBB file
Step 2: Make sure you SAVE to the UNIT 08 FOLDER

RENAME THE COMPANY

it e et e e e e e e e e e e e e e e e e e e e e e

After you have followed the instructions to restore your data files, you will find the company file
you have restored contains sample data fora company called Larry’s Landscaping. Your first

activity is to personalize that name fo meet your needs

follow these instructions: NOTE: The process to rename the
company is found in Appendix B
Step 1: From the Menu bar, select Company and will be repeated throughout

Step 2: Select MY COMPANY
Step 3: Select EDIT
Step 4: Update the Company Name Field to:

all the activities in the text.

YourName Larry’s Landscaping
Step 5: CLICK on OK
Step é: Close the My Company window.
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P8 TB

Step 1. Export to Excel the Trial Balance report for Larry’s Landscaping for This Fiscal
Quarter

Step 2. Dates: 10/01/2023 to 12/31/2023

Step 3. Follow the instructions in Appendix C to export the report fo the Excel file named

UNIT_08_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: P8 TB
Step 5. Save and close the Excel file

ADJUSTING ENTRIES

it e et e e e e e e e e e e e e e e e e e e e e e

Enter the following adjusting entries for Larry’s Landscaping

Date Entry Account Debit Credit
Number
12/31/2023 A108 6700 Depreciation (Expense) $575.00
1520 Accumulated Depreciation - $575.00
Truck
‘ Date Entry Account Debit Credit
Number
12/31/2023 A109 6900 Insurance (Expense) $100.00
Prepaid Insurance $100.00
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P8 ADJ JUR

Step 1. From the Report Center, select Accountant & Taxes = Adjusting Journal Entries

Step 2. Select Date: This Month 12/01/2023 to 12/31/2023

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_08_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet: P8 ADJ JUR

Step 6. Highlight the adjusted trial balance account balances that changed as a result of
adjustments.
Step 7. Save and close the Excel file
P8 ADJ TB
Step 1. From the Report Center, select Accountant & Taxes > Adjusted Trial Balance

Step 2. Select Date: This Month 12/01/2023 to 12/31/2023

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_08_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet. P8 ADJ TB

Step 6. Highlight the adjusted frial balance account balances that changed as a result of
adjustments.
Step 7. Save and close the Excel file

IMPORTANT ADJUSTMENT INFORMATION — FROM APPENDIX D

RECORDING DEBITS AND CREDITS

Five different types of accounts are listed below along with the effects that debits and credits
have on them.

Account Type Debit Credit
Asset Increase Decrease
Liability Decrease | Increase
Equity Decrease  Increase
Revenues (Income) Decrease | Increase
Expenses Increase Decrease

The following adjusted journal entry displays a depreciation expense record. Notice how the
number of the depreciation expense are in the expense costs category (60900). The account
number for the Accumulated Depreciation is in the asset category (17000).
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Make General Journal Entries

Main Reporis

«» B B X Beweiom ¢ @ 0 Q0 =
Find New Save Delete ﬁMemmize Reverse Print Aftach Hide Send
¥ File List GJEs
pate (1213112021 HE ENTRY NO. FAMZ010 & ADJUSTING ENTRY
ACCOUNT i DEBIT i CREDIT i MEMO i NAME i BILLABL..} CLASS
60900 - Depreciation Expense 44 43591 Record 2010 Depreciation -
p—

17000 - Accumulated Depreciation 44 43591 Record 2010 Depreciation

Expense
(increase)

Asset
(decrease)

Totals 4443591 4443591

List of Selected General Journal Entries: | Last Fiscal Year -

{ DATE ENTRY. NO. ADJ ACCOUNT MEMGC DEBIT/CREDIT(+/]

11213112021 62100 - Insurance:62120 - Liability Insurance July allocation of prepaid rider policy

121312021 FAM2010 60900 - Depreciation Expense Record 2010 Depreciation
:12#01#2[!21 13100 - Pre-paid Insurance
%111304‘2021 62100 - Insurance:62120 - Liability Insurance July allocation of prepaid rider policy
:11101!2021 13100 - Pre-paid Insurance

62100 - Insurance:62120 - Liability Insurance July allocation of prepaid rider policy

10312021

Save & Close

ACCOUNT NUMBERS

—
Account numbers are used to uniquely identify accounts. Usually account numbers are used as

a coding system to also identify the account type. For example, a typical numbering system for
accounts might be as follows:

10000 - 19999 Assets

20000 - 29999 Liabilities

30000 - 39999 Equity

40000 - 49999 Income or Revenue

50000 - 59999 Job Costs/Cost of Goods Sold
60000 - 69999 Overhead Costs or Expenses
70000 - 79999 OtherIncome

80000 - 89999 Other Expense

The five digits provide some growing room when new accounts need to be sandwiched into the
list in the right order. The five digits are used as follows:

v' First Digit—the first digitis the high-level account type (asset, liability, etc.)
v" Second Digit—the second two digits are used in account numbering
v"  LastTwo Digits—the Iast two digits are used in subaccount numbering

You can sfill override the standard numbering system to any system you'd like or avoid account
numbers altogether.
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STUDENT LESSON FILES
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You will find the following files in your Student files for UNIT 09.

e UO%al Rock Castle Constfruction

e U0%9a2 Larry's Landscaping

e UNIT_09_Reports
To complete the first lesson exercises, RESTORE the u0%9al Rock Castle Construction company file
from the UNIT 09 folder.

NOTE: The process to restore a backup is found in Appendix A.01 and will be repeated
throughout all the activities in the text.

RENAME THE COMPANY

=

e

e

e

e e

&

After you have followed the instructions fo restore your data files, you will find the company file
you have restored contains sample data for a company called Rock Castle Construction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 1. From the Menu bar, select Company

Step 2. Select MY COMPANY

Step 3. Select EDIT

Step 4. Update the Company Name Field fo: YourName Rock Castle Construction

Step 5. CLICK on OK

Step 6. Close the My Company window.
NOTE: The process to rename the company is found in Appendix B and will be repeated
throughout all the activities in the text.

ACCOUNTING CYCLE

The accounting cycle is a series of accounting activities that a business performs each
accounting period.

INPUT PROCESSING OUTPUT

— — E— —_

General Journal General Ledger
A

The accounting cycle usually consists of the following steps:
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v' Chart of Accounts — The Chart of Accounts is a list of all accounts used to accumulate
information about assets, liabilities, owners’ equity, revenues, and expenses. In
QuickBooks, the Chart of Accounts is created when the company is created; overtime,
the accounts are edited to meet the needs of the company.

v" Transactions. During the accounting period, record transactions with customers, vendors,
employees and owners.

v' Trial Balance. A Trial Balance lists each account and the account balance at the end of
the accounting period. Prepare a Trial Balance to verify that the accounting system is in
balance - total debits should equal total credits. An unadjusted Trial Balance is a Trial
Balance prepared before adjustments.

v Adjustments. Atthe end of the accounting period before preparing financial
statements, make any adjustments necessary fo bring the accounts up to date.
Adjustments are entered in the Journal using debits and credits.

v" Adjusted Trial Balance. Prepare an Adjusted Trial Balance (a Trial Balance after
adjustments) to verify that the accounting system still balances. If additional account
detail is required, Print the general ledger (the collection of all the accounts listing the
fransactions that affected the accounfs).

v" Financial Statements. Prepare financial statements for external users (Profit & Loss,
Balance Sheet, and Statement of Cash Flows). Prepare income tax summary reports and
management reports.

TRIAL BALANCE

___________________________________________________________________________________________________________________________|
A frial balance is a listing of the ledger accounts and their debit or credit balances to determine

that debits equal credits in the recording process. The accounts appear in this order: assets,
liabilities, stockholders' equity, dividends, revenues, and expenses. Within the asset’s category,
the most liquid (closest to becoming cash) asset appears first and the least liquid appears last.
Within the liabilities, those liabilifies with the shortest maturities appear first.

Preparing journal entries in a computerized system is different than in a manual system. The
computer normally asks for the number of the account to be debited. After you type the
account number, the computer shows the account title inits proper position. The cursor then
moves fo the debit column and waits for you to enter the amount of the debit. Then it asks if
there are more debits. If not, the computer prompts you for the account number of the credit.
After you type the account number, the computer supplies the account name of the credit and
enters the same amount debited as the credit. When there is more than one creditf, you can
override the amount and enter the correct amount. Then you would enter the other credit in the
same way. If your debits and credits are not equal, the computer warns you and makes you
correct the error. You can supply an explanation for the entry from a standard list or type itin. As
you enter the journal enfries, the computer automatically posts them to the ledger accounts. At
any time, you can have the computer print a frial balance.

MEMORIZED REPORTS

Step 1. From the Report Center, select Accountant & Taxes = Adjusted Trial Balance

Step 2. Select Dates: This Month. Because your company has enfries for December 2022,
it should automatically revert to 12/01/2022 to 12/31/2022

Step 3. Notice the Unadjusted (Trial) Balance columns contain account balances before
adjusting enfries.

Step 4. Notice the Adjustments columns contain the amounts for adjusting entrees at

December 31, 2022

CH9 ADJ TB
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Step 5. Export to Excel

Step 6. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_09_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CH9 ADJ TB

Step 8. Save and close the Excel file.

Leave the QuickBooks the Adjusted Trial Balance report open on your screen

Step 9. To memorize the Adjusted Trial Balance open on your screen, select the
Memorize bufton

Customize Report | Commenton Report Memorize print |v| E-mail v | Excel v | HideHeader =Collapse | Refresh
Dates  This Month * From 12012022 W To 1237208l SartBy Default - f
Report Basis: ® Accrual ()Cash  Show Filters
33 AM YourName Rock Castle Cong
e Adjusted Trial Balance
Accrual Basis December 2022
Balance Adjusted Balance
Debit Credit Debit Credit Debit Creait
10100 - Checking b 4598510 4 45,969.10
10300 - Savings 17,910.19 17,910.19
10400 - Petty Cash 500.00 500.00
11000 - Accounts Receivable 93,007.93 93,007.93
11100 - Interest Receivable 400.00 400.00
12000 - Undeposited Funds. 2,450.00 2,440.00
12100 - Inventory Asset 30683.38 30,683.38
12800 - Employee Advances 83200 83200
13100 - Pre-paid Insurance 4,050.00 12883 390147 b
13400 - Retainage Receivable 3,703.02 3,703.02
15000 - Furniture and Equipment 34,326.00 34,326.00
15100 - Vehicles 78,938.91 7893891
15200 - Buildings and Improvements 325,000.00 325,000.00
15300 - Construction Equipment 15,300.00 15,300.00
16900 - Land 50,000.00 90,000.00
17000 - Accumulated Depreciation 110,344.60 50,000.00 160,344.60
18700 - Security Deposits 1,720.00 1,720.00
20000 - Accounts Payable 26636.92 2663652
20500 - QuickBooks Credit Card 84.20 8420
20600 - Cal0il Credit Card 38262 38262
20300 - Interest Payable 3,000.00 3,000.00
21000 - Unearned Revenue 1,000.00 1,000.00
24000 - Payroll Liabilitie s:24010 - Federal Withholding 1,364.00 1,364.00
24000 - Payroll Liabilities:24020 - FICA Payable 2,118.82 211882
24000 - Payroll Liabilitie s:24030 - AEIC Payable o0.00 0.00
24000 - Payroll Liabilities:24040 - FUTA Payable 100.00 100.00
& Withnoldi

Step 10.  In the Name Field enter Rock Castle Construction Adjusted Trial Balance
Step 11.  Select Save in Memorized Report Group: Accountant

Step 12. Click OK

Step 13.  Close the Adjusted Trial Balance window

USE A MEMORIZED REPORT

.= .=

Step 1. You can access the Memorized reports from either the report center or the report
list. Depending on the type of method you choose, select the memorized report
you just created.

Step 2. Select Accountant on the left of the Report Center window or on the right of the
report list.

Step 3. When the Memorized List window appears, double-click Rock Castle
Construction Adjusted Trial Balance fo display the Adjusted Trial Balance

.=

.=

B =

.=
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Step 4. At this point, you can make any changes as needed, such as the date. In this
case, select Cancel since we have already exported the report.

o General Ledger Joumal Eniries Entered Today

Memorized Report

o Dates: Tooay
visz022 s 1002

(> s CReOm

Dates:  This Menih-o-date
nmn 2

QR @®

i

PROFIT AND LOSS

R

e

e

QuickBooks permits you to prepare the Profit and Loss Statement using either accrual or the cash
basis. The program also permits you to prepare Profit and Loss Statements monthly, quarterly, or
annually.

e

e e

=

CH9 PL STD
Step 1. From one of the report options, select Company & Financial - Profit and Loss
Standard
Step 2. Select Dates: This Fiscal Year. The dates should appear as 01/01/2022 To
12/31/2022.

Step 3. Click the Customize Report option.

Step 4. Click the Display tab

Step 5. Select Report Basis: Accrual

Step 6. In the Columns by option, select Display columns by Quarter across the top.

Step 7. Click OK

Step 8. Export to Excel

Step 9. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_09_REPORTS Excel file.

Step 10.  From the drop-down list, select the sheet: CH9 PL STD

Step 11.  Highlight the highest total for 40130 Labor Income

Step 12.  Save and close the Excel file.

CH9 BAL STD
Step 1. From one of the report opfions, select Company & Financial = Balance Sheet
Standard
Step 2. Select Dates: This Fiscal Year. The dates should appear as 01/01/2022 To

12/31/2022.
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Step 3. Click the Customize Report opftion.

Step 4. Click the Display tab

Step 5. Select Report Basis: Accrual

Step 6. In the Columns by option, select Display columns by Quarter across the top.

Step 7. Click OK

Step 8. Export to Excel

Step 9. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_09_REPORTS Excel file.

Step 10. From the drop-down list, select the sheet: CH9 BAL STD

Step 11.  Highlight the negative balances in the balance sheet

Step 12.  Save and close the Excel file.

STATEMENT OF CASH FLOWS

R

e

e

e

e

The statement of cash flows shows the cash inflows and outflows for a company over a specific
period. The headings and elements of each statement are similar from company to company.
The cash inflows and cash outflows from operating, investing, and financing activities are
displayed on the Statement of Cash Flows Report. Operating activities generally include the
cash effects of fransactions and other events that pass in the determination of net income.

e

=

CH9 SCF
Step 1. From one of the report options, select Company & Financial > Statement of Cash
Flows
Step 2. Select Dates: This Fiscal Year. The dates should appear as 01/01/2022 To
12/31/2022.

Step 3. Click the Customize Report opftion.
Step 4. Click the Display tab
Step 5. Click the Advanced option
a. Display Rows: Active
b. Display Columns: Non-zero
c. Reporting Calendar: Fiscal Year
Step 6. Click OK
Step 7. Export to Excel
Step 8. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_09_REPORTS Excel file.
Step 9. From the drop-down list, select the sheet: CH9 SCF
Step 10. Save and close the Excel file.

TAX REPORTS

I —————
When you use the QuickBooks accounting software, you can set up a list of accounts into

different categories such as liabilities, assets, expenses and income. When you want to review
information about a line item in the program, you need fo set up an individual account for that
line item. The same holds true if you want to report financial information on a tax return — you
need to create aspecific account to report and collect the data.

ADDING AN EXPENSE ACCOUNT TO A TAX LINE

o
=

e
——

e
——

e
——

e
——

Go to the "Tax-Line Mapping” screen or menu in QuickBooks and select the tax form you want
fo use. You will find a drop-down menu where you can select the tax line that corresponds with

e
——

)
=
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the expense account data. After selecting the tax line, use the drop-down menu to assign the
new expense account that you created or one that you previously established.

EXISTING ACCOUNTS

To assign an existing expense account to a tax line in QuickBooks, open the “Chart of Accounts”
menu and highlight the appropriate expense account. Right-click over the name of the
account with your mouse and select “Edit Account.” Then choose the option to adjust the “Tax-
Line Mapping” information from the menu that appears. Use the following drop-down menus to
choose the appropriate tax form and tax line.

YOUR ACCOUNTANT

o
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If your accountant has access to the data you record in QuickBooks, it may be best to have this
individual assign the expense accounts fo tax lines. Some accountants prefer to do this task
themselves because it helps ensure bookkeeping accuracy and consistency. To prevent the
need fo backirack through potentially incorrect data in the future, consult with your accountant
before adjusting your expense accounts and their tax lines.
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Once the Chart of Accounts has been updated to include the important tax line mapping,
QuickBooks has three different reports that are available:

1. Income Tax Preparation report. Lists the assigned tax line for each account.

2. Income Tax Summary report. Summarizes income and expenses that should be listed on
a business income fax refurn.

3. Income Tax Detdail report. Provides more detailed information about the income or
expense amount appearing on each tax line of the Income Tax Summary report.

CH9? INC TAX

Step 1. From one of the report options, select Accountant & Taxes = Income Tax
Preparation

Step 2. Select Dates: This Tax Year. The dates should appear as 01/01/2022 To 12/31/2022.

Step 3. Click the Customize Report option.

Step 4. Click the Display tab

Step 5. Select Report Basis: Accrual

Step 6. Click OK

Step 7. Export to Excel

Step 8. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_09_REPORTS Excel file.

Step 9. From the drop-down list, select the sheet: CH? INC TAX

Step 10.  Highlight the account(s) assigned to B/S Assetfs: Land

Step 11.  Save and close the Excel file.

CHANGE THE TAX LINE

B
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Step 1. From the Home Page, select Chart of Accounts

Step 2. From the chart of Accounts window, right-click on the account: 63100 Postage

Step 3. Select Edit Account

Step 4. When the Edit Account window appears, change the Tax-Line Mapping from
Unassigned to: Other Deductions: Postage & Delivery

Step 5. To save the changes, click Save and Close

Step 6. Close the Chart of Accounts window.
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CHANGE THE FOLLOWING TAX LINES

54000 Job Expenses COGS-Form 1125-A: Add’l 263A Costs
54100 Bond Expense COGS-Form 1125-A: Add’l 263A Costs
54200 Equipment Rental COGS-Form 1125-A: Add’'l 263A Costs
54300 Job Materials COGS-Form 1125-A: Add’| 263A Costs
54400 Permits and Licenses COGS-Form 1125-A: Add’l 263A Costs
54500 Subcontractors COGS-Form 1125-A: Cost of Labor
54520 Freight and Delivery COGS-Form 1125-A: Cost of Labor
54599 Less Discounts Taken COGS-Form 1125-A: Other Costs

CH? INC TAX-2

Step 1.

Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.
Step 8.

Step 9.

From one of the report options, select Accountant & Taxes = Income Tax
Preparation

Select Dates: This Tax Year. The dates should appear as 01/01/2022 To 12/31/2022.
Click the Customize Report opfion.

Click the Display tab

Select Report Basis: Accrual

Click OK

Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_09_REPORTS Excel file.

From the drop-down list, select the sheet: CH9 INC TAX-2

If you are not familiar with MS Excel, there are a few easy steps that should be followed to view
your exports for accounts:

Step 10.
Step 11.

Step 12.

Page | 213

With your Excel worksheet in view, hold down your CTRL key and Hit the letter A
(CTRL+A). This keystroke combination selects the enfire worksheet.

Be careful not to select any of the individual cell in the worksheet and click on
the Home ribbon band. In the cells group, Click on the more opftion for Format
Select AutoFit Column Width
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Step 13.  Highlight the changed tax lines you have added
Step 14.  Save and close the Excel file.

INCOME TAX SUMMARY REPORT
I A——
After the Tax Line for each account is correct, the company isready to print an Income Tax

Summary report. The Income Tax Summary report lists sales and expenses that should appear on
the business federal tax return filed with the IRS.

When beginning a business, you must decide what form of business enfity to establish. Your form
of business determines which income tax return form you have to file. The best course of action is
to consult with a certified tax professional before you choose what tax forms to use.

The most common forms of business are the sole proprietorship, partnership, corporation, and S
corporation. A Limited Liability Company (LLC) is a business structure allowed by state statute.
Legal and tax considerations entfer into selecting a business structure.

e Sole Proprietorships

e Partnerships

e Corporations

e S Corporations

e Limited Liability Company (LLC)

SOLE PROPRIETORSHIP
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A sole proprietforship is easy to form and gives you complete control of your business. You're
automatically considered to be a sole proprietorship if you do business activities but don't
register as any other kind of business.

&

Sole proprietorships do not produce a separate business entity. This means your business assets
and liabilities are not separate from your personal assets and liabilities. You can be held
personally liable for the debts and obligations of the business. Sole proprietors are still able to get
a trade name. It can also be hard to raise money because you can't sell stock, and banks are

hesitant to lend to sole proprietorships.
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Sole proprietorships can be a good choice for low-risk businesses and owners who want fo fest
their business idea before forming a more formal business.

PARTNERSHIP
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Partnerships are the simplest structure for two or more people to own a business together. There
are two common kinds of partnerships: limited partnerships (LP) and limited liability partnerships
(LLP).

Limited partnerships have only one general partner with unlimited liability, and all other partners
have limited liability. The partners with limited liability also tend fo have limited control over the
company, which is documented in a partnership agreement. Profits are passed through to
personal tax returns, and the general partner — the partner without limited liability — must also
pay self-employment taxes.

Limited liability partnerships are similar to limited partnerships but give limited liability to every
owner. An LLP protects each partnher from debts against the partnership, they won't be
responsible for the actions of other partners.

Partnerships can be a good choice for businesses with multiple owners, professional groups (like
aftorneys), and groups who want to test their business idea before forming a more formal
business.

LIMITED LIABILITY COMPANY (LLC)
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An LLC letfs you take advantage of the benefits of both the corporation and partnership business
structures.

LLCs protect you from personal liability in most instances, your personal assets — like your vehicle,
house, and savings accounts — won't be atrisk in case your LLC faces bankruptcy or lawsuits.

CORPORATION
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In general, a corporation has all the legal rights of an individual, except for the right to vote and
certain other limitations. Corporations are given the right to exist by the state that issues their
charter. If you incorporate in one state to take advantage of liberal corporate laws but do
business in another state, you'll have to file for "qualification" in the state in which you wish to
operate the business. There's usually a fee that must be paid to qualify to do business in a state.

In forming a corporation, prospective shareholders exchange money, property, or both, for the
corporation's capital stock. A corporation generally takes the same deductions as a sole
proprietorship fo figure its faxable income. A corporation can also take special deductions. For
federal income fax purposes, a C corporation isrecognized as a separate taxpaying entity. A
corporation conducts business, realizes net income orloss, pays taxes and distributes profifs to
shareholders.

CH9 TAX SUM
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Step 1. From one of the report options, select Accountant & Taxes =2 Income Tax
Summary Report

Step 2. Select Dates: This Tax Year. The dates should appear as 01/01/2022 To 12/31/2022.

Step 3. Click the Customize Report opfion.

Step 4. Click the Display tab

Step 5. Select Report Basis: Accrual
Step 6. Click OK
Step 7. Export to Excel. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_09_REPORTS Excel file. From the drop-down list, select the
sheet: CH? TAX SUM

Step 8. Highlight - The areas of this report that changed because of the changes you
made to the tax line. Save and Close the Excel file.

CH9 TAX DET

If you need to view a detail for the line items shown on the Income Tax Summary Report, the
Income Tax Detail report is used.

Step 1. From one of the report options, select Accountant & Taxes = Tax Detail Report
Step 2. Select Dates: This Tax Year. The dates should appear as 01/01/2022 To 12/31/2022.
Step 3. Click the Customize Report option.

Step 4. Click the Display tab

Step 5. Select Report Basis: Accrual
Step 6. Click OK
Step 7. Export to Excel. Follow the instructions in Appendix C to export the report fo the

Excel file named UNIT_09_REPORTS Excel file. From the drop-down list, select the
sheet: CH9 TAX DET

Step 8. Highlight - The Total Add’l section 263A costs. Save and Close the Excel file.
MANAGEMENT REPORTS

|
Reports used by management do not have to follow a specified set of rules such as the Internal
Revenue Code. Instead, management reports are prepared as needed to provide
management with information for making operating and business decisions.

Management reports include the following:

Cash Flow Forecast

Accounts Receivable Aging (Unit 04)
e Accounts Payable Aging (Unit 05)
Inventory Report (Unit 06)
Budgets

CASH FLOw FORECAST

B
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The cash flow forecast enables companies to project whether they will have enough cash fo
pay bills when they are due. If it appears that additional cash may be needed, the company
may arrange for a loan or line of credit to pay bills. The Cash Flow Forecast report lists projected
cash flows and cash outflows.

.=

&

CH9 CASH FLOW

Step 1. From one of the report options, select Company & Financial - Cash Flow
Forecast
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Step 2. Select Dates: Next 4 Weeks. The dates should appear as 12/11/2022 To
01/07/2023.

Step 3. Export to Excel. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_09_REPORTS Excel file.

Step 4. From the drop-down list, select the sheet: CH9 CASH FLOW

FINANCIAL INSIGHTS

___________________________________________________________________________________________________________________________|
The accounting cycle addresses the logistics of making certain the accounting system balances
with the frial Balance, making necessary adjustments to bring accounts up to date, and
preparing financial reports. Entrepreneurs often need more than this from financial software.
QuickBooks offers an Insights digital dashboard to assist entrepreneurs in this endeavor.

Follow these instructions to view the Insights for Rock Castle Construction:

Step 1. From the Home Page, select: Insights
Step 2. Select the arrow to the right of the screen to advance to the next insight
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Step 3. Notice in the yearly comparison how Rock Castle's income has increased in 2022
Step 4. Select the right arrow again fo advance to the next insight.
Step 5. This insight shows the top customers by sales.
Step 6. Write down the top Customer’'s name here. You will be
asked to enter the name in the Quiz for this Unit.
CH9 PL VERT
Step 1. From one of the report opfions, select Company & Financial = Profit & Loss
Standard
Step 2. Select Dates: This Fiscal Year. The dates should appear as 01/01/2022 To
12/31/2022.

Step 3. Click the Customize Report button
Step 4. Use the Display tab
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Step 5. Report Basis: Accrual

Step 6. Columns: Total Only

Step 7. Sort by: Default Ascending Order

Step 8. Add sub columns for: % of Income

Step 9. Click OK

Step 10. Export to Excel. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_09_REPORTS Excel file.

Step 11. From the drop-down list, select the sheet: CH9 PL VERT

Step 12.  Highlight - The single largest expense as a percentage of income

Step 13.  Highlight - The profit margin (net income as a percentage of sales)

Step 14. Save and Close the Excel file

CH9 BS VERT

Step 1. From one of the report options, select Company & Financial & Balance Sheet
Standard

Step 2. Select Dates: This Fiscal Year. The dates should appear as of 12/31/2022

Step 3. Click the Customize Report button

Step 4. Use the Display tab

Step 5. Report Basis: Accrual

Step 6. Columns: Total Only

Step 7. Sort by: Default Ascending Order

Step 8. Add sub columns for: % of Column

Step 9. Click OK

Step 10. Export to Excel. Follow the instructions in Appendix C to export the report fo the
Excel file named UNIT_09_REPORTS Excel file.

Step 11. From the drop-down list, select the sheet: CH9 BS VERT

Step 12.  Highlight - The asset that represents the largest percentage of total assets

Step 13.  Highlight - The percentage of assets financed with debt. (HINT: What is the
percentage of total liabilities?)

Step 14.  Save and Close the Excel file

CH9 GL

Step 1. From one of the report options, select Accountant & Taxes 2 General Ledger

Step 2. Select Dates: 12/15/2022 to 12/31/2022

Step 3. Click the Customize Report button

Step 4. Use the Display > Advanced

Step 5. Include: In Use

Step 6. Open Balance/Aging: Report Date

Step 7. Click OK

Step 8. Click the Filters tab > Account > All Assets

Step 9. Include split detail2 No

Step 10.  Click OK

Step 11. Export to Excel

Step 12.  Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_09_REPORTS Excel file.

Step 1. From the drop-down list, select the sheet: CH? GL

Step 2. Highlight - The account on your General Ledger report where you think the
accountant found the missing cash last year.

BACKUP YOUR COMPANY FILE

Y Y Y Y Y Yy,
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Use the instructions in Appendix A to back up your company file. Make sure your
backup file is savedin the designated folder of this unit (UNIT 09 BACKUPS).

UNIT 09 PROJECT (ON-YOUR-OWN)

Follow the instructions in Appendix A (Backup & Restore QuickBooks Files) to restore the starter
file for u09a2 Larrys Landscaping. This file is in your UNIT 09 folder.

Step 1: RESTORE the u09a2 Larrys Landcapaing.QBB file
Step 2: Make sure you SAVE to the UNIT 09 FOLDER

RENAME THE COMPANY

Y Y Y Y Y Yy,
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After you have followed the instructions to restore your data files, you will find the company file
you have restored contfains sample data for a company called Larry’s Landscaping. Your first
activity is to personalize that name to meet your needs follow these instructions:

Step 1: From the Menu bar, select Company

Step 2: Select MY COMPANY

Step 3: Select EDIT

Step 4: Update the Company Name Field to: YourName Larry’s Landscaping

Step 5: CLICK on OK
Step 6: Close the My Company window.
DISPLAY THE ACCOUNT NUMBERS

Step 1. Edit > Preferences - Accounting > Company Preferences 2> Use Account
numbers
P9 PL
Step 1. From one of the report options, select Company & Financial > Profit & Loss
Standard
Step 2. Select Dates: 01/01/2023 o 12/31/2023
Step 3. Export to Excel. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_09_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: P9 PL

Step 5. Highlight - The item that generates the most income (revenue) for Larry’s
Landscaping.

Step 6. Save and Close the Excel file

P9 PL VERT

Step 1. From one of the report options, select Company & Financial 2> Profit & Loss
Standard

Step 2. Select Dates: 01/01/2023 to 12/31/2023

Step 3. Customize the report to show a vertical analysis of each item as a percentage of
income.

Step 4. Export to Excel. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_09_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: P9 PL VERT

Step 6. Highlight = The single largest expense as a percentage of income
Step 7. Highlight - The profit margin (net income as a percentage of sales)
Step 8. Save and Close the Excel file
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P9 BS

Step 1. From one of the report options, select Company & Financial & Balance Sheet
Standard
Step 2. As of: 12/31/2023
Step 3. Export to Excel. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_09_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet. P9 BS
Step 5. Save and Close the Excel file
P9 BS VERT
Step 1. From one of the report options, select Company & Financial > Balance Sheet
Standard
Step 2. As of: 12/31/2023
Step 3. Customize the report to show a vertical analysis of each item as a percentage of
total assets.
Step 4. Export to Excel. Follow the instructions in Appendix C to export the report fo the
Excel file named UNIT_09_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: P9 BS VERT
Step 6. Highlight - The asset that represents the largest percentage of total assefs.
Step 7. Highlight - The percentage of assets financed with debt. (HINT: What is the
percentage of total liabilities?)
Step 8. Save and Close the Excel file
P9 SCF
Step 1. Open the Statement of Cash Flows
Step 2. Dates: 01/01/2023 to 12/31/2023
Step 3. Export to Excel. Follow the instructions in Appendix C fo export the report fo the
Excel file named UNIT_09_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: P9 SCF
Step 5. Save and Close the Excel file
P9 AR AGING
Step 1. Open the Accounts Receivable (A/R) Aging Summary
Step 2. As of: 12/31/2023
Step 3. Export to Excel. Follow the instructions in Appendix C fo export the report fo the
Excel file named UNIT_09_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: P9 AR AGING
Step 5. Save and Close the Excel file
P9 AP AGING
Step 1. Open the Accounts Payable (A/P) Aging Summary
Step 2. As of: 12/31/2023
Step 3. Export to Excel. Follow the instructions in Appendix C fo export the report fo the
Excel file named UNIT_09_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: P9 AP AGING
Step 5. Save and Close the Excel file

BACKUP YOUR COMPANY FILE
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Use the instructions in Appendix A to back up your company file. Make sure your
backup file is savedin the designated folder of this unit (UNIT 09 BACKUPS).
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To create a new company data file in QuickBooks, use the EasyStep Inferview. The EasyStep
Interview asks you a series of questions about your business. Then QuickBooks uses the
information tfo customize QuickBooks fo fit your business needs.

Four opftions for how to set up a new company are:

Express Start: Recommended for new QuickBooks users, this option will ask you a

few basic questions and do the rest for you.

Detailed Start: This opftion lets you control the setup and fine-tune the company file to
meet your specific needs.

Create: This choice permits you to create quickly a new company file by

copying the preferences and key lists from an existing company.

Other Options: This opfion lefs you convert data from Quicken or other

accounting software to create a new QuickBooks company file.

EASY STEP INTERVIEW

Create a new QuickBooks company using the EasyStep Interview as follows:

Step 1. Select Create a new company

Step 2. When the QuickBooks Setup window appears, select Detailed Start

Step 3. When your Company Information window appears, entfer

Step 4. Company Name: YourName Paint Palette. Press the Tab key, and QuickBooks

will automatically enter the company name in the Legal name field. Since the
company willdo business under its legal name, the Company name and Legal
name fields are the same.

Step 5. Enter the company information.
Tax ID 333-22-4444
Address 333 Universe Boulevard
City Bayshore
State CA
Zip 94326
Phone 800-555-1358
Email <Enter your email address>
Step 6. Select Next
Step 7. In the Select Your Industry window, select General Service-based Business
Step 8. Select Next
Step 9. When the How Is Your Company Organized? window appears, select Sole

Proprietorship.
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How your business enfity isorganized (Sole Proprietorship, Partnership, Limited Liability
Partnership (LLP). Limited Liability Company (LLC). C Corporation. S Corporation. or Non-
Profit) determines which fax form and tfax lines you use.

Step 10.
Step 11.
Step 12.
Step 13.
Step 14.
Step 15.
Step 16.
Step 17.

Step 18.

Step 19.
Step 20.

Select Next

Select the first month of your fiscal year: January
Select Next

In the Set Up Your Administrator Password window:
Enfter your administrator password (Cuestal23)
Retype the password

Select Next.

When the Create Your Company File window appears, click Next fo choose
a file name and location fo save your company file.

When the File name for New Company window appears, select save in the
folder created for UNIT 10

Enter File name: Your Name Paint Palette

Click Save

CUSTOMIZE THE QUICKBOOKS COMPANY
O

The My Shortcuts window should appear on the left side of your QuickBooks company

screen. The next section of the Easy-Step Interview is to customize QuickBooks by furning on
features to fit your business needs

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 7.
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When the What Do You Sell2 window appears:

a. Select Services only

b. Click Next

When asked "Do you charge sales taxe"

a. Select No

b. Click Next

When asked "Do you want to creafe estimates in QuickBooks?2"
a. Select Yes

b. Click Next

When the Using Statements in QuickBooks window appears:
a. "Do you want to use billing statements in QuickBookse" Select Yes
b. Click Next

When the Using Progress Invoicing window appears:

a. "Do you want to use progress invoicing?" Select No

b. Click Next

When the Managing Bills You Owe window appea rs:

a. "Do you want to keep track of bills you owe?2" Select Yes
b. Click Next

When the Tracking Time in QuickBooks window appears :
a. "Do you want to frack time in QuickBooks?2" Select Yes

b. Click Next




Step 8. When the Do You Have Employees? window appears:
a. Select No
b. Click Next
Step 9. Read the Using Accounts in QuickBooks window . Click Next.
Step 10. When the Select a Date to Start Tracking Your Finances window appears:
a. Select Use today 's date or the first day of the quarter or month
b. Enter Date 01/01/2023
c. Click Next
Step 11. When the Review Income and Expense Accounts window appears, click Next
Step 12. When the Congratulations! window appears, click Go to Setup

QUICKBOOKS COMPANY SETUP

I ————
After the EasyStep Inferview is finished, you can start using the QuickBooks company file or
you can finish the company setup using the following QuickBooks Setup window. Complete
the following steps to customize your QuickBooks Company file:
Step 1. In the Add the People You Do Business With section of the
QuickBooks Setup window, click the Add button
Step 2. You have several options for how fo add information about
people you do business with as shown in the following Add
the People You Do Business With window. Select Paste from
Excel or enter manually.
Step 3. Select Continue
Step 4. When the Select Who to Add window appears, entfer the
following information about your first customer, Sofia Rafael.

Name Rafael, Sofia

First Name Sofia

Last Name Rafael

Email sofiarafael@ewww.com
Phone 415-555-5432
Address 32 North Avenue

City, State, Zip Bayshore, CA 94326
Contact Name Sofia Rafael

Step 5. Select Customer radio button for Sofia Rafael

ADD VENDOR

B

Move fo the next line and enter the following information about Brewer Paint
Supplies
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Name Brewer Paint Supplies
Company Name Brewer Paint Supplies
Email brewerpaint@www.com

Page | 225



mailto:sofiarafael@www.com

Phone 415-555-6372
Address 18 Spring Street
City, State, Zip Bayshore, CA 94326
Contact Name Mark Brewer
Step 1. Select Vendor radio button for Brewer Paint Supplies
Step 2. Click Continue
Step 3. If you had opening balances, you could enter those now.

Instead, click Continue

ADD THE PRODUCTS AND SERVICES YOU SELL

B
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The products and services you sell are entered into the Item List. As you know from Unit 06,
the Item List contains information about service items, inventory items, and non-inventory
items. Paint Palette plans to sell four different service items to customers:

1. Labor: mural painting
2. Labor: faux painting

3. Labor: inferior painting
4. Labor: exterior painfing

In the products and services, you sell section of the QuickBooks Setup window, follow these
steps:

Step 1. Select the Add button

Step 2. Select ltem type Service

Step 3. Select Continue

Step 4. Enter the following information about the new service item:
Name: Labor
Descripfion: Painting Labor
Price: 0.00

Step 5. Click Continue

Step 6. Click Continue again to return fo the QuickBooks Setup window.

ADD BANK ACCOUNTS

B
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.=

.= .=
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Bank accounts in QuickBooks are used fo frack your company's deposits, payments, and current
bank balances. A QuickBooks company file can have more than one bank account. For

example, some companies use one bank account for payroll and another bank account for all
other banking items.

To add a bank account for Paint Palette, follow these steps:

Step 1. In the Add Your Bank Accounts section of the QuickBooks Setup window,
click the Add
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Step 2. Enter the following information about Paint Palette's bank account:

Account Name Checking
Account Number 123456789
Opening Balance 0.00

Opening Balance Date | 01/01/2023
Step 3. Click Continue

Step 4. When asked if you want to order checks designed for QuickBooks, select
No Thanks

Step 5. Click Continue to return to the QuickBooks Setup window

Step 6. Select Start Working at the bottom of the QuickBooks Setup window

Step 7. When the New Feature Tour window appears, explore the new features
including the Invoice Status Tracker and Check to Pay Bills

Step 8. Close the New Feature Tour window

ADD A JOB
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Before exporting the Customer List, lef's add a new job for Sofia Rafael.

Step 1. To add a new job, first display the Customer Center by selecting
Customers on the Navigation Bar

Step 2. Select Sofia Rafael in the Customers & Jobs List, then right-click to
display the pop-up menu. Select Add Job.

Step 3. Enter the following information into the New Job window:
Job Name Dining Room
Opening Balance: 0.00
As of: 01/01/2023
Job Description: Dining Room Landscape Mural
Job Type: <Add New> Mural
Job Status: Awarded
Start Date: 01/03/2023

Step 4. Click OK fo save

CH10 CUS
Step 1. From the Customer & Receivables Reports, Export the Customer
Contact List to Excel
Step 2. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_10_REPORTS Excel file.
Step 3. From the drop-down list, select the sheet: CH10 CUS

Step 4. Save and close the Excel file.
CH10 VEN
Step 1. From the Vendors & Payables Reports, Export the Vendor Contact
List to Excel
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Step 2. Follow the instructions in Appendix C fo export the report to the
Excel file named UNIT_10_REPORTS Excel file.

Step 3. From the drop-down list, select the sheet: CH10 VEN
Step 4. Save and close the Excel file.
CH10 ITM
Step 1. From the Lists Reports, Select the ltem Listing
Step 2. Select Date: 01/01/2023
Step 3. Export to Excel
Step 4. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_10_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: CH10 ITM
Step 6. Save and close the Excel file.
FEATURES
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Notice that the Home Page for Paint Palette differs from the Home Page for Rock Castle
Construction in the following ways:

1. The Vendors section of the Home Page for Paint Palette does notinclude
Purchase Orders, Receive Inventory, and Enter Bills Against Inventory icons.
During the company setup, you indicated that Paint Palette was a service
company. Since you will not be selling a product, you will not be fracking
inventory for resale.

2. Also nofice that the Employees section does not include the Pay
Employees, Pay Liabilities, and Process Payroll Forms icons. During the
company setup, you indicated that there were no employees, so these
icons are not needed for Paint Palette.

VERIFY COMPANY INFORMATION
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To enter additional company information:

Step 1. Select My Company on the Navigation Bar
Step 2. Select Edit

Step 3. Verify the Company Name: YourName Paint Palette
Step 4. Click OK

Step 5. Verify the Income Tax Form: Form 1040 (Sole Proprietor)
Step 6. Close the Company window

CUSTOMIZE PREFERENCES
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Customize your QuickBooks Preferences:

Step 1. Select Edit > Preferences > General > My Preferences

Step 2. Select Default Date to Use for New Transactions: Use the last entered date as
default

Step 3. Select Desktop View > My Preferences - Show Home Page when opening a

company file
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Step 4. To customize the appearance of your QuickBooks, select Company File Color
Scheme
Step 5. Click OK fo close the preferences window

CusTOMIZE CHART OF ACCOUNTS
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The Chart of Accounts is a list of all the accounts Paint Palette will use when maintaining ifs
accounting records. The Chart of Accounts islike a table of contents for accounting records.

e

e

e

e
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In the Easy-Step Interview, when you selected General Service-based Business as the type of
industry, QuickBooks automatically created a Chart of Accounts for Paint Palette. Then
QuickBooks permits you to customize the Chart of Accounts to fit your accounting needs.

Step 1. Click Chart of Accounts icon in the Company section of the Home Page
Step 2. Notice that the Chart of Accounts does not list the account numbers
Step 3. Select Edit > Preferences - Accounting

Step 4. Select the Company Preferences tab

Step 5. Select Use account numbers

Step 6. Uncheck Warn if fransactions are 30 day(s) in the future

Step 7. Click OK

Step 8. Your Chart of Accounts should now display account numbers preceding

the account fitles.

ADD NEW ACCOUNTS
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Paint Palette will be purchasing a new computer. To account forthe computer, you will need to
add the following three accounts to the Chart of Accounts:

v Account Computer

v Subaccount Computer Cost
v Subaccount Accumulated Depreciation Computer

The Computer Cost subaccount contains the original cost of the computer. The Accumulated
Depreciation subaccount for the computer accumulates all depreciation recorded for the
computer overits useful life. The parent account, Computer, will show the net book value of the
computer (cost minus accumulated depreciation).

Step 1. From the company section of the Home page, Click Chart of Accounts

Step 2. Click Account > New

Step 3. From the Account type, Select Fixed Asset (major purchases)

Step 4. Click Continue

Step 5. When the Add New Account window appears, select Account Type: Fixed
Asset

Step 6. Enter Account Number: 14100

Step 7. Enter Account Name: Computer

Step 8. Enter Description: Computer

Step 9. Select Tax Line: <Unassigned>

Step 10. Click Save & New fo enter another account
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ADD NEW SUB ACCOUNT

R

e

e

e

e

When a blank Add New Account window appears, add a Computer Cost sub account as
follows:

e

&

Step 1. Account Type: Fixed Asset
Step 2. Account Number: 14200

Step 3. Account Name: Computer Cost
Step 4. Subaccount of: 14100 Computer
Step 5. Descripfion: Computer Cost
Step 6.  Tox Line: <Unassigned>
Step 7. Click Save & New

ADD THE ACCUMULATED DEPRECIATION ACCOUNT

B

.=

.=

.=

L e L
B R S S S SRS S e

Step 1. Account Type: Fixed Asset

Step 2. Account Number: 14300

Step 3. Account Name: Accumulated Depr Computer

Step 4. Subaccount of: 14100 Computer

Step 5. Description: Accumulated Depreciation Computer
Step 6. Tax Line: <Unassigned>

Step 7. Click Save & Close

CH10 COA

Step 1. From the Reports section select List (or Accountant & Taxes) > Account Listing
Step 2. Select Date: 01/01/2023
Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_10_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet: CH10 COA
Step 6. Save and close the Excel file.

RECORD OWNER’S INVESTMENT

|
To launch your new business, you invest $10,000 in Paint Palette. In order to keep business

records and your personal records separate, you open a business Checking account at the
local bank for Paint Palette. You then deposit your personal check for $10,000 in the business
Checking account.

In Units 2 and 3 you recorded deposifs using the Record Deposits icon in the Banking section of
the Home Page. You can also record deposifs directly in the Check Register.

QuickBooks then fransfers the information to the Make Deposits window.

Step 1. Click the Record Deposits icon in the Banking section of the Home Page
Step 2. In the Make Deposits window, select Deposit To: Checking
Step 3. Select Date: 01/01/2023
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Step 4. On the Received From drop-down list, select <Add New>. Select Other ,
then click OK.

Step 5. EnterName : YourName. Click OK.

Step 6. Account: 30000: Opening Balance Equity. Press the Tab key.

Step 7. Memo: Invested $10,000 in business

Step 8. Check No.: 1001

Step 9. Payment Method: Check

Step 10. Amount: 10,000.00
Step 11. Select the Save icon at the top of the Make Deposits window

CH10 JUR

Step 12. Select the Journal icon at the top of the Make Deposits window

Step 13. Export the Transaction Journal fo Excel

Step 14. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_10_REPORTS Excel file.

Step 15. From the drop-down list, select the sheet: CH10 JUR

Step 16. Save and close the Excel file.

Step 17. Close the Transaction Journal window and the Make Deposits window

VENDOR AND EXPENSE TRANSACTIONS
.

Vendor and expense fransactions can be either purchases made with a check or credit
card or credit purchases on account that will be paid later.

RECORD VENDOR AND EXPENSE TRANSACTIONS USING THE WRITE CHECKS WINDOW

e e e e e e e e e e e e

Paint Palette purchased a computer for $3,000. Because Paint Palette paid by check
at the purchase, you can use the Write Checks window to record the purchase.

Step 1. Click the Write Checks icon in the Banking section of the Home Page
Step 2. In the following Write Checks window, select Bank Account: Checking
Step 3. Select Date: 01/01/2023

Step 4. Pay to the Order of <Add New Vendor> : Cornell Technologies

Step 5. Amount: 3000.00

Step 6. Account: 14200 Computer Cost

Step 7. Check: Print Later

Step 8. Select the Save icon atf the top of the Write Checks window

CH10 JUR-2

Step 9. Select the Reports tab > Transaction Journal

Step 10.  Export the Transaction Journal report to Excel

Step 11. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_10_REPORTS Excel file.

Step 12. From the drop-down list, select the sheet: CH10 JUR-2
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Step 13.
Step 14.

Save and close the Excel file.
Close the Transaction Journal window and Write Checks windows

ENTER CREDIT PURCHASES

Step 1. Click the Enter Bills icon in the Vendors section of the Home Page

Step 2. Select Date: 01/03/2023

Step 3. Select Vendor : Brewer Paint Supplies

Step 4. Enter Amount Due: 450.00

Step 5. Select Terms: Net 30

Step 6. Click the Expenses tab

Step 7. Select Account <Add New>: 64800 Paint Supplies Expense

Step 8. Select Customer & Job: Rafael, Sofia: Dining Room

Step 9. Verify that Billable is checked

Step 10. Select the Save icon at the top of the Enter Bills window . If
asked if you want to make the change in payment terms
permanent, select Yes.

CH10 JUR-3

Step 15. Select the Reports tab > Transaction Journal

Step 16.  Export the Transaction Journal report to Excel

Step 17. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_10_REPORTS Excel file.

Step 18. From the drop-down list, select the sheet: CH10 JUR-3

Notice that QuickBooks records the bill as accounts payable, indicating that Paint Palette
has an obligation to pay these amounts to vendors. QuickBooks increases liabilities
(accounts payable) on the company's Balance Sheet.

RECORD MEMORIZED TRANSACTION

Often a transaction is recurring, such as monthly rent or ufility payments. QuickBooks'
memorized transaction feature permifs you to memorize or save recurring fransactions.

Paint Palette leases a van for a monthly lease payment of $306. You will use a memorized
fransaction to reuse each month to record the lease payment.

Step 1.
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From the open Enter Billswindow onyour screen, entfer the following
information about the van lease bill.

Date: 01/04/2023

Vendor <Add New> Joseph Leasing
Amount Due: 306.00

Terms: Net 30

Account: 67100 Rent Expense
Memo: Van Lease




Step 2. Select Memorize icon atf the top of the Enter Billswindow

Step 3. When the Memorize Transaction window appears, select Add to my
Reminders List

Step 4. Select How Offen: Monthly

Step 5. Enter Next Date: 02/01/2023

Step 6. Click OK to record the memorized fransaction
Step 7. Select the Save icon at the top of the Enter Bills window . If asked if
you want to make the change in payment terms permanent, select
Yes.
Step 8. Select the Reports tab > Transaction Journal
CH10 JUR-3B
Step 9. Export the Transaction Journal report to Excel or print the report

Step 10.  Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_10_REPORTS Excel file.

Step 11. From the drop-down list, select the sheet: CH10 JUR-3B

Step 12.  Click Save & Close fo close the Enter Bills window and record the van lease

VIEW OR EDIT A MEMORIZED TRANSACTION

Step 1. Select the Lists Menu » Memorized Transaction List

Step 2. When the Memorized Transaction List window appears , double-click the
memorized tfransaction you want to use.

Step 3. QuickBooks displays the Enter Bills window with the memorized tfransaction data

already entered. You can make any necessary changes on the form, such as

changing the date. To record the bill in QuickBooks, you would click Save &
Close .

Step 4. At this time, close the Enter Bills window without saving. Then close the
Memorized Transaction List window. Later, you will use the memorized
fransaction.

PAY BILLS

To pay bills already entered, follow these instructions:

Step 1. Click the Pay Bills icon in the Vendors section of the Home Page
Step 2. When the Pay Bills windows appears, select Show Bills: Due on or before
02/04/2023

Step 3. Select to pay the Brewer Paint Supplies bill for $450.00 and the Joseph Leasing
Bill for $306.00

Step 4. Select Payment Method: Check

Step 5. Select To be printed

Step 6. Select Payment Account: Checking

Step 7. Enter Payment Date: 01/04/2023

Step 8. Click Pay Selected Bills to record the bills selected for payment

Step 9. Select Done to close the Payment Summary window
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CH10 JUR-4

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.

Select the Reports> Accountant & Taxes = Journal

Select Dates: 01/03/2023 to 01/04/2023

Export the Journal report to Excel

Follow the instructions in Appendix C fo export the report fo the Excel file named
UNIT_10_REPORTS Excel file.

From the drop-down list, select the sheet: CH10 JUR-4

CUSTOMIZE INVOICES

Create a Custom Invoice Template with a Service Date column. This permits Paint
Palette to bill customers once a month for all services provided during the month, listing
each service date separately on the invoice.

To create a Custom Invoice Template, complete the following steps:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.

Step 8.
Step 9.
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Click the Create Invoices icon in the Customers section of the Home Page
Click the Formatting tab in the upper portion of the Create Invoices window
Select Manage Templates

In the Manage Templates window, select Intuit Service Invoice

Then click Copy

To change the invoice tfemplate name, select Copy of: Intuit Service Invoice

In the template Name field, change the template name to: Service Date Invoice

[NELELE Temﬁlates

SELECT TEMPLATE PREVIEW

Template Name | Sevice Date Invoice|

01 Central Coast Support
02 SAN LUIS COASTAL USD
03 MCleeves - Personal

04 CC Support - short
Aftorney’s Invoice

— Copy of: Intuit Service Invoice

Fixed Fee Invoize

Intuit Product Invoice

Intuit Professiongl Invoice

Intuit Service Invoi e

Invoice from Proposal
Progress Invoice

Time & Expense Invo ce

Total

Copy Delete

Help Download Templates... “

Cancel

Click OK to close the Manage Templates window
Verify the Selected Template is Service Date Invoice




Step 10.  Click the Additional Customization button.

SELECTED TEMPLATE PREVIEW
Service Date Invoice Manage Templates...
Cemtral € oot Suppost Invoice
LOGO & FONTS 150 Hemmardo Ave
harre B A G 344E [ s T treaws ]
- -
[l Use logo Select Logo...

Select Color Scheme:
Please Select.. «

Apply Color Scheme

Change Font Far:

Title = Change Font... S N
Company Mame l | |
Casnily L iz e Agmani
Company Address
Labels
v
COMPANY & TRAN SACTION INFORMATION
|¥| Company Name ] Phone Number Update Information...
¥ Company Address | E-mail Address
"] Fax Number ] Web Site Address Additional
] Print Past Due Stamp . .
Select only when you want to include Past Due information Stamp. CUStomlzatlon
¥ Print Status Stamp
Select to include the status on the form. Various statuses are, Paid, Pending,
Received, Vioid, and so on.
How do | apply a design across multiple farms? Print Preview...

Help Additional Customization... Layout Designer... Cancel

Step 11.  To add a Service Date column to the custom template, when the Additional
Customization window appears, click the Columns tab

Step 12. Check Screen and Print.

Step 13.  Enter Title for Service Date: Date
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Step 14.  Renumber the Order so they appear as shown

SELECTED TEMPLATE PREVIEW
Service Date Invoice [ Template is inactive
Invoice
Header Columns  Prog Cols Footer Print
T L
New Label
Screen  Print Order  Title
Service Date @ =] 9 Date
Em 7 0 2 ltem
Description 7 @ 3l Description i | | From
Mir Part Number gy [} a MPN . [r— Cumrtny fn pe—
Quantity o) 4 Cluantity
Rate 5 Rate
Amount 7 %] ] Amount
Class @ B 0 “
Other 1 a [2] o
Other 2 ] o i}
O d f MAKE SAME cenTER UNDOREDG z00m
r e r 0 =] @ L] x a (] b ] a L] “ » Y Q
Properties... aa 7| copy Remove  Copy Format Height  Width Size Horz Undo Redo n out

Appearance buaPuaturtanston s bt Bttt Brats st Bttty Bttt Bt bt st Bubigdu g 4
UTCHECk SCeer or ety Defaulf] T ComiGemteen ., Hrmyoiéej
o T
o Layout Designer
Step 15.  Click the Layout
Designer bufton i i i - W‘ =
and adjust the o s Tt

field sizes as
needed

Step 16.  Click OK to
close the Layout

f columns |
adjusting

‘N
Designer
window. Click Dotted line
OK again to represents margin
settings

close the 9

o e o
CUStOmIZOTIOn Data field for Senviced ' Zoom: 100% 000,431 524x538
WindOWS. Margins.. | [E]  grid.. @ Show envelope window

Step 17.  To view the
custom invoice, if necessary, from the create Invoices window, select Template:
Service Date Invoice

Step 18. Noftice that the first column of the invoice is now the Date column
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CREATE INVOICE
.

Create an invoice fo record painting services provided by Paint Palette to Sofia Rafael
during January:

Step 1. If the Create Invoices window is not already open on your
screen, select the Create Invoices icon in the Customers section
of the Home Page

Step 2. Select Customer & Job: Rafael, Sofia: Dining Room

Step 3. When the Billable Time/Costs window appears toremind you the
job hasoutstanding billable time, click Selectthe outstanding
billable time and coststo add to thisinvoice?

Step 4. Click OK

Step 5. To select billable costs to apply fo the Rafael invoice, from the
Choose Billable Time and Costs window select the Expenses tab

Step 6. Enter Markup Amount or %:40.0%. (Be sure to enter %, otherwise $40
will be the markup.)

Step 7. Select Markup Account: 47900 - Sales

Step 8. Check to select: Brewer Paint Supplies

Step 9. Click OK to bill the Paint Supplies cost

Step 10. Select Template : Service Date Invoice

Step 11. Enter Invoice Date: 01/10/2023

Step 12. The Rafael invoice will list Total Reimbursable Expenses of $630.00

Step 13. Next, enter the Service Date in the Create Invoices window:
01/05/2023

Step 14. Select Item <Add New>: Labor Mural.

Step 15. Type: Service

Step 16. Subitem of: Labor

Step 17. Description: Labor Mural

Step 18. Rate: 50.00

Step 19. Account. 47900 Sales

Step 20. Quantity: 7 (hours)

Step 21. Enter Date (column): 01/06/2023

Step 22. Select Item: Labor Mural

Step 23. Quantity: 7 (hours)

Step 24. Select Print Later

Step 25. Select the Save icon

CH10 JUR-5

Step 26.  Select the Reports tab - Transaction Journal

Step 27. Export the Journal report to Excel

Step 28. Follow the insfructions in Appendix C fo export the report to the Excel
file named UNIT_10_REPORTS Excel file.

Step 29. From the drop-down list, select the sheet: CH10 JUR-5

RECEIVE PAYMENT
.

To record Sofia Rafael's payment for the invoice:

Step 1.
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From the Customers section of the Home Pag e, click the Receive Payments
icon




Step 2.

Select Received From: Rafael, Sofia: Dining Room

Step 3. Enter Amount: 1330.00

Step 4. Select Date: 01/11/2023

Step 5. Select Payment Method :Check

Step 6. Enter Check No. 555

Step 7. Select Save & New

Step 8. Select the Find back arrow fo display the customer payment just recorded
CH10 JUR-6

Step 9. Select Reports tab > Transaction Journal

Step 10. Export the Journal report to Excel

Step 11.  Follow the instructions in Appendix C to export the report to the Excel

fle named UNIT_10_REPORTS Excel file.
Step 12.  From the drop-down list, select the sheet: CH10 JUR-é

MAKE DEPOSIT

When a customer makes a payment, the customer's account receivable isreduced by the
amount of the payment. In this case, Sofia Rafael's account receivable isreduced by

$1.330.00.
Step 1. From the Banking section of the Home Page, click the Record Deposits icon
Step 2. When the Payments to Deposit window appears, select the payment from
Sofia Rafael
Step 3. for deposit
Step 4. Click OK and the Make Deposits window appears
Step 5. Select Deposit To: Checking
Step 6. Select Date: 01/11/2023
Step 7. Verify the Amount is $1330.00
Step 8. Select the Save icon atf the top of the Make Deposits window
CH10 JUR-7
Step 1. Select Journal icon
Step 2. Export the Journal report to Excel
Step 3. Follow the instructions in Appendix C fo export the report to the Excel
fle named UNIT_10_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: CH10 JUR-7
Step 9. Close the Transaction Journal and the Make Deposifs windows

Page | 238




INVOICE TRACKER

To view the Invoice History Tracker:

From the Customer section of the Home Page, click the Create Invoices icon
When the Create Invoices window appears , select the back

arrow to display the Rafael Dining Room invoice

Select the See History link to display the Invoice History Tracker

The Invoice History Tracker displays the date the invoice was created and

e If the invoice had been emailed, the Invoice History tracker would also display
when the invoice was sent and viewed by the customer

Step 1.
Step 2.
Step 3.
includes the following:
e Date and amount of the payment (s) received
e Date and amount deposited
Step 4.

ADD ACCOUNTS

Close the Invoice History Tracker window and the Create Invoices window

Account Name:
Account Num:
Account Type:
Account
Description:

Tax Line:

New Account for
Chart of Accounts

Account Name:
Account Num:
Account Type:
Account
Description:

Tax Line:

New Accountfor
Chart of Accounts

Accounf Name:
Account Num:

New Account for AccountType:
Chart of Accounts  Subaccount of:
Description:
Tax Line:
Account Name:
New Account for Account Num:
Chartof Accounts  AccountType:
Subaccount of:
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Paint Supplies

13000

Other Current Asset
Paint Supplies on Hand

Unassigned

Equipment
14400

Fixed Asset
Equipment

Unassigned

Equipment Cost
14500

Fixed Asset
14400 Equipment
Equipment Cost
Unassigned

Accumulated Depr Equipment
14600

Fixed Asset

14400 Equipment




Description:

Accumulated Depreciation

Equipment

Tax Line:

Account Name:

Unassigned

Depreciation Expense

Account Num: 62400
Edit Existing Account Type: Expense
Account Account Depreciation of equipment, buildings, and
Description: improvements
Tox Line: Schedule C: Other business expenses
AccountName: Paint Supplies Expense
Account Num: 64800
Edit Existing Account Type: Expense
Account Account Description: Paint Supplies Expense
Tax Line: Schedule C: Supplies (notfrom
COGS)
CH10 COA-2
Step 1. From the Reports section select List (or Accountant & Taxes) > Account Listing

Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

Select Date: 01/11/2023
Export to Excel

Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_10_REPORTS Excel file.

From the drop-down list, select the sheet: CH10 COA-2

Save and close the Excel file.

ADD CUSTOMERS

Add the follow

New Customer
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ing customers to your Paint Palette company:

Customer
Opening Balance
As of

Address Info:

First Name

Last Name

Main Phone
Mobile

Address

Payment Settings:

Account No.

Payment Terms

Preferred Delivery Method
Preferred Payment Method

Kari, Tracey
0.00

01/01/2023

Tracey

Kari
415-555-1234
415-555-999¢9

99 Reyka Drive
Bayshore, CA 94326

1002
Net30
E-mail
Check




Additional Info:
Customer Type

ADD JOB

Referral

Job Info:
Job Name Foyer
Opening Balance 0.00
Job for
As of: 01/01/2023
Kari, Tracey
Job Description: Foyer Marbled Faux Painting
Job Type <Add New> Faux Painting
Job Status: Pending
CH10 CUS-2
Step 1. From the Customer & Receivables Reports, Export the Customer

Contact List to Excel

Step 2.

Follow the instructions in Appendix C fo export the report to the

Excel file named UNIT_10_REPORTS Excel file.

Step 3.
Step 4.

From the drop-down list, select the sheet: CH10 CUS-2
Save and close the Excel file.

EDIT VENDORS

Edit
Cornell Technologies

Edit
Joseph Leasing
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Company Name:

First Name:
Last Name:
Main Phone:
Address:

Account No.
Payment Terms
Credit Limit
Vendor Tax ID:
Additional Info:
Vendor Type:

Company Name:

First Name:
Last Name:
Main Phone:
Address:

Account No.

Cornell Technologies
Bill

Cornell

415-555-8181

108 Austin Avenue
Bayshore, CA 94324
2002

Net30

18000.00

37-4356781

Supplies

Joseph Leasing
Joseph

Asher

415-555-0412

13 Appleton Drive
Bayshore, CA 94324
2003




Payment Terms Net30
Credit Limit
Vendor Tax ID: 37-1726354
Additional Info:
Vendor Type: Leasing
CH10 VEN-2
Step 1. From the Vendors & Payables Reports, Export the Vendor Contact

List to Excel

Step 2. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_10_REPORTS Excel file.

Step 3. From the drop-down list, select the sheet: CH10 VEN-2

Step 4. Save and close the Excel file.

ADD ITEMS

ltem Type Service
[tem Name Labor Faux
Subitem of Labor
New Sub ltem Description Labor Faux Painting
Rate 36.00
Account 47900 - Sales
Iltem Type Service
[tem Name Labor Interior
New Sub Item Subifgm‘ of Labor ] T
Description Labor Interior Painting
Rate 20.00
Account 47900 - Sales
Iltem Type Service
[tem Name Labor Exterior
New Sub Item Subife'm‘ of Labor . T
Description Labor Exterior Painting
Rate 30.00
Account 47900 - Sales
CH101TM-2
Step 1. From the Lists Reports, Select the Item Listing
Step 2. Export to Excel
Step 3. Follow the instructions in Appendix C fo export the report fo the
Excel file named UNIT_10_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: CH10 ITM-2
Step 5. Save and close the Excel file.
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RECORD VENDOR AND EXPENSE TRANSACTIONS

Use the following table to determine what type of fransaction is being used the transactions are
intfegrated info vendor and expense fransactions. The wording can be confusing. The cell fo

the right of the transaction explanation is for you to determine the type of fransaction that
should be created.

The Van Lease is a memorized transaction for a bill. The Van Lease payments are bill pays for the
memorized transactions.

Transaction Type of
Transaction

01/04/2023 Paint Palette made a credit purchase of $1,000
from Brewer Paint Supplies of painting equipment
including ladders and drop cloths. The painting
equipment isrecorded as an asset because it will
benefit more than one accounting period and will
be depreciated over the useful life of the
equipment. Use Account 14500 Equipment Cost
to record the $1,000 purchase of painting
equipment.

02/01/2023 Use the memorized transaction to record the bill  Memorized
for the February van lease to be paid later

Paid following bills:

DPAS P e $1,000 Brewer Paint Supplies bill
e Van lease bill for February
03/01/2023 Received bill for van lease for March Memorized
03/30/2023 Paid van lease for March (Due: 03/31/2023)
04/01,/2023 Received bill for van lease for April Memorized
Purchased $50 of paint supplies on account
Tl from Brewer Paint Supplies. Record as Paint
Supplies Expense.
* Paid van lease for April (Due: 05/01/2023)
04/30/2023 e Paid for paint supplies purchased on April
04
05/01/2023 Received bill for van lease for May Memorized

05/30/2023 Paid van lease for May (Due: 05/31/2023)
06/01/2023 Received bill for van lease for June Memorized

06/30/2023 Paid van lease for June (Due: 07/01/2023)
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Transaction Type of
Transaction

Purchased $100 of paint supplies on account
A from Brewer Paint Supplies. Record as Paint
Supplies Expense.

07/01/2023 Received bill for van lease for July Memorized

e Paid van lease for July (Due: 07/31/2023)
07/30/2023 e Paid for paint supplies purchased on July 1

08/01/2023 Received bill for van lease for August Memorized

08/30/2023 Paid van lease for August (Due: 08/31/2023)

09/01/2023 Received bill for van lease for September Memorized

Purchased $75 of paint supplies on account
09/02/2023 from Brewer Paint Supplies. Record as Paint

Supplies Expense.

* Paid September van lease (Due:

10/01/2023)
09/30/2023 e Paid for paint supplies purchased on
09/02/2023
10/01/2023 Received bill for van lease for October Memorized

10/30/2023 Paid van lease for October (Due: 10/31/2023)

11/01/2023 Received Dbill for van lease for November Memorized
Paid van lease for November (Due:

11/30/2023 12/01/2023)

12/01/2023 Received Dbill for van lease for December Memorized

Purchased $180 of paint supplies on account
12/20/2023 from Brewer Paint Supplies. Record as Paint
Supplies Expense.
Paid van lease for December (Due:

12/30/2023
/30/ 12/31/2023)
CH10 VEN DET

Step 1. From the Vendors & Payables Reports, Export the Vendor Detail
report for 2023

Step 2. Follow the instructions in Appendix C fo export the report to the
Excel file named UNIT_10_REPORTS Excel file.

Step 3. From the drop-down list, select the sheet: CH10 VEN DET

Step 4. Save and close the Excel file.
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CUSTOMER AND SALES TRANSACTIONS

Use the Service Date Invoice template to record the customer and sales transactions for Paint

Palette during the year 2023.

NEW INVOICE
INVOICE DATE 02/28/2023
CUSTOMER Sofia Rafael
Jos Dining Room

INVOICE PAID IN FULL & DEPOSITED
RECORD PAYMENT & DEPOSITINTO CHECKING

NEW INVOICE
INVOICE DATE 03/31/2023
CUSTOMER Sofia Rafael
Jos Dining Room
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SERVICE DATE
ITEM

HOURS
SERVICE DATE
[TEM

HOURS

SERVICE DATE

[TEM
HOURS

SERVICE DATE
[TEM
HOURS

SERVICE DATE
ITEM
HOURs

SERVICE DATE
[TEM
HOURS

DATE:

CHECK:

SERVICE DATE
[TEM

HOURS
SERVICE DATE
[TEM

HOURS

SERVICE DATE
[TEM
HOURS

SERVICE DATE
[TEM

HOURS
SERVICE DATE
[TEM

HOURS

02/10/2023
Labor: Mural
10
02/11/2023

Labor: Mural
9

02/15/2023
Labor: Mural
10

02/18/2023
Labor: Mural
11

02/20/2023
Labor: Mural
12

02/22/2023
Labor: Mural
10

03/15/2023
675

03/05/2023
Labor: Mural
9
03/09/2023
Labor: Mural
10

03/13/2023

Labor: Mural
11

03/20/2023
Labor: Mural
10
03/29/2023
Labor: Mural
10




INVOICE PAID IN FULL & DEPOSITED

RECORD PAYMENT AND DEPOSITINTO CHECKING

INVOICE DATE

CUSTOMER
JOB

NEW INVOICE

04/30/2023
Tracey Kari
Foyer

INVOICE PAID IN FULL & DEPOSITED
RECORD PAYMENT & DEPOSITINTO CHECKING

INVOICE DATE
CUSTOMER
JOoB

NEW INVOICE

05/15/2023
Tracey Kari
Foyer

INVOICE PAID IN FULL & DEPOSITED
RECORD PAYMENT & DEPOSITINTO CHECKING

INVOICE DATE
CUSTOMER
JoB
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NEW INVOICE

06/30/2023
Sofia Rafael
Vaulted Kitchen

DATE:

CHECK:
SERVICE DATE
ITEM

HOURS
SERVICE DATE
[TEM

HOURS

SERVICE DATE
ITEM
HOURS

SERVICE DATE
[TEM
HOURS

DATE:

CHECK:

SERVICE DATE
[TEM

HOURS
SERVICE DATE
[TEM

HOURS

SERVICE DATE
[TEM
HOURS

DATE:

CHECK:

SERVICE DATE
[TEM

HOURS
SERVICE DATE
ITEM

HOURS

SERVICE DATE
ITEM
HOURS

04/15/2023

690
04/10/2023

Labor: Faux
9

04/15/2023
Labor: Faux
9

04/25/2023
Labor: Faux
8

04/29/2023
Labor: Faux
8

05/15/2023
432

05/10/2023
Labor: Faux
9

05/18/2023
Labor: Faux
9

05/25/2023
Labor: Faux
8

06/15/2023
455

06/10/2023
Labor: Mural
10
06/17/2023

Labor: Mural
10

06/28/2023
Labor: Mural
10




INVOICE PAID IN FULL & DEPOSITED
RECORD PAYMENT & DEPOSITINTO CHECKING

INVOICE DATE

CUSTOMER
JoB

NEW INVOICE

07/31/2023
Sofia Rafael
Vaulted Kitchen

INVOICE PAID IN FULL & DEPOSITED
RECORD PAYMENT & DEPOSITINTO CHECKING

INVOICE DATE

CUSTOMER
JoB

NEW INVOICE

08/31/2023
Sofia Rafael
Vaulted Kitchen

INVOICE PAID IN FULL & DEPOSITED
RECORD PAYMENT & DEPOSITINTO CHECKING

INVOICE DATE

CUSTOMER
JOB
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NEW INVOICE

10/31/2023
Tracey Kari
Screen Porch

DATE:

CHECK:

SERVICE DATE
[TEM

HOURS
SERVICE DATE
ITEM

HOURS

SERVICE DATE
ITEM
HOURS

DATE:

CHECK:

SERVICE DATE
ITEM

HOURS
SERVICE DATE
[TEM

HOURS

SERVICE DATE
[TEM
HOURS

DATE:

CHECK:

SERVICE DATE
ITEM

HOURS
SERVICE DATE
[TEM

HOURS

SERVICE DATE
ITEM
HOURS

07/15/2023
733

07/09/2023
Labor: Mural
9

07/18/2023
Labor: Mural
10

07/27/2023
Labor: Mural
10

08/15/2023
750

08/09/2023
Labor: Mural
8

08/18/2023
Labor: Mural
9

08/22/2023
Labor: Mural
10

09/15/2023
782

10/11/2023
Labor: Mural
8

10/20/2023

Labor: Mural
5

10/22/2023
Labor: Mural
6




INVOICE PAID IN FULL & DEPOSITED DATE: 11/15/2023
RECORD PAYMENT & DEPOSITINTO CHECKING CHECK: 685
SERVICE DATE 11/11/2023
ITEM Labor: Mural
NEW INVOICE Hours 11
SERVICE DATE 11/18/2023
INVOICE DATE 11/30/2023 ITEM Labor: Mural
CUSTOMER Tracey Kari Hours 6
JoB Screen Porch SERVICE DATE 11/27/2023
ITEM Labor: Mural
HouRs 9
INVOICE PAID IN FULL & DEPOSITED DATE: 12/15/2023
RECORD PAYMENT & DEPOSITINTO CHECKING CHECK: 725
CH10 CUS DET
Step 1. From the Customer & Receivables Reports, Export the Customer
Detail report for 2023 to Excel
Step 2. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_10_REPORTS Excel file.

Step 3. From the drop-down list, select the sheet: CH10 CUS DET

Step 4. Save and close the Excel file.

CH10 DEP DET

Step 1. From the Banking Reports, Export the Deposit Detail Report for 2023

tfo Excel

Step 2. Follow the insfructions in Appendix C fo export the report to the

Excel file named UNIT_10_REPORTS Excel file.

Step 3. From the drop-down list, select the sheet: CH10 DEP DET

Step 4. Save and close the Excel file.

ADJUSTMENTS

The purpose of the Trial Balance is to determine whether the accounting system in balance
(debits equal credits). Create aTrial Balance report for Paint Palette at December 31, 2023.

CH10TB

Step 1. From the report Center select Accountant & Taxes - Trial Balance
Step 2. Select Dates From: 12/31/2023 to 12/31/2023
Step 3. Export to Excel
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Step 4. Follow the instructions in Appendix C fo export the report to the
Excel file named UNIT_10_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet: CH10 TB

Step 6. Save and close the Excel file.

At the end of the accounting period, itisnecessary to make adjusting enfries to bring a

company's accounts up to date as of year-end. Three adjusting entries are needed for
Paint Palette as of December 31, 2023.

ADJUSTING ENTRY Al

=

e

e

e

e

e

&

Step 1. To entfer adjusting enfries, select Accountant Menu - Make General Journal
Entries
Step 2. Next, use the Make General Journal Enfries window to record the adjusting

enfry (A1) for depreciation expense on the computer for Paint Palette af
December 31, 20 23. The $3,000 computer cost will be depreciated over a
useful life of five years. (Depreciation expense is calculated as $3,000/5
years= $600 per year.)

Step 3. Use Account 62400 and 14300 to record the adjusting entry. Refer to
Appendix D for ideas on how the adjustment should be made.

ADJUSTING ENTRY A2

=

e

Step 1. Record an adjusting enfry (A2) to record depreciation expense for the
painting equipment for the year.

Step 2. The $1,000 painting equipment cost is depreciated using straight-line
depreciation over five years with no salvage value.

Step 3. Use Account No. 62400 and 14600 fo record the adjusting enftry.

e

e

e e

&

ADJUSTING ENTRY A3

o
=

e
—ar

e
—ar

e
—ar

it

e e
—ar —ar

Step 1. On December 31, 2023, you take an inventory of unused paint supplies on
hand to learn that

Step 2. $100 of paint supplies are still on hand as of that date. Since the supplies were
recorded as supplies expense when originally purchased, an adjusting entry is
needed (A3).

Step 3. Use Account 13000 to record the $100 of unused paint supplies as an asset
with future benefit.

Step 4. Click Save & Close to save the adjusting journal entries

CH10 ADJ JUR

Step 1. To create an Adjusting Journal Entries report on December 31, 2023,
for Paint Palette, from the Report Center, select Accountant & Taxes >
Adjusting Journal Entries

Step 2. Select Dates: 12/31/2023 To 12/31/2023

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C fo export the report to the
Excel file named UNIT_10_REPORTS Excel file.
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Step 5. From the drop-down list, select the sheet: CH10 ADJ JUR

Step 6. Save and close the Excel file.
CH10 JUR-8
Step 1. To create a Journal report for Paint Palette, from the one of the

Report options, select Accountant & Taxes > Journal

Step 2. Select Dates: 01/01/2023 To 12/31/2023

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_10_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet: CH10 JUR-8

Step 6. Save and close the Excel file.
CH10 PL STD
Step 1. Export the Profit and Loss Standard to Excel
Step 2. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_10_REPORTS Excel file.
Step 3. From the drop-down list, select the sheet: CH10 PL STD

Step 4. Save and close the Excel file.
CH10 BS STD
Step 1. Export the Balance Sheet Standard to Excel
Step 2. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_10_REPORTS Excel file.
Step 3. From the drop-down list, select the sheet: CH10 BS STD

Step 4. Save and close the Excel file.
CH10 SCF
Step 1. Export the Statement of Cash Flows fo Excel
Step 2. Follow the instructions in Appendix C to export the report to the

Excel file named UNIT_10_REPORTS Excel file.
Step 3. From the drop-down list, select the sheet: CH10 SCF
Step 4. Save and close the Excel file.

CLOSE THE ACCOUNTING PERIOD

o
=

e
—r

e e e e e e R
= = B S S S S e B R S SR S S S ]

To enter the closing date in QuickBooks:

Step 1. Select Company Menu > Set Up Users and Passwords> Set Up Users

Step 2. If necessary, enfer information for the QuickBooks Administrator, then click
(0] ¢

Step 3. When the following User List window appears, click the Closing Date button

Step 4. Enter the closing date: 12/31/2023

Step 5. Click OK to close the Set Closing Dafe and Password window
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NEW COMPANY SETUP

Page | 251




To create a new company data file in QuickBooks, use the EasyStep Inferview. The EasyStep
Interview asks you a series of questions about your business. Then QuickBooks uses the
information fo customize QuickBooks fo fit your business needs.

Four opftions for how to set up a new company are:

* Express Start: Recommended for new QuickBooks users, this option will ask you a
few basic questions and do the rest for you.
* Detailed Start: This option lets you confrol the setup and fine-tune the company file to
meet your specific needs.
* Create: This choice permifs you fo create quickly a new company file by
copying the preferences and key lists from an existing company.
* Other Options: This option lets you convert data from Quicken or other
accounting software to create a new QuickBooks company file.

EASY STEP INTERVIEW

Create a new QuickBooks company using the EasyStep Interview as follows:

Step 21. Select Create a new company
Step 22. When the QuickBooks Setup window appears, select Detailed Start
Step 23. When your Company Information window appears, entfer

Step 24. Company Name: YourName Mookie The Beagle Spa. Press the Tab key, and
QuickBooks will automatically enter the company name in the Legal name
field. Since the company will do business under its legal name, the Company
name and Legal name fields are the same.

Step 25.  Enter the company information.

Tax ID 123-45-6789
Address 432 Phoenician Way
City Mountain View
State CA
Zip 94043
Phone 415-555-4320
Email <Enter your email address>
Step 2é. Select Next
Step 27. In the Select Your Industry window, select General Service-based Business
Step 28. Select Next
Step 29. When the How Is Your Company Organized? window appears, select Sole

Proprietorship.

How your business enftity isorganized (Sole Proprietorship, Partnership, Limited Liability
Partnership (LLP). Limited Liability Company (LLC). C Corporatfion. S Corporation. or Non-
Profit) determines which tax form and tax lines you use.
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Step 30. Select Next

Step 31. Select the first month of your fiscal year: January
Step 32. Select Next
Step 33. In the Set Up Your Administrator Password window:

Step 34. Enter your administrator password (Cuestal23)
Step 35. Retype the password
Step 36. Select Next.

Step 37. When the Create Your Company File window appears, click Next fo choose
a file name and location fo save your company file.

Step 38. When the File name for New Company window appears, select save in the
folder created for UNIT 11

Step 39. Enter File name: Your Name Mookie The Beagle Spa

Step 40. Click Save

CUSTOMIZE THE QUICKBOOKS COMPANY

—
The My Shortcuts window should appear on the left side of your QuickBooks company

screen. The next section of the Easy-Step Interview is to customize QuickBooks by furning on
features tfo fit your business needs

Step 1. When the What Do You Sell2 window appears:
a. Select Services only

b. Click Next
Step 2. When asked "Do you charge sales taxe"
a. Select No
b. Click Next
Step 3. When asked "Do you want to creafe estimates in QuickBooks?"
a. Select No
b. Click Next
Step 4. When the Using Statements in QuickBooks window appears:
a. "Do you want to use billing statements in QuickBookse" Select No
b. Click Next
Step 5. When the Using Invoices in QuickBooks window appears:
a. "Do you want to use billing statements in QuickBookse" Select Yes
b. Click Next
Step 6. When the Using Progress Invoicing window appears:
a. "Do you want to use progress invoicing?" Select No
b. Click Next

Step 7. When the Managing Bills You Owe window appea rs:
a. "Do you want to keep track of bills you owe?2" Select Yes

b. Click Next

Step 8. When the Tracking Time in QuickBooks window appears :
a. "Do you want fo frack time in QuickBooks?2" Select Yes
b. Click Next

Step 9. When the Do You Have Employeese window appears:
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Step 10.
Step 11.

Step 12.
Step 13.

a. Select No
b. Click Next
Read the Using Accounts in QuickBooks window . Click Next.
When the Select a Date fo Start Tracking Your Finances window appears:
a. Select Use today 's date or the first day of the quarter or month
b. Enfer Date 01/01/2023
c. Click Next

When the Review Income and Expense Accounts window appears, click Next
When the Congratulations! window appears, click Go to Setup

VERIFY TAX FORMS

Step 1.
Step 2.

From the Company Menu select My Company-> Report Information
Income Tax Form Used: Form 1040 (Sole Proprietor)

DISPLAY ACCOUNT NUMBERS

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Select Edit

Select Preferences

Select Accounting

Select Company Preferences
Select Use Account Numbers

ADD ACCOUNTS

New Account for
Chart of Accounts

New Account for
Chart of Accounts

New Accountfor
Chart of Accounts
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Accounf Name:
Account Num:
Account Type:
Account
Description:

Tax Line:

Account Name:
Account Num:
Sub Account of:
Account Type:
Account
Description:

Tax Line:

Account Name:
Account Num:
Account Type:
Subaccount of:
Description:

Tax Line:

Pet Spa Equipment
14000

Fixed Asset

Pet Spa Equipment

Unassigned

Pet Spa Equipment Cost
14100

Pet Spa Equipment
Fixed Asset

Equipment

Unassigned

Pet Spa Equipment Acc Depr
14200

Fixed Asset

Pet Spa Equipment

Pet Spa Equipment
Depreciation

Unassigned




AccountName:
Accounft Num:

New Accountfor ggf;;ggg?e:
Chart of Accounts Credit Card Acct.
No
Tax Line:

New Account
for Chart of
Accounts

New Account
for Chart of
Accounts

New Account
for Chart of
Accounts

New Account
for Chart of
Accounts
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Account Name:
Account Num:
Account Type.:
Account Description:
Tax Line:

Account Name:
Account Num:
Account Type:

Sub Account of:
Account Description:
Tax Line:

Account Name:
Account Num:
Account Type:

Sub Account of:
Account Description:
Tax Line:

Account Name:

Visa Credit Card-4563
21000

Credit Card

Visa Credit Card
4561-5824-5789-4563

Unassigned

Supplies Expense

64800

Expense

Supplies Expense

Schedule C: Supplies (notfrom COGS)

Pet Spa Supplies Expense
64810

Expense

Supplies Expense

PetSpa Supplies Expense
Schedule C: Supplies (notfrom
COGS)

Technology Supplies Expense
64820

Expense

Supplies Expense

Technology Supplies Expense
Schedule C: Supplies (notfrom
COGS)

Lease Expense

Account Num: 67000

Account Type: Expense

Account Lease Expense for Vehiclesand
Description: Equipment

Tox Line: Schedule C: Rent/Lease Vehicles,

Equipment




Account Name: Depreciation Expense

Account Num: 62400
Edit the Account Type: Expense
Account Account Depreciation on equipment, buildings,
Description: and improvements
Tax Line: Schedule C: Other business expenses
Account Name: Checking-2323
Account Num: 10100
New Account AccountType: Bank
for Chart of Account Business Checking
Accounts Description:
Bank Acct No: 45672323

Routing Number: 122235821

Account Name: Rent Expense
Account Num: 67100
Edit the Account Type: Expense

Account Account Rent paid for company offices or other
Description: strictures in the business
Tax Line: Schedule C: Rent/lease other bus. Prop.

CH11 COA
Step 1. From the Reports section select List (or Accountant & Taxes) > Account Listing

Step 2. Date: January 1, 2023 (If the date did not change, it can be changed by
customizing the report. Change the subtfitle in the header)

Step 3. Export to Excel

Step 4. Follow the instructions in Appendix C fo export the report to the Excel file named
UNIT_11_REPORTS Excel file.

Step 5. From the drop-down list, select the sheet: CH11 COA

Step 6. Save and close the Excel file.

ADD CUSTOMERS

I ————
Add the following customers to your Mookie The Beagle Spa company:

Customer Name: Kari, Tracey

Opening Balance 0.00

Company Name Tracey Kari

As of 01/01/2023
New Customer Address Info:

First Name Tracey

Last Name Kari

Main Phone 415-555-1234

Mobile 415-555-9999
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Add Job

New Customer

Address

Payment Settings:

99 Reyka Drive
Bayshore, CA 94324

Account No. 3002

Payment Terms Net 30

Preferred Delivery Method E-mail

Preferred Payment Method Check

Additional Info:

Customer Type Referral

Job Name: Odin

Job Description: Odin Golden Retriever
Job Type <Add New.: Large Pet

Job Status: Awarded

Name Rafael, Sofia
Opening Balance: 0.00

As of: 01/01/2023

First Name Sofia

Last Name Rafael

Main Email sofiarafael@ewww.com
Main Phone 415-555-5432
Address 32 North Avenue
City, State, Zip Bayshore, CA 94326
Company Name Sofia Rafael
Payment Settings:

Account No. 3001

Payment Terms: Net 30

Preferred Delivery Method E-mail

Preferred Payment Method Visa

Customer Type <add New>

Direct Contact

Add Job

New Customer
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Job Name: Mazda

Job Description: Mazda Corgi
Job Type: Small Pet

Job Status: Awarded
Customer Petit, Mimi
Opening Balance 0.00

As of 01/01/2023
Address Info:

First Name Mimi

Last Name Petit

Main Phone

Mobile 415-555-2160
Address 220 Asace Avenue

Company Name:
Payment Settings:

Bayshore, CA 94326
Mimi Petit




Account No. 3003
Payment Terms Net30
Preferred Delivery Method E-mail
Preferred Payment Method Check
Additional Info:

Customer Type <Add New> Internet

Job Name: Bebe
Job Description: Bebe French Bulldog
Ao Job Type: Medium Pet

Job Status: Awarded

Customer Martini, Graziella

Opening Balance 0.00

As of 01/01/2023

Address Info:

First Name Graziella

Last Name Martini

Main Phone

Mobile 415-555-1270

Address 2213 Marco Drive
New Customer Bayshore, CA 94324

Company Name Graziella Martini

Payment Settings:

Account No. 3004

Payment Terms Net 30

Preferred Delivery Method E-mail
Preferred Payment Method Check
Additional Info:

Customer Type <Add New> Social Media

Job Name: Mario
Add Job Job Desc'rip’rion: Marrio Italian Greyhound
Job Type: Small Pet
Job Status: Pending
CH11 CUS
Step 1. From the Customer & Receivables Reports, open the Customer
Contact list
Step 2. Customize the Report using the following setfings:
a. Remove Primary Contact, Fax and Balance Total
b. Show Account No.
c. Show Job Type
d. Show Job Description
e. Show Job Status
f. Show Main Email

Step 3. Generate the report
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Step 4. Click and drag the headings of the new columns showing to the
following posifions:
i. Customer
ii. Billto
iii. Main Phone
iv. Main Email
v. Account No.
vi. Job Type
vii. Job Status
viii. Job Description
Step 5. Customize the Header/Footer to read as follows:
a. Report Title: Customer Contact and Job List
b. Subtitle: January 01, 2023

Step 6. Memorize the new Customer Contact List as Customer and Job List

Step 7. Save in Customers

Step 8. Export the Customer Contact List fo Excel

Step 9. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_11_REPORTS Excel file.

Step 10. From the drop-down list, select the sheet: CH11 CUS

Step 11.  Save and close the Excel file.

ADD VENDORS

o
=

o
e

e e
R

o
e

R e e e e Y

New Vendor

Name

Sofia Rafael Associates

Opening Balance

$0.00 as of 01/01/2023

Company Name

Sofia Rafael Associates

First Name Sofia

Last Name Rafael

Job Title Owner

Main Phone 415-555-6543
Mobile 415-555-5432
Address 32 North Avenue
City, State, Zip Bayshore, CA 94326

Account No.

4001

Payment Terms

Net 30

Print on Check as

Sofia Rafael Associates

Vendor Tax ID

37-7272727

Vendor Type

Supplies

New Vendor

Name

Joseph Leasing

Opening Balance

$0.00 as of 01/01/2023

Company Name

Joseph Leasing

First Name Joseph

Main Phone 415-555-0412
Address 13 Appleton Drive
City, State, Zip Bayshore, CA 94326

Account No.

4002

Payment Terms

Due on receipt

Print on Check as

Joseph Leasing

Vendor Type <Add New>

Leasing
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New Vendor

Name

Bichotte Supplies

Opening Balance

$0.00 as of 01/01/2023

Company Name

Bichotte Supplies

First Name Bichotte
Main Phone 415-555-4567
Address 810 Francais Drive

City, State, Zip

Bayshore, CA 94326

Account No.

4003

Payment Terms Net 30
Print on Check as Bichotte Supplies
Vendor Type Supplies

New Vendor

Name

Cathy PetCare Supplies

Opening Balance

$0.00 as of 01/01/2023

Company Name

Cathy PetCare Supplies

First Name Cathy

Main Phone 415-555-1010
Mobile

Address 10 Chassure Street

City, State, Zip

Bayshore, CA 94324

Contact Name

Account No.

4004

Payment Terms

Net 30

Print on Check as

Cathy PetCare Supplies

Vendor Tax ID

Vendor Type

Suppliers

CH11 VEN
Step 5. From the Vendors & Payables Reports, generate the Vendor
Contact List
Step 6. Customize the Report using the following settings:
a. Remove Primary Contact, Fax, Balance Total
b. AddTerms, Vendor Type
Step 12.  Customize the Header/Footer to read as follows:
a. Report Title: Vendor Contact and Type List
b. Subtitle: January 01, 2023
Step 13.  Memorize the new Vendor Contact List as Vendor Contact and
Type List
Step 14. Save in Vendors
Step 7. Export the Vendor List
Step 8. Follow the insfructions in Appendix C fo export the report to the
Excel file named UNIT_11_REPORTS Excel file.
Step 9. From the drop-down list, select the sheet: CH11 VEN
Step 10. Save and close the Excel file.

Page | 260




ADD ITEMS

Enter the following items in the item list for Mookie The Beagle Spa. Use the income account:
47900 Sales

SUBITEM OF NAME TYPE SALES DESCRIPTION iﬁ‘:‘ CE:
Shampoo Shampoo Small Service Shampoo Small dog $36
Shampoo Shampoo Medium Service  Shampoo Medium dog $45
Shampoo Shampoo Large Service Shampoo Large dog $54
Shampoo Shampoo Extra Large | Service | Shampoo Extra Large dog | $63
Conditioner Conditioner Small Service | Conditioner Small dog $9
Conditioner Conditioner Medium  Service Conditioner Mediumdog $9
Conditioner Conditioner Large Service | Conditioner Large dog $18

Conditioner Extra Conditioner Extra Large
Conditioner Large Service dog $18
Blow Dry Blow Dry Small Service  Blow Dry Small dog $18
Blow Dry Blow Dry Medium Service | Blow Dry Medium dog $27
Blow Dry Blow Dry Large Service Blow Dry Large dog $33
Blow Dry Blow Dry Extra Large | Service | Blow Dry Extralarge dog | $36
Doggie
Massage Short Massage Service | Massage 15 Minutes $27
Doggie
Massage Medium Massage Service Massage 30 Minutes $45
Doggie
Massage Extended Massage Service | Massage 50 Minutes $54
Grooming Trim Coat Service | Trim Doggie Coat $36
Grooming Trim Nails Service Trim Doggie Nails and File  $ 9
CH11I1TM

Step 5. From the Lists Reports, Select the Item Price List

Step 6. Customize the Report: Remove the Preferred Vendor Column

Step 7. Export to Excel

Step 8. Follow the insfructions in Appendix C fo export the report to the

Excel file named UNIT_11_REPORTS Excel file.
Step 9. From the drop-down list, select the sheet: CH11 ITM
Step 10. Save and close the Excel file.
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02/01/2023
02/10/2023
02/20/2023

02/22/2023

CUSTOMIZE INVOICE TEMPLATE

]
Using the activity in Unit 10 as a guideline, create a custom invoice for Mookie The Beagle Spa

that contains a date.

Step 1.

Create a service date invoice for Mookie The Beagle Spa

The service date permits the company to bill clients once a month for all services provided
during the month, listing each service date separately on the invoice.

RECORD TRANSACTIONS

$7,200

$1,350

$1

Deposit Check 5555
Bill-> Bill
Pay

Bill

$360 503

$198  Bill

$99 Visa Credit
Card-4563
$135 Bill

Visa Credit
Card-4563
Bill Pay

$81

,485 Check 502

Use the service date invoice template to record the following customer transactions:

01/01/2023 CK Walkerinvestedinthe
business
01/01/2023 JosephlLeasing Van Lease
01/02/2023 Cathy PetCare Supplies (pet
spa equipment)
01/03/2023 Sofia Rafael Associates
(Technology Supplies Expense)
01/06/2023 Bichotte Supplies (Office
supplies expense)
01/08/2023 Cathy Pet Care (Pet Spa
Supplies Expense)
01/10/2023 FastFuel <add new>
(automobile expense)
01/20/2023 Cathy PetCare Supplies
NEW INVOICE
INVOICE DATE 01/30/2023
CUSTOMER Sofia Rafael
Jos Mazda

Transaction

Joseph Leasing (Van lease
expense)
SofiaRafael

Cathy PetCare Supplies (Pet
Spa Supplies Expense)

VISA (add vendor)
Account: 21000 Visa Credit
Card-4563
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Amount

$350
$72.00
$45

$180

01/13/2023
Shampoo Small
Conditioner Small
Blow Dry Small

SERVICE DATE
ITEM
[TEM

ITEM

ITEM Trim Nails

Transaction Method Number

Type (s)

Bill = Bill 504

Pay

Payment& Visa 5555-5555-5555-
Deposit 5555 Exp 01/2025
Bill

Check Checking | 505




Step 1.

Step 2.
Step 3.

Step 4.

Step 5.

CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB
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Many of the customers have reoccurring services. You will be generating one

invoice at the end of the month.
Use the new Service Date Invoice Template

Since there are many services for the same service date, it is easier to enter
the service date in the service date column and then list the items. You will
have several blank service dates for the items of the same date.

All the services for the month should be on one invoice for that customer.

The invoices are generated atthe end of the month.

These services for the invoice generated on February 28, 2023:

SERVICE DATE

[TEM
[TEM
[TEM

BILL TO ITEM
ITEM
Tracey Kari
. SERVICE DATE
Odin
ITEM
[TEM
ITEM
[TEM
BILL TO SERVICE DATE
ITEM
Sofia Rafael ITem
Mazda e
TEM
ITEM
BILL TO SERVICE DATE
ITEM
Mimi Petit |
Bebe =M

ITEM
[TEM

ITEM

02/02/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

02/10/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

02/13/2023
Shampoo Smali
Conditioner Smaill
Blow Dry Small
Trim Nails
Medium Massage

02/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage




BILL TO ITEM
CUSTOMER Tracey Kari SERVICE DATE
Jos Odin
ITEM
ITEM
ITEM
ITEM
BILL TO SERVICE DATE
ITEM
CUSTOMER Sofia Rafael ITEMm
Jos Mazda e
ITEM
Step 6. Invoice Date: 02/28/2023
Step 7. Generate the Final Invoice for Sofia Rafael: Mazda
Step 8. Generate the Final Invoice Tracey Kari: Odin
Step 9. Generate the Final Invoice for Mimi Petit: Bebe

RECORD TRANSACTIONS

Date Transaction

03/01/2023 Sofia Rafael Associates
03/01/2023 Joseph Leasing (Van lease

expense)
03/10/2023 Sofia Rafael: Mazda
03/10/2023 ' Tracey Kari: Odin
03/10/2023 Mimi Petit: Bebe
03/10/2023 @ Record deposit for the

paymentsreceived
03/15/2023 Cathy Pet Care Supplies
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Amount

$198
$350

$225
$645
$144
$1,014

$45

SERVICE DATE

ITEM
[TEM
ITEM

02/20/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

02/27/2023
Extended
Massage

Shampoo Large
Conditioner Large
Blow Dry Large

02/27/2023
Shampoo Smali
Conditioner Small
Blow Dry Small
Medium Massage

Transaction Method Number

Type (s)
Bill Pay

Check

Receive
Payment
Receive
Payment
Receive
Payment
Deposit

Bill Pay

Check 506
507

VISA 5555-55565-5555-
5555 Exp 01/2025

Check 1234
Check 178
Check 508




Step 1. Enter the following Invoices using the service datfes provided. These invoices are
for March 2023:

SERVICE DATE 03/01/2023
Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
BILL TO ITEM Blow Dry Large
ITEM Trim Nails
CUSTOMER Tracey Kari SeRvice Date 03/08/2023
108 Odin Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
ITEM Blow Dry Large
BILL TO SERVICE DATE 03/15/2023
ITEM Shampoo Smaill
CUSTOMER Sofia Rafael ITEM Conditioner Small
ITEM Blow Dry Small
Jo Mazda ITEm Trim Nai)Ils
ITEM Medium Massage
SERVICE DATE 03/15/2023
Extended
ITEM Massage
ITEM Shampoo Large
BILL TO ITEM Conditioner Large
ITEM Blow Dry Large
CUSTOMER Tracey Karl SeRvice DaTe 03/22/2023
JoB Odin Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
ITEM Blow Dry Large
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BILL TO SERVICE DATE 03/16/2023

ITEM Shampoo Medium
CUSTOMER Mimi Petit Conditioner
ITEM edaium
1o Bebe ITEM Blow Dry Medium
ITEM Trim Nails
Extended
ITEM Massage
BILL TO SERVICE DATE 03/27/2023
ITEM Shampoo Smali
CUSTOMER Sofia Rafael ITEM Conditioner Smaill
Jos Mazda ITEM Blow Dry Small
ITEM Medium Massage
SERVICE DATE 03/29/2023
BiLL TO Extended
ITEM Massage
CUSTOMER Tracey Kari ITEm Shampoo Large
Jos Odin ITEm Conditioner Large
ITEM Blow Dry Large
BILL TO SERVICE DATE 03/30/2023
ITEM Shampoo Small
CUSTOMER Graziella Martini ITEM Conditioner Small
. ITEM Blow Dry Small
o Marlo Extended
ITEM Massage
ITEM Trim Nails
Step 1. Invoice Date: 03/31/2023
Step 2. Generate the Invoice for Sofia Rafael: Mazda
Step 3. Generatfe the Invoice Tracey Kari: Odin
Step 4. Generate the Invoice for Mimi Petit: Bebe
Step 5. Generate the Invoice for Graziella Martini: Mario

Transaction Amount Transaction Method Number
Type (s)
04/01/2023 Joseph Leasing (Van lease $350 Check 509
expense)
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Date Transaction Amount Transaction Method Number
Type (s)

04/10/2023 @ Sofia Rafael: Mazda $225  Receive VISA 5555-5555-5555-
Payment 5555 Exp 01/2025

04/10/2023 Tracey Kari: Odin $804 Receive Check 1342
Payment

04/10/2023 = Mimi Petit: Bebe $144  Receive Check 185
Payment

04/10/2023 Graziella Martini: Mario $126 Receive Check 572
Payment

04/10/2023 @ Record deposit for the $1,299 Deposit

paymentsreceived
04/20/2023 FastFuel (gasoline) $54 Charge VISA
Step 1. Enter the following Invoices using the service dates provided. These invoices are

for April 2023:

SERVICE DATE 04/01/2023
Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
BILL TO ITEM Blow Dry Large
ITEM Trim Nails
T;JSTOMER TrOFey Kari SERVICE DATE 04/08/2023
Odin Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
ITEM Blow Dry Large
BILL TO SERVICE DATE 04/15/2023
ITEM Shampoo Smaill
CUSTOMER Sofia Rafael ITEM Conditioner Small
JoB Mazda :TEM Bl.ow Dr}l Small
TEM Trim Nails
ITEM Medium Massage
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CUSTOMER
JOB

CUSTOMER
JoB

CUSTOMER
JOB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM

[TEM

ITEM
[TEM

ITEM

SERVICE DATE
ITEM
[TEM
ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

04/15/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

04/22/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

04/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage

04/27/2023
Shampoo Smali
Conditioner Small
Blow Dry Small
Medium Massage

04/29/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large




BILL TO SERVICE DATE 04/30/2023

ITEM Shampoo Smaill
CUSTOMER Graziella Martini ITEM Conditioner Small
JoB : ITEM Blow Dry Small
Mano Extended
ITEM Massage
ITEM Trim Nails

Step 1. Date of Invoices: 04/30/2023

Step 2. Prepare the final invoice for the following customers:
Sofia Rafael: Mazda

b. Tracey Kari: Odin

Cc. Mimi Petit: Bebe
d

o

. Graziella Martini: Mario

Date Transaction Amount Transaction Method Number
Type (s
05/01/2023 @ Joseph Leasing (Van lease $350 | Check 510
expense)
05/10/2023 | Sofia Rafael: Mazda $225 | Receive VISA 5555-5555-5555-
Payment 5555 Exp 01/2025
05/10/2023 | Tracey Kari: Odin $804 | Receive Check | 1363
Payment
05/10/2023 | Mimi Petit: Bebe $144 | Receive Check | 201
Payment
05/10/2023 | Graziella Martini: Mario $126 | Receive Check | 577
Payment
05/10/2023 | Record deposit for the $1,299 | Deposit
paymentsreceived
05/22/2023 | Paid Visa Credit Card $54 | Checking | Check | 511
Step 1. Enter the following Invoices using the service datfes provided. These invoices are

for May 2023:
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CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

ITEM

SERVICE DATE

[TEM
[TEM

[TEM
[TEM

SERVICE DATE
ITEM
[TEM

ITEM
[TEM

[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM
[TEM

[TEM
[TEM

05/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

05/08/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

05/15/2023
Shampoo Smali
Conditioner Smaill
Blow Dry Small
Trim Nails
Medium Massage

05/15/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

05/22/2023

Short Massage
Shampoo Large
Conditioner Large
Blow Dry Large




CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JoB

CUSTOMER
JOB

Step 3.
Step 4.

BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

BiLL TO

Tracey Kari
Odin

BiLL TO

SERVICE DATE
ITEM

[TEM

ITEM
ITEM

ITEM

SERVICE DATE
[TEM
ITEM
ITEM

ITEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM

Graziella Martini ITEm

Mario

Date of Invoices: 05/30/2023
Use Outstanding Billable Costs fo generate invoices for the following:

a. Sofia Rafael: Mazda

b. Tracey Kari: Odin

Cc. Mimi Petit: Bebe

d. Graziella Martini: Mario

‘ Date Transaction

06/01/2023
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Amount

Joseph Leasing (Van
lease expense)

ITEM

[TEM
[TEM
ITEM

Type (s)
$350 Check

05/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage

05/27/2023
Shampoo Smali
Conditioner Small
Blow Dry Small
Extended
Massage

05/29/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

05/30/2023
Shampoo Smaill
Conditioner Small
Blow Dry Small

Extended
Massage

Trim Nails
Trim Coat

Transaction Method Number

512




06/10/2023
06/10/2023
06/10/2023
06/10/2023

06/10/2023

Step 1.

Sofia Rafael: Mazda
Tracey Kari: Odin

Mimi Petit; Bebe

Graziella Martini: Mario

Record deposit for the

paymentsreceived

for June 2023:

CUSTOMER
JOB

CUSTOMER
JoB
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BILL TO

Tracey Kari
Odin

BiLL TO

Sofia Rafael
Mazda

$234
$777
$144

$162

$1.317

Receive
Payment
Receive
Payment
Receive
Payment
Receive
Payment

Deposit

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

[TEM
SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM
ITEM
ITEM
ITEM

ITEM

5555-5555-5555-

VISA 5555 Exp 01/2025
Check @ 1372

Check | 210

Check | 581

Enter the following Invoices using the service datfes provided. These invoices are

06/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

06/08/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

06/15/2023
Shampoo Small
Conditioner Small
Blow Dry Small
Trim Nails
Medium Massage




CUSTOMER
JOB

CUSTOMER
JoB

CUSTOMER
JoB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM

[TEM

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
[TEM
ITEM
ITEM
ITEM
ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

[TEM

06/15/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

06/22/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

06/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage

Trim Coat

06/27/2023
Shampoo Small
Conditioner Smaill
Blow Dry Small
Medium Massage
Trim Nails

Trim Coat

06/29/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails




BILL TO SERVICE DATE 06/30/2023

ITEM Shampoo Smali
CUSTOMER Graziella Martini ITEM Conditioner Small
JoB : ITEM Blow Dry Small
Mario Extended
ITEM Massage

Step 5. Date of Invoices: 06/30/2023
Sofia Rafael: Mazda

b. Tracey Kari: Odin

c. Mimi Petit: Bebe

d. Graziella Martini: Mario

Q

Transaction Amount Transaction Method Number

Type (s)

Joseph Leasing (Van

07/01/2023 $350 Check 513
lease expense)
. , Receive 5555-5555-5555-
07/10/2023 Sofia Rafael: Mazda $270 Payment VISA 5555 Exp 01/2025
07/10/2023 Tracey Kari: Odin s813 | Receive | ~pock | 1381
Payment
07/10/2023 Mimi Petit: Bebe $180 Receive | pock 215
Payment
07/10/2023 Graziella Martini: Mario 117 Receive |~ ck | 589
Payment
07/10/2023 Recorddepositforthe $1.380  Deposit
paymentsreceived
07/20/2023  FastFuel (automobile) $63 ‘C"j‘gcred“ Credit

Step 1.  Enfer the following Invoices using the service dates provided. These invoices are
for July 2023:
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CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

ITEM

SERVICE DATE

[TEM
[TEM

[TEM
[TEM

SERVICE DATE
ITEM
[TEM

ITEM
[TEM

[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

07/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

07/08/2023
Extended
Massage

Shampoo Large

Conditioner Large
Blow Dry Large

07/15/2023
Shampoo Smali
Conditioner Smaill
Blow Dry Small
Trim Nails
Medium Massage

07/15/2023
Extended
Massage
Shampoo Large

Conditioner Large
Blow Dry Large

07/22/2023
Extended
Massage

Shampoo Large
Conditioner Large
Blow Dry Large




BILL TO SERVICE DATE 07/16/2023

ITEM Shampoo Medium
CUSTOMER Mimi Petit Conditioner
ITEM Medium
JoB
Bebe ITEM Blow Dry Medium
ITEM Trim Nails
Extended
ITEM Massage
BiLL TO SERVICE DATE 07/27/2023
ITEM Shampoo Small
CUSTOMER Sofia Rafael ITEM Conditioner Small
Jos ITEM Blow Dry Small
Mazda ITEM Medium Massage
SERVICE DATE 07/29/2023
BiLL TO Extended
ITEM Massage
CUSTOMER Tracey Kari ITem Shampoo Large
JoB Odin ITEM Conditioner Large
ITEM Blow Dry Large
BILL TO SERVICE DATE 07/30/2023
ITEM Shampoo Small
CUSTOMER Graziella Martini ITEM Conditioner Small
Jos Mari ITEM Blow Dry Small
ario Extended
ITEM Massage
ITEM Trim Nails
Step 6. Date of Invoices: 07/30/2023
a. Sofia Rafael: Mazda
b. Tracey Kari: Odin
c. Mimi Petit: Bebe
d. Graziella Martini: Mario
08/01/2023 ~OsephLeasing (Van $350 Check 514
lease expense)
. ) Receive 5555-5555-5555-
08/10/2023 Sofia Rafael: Mazda $225 Payment VISA 5555 Exp 01/2025
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08/10/2023
08/10/2023
08/10/2023

08/10/2023
08/20/2023

Step 1.

Tracey Kari: Odin
Mimi Petit: Bebe

Graziella Martini: Mario

Record deposit for the
paymentsreceived
Visa Credit Card

for August 2023:

BILL TO

CUSTOMER Tracey Kari

JoB

Odin

BiLL TO

CUSTOMER Sofia Rafael

JOB

Mazda
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$804
$144
$126

$1.299
$63

Receive
Payment
Receive
Payment
Receive
Payment

Deposit
Checking

SERVICE DATE

[TEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM
[TEM
ITEM
ITEM

[TEM

Check 1390
Check 223
Check 595
Check 515

Enter the following Invoices using the service dates provided. These invoices are

08/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

08/08/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

08/15/2023
Shampoo Smali
Conditioner Smaill
Blow Dry Small
Trim Nails
Medium Massage




CUSTOMER
JOB

CUSTOMER
JoB

CUSTOMER
JoB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM

[TEM

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
[TEM
ITEM
ITEM
ITEM
ITEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

08/15/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

08/22/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

08/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage

Trim Coat

08/27/2023
Shampoo Small
Conditioner Smaill
Blow Dry Small
Medium Massage
Trim Coat

08/29/2023
Extended
Massage

Shampoo Large
Conditioner Large
Blow Dry Large




BiLL TO

CUSTOMER Graziella Martini
JOB Mario
Step 7. Date of Invoices: 08/31/2023

a. Sofia Rafael: Mazda

b. Tracey Kari: Odin

c. Mimi Petit: Bebe

d. Graziella Martini: Mario

Joseph Leasing (Van

{3/Al2025 lease expense) $350
09/10/2023 SofiaRafael: Mazda $261
09/10/2023 Tracey Kari: Odin $795
09/10/2023 Mimi Petit: Bebe $180
09/10/2023 Graziella Martini: Mario $126
09/10/2023 Record deposﬁfor the $1,362

paymentsreceived

Cathy PetCare
09/20/2023 (Purchased Petspa $72

Supplies on account)

Step 1.

for September 2023:
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SERVICE DATE
ITEM
ITEM
ITEM

[TEM
[TEM

Check

Receive
Payment
Receive
Payment
Receive
Payment
Receive
Payment

Deposit

08/30/2023
Shampoo Smaill
Conditioner Smaill
Blow Dry Small

Extended
Massage
Trim Nails
516

5555-5555-5555-

VA 5555 Exp 01/2025
Check 1350
Check 234
Check 603

Enter the following Invoices using the service dates provided. These invoices are




CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

ITEM

SERVICE DATE

[TEM
[TEM

[TEM
[TEM

SERVICE DATE
ITEM
[TEM

ITEM
[TEM

[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

09/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

09/09/2023
Extended
Massage

Shampoo Large

Conditioner Large
Blow Dry Large

09/15/2023
Shampoo Smali
Conditioner Smaill
Blow Dry Small
Trim Nails
Medium Massage

09/15/2023
Extended
Massage
Shampoo Large

Conditioner Large
Blow Dry Large

09/22/2023
Extended
Massage

Shampoo Large
Conditioner Large
Blow Dry Large




CUSTOMER
JOB

CUSTOMER
JoB

CUSTOMER
JOB

CUSTOMER
JOB

Step 8.
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BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

BiLL TO

Graziella Martini
Mario

Date of Invoices: 09/30/2023

Q

b
c.
d

Sofia Rafael: Mazda

. Tracey Kari: Odin

Mimi Petit: Bebe

. Graziella Martini: Mario

SERVICE DATE
[TEM

[TEM

[TEM
[TEM

[TEM

SERVICE DATE
[TEM
ITEM
ITEM
ITEM
ITEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM
[TEM
ITEM

[TEM
[TEM

09/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage

09/27/2023
Shampoo Small
Conditioner Small
Blow Dry Small
Medium Massage
Trim Coat

09/29/2023
Extended
Massage

Shampoo Large
Conditioner Large
Blow Dry Large

09/30/2023
Shampoo Smaill
Conditioner Small

Blow Dry Small
Extended
Massage
Trim Nails




Date Transaction Amount Transaction Method Number

10/01/2023 JOsePhLeasing (Van $350 Check 517
lease expense)
Receive 5555-5555-5555-
10/10/2023 Sofia Rafael: Mazda $261 Pavment VISA 5555
Y Exp 01/2025
10/10/2023  Tracey Kari: Odin $8p4 Receive | ~p k1359
Payment
10/10/2023 = Mimi Petit: Bebe $144 Receive ' v 43
Payment
10/10/2023  Graziella Martini: Mario 126 | Receive |~k | 612
Payment
10/10/2023 Recorddeposit forthe $1,335 Deposit
paymentsreceived
Cathy PetCare
10/20/2023 (Purchased Petspa $72 Pay Bill Check 518

Supplies on account)

Step 1. Enter the following Invoices using the service dates provided. These invoices are
for October 2023:

SERVICE DATE 10/01/2023
Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
BILL TO ITEM Blow Dry Large
ITEM Trim Nails
CUSTOMER i
o8 Trog:ey Kari SERVICE DATE 10/10/2023
Odin Extended
ITEM Massage
ITEM Shampoo Large
ITEM Conditioner Large
ITEM Blow Dry Large
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CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB
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BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

SERVICE DATE
[TEM
[TEM

[TEM
[TEM

[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM

[TEM

ITEM
[TEM

[TEM

SERVICE DATE
ITEM
[TEM

ITEM
[TEM

10/15/2023
Shampoo Smaill
Conditioner Smaill
Blow Dry Small
Trim Nails
Extended
Massage

10/15/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

10/22/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

10/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails

Short Massage

10/27/2023
Shampoo Small
Conditioner Small

Blow Dry Small
Medium Massage




SERVICE DATE 10/29/2023

Extended
BILL TO ITEMm Massage
ITEM Shampoo Large
CUSTOMER Tracey Kari ITEm Conditioner Large
Jos Odin ITEM Blow Dry Large
ITEM Trim Coat
ITEM Trim Nails
BILL TO SERVICE DATE 10/30/2023
ITEM Shampoo Smaill
CUSTOMER Graziella Martini ITEM Conditioner Small
. ITEM Blow Dry Small
108 Mario Exiende)::!
ITEM Massage
ITEM Trim Nails

Step 1. Date of Invoices: 10/30/2023
a. Sofia Rafael: Mazda
b. Tracey Kari: Odin
C. Mimi Petit: Bebe
d. Graziella Martini: Mario

Transaction Amount Transaction Method Number

Type (s)

Joseph Leasing (Van

11/01/2023 $350 Check 519
lease expense)

Receive 5555-5555-5555-

11/11/2023 @ Sofia Rafael: Mazda $234 Pavment VISA 5555

y Exp 01/2025

11/11/2023 Tracey Kari: Odin g849 | Receive |~ ok | 1368
Payment

11/11/2023 = Mimi Petit: Bebe 117 Receive '~k 25
Payment

11/11/2023 Graziella Martini: Mario $12¢ | Receive |~ ok | 621
Payment

11/11/2023 Record deposit for the $1,326  Deposit

paymentsreceived

Step 1. Enter the following Invoices using the service dates provided. These invoices are
for November 2023:
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CUSTOMER
JOB

CUSTOMER
JOB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

ITEM

SERVICE DATE

[TEM
[TEM

[TEM
[TEM

SERVICE DATE
ITEM
[TEM

ITEM
[TEM

[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

11/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

11/11/2023
Extended
Massage

Shampoo Large
Conditioner Large
Blow Dry Large

11/15/2023
Shampoo Smali
Conditioner Smaill
Blow Dry Small
Trim Nails
Medium Massage

11/15/2023
Extended
Massage

Shampoo Large

Conditioner Large
Blow Dry Large

11/22/2023
Extended
Massage
Shampoo Large

Conditioner Large
Blow Dry Large




BILL TO SERVICE DATE 11/16/2023

ITEM Shampoo Medium
CUSTOMER Mimi Petit Conditioner
ITEM Medium
JoB
Bebe ITEM Blow Dry Medium
ITEM Trim Nails
Extended
ITEM Massage
BILL TO SERVICE DATE 11/27/2023
ITEM Shampoo Smali
CUSTOMER Sofia Rafael ITEM Conditioner Smaill
Jos ITEM Blow Dry Small
Mazda ITEM Medium Massage
SERVICE DATE 11/29/2023
BiLL TO Extended
ITEM Massage
CUSTOMER Tracey Kari ITEm Shampoo Large
JoB Odin ITEMm Conditioner Large
ITEM Blow Dry Large
BILL TO SERVICE DATE 11/30/2023
ITEM Shampoo Small
CUSTOMER Graziella Martini ITEM Conditioner Small
JOB Mario ITEM Blow Dry Small
Extended
ITEM Massage
ITEM Trim Nails

Step 2. Date of Invoices: 11/30/2023
a. Sofia Rafael: Mazda
b. Tracey Kari: Odin
c. Mimi Petit: Bebe
d. Graziella Martini: Mario

Transaction Amount Transaction Method Number

Type (s)

Joseph Leasing (Van

12/01/2023 $350 Check 520
lease expense)
Receive 5555-5555-5555-
12/12/2023 @ Sofia Rafael: Mazda $225 P VISA 5555
ayment

Exp 01/2025
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12/12/2023 Tracey Kari: Odin

12/12/2023 | Mimi Petit: Bebe

12/12/2023 | Graziella Martini: Mario

Record deposit for the

12/12/2023 paymentsreceived

12/20/2023 FastFuel (gasoline)

Step 1.
for December 2023:

BILL TO

CUSTOMER
JOB

Tracey Kari
Odin

BiLL TO

CUSTOMER
JoB

Sofia Rafael
Mazda
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$804
$144
$126
$1,299

$54

Receive
Payment
Receive
Payment
Receive
Payment

Deposit

Visa Credit

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
[TEM
ITEM
ITEM
ITEM

ITEM

Check | 1377
Check | 261
Check | 630
Credit

Card

Enter the following Invoices using the service datfes provided. These invoices are

12/01/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Nails

12/12/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

12/15/2023
Shampoo Small
Conditioner Small
Blow Dry Small
Trim Nails
Medium Massage




CUSTOMER
JOB

CUSTOMER
JoB

CUSTOMER
JOB

CUSTOMER
JOB
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BILL TO

Tracey Kari
Odin

BiLL TO

Mimi Petit
Bebe

BiLL TO

Sofia Rafael
Mazda

BILL TO

Tracey Kari
Odin

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

SERVICE DATE
ITEM

[TEM

ITEM
[TEM

ITEM

SERVICE DATE
ITEM
[TEM
ITEM
[TEM

SERVICE DATE

ITEM
[TEM

ITEM
[TEM

[TEM
[TEM

12/15/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

12/22/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large

12/16/2023
Shampoo Medium
Conditioner
Medium

Blow Dry Medium
Trim Nails
Extended
Massage

12/27/2023
Shampoo Smali
Conditioner Small
Blow Dry Small
Medium Massage

12/29/2023
Extended
Massage
Shampoo Large
Conditioner Large
Blow Dry Large
Trim Coat

Trim Nails




CUSTOMER

JOB

Step 2.

BILL TO SERVICE DATE 12/30/2023

ITEM Shampoo Smaill
Graziella Martini ITEM Conditioner Small
. ITEM Blow Dry Small
Mario Extended
ITEM Massage
ITEM Trim Nails
ITEM Trim Coat

Date of Invoices: 12/30/2023
a. Sofia Rafael: Mazda

b. Tracey Kari: Odin

Cc. Mimi Petit: Bebe

d. Graziella Martini: Mario

CH11 DEP DET

Step 5.
Step 6.

Step 7.
Step 8.

From the Banking Reports, Export the Deposit Detail Report for 2023
to Excel

Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_11_REPORTS Excel file.

From the drop-down list, select the sheet: CH11 DEP DET

Save and close the Excel file

CH11 CHK DET

Step 1.
Step 2.

Step 3.
Step 4.

From the Banking Reports, Export the Check Detail Report for 2023
to Excel

Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_11_REPORTS Excel file.

From the drop-down list, select the sheet: CH11 CHK DET

Save and close the Excel file

CH11 CUS DET

Step 5.
Step 6.

Step 7.
Step 8.

From the Customer & Receivables Reports, Export the Customer
Balance Detail report for 2023 to Excel

Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_11_REPORTS Excel file.

From the drop-down list, select the sheet: CH11 CUS DET

Save and close the Excel file.

CH11 VEN EXP

Step 1.
Step 2.
Step 3.
Step 4.

Step 5.
Step 6.
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From the Vendors & Payables Reports, Export the Transaction List by
Vendor

From 01/01/2023 to 12/31/2023

Customize the Report Title: Vendor Expense Detail

Follow the instructions in Appendix C to export the report fo the
Excel file named UNIT_11_REPORTS Excel file.

From the drop-down list, select the sheet: CH11 VEN EXP

Save and close the Excel file.




CH11 1B

Step 7. From the report Center select Accountant & Taxes = Trial Balance

Step 8. Date: 12/31/2023

Step 9. Export to Excel

Step 10. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_11_REPORTS Excel file.

Step 11. From the drop-down list, select the sheet: CH11 TB

Step 12.  Verify account 12000 Undeposited Funds has a $0.00 balance.
Highlight the Undeposited Funds $0.00 balance

Step 13. Save and close the Excel file.

DEPRECIATION

|
The concept of depreciation isreally pretty simple. For example, let's say you purchase a truck
for your business. The fruck loses value the minute you drive it out of the dealership. The truck is
considered an operational asset in running your business. Each year that you own the truck, it
loses some value, until the fruck finally stops running and has no value to the business. Measuring
the lossin value of an asset is known as depreciation.

Depreciation is considered an expense and is listed in an income statement under expenses. In
addition to vehicles that may be used in your business, you can depreciate office furniture,
office equipment, any buildings you own, and machinery you use to manufacture products.

Land is not considered an expense, nor can it be depreciated. Land does not wear out like
vehicles or equipment.

To find the annual depreciation cost for your assets, you need to know the initial cost of the
assets. You also need to determine how many years you think the assets will retain some value
for your business. In the case of the truck, it may only have a useful life of ten years before it
wears out and loses all value.

STRAIGHT-LINE DEPRECIATION

o
=

e
—r

e
—r

it

e e e

Straight-line depreciation is considered to be the most common method of depreciating assets.
To compute the amount of annual depreciation expense using the straight-line method requires
two numbers: the initial cost of the asset and its estimated useful life. For example, you purchase
a truck for $20,000 and expect itto have use in your business for ten years. Using the straight-line
method for determining depreciation, you would divide the initial cost of the fruck by its useful
life.

The $20,000 becomes a depreciation expense that is reported on your income statement under
operation expenses at the end of each year.

For tax purposes, some accountants prefer to use other methods of accelerating depreciation in
order to record larger amounts of depreciation in the early years of the asset to reduce tax bills
as soon as possible.
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You need, additionally, to check the regulations published by the federal Internal Revenue
Service and various state revenue authorities for any specific rules regarding depreciation and
methods of calculating depreciation for various types of assets

The depreciation formula (straight-line) to compute straight-line depreciation for a one-year
period is:

Asset cost - Estimated residual value
Annual depreciation =

Estimated years of Useful life

QUICKBOOKS METHODS

_______________________________________________________________________________________________________________________________________________________|
Fixed asset tracking and the Fixed Asset Manager

Tracking the book value of long-term assets as they decline over time can be a fricky business.
The amount by which they depreciate can affect not only the worth of a business, but the size of
a tax bill. It'simportant fo develop good record-keeping habits where such fixed assets are
concerned. If's also important for accountants and their clients to work together to make sure all
the necessary information is being recorded so both financial statements and tax returns are
correct.

QuickBooks can help both accountants and small business owners using fixed asset items and
the Fixed Asset Manager.

ON THE SMALLBUSINESS SIDE

_______________________________________________________________________________________________________________________________________________________|
Tracking fixed assets with fixed asset items enables you to record such information about an
asset as purchase date and price, whether the asset was new or used when purchased, and the

asset's sale price if you decide to sell it. You can also generate customizable reports listing all
your fixed assefs.

To see examples of fixed asset items, open the product-based sample company file for Rock
Castle Constfruction, then go to the Lists menu and click Fixed Asset Item List.

ON THE ACCOUNTANT'S SIDE

I ————
When the Fixed Asset Manager is started from within either a QuickBooks Accountant or
QuickBooks Enterprise Solutions edifion, it pulls in information about fixed assets from an open
company file. Then the accountant can determine depreciation for the assets and post a
journal entry back to the company file. The accountant can also entfer assets in the Fixed Asset
Manager and send that information back to QuickBooks.

The Fixed Asset Manager integrates with Infuit's ProSeries Tax products, which makes it easier to
get asset information from QuickBooks into ProSeries Tax.

Here are some of the features the Fixed Asset Manager offers:
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e Tight infegration with QuickBooks data.

e A detailed, customizable asset entry screen.

o Sixdepreciation bases (Book, State, Federal, Other, AMT, ACE).
e Projected depreciation calculations.

¢ Disposition fracking.

e Custom queries and sorting.

e Full calculation overrides.

e A wide variety of built-in depreciation reports and forms.

e Mulliple ways to export and import data.

e Infegration with ProSeries Tax products.

In addition to synchronizing data with QuickBooks, the Fixed Asset Manager has its own data files
that can hold more detailed asset information than a company (QBW) file can hold.

To open the Fixed Asset Manager, go to the Accountant menu and click Manage Fixed Assets.
To open the Fixed Asset Manager, go to the Company menu and click Manage Fixed Assefs.

To see an example of a file with information you can pull into the Fixed Asset Manager, open the
product-based sample company file for Rock Castle Construction. To view the fixed asset items
included in the file, go to the Lists menu and click Fixed Asset ltem List.

ENTERING A DEPRECIATION TRANSACTION

R

e

e

e

e

e

&

If your accountant uses the QuickBooks Fixed Asset Manager and you track your fixed assets

with fixed asset items, you may not need to enter depreciation fransactions. Ask your
accountant for more information.

—_

Go to the Lists menu and click Chart of Accounts. E

Double-click the sub account that fracks accumulated depreciation for the asset you're
depreciating.

Enter the transaction in the bottom of the register:

Enter the depreciation amount as a decrease in the register.

In the Account field, enter the expense account that you set up to frack depreciation.
Save the entry.

If you use a fixed asset item to frack this asset, you can edit your fixed asset item and
record that you've entered this depreciatfion fransaction in the Notes field.

N

No o~ ®

EFFECT ON YOUR ACCOUNTS

R

e

e

e

e

e

&

In the asset's fixed asset account, QuickBooks subtracts the depreciation amount from the cost
of the asset.

In the account that tracks depreciation, QuickBooks enters the depreciation amount as an
increase to your company's depreciation expense.
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ADJUSTING ENTRIES

R

e
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ADJUSTING ENTRY ADIJ1

Step 4. To enter adjusting entries, select Accountant Menu - Make General Journal
Entries

Step 5. The end of the 2023-year inventory revealed the pet spa had $39 of office
supplies on hand. Use the Make General Journal Enfries window to record the
adjusting entry (ADJ1) for additional office supplies on hand

Step 6. Add account 13100 Office Supplies on Hand > Other Current Assets

ADJUSTING ENTRY ADJ2

Step 1. The end of the 2023-year inventory revealed the pet spa had $108 of pet spa
supplies on hand. Use the Make General Journal Enfries window to record the
adjusting entry (ADJ2) for additional office supplies on hand

Step 2. Add account 13200 Pet Spa Supplies on Hand > Other Current Assets

ADJUSTING ENTRY ADJ3

Step 5. The pet spa equipment cost $1,350

Step 6. Calculate the equipment cost using straight-line depreciation over five
years with no salvage value.
Step 7. Click Save & Close to save the adjusting journal entries

CH11 ADJ JUR

Step 1. From the Accounting section, pull the Adjusting Journal Entries report for
December 31, 2023

Step 2. Export the Transaction Journal to Excel

Step 3. Follow the instructions in Appendix C fo export the report to the Excel file named

UNIT_11_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: CH11 ADJ JUR

Step 5. Save and close the Excel file.
Step 6. Close the Transaction Journal window and the Make Deposits window
CH11 ADJ TB
Step 1. From the Accounting section, pull the Adjusted Trial Balance report for
December 31, 2023
Step 2. Export the Transaction Journal fo Excel
Step 3. Follow the instructions in Appendix C to export the report to the Excel file named

UNIT_11_REPORTS Excel file.
Step 4. From the drop-down list, select the sheet: CH11 ADJ TB

Step 5. Highlight the amounts affected by the adjusting entries
Step 6. Save and close the Excel file.

CH11 PL JOB
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Step 5. Export the Profit and Loss by Job to Excel
Step 6. Follow the instructions in Appendix C to export the report to the
Excel file named UNIT_11_REPORTS Excel file.
Step 7. From the drop-down list, select the sheet: CH11 PL JOB
Step 8. Save and close the Excel file.
CH11 BS STD
Step 5. Export the Balance Sheet Standard to Excel
Step 6. Follow the insfructions in Appendix C fo export the report to the
Excel file named UNIT_11_REPORTS Excel file.
Step 7. From the drop-down list, select the sheet: CH11 BS STD
Step 8. Save and close the Excel file.
CH11 SCF
Step 5. Export the Statement of Cash Flows fo Excel
Step 6. Follow the insfructions in Appendix C fo export the report to the
Excel file named UNIT_11_REPORTS Excel file.
Step 7. From the drop-down list, select the sheet: CH11 SCF
Step 8. Save and close the Excel file.
CH11 CFF
Step 1. Export the Cash Flow Forecast
Step 2. From 01/01/2024 to 01/31/2024
Step 3. Export to Excel
Step 4. Follow the instructions in Appendix C fo export the report to the
Excel file named UNIT_11_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: CH11 CFF
Step 6. Save and close the Excel file.
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COMPREHENSIVE PROJECT

UNIT 12 CREATE YOUR QUICKBOOKS COMPANY
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This is an opportunity to define a company of your choosing using QuickBooks. You can use an
existing company model or a fictitious company. It isimportant that you keep in mind the
company must have specific preferences available for fransactions you will be creating to
complete the project.

In this unit, you will complete the first phase of the project by determining your business structure
(Modules 1 & 2). The activities in Units 10 and 11 can be used as a reference to of how to plan
the structure of your company. The comprehensive project consists of four modules.

Module 1 - Project Plan (Proposal & Setup)

Module 2 - Lists (Customers, Vendors, ltems)

Module 3 - Sample Transactions (Invoices, Payments, Deposits and Memorized Transactions)

Module 4 - Assigned Transactions (A list of fransactions that include specific invoice
amounts, statements, bill pay and customized form:s)

MODULE 1 - PROJECT PLAN

___________________________________________________________________________________________________________________________|
Step 41. Using MS Word, Open the Module 1 handout in your Unit 12 folder (Word

Document).
Step 42. Student Name: Type your name in the adjacent blank cell.
Step 43. Save your document as Module 1

NEW QUICKBOOKS COMPANY USING THE EASYSTEP INTERVIEW

R

e

Step 44. Select Create a new company
Step 45. When the QuickBooks Setup window appears, select Detailed Start

e

e

e e e

e PR R R R R R

01 COMPANY INFORMATION

Step 4é. When your Company Information window appears, enter your desired
company name. Fillin the detailed company information listed in the Module
1 handout.

Step 47. Make a screen copy of your input and paste the image into the first blank cell of

the Module 1 handout.

02 SELECTYOUR INDUSTRY

Step 48. When you select your industry, create a screen shot and paste it info the Module
1 area marked Select Your Industry.

03 ORGANIZATION

Step 49. This is where you are fo choose the type of business organization your company
will be using (Sole Proprietorship, Partnership, Corporation, S-Corporation or
Limited Liability Company). After you have completed the selection create a
screen shot and paste itinto the blank cell below How Is Your Company
Organized?

04 FISCAL YEAR

Step 50. You can use any fiscal year you choose; however, please keep in mind in Module
4, you are given a list of fransactions. The dates for these fransactions are an
important part of the activity. Your transactions will be for the last quarter of 2020.
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Step 51. Once you have completed the fiscal year setup, take a screen shot and place it
in the area for Your Fiscal Year.

05 ADMIN PASSWORD

Step 52. You need to setup an administrator password for your company. Ifis
recommended that you use a simple password like (Cuesta123). | have dealt
with many students that have forgotten the password they create and are forced
to recreate their company.

Step 53. Create ascreen shot of your password setup

06 SAVETHE COMPANY FILE

Step 54. The next step is to save your file. Remember QuickBooks saves many files in the
same location. | suggest creating a folder for the project and save the file in your
new project folder. You can use a file name that represents your company. It is
the folder that is important. You will be using this file each time you add to your

project.
Step 55. Enter File Name: Your Choice
Step 56. Click Save
Step 57. Create ascreen shot of the project folder along with the QuickBooks company

file and all the folders created in the process.

07 HOME SCREEN

Step 58. Your QuickBooks company file should have a home screen with the following
preferences available:
a. Purchase Orders
b. Invoices
c. Bills & Pay Bills
d. Sales Receipfts
e. Refunds & Credifs
Step 59. Create ascreen shot of the home screen that shows these options are available.
You will need them for the final module (4).

BACKUP YOUR COMPANY FILE

B

.=

.=

.=

.= .=

&

Step 2.  Use the instructions in Appendix A to back up your company file. Make
sure your backup file is saved in the designated folder of this unit (PROJECT
BACKUPS).

SUBMIT THE MODULE 1 WORD DOCUMENT

R

e

e

e

e

e

&

After the screen shots have been created, you are ready to save the Module 1 document.
Submit the completed document to the Module 1 - Individual Project: Proposal & Setup

Step 1. Save the Module 1 document with the screen shots to your project folder.
Step 2. Submit your completed document to the assignment called:

Module 1 - Individual Project: Proposal & Setup
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MODULE 2 - LISTS CUSTOMERS, VENDORS, ITEMS

I ————
After setting up the protfotype for your company identified in module 1, QuickBooks will have a
standard Chart of Accounts setup designed for your type of business. In this module you will
modify the existing Chart of Accounts

CHART OF ACCOUNTS REVISIONS

B e e B s e e e

Step 2.

5 Points

Step 3.

Step 4.

10
Points

Step 5.

5 Points

Step 6.
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Account Number
Account Type
Range
DISPLAY ACCOUNT Asset Accounts 10000 - 19999
NUMBERS: Instructions Liability Accounts 20000 - 29999
are in your textbook Equity Accounts 30000 - 39999
(unit 2). Revenue (income) Accounts 40000 - 49999
EXPORT THE ACCOUNT Cost of Goods Accounts 50000 - 59999
LISTING TO EXCEL (COA- | Expense Accounts 60000 - 69999
‘|): Exporf your origino| Non-POSﬂng 90000 - 99999

Account Listing to the Excel document provided (MODULE 2-REPORTS.XLSX). Follow
the instructions in Appendix C to export the report to the Excel file named MODULE
2-REPORTS Excel file. . From the dropdown list of sheets, you will be selecting COA-1.

MAKE ADJUSTMENTS TO YOUR CHART OF ACCOUNTS: In order to make these
adjustments, you may choose to rename, delete or change the name of the
original accounts. You should make at least one of these types of adjustments in
each of the following categories:

Asset (Fixed, Other Current or Other Asset)

Equity

Income

Liabilities (Other Current Liability, Long Term Liability)

Cost of Goods Sold

Expense

Bank

CREDIT CARD ACCOUNTS: Credit card accounts are considered Liability accounts.
Use the table provided to add at least 3 credit card accounts to your company.
Keep in mind credit card accounts are reconciled and they have their own unique
register just like bank accounts. They can be Gas, Visa, Mastercard, Amex, or a
Company Line of Credit from a vendor (i.e. Home Depot, Hayward Lumber, etc.)

EXPORTTHE ACCOUNT LISTING TO EXCEL (COA-2): Export your revised Account
Listing to the Excel document provided (MODULE 2-REPORTS.XLSX). Follow the

instructions in Appendix C to export the report to the Excel file named MODULE 2-
REPORTS Excel file.. From the dropdown list of sheets, you will be selecting COA-2.

AN N N NN

HIGHLIGHTTHE CHANGES MADE (COA-2): In your new account listing exported
to Excel, highlight the accounts you have just added using the text highlighter in
Excel. Saveyourresult and close the Excel workbook.




ADD CUSTOMERS

R

e

Step 1.

Step 2.

Step 3.

10
Points

Step 4.

5 Points
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Add at least 7 customers to your customer list. Make sure you fill out the
information for each company containing the following bits of information:
Company Name

Full Name of Primary Contact

Bill TO/SHIP TO: Address

Main Email

Main Phone

Website

Any addifional information you feel is necessary to meet the needs of your
company.

e

e

e

&

AN N NN

CUSTOMIZE THE CUSTOMER CONTACT LIST: From the Customer Contact List report,
customize the report so that it shows only the following fields:

Customer

Company

Main Phone

Main Email

Website

First Name

CREATE A CATEGORY & MEMORIZE THE REPORT - Create a category in your
memorized report list called Module 2 and save the new customized Customer
Contact List.

AN N N N NN

NOTE: To add a category in the memorized reports, follow these steps.

Click Reports

Choose Memorized Reports

Memorized Report List

From the bottom left of the Memorized report list, Click Memorize Report
Choose New Group and name the group as specified (Module 2)

Now you can save your new Customer Contact List in the Module 2 Folder
from the reports menu under memorized reports.

EXPORTTHE CUSTOMER CONTACT LISTTO EXCEL (CUST): Export yourrevised
report fo the Excel document provided (MODULE 2-REPORTS.XLSX). Follow the
instructions in Appendix C to export the report to the Excel file named MODULE
2-REPORTS Excel file.. From the dropdown list of sheets, you will be selecting
CUST.

AN N N N NN




ADD VENDORS

R

e

e e e e

&

Step 1. Add at least 7 vendors to your vendor list. Make sure you fill out the information
for each company containing the following bits of information:

v" Vendor Name
10 v Billed From
Points v" Account Settings (Choose account to prefill for each vendor)
v" Main Phone
v" Any additional information you feel is necessary to meet the needs of your
company
Step 2. EXPORTTHE VENDOR CONTACT LISTTO EXCEL (VEND): Export your revised
report to the Excel document provided (MODULE 2-REPORTS.XLSX). Follow the
& Points instructions in Appendix C to export the report to the Excel file named MODULE
2-REPORTS Excel file.. From the dropdown list of sheets, you will be selecting
VEND
Step 3. MEMORIZE THE REPORT: Save the new report in the Module 2 Report list
Step 4. SAVE YOUR EXCEL FILE: Check your Excel file that it contains the COA-1, COA-2,
CUST & VEND sheets completed as specified in the previous instructions.
Step 5. UPLOAD THE FILE TO CANVAS: You will be uploading the completed report to the

designated area of the Canvas course room for PROJECT MODULE 2: LISTS (Chart
of Accounts, Customers, Vendors)

UNIT 12 CORRECT YOUR PARTNER

For this assignment you will be using the Assignment keys for Units 10 and 11 to correct the work your
partner has completed. Upload the following forms and fill them out as you compare the assignment to the
key that has been posted for the individual unit.

Step 1. In Canvaslook for the assignment called Unit 12 - Correct Your Partner

Step 2. Make sure you have a designated partner for this activity. Yourinstructor will
assign the tfeams using the Canvas groups function. This will give you an area you
can use to discuss any questions you may have with your designated partner.
The partners will only be assigned to those students that have completed Units 10,
and 11.

Step 3. In your Unit 12 folder, open the Word document called Check Your Partner.
Please use this file as a template for analyzing the assignments your partner has
submitfed. Please make detailed notes.

Step 4. Save your word document. Submit your notes to your partner and to the Canvas
assignment area for Unit 12 — Correct Your Partner.

Page | 300




ADVANCED FEATURES FOR
ACCOUNTANTS

UNIT 13 ADVANCED FEATURES FOR ACCOUNTANTS

Accounting: Career Overview

ACCOUNTING SKILLS CERTIFICATION

Analytical Public accountants must pass the
Communication/Interpersonal Certified Public Accounting (CPA)
Detail Oriented Exam

Information Technology

Organizational/Business

Accountants collect, organize
3 and track financial information
for organizations

$42,410

EMPLOYMENT OUTLOOK
B)the balance

$68,150 $120,910
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STUDENT LESSON FILES

You will find the following files in your Student files for UNIT 13.

e Ul3al Paint Palette

e UNIT_13_Reports
To complete the first lesson exercises, RESTORE the u13al Paint Palette company file from the
UNIT 13 folder.

Password: Cuesta123

RENAME THE COMPANY

After you have followed the instructions to restore your data files, you will find the company file

you have restored contains sample data fora company called Rock Castle Construction. Your
first activity is o personalize that name to meet your needs follow these instructions:

Step 49. From the Menu bar, select Company

Step 50. Select MY COMPANY

Step 51.  Select EDIT

Step 52. Update the Company Name Field to: YourName Paint Palette

Step 53. CLICK on OK
Step 54. Close the My Company window.

MANAGERIAL ACCOUNTING

I ————
Managerial accounting helps managers make good decisions. Managerial accounting provides
information about the cost of goods and services, whether a product is profitable, whether to
invest in a new business venture, and how to budget. It compares actual performance to

planned performance and facilitates many other important decisions critical to the success of
organizations.

Whereas financial accounting provides financial information primarily for external use,
managerial accounting information is forinternal use. By reporting on the financial activities of
the organization, financial accounting provides information needed by investors and creditors.

Most managerial decisions require more detailed information than that provided by external
financial reports. For instance, in their external financial statements, large corporations such as
General Electric Company show single amounts on their balance sheets forinventory. However,
managers need more detailed information about the cost of each of several hundred products.

Managerial accountants face many choices involving ethics. For example, managers are
responsible for achieving financial targets such as net income. Managers who fail to achieve
these targetfs may lose their jobs. If a division or company is having frouble achieving financial
performance targets, managers may be fempted to manipulate the accounting numbers.

In its Standards of Ethical Conduct for Management Accountants, the Institute of Management
Accountants (IMA) states that management accountants have an obligation to maintain the
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highest levels of ethical conduct by maintaining professional competency, refraining from
disclosing confidential information, and maintaining integrity and objectivity in their work.

The standards recommend that people faced with ethical conflicts follow the company's
established policies that deal with such conflicts. If the policies do not resolve the conflict,
accountants should consider discussing the maftter with their superiors, potentially going as high
as the audit committee of the board of directors. In exireme cases, the accountants may have
no alternative but to resign.

CREATING A BUDGET

As Paint Palette enters its second year of operation, planning for future expansion is important to
its continued success. You develop the following budget for 2024.

e January sales are expected to be $4,300. Sales are expected to increase by 5% each
month thereafter.

e Paint supplies expense is budgeted at $35 per month.

e The van lease will be $270 per month. (Account no. 67100)

Follow these steps to prepare the budget for Paint Palette:

Step 1. From the menu bar, Select Company

Step 2. Select Planning & Budgeting

Step 3. Select Set Up Budgets

Step 4. In the Create New Budget window, select the year: 2024
Step 5. Select budget type: Profit and Loss

Step 6. Select Next

Step 7. Select No additional criteria
Step 8. Select Next
Step 9. Select Create budget from scratch

Step 10.  Click Finish

Page | 303




Step 11.  When the Set-Up Budgets window appears, Enter 4300.00 for 47900 Sales Account
inthe Jan 24 Column

Estinf 60200 - Automobi...

Set Up Budgets

Budget
FY2024 - Profit & Loss by Account v Create New Budget

Sales Income A

|4?900-Sales 51,600.00 4,300.00 4300.00 4,300.00 4,300.00 4,300.00 4,300.00 4,300.00 4,300.00 4,300.00 4,300.00 4,300.00 4,300.00|'
Costof Goods 5...
I% 60000 - Advertisi...

60400 - Bank Ser..
61700 - Compute...
62400 - Deprecia...
63300 - Insuranc...
53400 - Interest ...

54300 - Meals an...
54800 - Paint Su...

64900 - Office Su...
v

Copy Across Adjust Row Amounts Clear Save @ Cancel Help

Step 12.  Click the Copy Across button

Step 13.  Click the Adjust Row Amounts Butfon

Step 14.  When the Adjust Row Amounts window appears, select Start at: Currently
selected month

Step 15.  Select Increase each remaining monthly amount in this row by this dollar amount
or percentage.

Step 16.  Enter 5.0%

Step 17.  Check: Enable compounding

Step 18.  Click OK

Step 19.  Enter budget amounts for Paint Supplies Expense of $35 per month

Step 20.  Click the Copy Across button

Step 21. Enter Rent Expense for the van of $270 per month

Step 22. Click the Copy Across button

Step 23.  Click OK to close the Set-Up Budgets window

CH13 BUD

Step 1. From the Report Center or the Report Menu select Budgets & Forecasts - Budget
Overview

Step 2. Select: FY2024 - Profit and Loss by Account > Next

Step 3. Select Report Layout: Account by Month > Next - Finish

Step 4. Select Dates: 01/01/2024 to 12/31/2024

Page | 304




Step 5. Export to Excel

Step 6. Follow the instructions in Appendix C to exportthe report to the Excel file named
UNIT_13_REPORTS Excel file.

Step 7. From the drop-down list, select the sheet: CH13 BUD
Step 8. Save and close the Excel file.

ESTIMATES

Often customers ask for a bid or estimate of job cost before awarding a contract. Paint Paletfte

needs to estimate job costs that are accurate in order not to overbid and lose the job or
underbid and lose money on the job.

To prepare a job cost estimate for Paint Palette, follow these steps:

Step 1. Click the Estimates icon in the Customers section of the Home Page

Step 2. In the Create Estimates window that appears, from the drop-down Customer List,
select <Add New>

New Customer
CustomerName: Karma Café
Address: 9 Passe Blvd
Bayshore, CA 94326

First Name: Karma

Job Status: Pending
Step 3. Click OK fo close the New Customer window
Step 4. To enter estimate information in the Create Estimates window, select Template:

Custom Estimate

Custom Estimate

Date: 01/05/2024

ltem: Labor: Exterior Painting
Quantity: 50

ltem Labor: Interior Painting
Quantity: 85

Step 5. Click Save & Close
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PROGRESS BILLING

A progress billing is an invoice that is infended fo obfain payment from a customer for that
portion of a project that has been completed to date. These billings are commonly issued when
a project has a long duration, so that the contractor can obtain enough funding fo support its
operations in the interim. Progress billings are especially common in the construction industry,
where projects could last for more than ayear. A progress billing contains the following unique
information that is not found on a standard invoice:

e The adjusted total contract amount

e The cumulative amount of progress billings to date
e The percentage of completion of the project

e The total amount remaining fo be billed

Customers sometimes build intfo the calculation of progress billings a withheld percentage of the
total contract, which is not billed until the project is complete. This withheld amount is used to
exert pressure on the contfractor to fix any remaining problems found by the customer.

To use progress billing for the Karma Café, follow these steps:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.

Step 7.
Step 8.
Step 9.
Step 10.

Step 11.
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Invoice

Select Edit > Preferences

Select Job & Estimates

Select Company Preferences

Select YES fo indicate you want to use Progress Invoicing

Check Don't print items that have zero amount

Click OK to save the Progress Invoicing preference and close the Preferences
window.

If a warning window appears, Click OK

Click the Create Invoices icon in the Customers section of the Home Page
When the Create Invoices window appears, select Customer: Karma Café
Select the Karma Café estimate to invoice

A

4 B KemaCafe SUMMARY
9 Passe Blvd
Eayshore, CAG4126 Preferred dellvery mathod E-m;
Cpen balance
Active estmates

010512024 3.20000/Karma Cate [ Help

Click OK




Step 12.  When the Create Progress, Invoice Based On Estimate window appears, select:
Create invoice for the entire estimate (100%)

Step 13.  Click OK

Step 14.  The Invoice template should now be Progress Invoice

Step 15.  Enter the number of hours worked on the Karma Café job

Progress Invoice

Invoice Number: 11

Date: 01/05/2024

ltem: Labor: Exterior Painting
Quantity: 20

ltem Labor: Interior Painting
Quantity: 0

Step 16.  Select the Save icon

CH13 JUR-1

Step 17.  Select the Reports tab at the top of the Create Invoices window

Step 18.  Select Transaction Journal

Step 19. Export to Excel

Step 20. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_13_REPORTS Excel file.

Step 21. From the drop-down list, select the sheet: CH13 JUR-1
Step 22.  Save and close the Excel file.

Create an additional invoice for Karma Café by completing the following steps:

Step 1. Click the Create Invoices icon in the Customers section of the Home Page
Step 2. When the Create Invoices window appears, select Customer: Karma Café
Step 3. Select the Karma Café estimate to invoice
Step 4. When the Create Progress
Invoice Based On Estimate rermacare —

For each itemn below, specify the quantity, rate, amount or % of the estimate amountto

have onthe invoice. Cancel

window appears, select:
Create invoice for selected e N e emean emieintauemr comme  ors
items or for different L e 220 AL S Rl ] ] Wl W
percentages of each item.

Step 5. Click OK

Step 6. When the Specify Invoice
Amounts for ltems on
Estimate window appears,
Check: Show Quantity and

% Show Quantity and Rate ¥ Bhow Percentage s

Labo ateriar 85 20, 1,7¢ 0 00% 17 20 34000 20.0% 20.0%

Total 1,240.00

Nate: Al items will transfer to the invoice. The quantities and amount will be as you indicated. Although items with a zero amount display on
screen, they can be setnotto printfrom the Jobs and Estimates Preferences.

Rate
Step 7. Check: Show Percentage
Step 8. Record the following information for the progress invoice.

Invoice Number: | 12

Progress Invoice Date: 01/12/2024
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ltem: Labor: Exterior Painting

Quantity: 30
ltem Labor: Interior Painting
Quantity: 17

Step 9. Click OK to record these amounts on the progress invoice

Step 10.  Select the Save opftion

CH13 JUR-2
Step 1. Select the Reports tab at the top of the Create Invoices window
Step 2. Select Transaction Journal
Step 3. Export to Excel
Step 4. Follow the instructions in Appendix C to exportthe report to the Excel file named
UNIT _13_REPORTS Excel file.
Step 5. From the drop-down list, select the sheet: CH13 JUR-2

Step 6. Save and close the Excel file.

CREDIT CARD SALES

___________________________________________________________________________________________________________________________|
Exactly how you charge a card differs depending on your business needs and your payment

account type. Intuit offers several different options. Depending upon what software and
account atfributes you have, you can accept payments in the following ways:

e Swipe cards on your mobile device with GoPayment. Take payments from anywhere.
Get your mobile card reader from Intuit and swipe cards for lower rates.

e Type card numbers on your mobile device with GoPayment. Fast and easy, but it's faster
and costs less to swipe cards with a card reader (available free with
GoPayment)GoPayment is available on all accounts. Signin to the Merchant Service
Center, choose Account > Processing Information. If Process with GoPayment isn't
already on, you can turn it on.

e Type card numbers in QuickBooks. In QuickBooks when you receive payment or process
a sales receipt, your payment account lefs you charge a credit card. You can just type
inthe card number but consider getting a card reader. Whenever you type card
numbers in by hand (instead of swiping a card through a reader), you pay a higher fee.

e Swipe cards in QuickBooks. You can get a card reader that connects to your computer
and works with QuickBooks. Whenever you swipe a card, you're eligible forlower rates on
that sale.

¢ Charge asaved card in QuickBooks. QuickBooks can save credit card details as part of
a customer record.

e Let customers pay a QuickBooks invoice immediately online. This is a great opfion that
differs depending upon what version of QuickBooks you have. Create an invoice and
you'll probably see this option. If not, consult QuickBooks Help for details.
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e Charge a card online within the Merchant Service Center. Process fransactions from
anywhere you have an internet connection. Process a payment in Merchant Service
Center . Note: These fransactions don't download to QuickBooks.

o Set up arecurring charge. Use the Recurring Payments feature in the Merchant Service
Center to bill customers on a regular schedule. Create a recurring credit card payment.

e Swipe cards through your Point-of-Sale PIN pad. Retail businesses using QuickBooks Point-
of-Sale can process through card PIN pads in the store and, as part of your account, use
GoPayment on mobile devices. It also accepts chips for credit cards!

e Through your web store. Compatible ecommerce vendors (Homestead, Go
Daddy,Web.com, UltraCart, IA Modules, and PDG Software) can help you connect your
web store to your Intuit payments account. Web-store processing capabilities are
automatically available on your account, so you no longer need to activate them in the
merchant center.

Record the following credit card payment:

Step 1. Receive the following payment:

Received From: Karma Café
Payment Amount: 600.00
Invoice: 11

Payment Date: 01/30/2024
Payment Method: Credit Debit
CardType: VISA

Card Number: 19999199992191999
Exp Date: 12/2024

Payment

Step 2. Select Done

Step 3. Click Save & Close

Step 4. Since you are not using the QuickBooks Merchant Account Services, when the
credit card payment is deposited at the bank on 01/30/2024, you will be
recording the deposit just as you would a check or cash deposit. Click the
Record Deposits icon in the Banking section of the Home Page

Step 5. Select Karma Café payment

Step 6. Click OK

Step 7. Confirm the deposit date is 1/30/2024

Step 8. From the Make Deposits window, select the Save icon
CH13 JUR-3
Step 9. Select the Journal option atf the top of the deposit window fo view the

fransaction journal
Step 10.  Export to Excel

Step 11. Follow the instructions in Appendix C to exportthe report to the Excel file named
UNIT_13_REPORTS Excel file.
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Step 12. From the drop-down list, select the sheet: CH13 JUR-3

BAD DEBTS
C__________________________________________________________________________|

Companies use two methods for handling uncollectible accounts:

1. Allowance Method - The allowance method provides in advance for uncollectible
accounts. This method represents the accrual basis of accounting and is the accepted
method to record.

2. Direct Write-off Method - The direct write-off method recognizes bad accounts as an
expense at the point when judged to be uncollectible and is the required method for
federal income tax purposes.

Even though companies carefully screen credit customers, they cannot eliminate all
uncollectible accounts. Companies expect some of their accounts to become uncollectible,
but they do not know which ones. The matfching principle requires deducting expenses incurred
in producing revenues from those revenues during the accounting period. The allowance
method of recording uncollectible accounts adheres to this principle by recognizing the
uncollectible accounts expense in advance of identifying specific accounts as being
uncollectible.

When a customer doesn't pay a debt owed to your company, the original invoice goes unpaid.
The bad debt makes it difficult to reconcile your accounts and run accurate reports. Before
recording a bad debft, you should create an account for the purpose of fracking such
fransactions. By doing so, you can use the Discounts and Credits option within QuickBooks to
record the debt while keeping the debt organized in a separate register for tax purposes.
Recording bad debts into your regular customer register can make it more difficult fo frack the
debt.

Paint Palette has chosen to use the direct write-off method to record an account when it is
uncollectible. After receiving a notice from Karma Café that they will be going out of business
and they do not plan to pay their outstanding bills, you will need to setup an account for the
debt expense. Follow these steps:

Step 1. Create anew account in the Chart of Accounts

New Account Type: Expense

Account Account 67000
Number:
AccountName: | Bad Debt Expense
Tax Line Schedule C: Bad debts from

sales/services

WRITE-OFF THE UNCOLLECTIBLE ACCOUNT RECEIVABLE
.

There are three different methods to record a bad debt using QuickBooks:
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1. Journal Entry Method — Make a journal enfry to remove the customer’s account
receivable (credit Accounts Receivable) and debit either Bad debt Expense (direct
write-off method) or the Allowance for Uncollectible Accounts (allowance method).

2. Credit Memo Method - The Credit Memo window is used fo record uncollectible
accounts.

3. Receive Payments Method - The Receive payments window (Discounts and Credits
icon) is used to record the write-off of the customer’s uncollectible account. This

method is used if the customer was charged sales tax on the fransaction that is to be
written off.

RECEIVE PAYMENTS METHOD

=

My Preferences Company Preferences “

RECEIVE PAYMENTS Cancel

e

e

T T

e RS

o Automatically apply Hutomatically | Use Undeposited Funds as a
payments calcul default dep

To record the write-off of an uncollectible
account receivable using the Receive Payments
window, first change the preferences for
automatically calculating the payments as 4
follows: F

Reminders

s & Graphs .
Tip: To make payment methods active or inactive, go to the Lists menu, click
Customer & Vendor Profile Lists, and then click Payment Method List

Step 1. From the menu bar, select Edit

Step 2. Select Preferences

Step 3. Select Payments

Step 4. Select Company Preferences

Step 5. Uncheck Automatically calculate
payments

Step 6. Select OK to close the preferences window

Follow these steps to record the write-off of an uncollectible account receivable using the
Receive Payment window:

Step 1. From the home screen, Click Receive Payments

Step 2. Select Received from: Karma Café

Step 3. Leave the Payment Amount as $0.00

Step 4. Enter Date: 01/30/2024

Step 5. Enter Memo: Write off Uncollectible Account

Step 6. Select the outstanding invoice dated: 01/12/2024

Step 7. Because the Amount field is $0.00, a warning may appear. Click OK
Step 8. Highlight the invoice by clicking onits Date field.

Step 9. Click the Discounts and Credits icon in the Receive Payments window
Step 10.  When the Discount and Credits window appears, enter Amount of Discount:
1,240.00

Step 11.  Select Discount Account: 67000 Bad Debt Expense
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Step 12. Click Done fo close the Discount and credits window

UM COMpany  CUSTOMETs VenaQrs EMPIOfEss  EanANg KEpONS  TNQOw HEm

- ne

Main  Reporls  Paymenls

«» § X S @2 9 & 2
Find New Delete  Prnml  Emai  Affach Look u uto A
% % Customerivoke = Paymenl  CrEmm

Customer Payment

1.240.00

SR04 Karma Cafe CustomerJob  Karma Cafe

umber 12 mount Due 1,24000

W | E==i| Mumo AmOILE

0.00 Date 011212024 Discoun it Used 1.240.00
cas | cHEck &

+ 0113002024 ] Cniginal Amt. 1.240.00 Credits Used 0.00

Balance Due 000

Discount Credits

ard
s
011212024 12 Discount Date e i o0
Terms
Suggested Discount 0.00
Amount of Discount
Discount Account 67000 - Bad Debl Expense =

Totals 1,240.00 1.240.00 1,240.00 000

CH13 JUR-4

Step 13.  From the Customer Payment for Karma Café, Select the Reports tab

Step 14.  Select Transaction Journal

Step 15.  Export to Excel

Step 16. Follow the instructions in Appendix C to export the report to the Excel file named
UNIT_13_REPORTS Excel file.

Step 17.  From the drop-down list, select the sheet: CH13 JUR-4

Step 13.  Click Save & New

AUDIT TRIAL

|
If you decide to allow multiple users access to the QuickBooks data file, you may want to turn on
the QuickBooks Audit Trial feature. The Audit Trial feature lets you keep a record of who makes
what changes fo the QuickBooks data file. If you have more than one person changing the
information in QuickBooks — in other words, you have multiple users working with the QuickBooks
data file — you should select the Use Audit Trial check box. Be aware that using the Audit Trial
slows down QuickBooks a bit. For this degradation in performance, however, you get a
permanent record of who is doing what in QuickBooks.
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To test the Audi Trial feature, first record a customer invoice to Sofia Rafael:

Step 1. Select the Create Invoices icon

TEMPLATE: Service Date Invoice
INVOICE DATE: 02/01/2024
CUsSTOMER JOB: | Sofia Rafael: Vaulted

New .
Invoice Kitchen
SERVICE DATE: 02/01/2024
[TEM: Labor: Labor Mural
QUANTITY: 3

Step 2. Select Save & Close

On 02/02/2024, Sofia Rafael pays her bill in cash. If the bookkeeper decides to keep the cash
and delete the invoice (so that Sofia Rafael would not receive another bill), the Audit Trial
maintains a record of the deleted invoice.

Step 3. Open the Rafael Invoice for $150 that you just created
Step 4. Select Edit Menu

Step 5. Select Delete Invoice
Step 6. Select OK

The Audit Trial report will list the original fransaction to record the $150 invoice and the change
fo delete the customer’s $150 invoice.

CH13 AUDIT

To prepare the Audit Trial report follow these steps:

Step 1. Use one of the Report menus to select Accountant & Taxes
Step 2. Select Audit Trial

Step 3. Select Dates: All

Step 4. Select the Date Entered/Last Modified: Today

Step 5. Export to Excel following the instructions in Appendix C
Step 6. Add some features: Select the Advanced tab

Step 7. Uncheck: Space between columns

Step 8. Check: Auto Outline (allows collapsing/expanding)

Step 9. Check: Auto Filtering (allows custom data filtering)

Step 10. Uncheck: Include QuickBooks Export Guide worksheet and helpful advice

Step 11. Select Show report header:  On printed report and screen
Step 12. Select to the Excel file named UNIT_13_REPORTS Excel file.
Step 13. From the drop-down list, select the sheet: CH13 AUDIT
Step 14.  Highlight - Today's date and time (result will vary), date recorded and the deleted
item for the fransaction for Sofia Rafael: Vaulted Kitchen

Notice in the Audit Trial report exported to Excel including the Auto Filter feature, each column
heading become a drop-down list. This Permits you fo sort or select a filter of your choice from

the drop-down lists. For example, you could use the Auto Filter to tfrack all items recorded by a
specific user (Last Modified by field).
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To track deleted or changed items in the Audit Trial report, you can filter on the status of
transactions to display Latest, Prior, or Deleted transactions (State Field).

Note that the Audif Trial feature requires more storage for larger files because both original
fransactions and changed fransactions are saved. So, the Audit Trial feature may slow
processing time.

ACCOUNTANT'S COPY
|
The Accountant's Copy feature in QuickBooks Desktop lets accountants and clients to work on a
company file at the same time. The Accountant's Copy is seamlessly transferred between
accountants and clients without the need to email bulky files.

The following sections outline how an Accountant's Copy works. It also explains what you can
and can't doin the Accountant's Copy.

ACCOUNTANT'S CopPY: WORKFLOW

R

e

e

e

YN
PR R R R R R

e

Rather than saving the Accountant’s Copy file on your computer or thumb drive, the
Accountant's Copy feature transfers files between accountants and clients through Intuit servers.

The following process illustrates the Accountant's Copy feature workflow:

1. The client creates an Accountant's Copy to send to the accountant for review and
editing. The client can confinue to work on current items in the working file (.QBW).

2. QuickBooks Desktop saves the Accountant’s Copy as an export file (.QBX) to the Intuit
server.

3. This friggers the system to send an email with a download link for the export file to the
accountant.

4. The accountant accesses and opens the file, creating a working file (.QBA), and makes
changes and corrections in it.

5. The accountant saves their changes and corrections, creating an import file (.QBY),
which is saved fo the Intuit server.

6. The client can then open this import file to apply the accountant's changes to the
company file.

DIVIDING DATE: EXPLAINED

o
=

e
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e
——

e
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&
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The Accountant's Copy uses the Dividing Date to define the fiscal period the accountant can
work on. The Dividing Date restricts the transactions the accountant can modify.

Accountants can only modify fransactions that fall on or before the dividing date. To prevent
conflict or the possibility of overwriting changes, clients can only modify transactions in their
working file that fall after the dividing date unless the Accountant's Copy Restriction isremoved.

CLIENTS: WHAT YOU CAN (AND CAN'T) DO WHILE CHANGES ARE PENDING

B

.=

.=

.=

Rt ke e b
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While your accountant is making changes in the Accountant's Copy you sent, you can work in

the .QBW working file to make changes to transactions in the current period, after the dividing
date.

You can also make the following types of changes in the QBW file with pending accountant’s
changes:

e Add new enfries to any of your lists

e Create, edit, and delete fransactions
e Edit the list information

e Turn on Payroll

However, while accountant's changes are pending, you can't make the following changes:

e Edit or delete existing accounts
e Send Assisted Payroll Data or Direct Deposits to Intuit

CLIENTS: RECONCILIATION AND PENDING CHANGES

o
=

o
e

o
e

o
e

o

o o
e e

It's possible to reconcile your accounts with a pending Accountant's Copy. However, your

reconciliation may be rolled back if you clear transactions dated on or before the dividing date,
orif your accountant reconciles the Accountant's Copy and undoes your reconciliation.

Verify with your accountant whether they plan to reconcile the Accountant’s Copy before you
reconcile your accounts in your working file.

Reconciliations performed in an Accountant's Copy are limited to 800 transactions. If the
number of fransactions reconciled is more than 800, then the reconciliation won't import into the
client file.

ACCOUNTANTS: WHAT YOU CAN (AND CAN'T) DO IN AN ACCOUNTANT'S COPY

o

o
e
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o
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o
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o
e

o

o
e

When you receive an Accountant's Copy from your client, QuickBooks Desktop prevents you
from editing information or transactions that may conflict with your client's work. It also prevents
your client from editing the information before the Dividing Date to avoid conflict with any
changes you make.

When working in an Accountant's Copy (the .QBA working file), you may encounter disabled or
sometimes highlighted areas in a client's file:

e Highlighted background: Information entered in these fields isincluded in the change file
that you send back to your client
¢ Non-highlighted background: You can change the information in non-highlighted fields,

if necessary, but the changes are not included in the change file you send back to your
client

There are also some specific limitations of the type of changes you can make.
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The following sections provide details about the specific changes you can and cannot make in
an Accountant's Copy.

LISTS: WHAT YOU CAN (AND CAN'T) DO

o
=

e
—r

e
—r

e
—r

e e e
e e

When working with Lists, you can make the following changes in an Accountant's Copy:

e
—r

e Add anitem to the Class List, Customer List, Employee List, Fixed Asset Item, Item List,
Other Names List, Vendor List, and Sales Tax Code List (Exception: You can't edit or make
itfems on the Sales Tax Code List inactive)

e Edititems on the Vendor List and the Item List (Excepfion: You can't change anitem to
another type on the Item List)

You cannot make the following changes:

e Add, edit, void, or delete build assemblies
e Change the type of an item

e Delete and merge existing accounts
e Enfer vehicle mileage

TRANSACTIONS: WHAT YOU CAN (AND CAN'T) DO

B .=
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.=

&

When working on transactions, you can make the following changes in an Accountant's Copy:

e Add, edit, and delete most types of fransactions dated on or before the dividing date

e Add new fransactions dated after the dividing date

e Edit account and tax information for existing items (tax line mapping cannot be sent
back to the client)

e Temporarily change preferences

e Make adjusting enfries

You cannot make the following changes:

e Add, delete, and edit (but not void) payments received
e Add, edit, void, or delete sales tax payments
e Add oruse credit card processing

e Create non-posting transactions such as estimates and sales orders
e Edit or void bill payments by credit card
e Transfer funds between accounfs

PAYROLL: WHAT YOU CAN (AND CAN'T) DO

B
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When working on payrollrelated items, you are generally restricted from making changes in the

Accountant's Copy. Although you can still process payroll tax forms. (For more information, see
Processing payroll or payroll forms in an Accountant's Copy)

You can't make the following payroll-related changes in an Accountant's Copy:
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e Add, edit, or delete payroll items

e Create, edit, delete, or void paychecks

e Enfer, edit, or delete fime sheet data

e Create, edit, delete, or void Direct Deposit checks for 1099 vendors
e Send Assisted Payroll Data or Direct Deposits to Intuit

WHAT ELSE YOU CAN (AND CAN'T) DO

o
=

e
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e
—r

e
—r
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When working in an Accountant's Copy, you can make the following changes:

e Print 1099 and 1096 forms in the historical period

e Create, adjust, and print 941, 940, and W-2 forms(You can't send adjustments back to the
client)

e Create new reports

e Add new customers, vendors, employees, and items(Exceptions are identified as
disabled fields in the Accountant's Copy)

YOU CANNOT MAKE THE FOLLOWING CHANGES IN AN ACCOUNTANT'S COPY:

o
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e Import data from Excel, Web Connect, and QuickBooks timer files
e Manage service keys (buy addifional licenses)

e Use planning and budgeting tools

e Use online banking services

Additionally, you cannot send the following changes back to the client:

e User or password changes
¢ Changes to memorized reports
e Changes to preferences

PRODUCT VERSIONS: ACCOUNTANT'S COPY AND QUICKBOOKS DESKTOP
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Ideally, the client and accountant using the Accountant's Copy feature should use the same
version or year of QuickBooks Desktop.

However, you can still work on the Accountant’s Copy using a different version if the gap
between the versionsis just one year, and the accountant has a more recent version.

To Create an Accountant’s Copy of Paint Palette, follow these steps:

Step 1. From the Menu bar select File

Step 2. Select Send Company File

Step 3. Select Accountant’s Copy

Step 4. Select Client Activities

Step 5. Select Save File

Step 6. After reading the information the Save Accountant’s Copy window, select
Accountant’'s Copy

Step 7. Select Next
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Step 8. Select Dividing Date: Custom 12/31/2024
Step 9. Normally you would select Next. In this case, select Cancel.

ASK MY ACCOUNTANT

In the Chart of Accounts is an account enfitled Ask My Accountant. Enirepreneurs using
QuickBooks can use this account to record items when they are uncertain how to record
specific items properly. The items can be recorded in this account and the accountant can
review these items and record them properly before financial statements are prepared.

Look for account name or number '

E!Eiiiiiiia
+ 61700 - Computer and Internet Expenses EXpense
+ 62400 - Depreciation Expense Expense
+ 63300 - Insurance Expense Expense
+ 63400 - Interest Expense Expense
« B4300 - Meals and Entertainment Expense
+ 64800 - Paint Supplies Expense Expense
+ 64900 - Office Supplies Expense

Expense

- Telephone

Expense
Expense

8400 - Travel Expens':
68600 - Utilities
+ 80000 - Ask My Accountant
+ 90000 - Estimates

Expense
Expense

Expense

Expense
Other Expense

Mon-Posting

Account ~ Aclivitie;
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QuickBooks Online

Which QuickBooks is RIGHT for MY business?

.
E;l;ks
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QUICKBOOKS ONLINE VS DESKTOP: WHICH IS RIGHT FOR YOU?

I ————
When it comes to accounting software, Intuit’'s QuickBooks seems to be a top pick for many
small business owners. This isn’t surprising when you consider that more than 4.3 million customers
worldwide rely on this popular product to tfrack income and invoices and manage bills.

Small and mediums-sized businesses and accountants are among the software’s core customer
base. QuickBooks has expanded greatly since it launched more than 20 years ago. Instead of

only having a version that's installed on your desktop, an online version has been added to the
mix.

QuickBooks Desktop is a one-time purchase software that's installed on your office desktop or
laptop computer, while QuickBooks Online is a cloud-based monthly subscription service. Before
you can compare the advantages of using QuickBooks Online and QuickBooks Desktop, you
should compare the pricing fiers of each one.

QUICKBOOKS ONLINE OVERVIEW

|
QuickBooks Online, a cloud-based software, was infroduced in 2001 and has grown fo have
more than 1 million paid subscribers. Cloud-based accounting systems are becoming more
popular because they offer a level of convenience that isn't available with desktop programs,
such as the ability to access to your financial information while out of the office. You see this with
QuickBooks Online, which allows you to create an account by signing in from your web browser
or via application download for Mac or Windows.

QuickBooks Online offers four plans: Simple Start, Essentials, Plus and Self-Employed. The best one
for your business will depend on your specific accounting needs, budget and type of business.
All versions allow you to frack income and expenses, capture and organize receipts with your
smarfphone, invoice and accept payments from your smartphone, and run reports such as your
profit and loss statements and balance sheets.

Self-Employed: Asits name suggests, the Self-Employed option is geared toward independent
contractors orsole proprietors who file a Schedule C 1040 Form when filing their faxes. The Self-
Employed versionis the cheapest at $10 per month (it's currently on sale for $5 per month for the
first three months) and offers the basic functions that the other versions perform. This version
categorizes business and personal frips so you can frack your mileage and estimate your
quarterly taxes. Take notice, however, that this plan doesn’t upgrade to the small business
version.

Simple Start: Like the Self-Employed version, the Simple Start option offers the bare minimum of
the QuickBooks Online plans. This plan, which is $10 per month for the first three months and $20
per month thereafter, will send estimates and frack sales and sales tax in addition to the benefits
previously listed. This is the least expensive plan available for small businesses that need
accounting but can manage without the features offered in the higher tiers.

Essentials: This opfion allows you to manage your bills more efficiently by allowing you to frack bill
status, record payments and create recurring payments. You can also add up to three people
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to access your books and track employee hours and billable hours. The Essentials planis $17 per
month for the first three months and $35 per month thereafter.

Plus: This is the deluxe version of the QuickBooks Online plans, offering the most of all plans. The
Plus plan, which is $30 per month for the first three months and then jumps to $60 per month,
allows you to do everything the other plans offer, plus track all yourindividual projects and
inventory and manage all of your 1099 contractors. The Plus Plan also allows five or more users
on the account. Intuit advertises this plan as its most popular.

For an additional fee, you can add on an Enhanced Payroll feature to any plan that will pay
employees and contractors free 24-hour direct deposit on unlimited pay schedules and types. It
can also pay and file federal and state payroll taxes and print and file W2s at the end of the

year. This feature is currently half-price for the first three months, at $19 per month, and will then
increase to $39 per month.

A Full-Service Payroll plan has all the basic features that the enhanced version offers, but it
comes with free same-day direct deposit and QuickBooks experts will arrange, file and pay
payroll taxes for you. This upgrade costs $49 per month for the first three months and is $99 per
month afterwards.

QuickBooks also has another tier: its Online Advanced option, which includes the cost of
QuickBooks Online Training, allows for 10 or more users, and gives you membership to its new
loyalty program, Priority Circle. It's $75 per month for the first three months and $150 per month
thereafter.

QUICKBOOKS DESKTOP OVERVIEW

___________________________________________________________________________________________________________________________|
Unlike the monthly fee you'd incur with QuickBooks Online, you'd only have fo purchase the

software for QuickBooks Desktop program once. Like the online plan, the desktop version offers
four plans from which you can select from.

QuickBooks Desktop Pro 2020: QuickBooks Desktop Pro 2018 is currently listed as $219.95, down
from its original $299.99 price. This user-friendly software doesn't require you to be an accounting
whiz. In fact, it allows you to track your businesses performance, has simple tools and setup, and
allows you to perform various functions such as importing data from a spreadsheet, tracking
income and expenses, scheduling automatic reporting (like profit and loss), and paying 1099
confractors. You can install this software on up to three computers.

QuickBooks Desktop Premier 2020: In addition to the perks mentioned in the lower-priced
desktop versions, this plan also offers forecasting, helps you manage fasks unique to your industry
and lets you install the software on up to five computers. Instead of paying the original price of
$499.95, you can get the Premier option for a one-time payment of $379.95.

QuickBooks Desktop Enterprise 2020: By now you've probably figured out that the more
expensive a QuickBooks sofftware program is, the more features it has. So at $990 per year
(originally $1100), Enterprise offers the most benefits out of all of the QuickBooks Desktop
products. You get everything offered in the versions, plus mobile inventory barcode scanning,
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membership to QuickBooks Priority Circle and the ability to install the software on up to 30
computers.

There are several functions in QuickBooks desktop Premier, Pro and Enterprise editions that are
not currently available in the online version. The following is a list of items unique to all three
desktop versions:

e Sales Orders

e Inventory assemblies

e Progress Invoicing

e Receiving Partial Purchase Orders
e Item Receipts

e Balance Sheet by Class

e QuickBooks Statement Writer

e Budget v Actuals for Job

e Prinfing 1096

This following QuickBooks features are only available in the Enterprise version:

e Serial Number/Lot Number Tracking
e Multiple Warehouse Locations

QUICKBOOKS ONLINE VS. DESKTOP: HOW THEY COMPARE

|
The online and desktop versions of QuickBooks have some of the same basic features; both
allow you to create professional invoices, frack sales and expenses and manage accounfs
payable. However, only QuickBooks Online allows you to have instant access to your files,
automatically schedule and send invoices, and work from a desktop, laptop, smartphone or
tablet at any time. This type of accessibility and convenience is important for someone who
wants to work from anywhere, wants to give their accountant access from anywhere, or just
prefers less data entry.

When you compare the desktop and online versions, it's very apparent that Intuit is making the
cloud-based subscription service a priority and they really want you to as well. As with anything,
there are some drawbacks to using online accounting software.

For one, you need an internet connection to do any work, which isn't required for the desktop
version. You also won't be able to work if there are any glitches with the website. Though more
than 1 million paid customers use the online version, many QuickBooks users use the desktop

version. Cost could also play a role in this since the desktop version offers one-time payment
opftions.

Product-based businesses with inventory needs typically work better with QuickBooks Desktop,
whereas service-based businesses or businesses that use multiple devices typically choose
QuickBooks Online.
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Today, there are more units of QuickBooks Desktop used by small businesses than QuickBooks
Online. However, many small businesses are converting their QuickBooks Desktop to QuickBooks
Online. Many new QuickBooks users are choosing QuickBooks Online over QuickBooks Desktop.

e INVOICE/SALES RECEIPT AUTOMATION - While QuickBooks Desktop has memorized
fransactions, they sfill must be sent to the customer manually. QuickBooks Online has a
feature called “recurring fransactions”. Recurring transactions can be set up o be
emailed automatically fo the customer. The QuickBooks Online user/owner can be
copied on each fransaction sent.

e NO NEED TO TRANSFER DATA OR SHARE COMPUTER TIME - Because you can access
your client’s QuickBooks Online data by being invited as an accountant user and signing
up for QuickBooks Online Accountant, there's no need to fransfer backup files,
Accountant Copy files or try to arrange to login to your client’s computer. You and your
clients can both work whenever you need to, without worrying what the other is doing,
with always on, anywhere access.

e Your Client Always Has the Latest Version —With new releases every four weeks,
QuickBooks Online users always have the latest and greatest.

e DELAYED CUSTOMER CHARGES/BILLING - QuickBooks Desktop has unbilled fime and
expenses, but again, the user sfill has to manually go in and bill the customer for them. In
QuickBooks Online, you can turn on a preference fo tell the program to do this
automatically, any time activity is assigned on a daily, weekly, monthly or yearly basis.
QuickBooks Online can remind the user to do it or automatically create an invoice for
the unbilled time and expenses. Depending on your preference, you can tell the user via
a message on the home page or not tell the user; it's your choice.

e ACTIVITY LOG - QuickBooks Desktop has the Audit Trial, which tells us when a fransaction
was created, modified or deleted. QuickBooks Online does this this better. The activity
log shows when a user logs in, logs out, edits a customer, vendor, item or account. It
shows when a third-party add-on accesses the data, when bank fransactions are
downloaded, and when those fransactions are matched or added fo registered

e AUTOMATIC EMAIL REPORTING - The online version of the program has memorized
group feature. Memorize a report in QuickBooks Online, add it to a group, and then set
that group to be emailed fo yourself or your client on a regular basis. For example, you
can send your clienfs their financials each month without ever actually logging info
QuickBooks Online! The best part is that the email “from address” is the user that set it up.
QuickBooks Online sends these out in the middle of the night, so your clients will think you
work fill the wee hours JUST FOR THEM.

e BANK TRANSACTIONS AUTOMATICALLY DOWNLOADED NIGHTLY -In QuickBooks
Desktop, the process of downloading bank transactions into QuickBooks has fo be
initiated manually, and if we're doing this for our clients, we have to have their password.
In QuickBooks Online, the client can set up the connection, and QuickBooks Online goes

out each night and automatically pullsin the tfransactions. There's no need for us o have
the user name or the password any longer.
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¢ QUICKBOOKS ONLINE HAS CLASS AND LOCATION TRACKING - QuickBooks Desktop has
class tracking or the ability to frack different profit centers, but QuickBooks Online adds
one more layer with Location fracking. For example, | have an auto shop client with two
locations in Michigan, one in Pinckney and one in Stockbridge. He likes to frack his
business by location as well as by customer comparing government to walk-in customers.
He uses Location tracking for each shop location and Class fracking for the customer
type.

CONVERTING TO QUICKBOOKS

You will find the following files in your Student files for UNIT 14.

e Ul4al Paint Palette
To complete the first lesson exercises, RESTORE the ul4al Paint Palette company file from the
UNIT 14 folder.

Password: Cuesta123

RENAME THE COMPANY

After you have followed the instructions to restore your data files, you will find the company file
you have restored contains sample data for a company called Rock Castle Constfruction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 55. From the Menu bar, select Company

Step 56. Select MY COMPANY

Step 57.  Select EDIT

Step 58. Update the Company Name Field to: YourName Paint Palette
Step 59. CLICK on OK

Step 60. Close the My Company window.

Use the Intuit Education link (hitps://www.intuit.com/partners/education-
program/products/quickbooks/student-gbo-signup/) fo signup for the online edition. Once you
click on the link, you can click on the QuickBooks Online link for students to register for free.

Please note, these screens change regularly. Your screen may look different that the illustration.
Because you have been using the desktop version, you may run into difficulty using your Cuesta
email address. Since this is just a 30-day frial, you can use an alternate email as well.
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https://www.intuit.com/partners/education-program/products/quickbooks/student-qbo-signup/
https://www.intuit.com/partners/education-program/products/quickbooks/student-qbo-signup/

Step 1.

Step 2.
Step 3.
Step 4.

Step 5.
Step 6.

Step 7.
Step 8.
Step 9.
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Choose QuickBooks

hoose your Intuit software

QuickBooks ProConnect Tax Online

QuickBooks Online

Prepare students to join the more than 2 million small businesses using QuickBooks
or start their own by learning QuickBooks for free.

Register for free (

Students

Students

> Learn more

? Looking for QuickBooks Desktop?

Click on or enter the hyperlink in the address bar of your web browser:
https://www.intuit.com/partners/education-
program/products/quickbooks/student-gbo-signup/

Select QuickBooks

Under the QuickBooks Online option, select Students

Fill out the personal information using the same email address you used for the
desktop version.

Click on Verify and Continue

Check your email. You willreceive alink to the sign in options for QuickBooks
Online Accountant.

Click on the link in the email received

Enter the email address you used for the initial registration

Write the Password you Create. You will need to use it every time you access the
company file.



https://www.intuit.com/partners/education-program/products/quickbooks/student-qbo-signup/
https://www.intuit.com/partners/education-program/products/quickbooks/student-qbo-signup/

Step 10.  To fill out the inifial information, use your name for the Accounting firm name

Please enter your firm's info

Your free account is almost ready.

Your Name

Accounting firm name

Central Coast Support

Your Zip Code

Firm ZIP code

93442

Number of full-time employees (including you)

2

Step 11.  Click Finish

Step 12.  QuickBooks will initiate a few infroductory screens. Accept the screens and then
click on the gear icon on the upper right corner of the screen.

Step 13. From the drop-down menu that appears, select Import Desktop Data

Step 14.  Using the open Paint Palette company from Unit 14, Follow the on-screen
Instructions (Steps 1, 2, & 3)

YourMame Paint Palette - QuickBooks Accountant Desktop 2019

chmparw Customers Vendors Employees Banking Repors Window Help

Home Page
Company Snapshot
Calendar

Documents 3 VENDORS

Lead Center

My Company

SetUp Users and Passwords 3

Customer Credit Card Protection... I %
Set Closing Date... Is Pay Bills
Bulk Enter Business Details

Planning & Budgeting 3
To Do List

Reminders

Alerts Manager

CUSTOMERS
Chart of Accounts Ctri+A
Make General Journal Entries...

Manage Currency b

- Export Company File to
Enter Vehicle Mileage.. . .
Prepare Letters with Envelopes QU]CkBOOkS Onllne

Export Company File to

Step 15. When prompted for and email or User ID use the email address you used for
registration. The password should be the same password you used fo register.

Step 16. Check the Remember Me option

Step 17.  Click Sign In

Step 18. Choose on of the options to verify your account. (Check your email or Cell Phone
for a verification code).
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Step 19.
Step 20.

Type in the 6-digit verification code
Click Continue

Step 21.
Step 22.
Step 23.
Step 24.
Step 25.

Step 2é.

Let’s import YourName Paint Palette

Choose the company in which to import your desktop
file. Your desktop data will replace—not merge with—
the data in the online company you choose.

The name of the
company you
Central Coast Support 10319 entered in Step 10

Choose the name of the company you entered in step 10

Click Continue

Type Agree to overwriting the data in the company

Click Replace

The data will begin to transfer fo the online edition. This may take up to 30
minutes (My fransfer only took a few seconds before | received the confirmation
email).

Click OK, got it to the message regarding the link will be sent to your email.

ADD CUSTOMERS

Step 1.
Step 2.
Step 3.
Step 4.
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From the left-hand panel, click on Sales
Select Customers S
Click New Customer

If prompted for QuickBooks
to use yourlocation, click
yes.

New Customer
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New Customer
(Note the
differences in
the Online
settings and
Desktop. You
can see just the
differences in
these fields used
in Unit 4)

NOTE: When you
are adding a
second email
put a comma
after the first
email in the
email field

ADDRESS INFORMATION

COMPANY

JinLai Metal Works

DISPLAY NAME AS

JinLai Metal Works

CUSTOMER NAME

Lai, Jin

FIRST NAME Jin
LAST NAME Lai
MAIN PHONE 415-555-7534

MOBILE PHONE

415-555-9638

ADDRESS BILL TO/SHIP TO

789 Black Hill Drive
Bayshore, CA 94326

MAIN EMAIL Jin@lJinLai.com
CC EMAIL reception@linLai.com
WEBSITE www.JinLai.com
PAYMENT AND BILLING

PAYMENT TERMS NET 30
PREFERRED DELIVERY MENTHOD Send Later
PREFERREED PAYMENT METHOD Check

TAX INFO

CUSTOMER IS TAXABLE | yes
ADDITIONAL INFORMATION

CUSTOMER TYPE | Referral

New Customer
(Note the
differences in
the Online
settings and
Desktop. You
can see just the
differences in
these fields used
in Unit 4)

ADDRESS INFORMATION

COMPANY Tom Whalen
DISPLAY NAME AS Tom Whalen
FIRST NAME Tom

LAST NAME Whalen
MAIN PHONE 415-555-1567

MOBILE PHONE

415-555-7896

ADDRESS BILL TO/SHIP TO

100 Sunset Drive
Bayshore, CA 94326

MAIN EMAIL TWhalen@Whalen.com
CC EMAIL Jessie@Whalen.com
WEBSITE www.whalen.com
PAYMENT AND BILLING

PAYMENT TERMS NET 30

PREFERRED DELIVERY MENTHOD Send Later
PREFERREED PAYMENT METHOD Check

TAX INFO

CUSTOMER IS TAXABLE | yes

ADDITIONAL INFORMATION

CUSTOMER TYPE

| From Advertisement
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ADD JOBS

I ————
Job listings in the Online version are entered differently. This is the process to use for entering the

following jobs:

Step 5. From the left-hand panel, click on Sales
Step 6. Select Customers

Step 7. Click New Customer

Customers

foyer

Beperts

New Job or Sub-Customer

ADDRESS INFORMATIO

Costomens | Frosducts and Sevica:

N

>
e P U VY WS P VR

COMPANY

Reception Area

DISPLAY NAME AS

Reception Area

IS SUB-CUSTOMER

Check the option

SELECT

JinLai Metal Works

BILL WITH PARENT

yes

New Job or Sub-Customer

ADDRESS INFORMATION
COMPANY Bathroom
DISPLAY NAME AS Bathroom

IS SUB-CUSTOMER

Check the option

SELECT

JinLai Metal Works

BILL WITH PARENT

yes

New Job or Sub-Customer

ADDRESS INFORMATION
CUSTOMER NAME Living Room
DISPLAY NAME AS Living Room

IS SUB-CUSTOMER

Check the option

SELECT

Tom Whalen

BILL WITH PARENT

yes

New Job or Sub-Customer

ADDRESS INFORMATION

CUSTOMER NAME

Kitchen

DISPLAY NAME AS

Kitchen

IS SUB-CUSTOMER

Check the option

SELECT

Tom Whalen

BILL WITH PARENT

yes
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CUSTOMER CONTACT LIST.PDF

For the online version, you will be generating the reports using the PDF writer for QuickBooks
online. It will be important that you save your reports in the Unit 14 folder. All the reports
generated will be uploaded to your Unit 14 assignment. Follow these insfructions to generate
the Customer Contact List.pdf

Step 1. Click on Reports
Step 2. Scroll down the report list to Sales and Customers

{

Sales and Customers =%
cherges Scroll Bar $

~ What you owe

Step 3. Click on Customer Contact List

Step 4. Click the Print Option

Step 5. Click Save as PDF

Step 6. QuickBooks online will save fo your downloads folder. Make sure you save in the
Unit 14 folder
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CREATE INVOICES

To create invoices online, you will return to the sales option and click on Customers to list all the

@ Accountant

QO & Qe

YOUR PRACTI
o CICE Overview All Sales Invoices ‘Customers Products and Services

Clients
ProAdvisor
Unbilled Last 365 Days Jnpaid Last 365 Days Paid
Work
$0 $0 $0 $0
Apps 0 ESTIMATE 0 UNBILLED ACTIVITY ‘0 OVERDUE ‘0 PAID LAST 30 DAYS

YOURBOOKS
Dashboard N
I (_ Batch actions ~ Q

[ | CUSTOMER a / COMPANY

Banking

'OPEN BALANCE ACTION
Expenses

JinLai Metal Works [

Sales |

(415) 555.7: Search Option Create invoice ¥

Workers _ _
(415) 555-7534

Reports

Create Invoice

(415) 555-7534

Taxes

Mileage
e [ Kari, Tracey 415-555-1234 $0.00 Create invoice v

Accounting

[ Foyer 415-555-1234 $0.00 Create invoice ¥

customers for your company. Note that there is a search opftion

Step 1. Click Sales > Customers

Step 2. Select JinLai Metal Works: Bathroom

Step 3. Select Create Invoice

Step 4. Notice that is automatically opens a service date invoice template. This is
because the template was created in the QuickBooks desktop program. Fill out
the following data for the invoice:

| Invoice Number 14
Invoice Date 12/01/2024
Sales Rep Enter your name
Service Date 11/15/2024
Product/Service Labor Faux
Description Labor Faux Painting
Quantity 8
Service Date 11/20/2024
Product/Service Labor Interior
Description Labor Interior Painting
Quantity 18

Step 5. The items are not taxable. Click the dropdown arrow next to the words Save and

Send. Select Save and New
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Invoice Number 15

Invoice Date 12/15/2024
SalesRep Enter your name
Service Date 11/30/2024
New Invoice Product/Service Labor Mural
ML NS IRV Gl Description Labor Mural
Reception Area [el¥els}iir% 8
Service Date 12/01/2024
Product/Service Labor Mural
Description Labor Mural
Quantity 12
Step 6. The items are not taxable. Select Save and New

Invoice Number

Invoice Date 12/15/2024
New Invoice Sole§ Rep Enter your name
Kari, Tracey: Foyer Service Date 11/30/2024
‘ ! Product/Service Labor Faux
Description Labor Faux Painting
Quantity 5
Step 7. The items are not taxable. Select Save and New
Invoice Number 17
Invoice Date 12/20/2024
SalesRep Enter your name
Service Date 11/30/2024
New Invoice Product/Service Labor Exterior
Kari, Tracey: Description Labor Exterior Painting
Screen Porch Quantity 10
Service Date 12/01/2024
Product/Service Labor Mural
Description Labor Mural
Quantity 5
Step 8. The items are not taxable. Select Save and Close

CUSTOMER BALANCE DETAIL.PDF

Step 1. Click Reports > Who owes you
Step 2. Click on Customer Balance Detail
Step 3. Click the Print Option

Step 4. Click Save as PDF

Step 5. QuickBooks online will save to your downloads folder. Make sure you save in the

Unit 14 folder
Step 6. QuickBooks names the file for you CustomerBalanceDetail. pdf
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CUSTOMIZE A REPORT
.

For this exercise, you will be generating a report and customizing the output of the report. Follow
these steps:

INCOME BY CUSTOMER SUMMARY.PDF

Step 1. Click Reports > Sales and Customers

Step 2. Select Income by Customer Summary

Step 3. Report Period All Dates

Step 4. Select Run Report

Step 5. In the upper right corner of your screen, select Customize. The customize report
opftions will appear.

Customize report

» General
Customize Save customization

Report period

All Dates v |

Accounting method

All

Cash @ Accrual
Number format Mot Specticd
[ ] Divide by 1000 Specified

D Without cents
Except zero amount D{Sde(-'t all)

q}JinLai Metal Works
» Rows/Columns

D JinLai Metal Works:Bathroom
Show non-zero or active only

Click the drop-down
arrows to view the | | [ kewmecss
Options w | |_|Kari,Tracey:Fuyer i

D JinLai Metal Works:Reception Area

Active rows/active ot ¥

Customer ‘ Specified o

w Header/Footer

Header
Company name | Central Cosst Support
Report title Income by Customer Summary

Report period

Footer

Run report
—

Step 6. Select the drop-down arrow next to the Filter option
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Step 7.
Step 8.
Step 9.

Step 10.
Step 11.

Step 12.

Select Customer - JinLai Metal Works

Select Run Report

Click the Print Option

Click Save as PDF

QuickBooks online will save to your downloads folder. Make sure you save in the
Unit 14 folder

QuickBooks names the file for you IncomebyCustomerSummary.pdf

VENDOR TRANSACTIONS

Step 1.
Step 2.
Step 3.
Step 4.
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Select the Expenses = Vendors

Select Brewer Paint Supplies

Under the Action Column, select the drop-down menu
Select Create Expense

OPEN BALANCE = ACTION

$180.00 Make payment | v |
Create bill

$0.00 Create expense@

Create bill

Create

Expense Craata bl '+




Step 5.

Step 6.
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You will be prompted to take a guided tour or get an overview. At the bottom of
the screen, there is a link. Click on the link for Start Adding an expense

| Payee Brewer Paint Supplies
Category 64800 Paint Supplies Expense
Date 11/30/2024
Payment Visa
Description Paint Supplies
Amount 250
Billable Yes
Markup % 15%
Tax Yes
Customer JinLai Metal Works: Bathroom
Category 64800 Paint Supplies Expense
Date 11/30/2024
Payment Visa
Description Paint Supplies
Amount 420
Billable Yes
Markup % 15%
Tax Yes
Customer Kari, Tracey:Foyer

Save and Close

DATE: 12/23/2024
VENDOR: Carole Design Media
Bill
: ACCOUNT: 6000 Advertising Expense
Add Vendor . . .
. DESCRIPTION: Adyvertising and Promotion
if necessary
TERMS: Net 30
AMOUNT DUE: $225.00
DATE: 12/23/2024
Bill VENDOR: Brown Equipment Rental
Add ACCOUNT: 67100 Rental Expense
Vendor if DESCRIPTION: Equipment Rental
necessary | 1erms: Net 15
AMOUNT DUE: $630.00




DATE: 12/23/2024
VENDOR: Campion Patrick, CPA
Bill ACCOUNT (NEW): Accounting Expense
Add NUMBER: 7410
Vendor if ; -
necessary DESCRIPTION: Accounting and Bookkeeping
TERMS: Net 30
AMOUNT DUE: $324.00
Bill DATE: 12/23/2024
Add VENDOR: Townley Insurance Agency
VEREeL I ACCOUNT: 63300 Insurance Expense
necessary
DESCRIPTION: Automobile Insurance
TERMS: Net 30
AMOUNT DUE: $427.62
Bill DATE: 12/23/2024
Add VENDOR: Great Statewide Bank
Vendor if ACCOUNT: 63400 Interest Expense
necessary
DESCRIPTION: Interest on Loan
TERMS: Net 15
AMOUNT DUE: $699.12

Step 7. Save and Close

EXPENSES BY VENDOR.PDF

Step 1. Click Reports = Expenses and Vendors

Step 2. Select Income by Expenses by Vendor Summary

Step 3. Report Period All Dates

Step 4. Select Run Report

Step 5. Click the Print Option

Step 6. Click Save as PDF

Step 7. QuickBooks online will save fo your downloads folder. Make sure you save in the
Unit 14 folder

Step 8. QuickBooks names the file for you ExpensesbyVendorSummary.pdf
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PAY BILLS

I ————
Step 1. Select the Expenses = Expenses
Step 2. In the upper right corner, select

Pay Bills

Step 3. You will then be fransferred to ‘ Birrchike | + |
the Pay Bills screen.

Step 4. Form the list of fransactions Fay Bills

select the following:

v" Carole Design Media
Great Statewide Bank
Townley Insurance Agency
Campion Patrick, CPA
Brown Equipment Rental
Step 5. Click Save and Print (lower right corner of the screen).

Yl

Order Checks

AN

BILLPAY CHECKS.PDF

Step 1. Select Standard
Step 2. Click Yes, I'm finished with setup

Step 3. Select Preview and Print
Step 4. Select Print
Step 5. Select Adobe PDF as the printer or Save as PDF depending on your computer

configuration.

Step 6. Save to your Unit 14 folder

Step 7. Name the file: BillPay Checks.pdf

Step 8. You will be prompted with a question asking if the checks printed correctly. If all
looks good on your PDF copy, Click done.

Step 9. Exit the Print Checks opfion by clicking on the X in the upper right corner of the
screen.

ADD BILLABLE EXPENSE CHARGES

JinLai Metal Works: Bathroom has some billable costs that should be invoiced. Follow these
steps to generate the new invoice:

Step 1. Select Sales > Customers
Step 2. Select JinLai Metal Works: Bathroom
Step 3. Select the Billable Expense Charge on 11/30/2024

Step 4. In the Action column, select Create Invoice

Step 5. Invoice Date: 12/01/2024

Step 6. Notice the invoice for Paint Supplies has been generated with the 15% markup
specified in the original purchase.

Step 7. Select the Sales tax rate option

Step 8. Click Add New - Single Tax rate
Step 9. Tax Name: San Luis Obispo
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Step 10.
Step 11.
Step 12.
Step 13.
Step 1.

Step 2.

Step 3.
Step 4.

Step 5.
Step 6.

Agency Name: State Board of Equalization

Rate %: 7.75

Click Save

Click Save and New

Select Customer: Kari, T e
Tracey: Foyer B =

Notice that in the right-
hand panel there is a ol
message that summarizes .
the additional billable

expense charges. Click

Add All T s
Invoice Date: 12/05/2024
Select the Sales tax rate e i
opftion

Select San Luis Obispo
Click Save and Close

SALES BY PRODUCT SERVICE DETAIL.PDF

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.

Step 8.

Click Reports - Sales and Customers

Select Sales by Product/Service Detail

Report Period 01/01/2024 to 12/31/2024

Select Run Report

Click the Print Option

Click Save as PDF

QuickBooks online will save fo your downloads folder. Make sure you save in the
Unit 14 folder

QuickBooks names the file for you SalesbyProductServiceDetail. pdf

RECEIVE PAYMENTS

To receive customer payments, follow these steps:

Step 1.
Step 2.
Step 3.

Step 4.
Step 5.
Step 6.
Step 7.
Step 8.
Step 9.
Step 10.
Step 11.
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Click Sales > Customers

Select JinLai Metal Works > Receive Payment

Notice that 3 invoices appear. Af this time, you will receive payment for Invoice
#14 and #18. Click on the two invoices.

Amount Received 957.78

Payment Date: 12/10/2024

Click Save and New

Select Customer: Kari, Tracey

Mark Invoice #19 and #16 for payment

Amount Received: 700.43

Payment Date: 12/10/2024
Click Save and Close

FE s




VIEW CHECK REGISTER

Step 1.
Step 2.

Step 3.
Step 4.

From the right panel, click on Dashboard
The dashboard displays the Income, Expenses, Profit and Loss Bank Accounts,

Sales and other options. From the Bank Accounts section, Click Go to Registers
Click Checking

Note the two payments you just made are now in the register. Click on the

Step 5.
Step 6.

€ Backto Chart of Accounts

Bank Register | checiing -

deposit for Kari, Tracey
$16,539.47

Goto: 1-38 of 38

PAYEE
ACCOUNT

MEMOQ PAYMENT DEPOSIT v BALANCE

=}

‘ Delete ‘
50

5

T (oo EE
7 24 $15,839.04

$14,881.26

T

Click on Edit
At the bottom of the fransaction screen, there is a more option. Click on More

KARI, TRACEY JOURNAL.PDF

Step 7. Select Transaction Journal from the menu that appears

Step 8. Click the Print Option

Step 9. Click Save as PDF

Step 10.  QuickBooks online will save to your downloads folder. Make sure you save in the
Unit 14 folder

Step 11.  QuickBooks names the file for you Journal.pdf

ACOUNT LIST

Step 1. In the Left-side menu, select Accounting - Chart of Accounts

Step 2. Run Report

Step 3. Click the Print Option

Step 4. Click Save as PDF

Step 5. QuickBooks online will save fo your downloads folder. Make sure you save in the
Unit 14 folder

Step 6. QuickBooks names the file for you AcountlList.pdf
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TIME TO EXPLORE

I ————
The online version of QuickBooks has many educational tutorials. These tutorials contain

detailed instructions on how to familiarize yourself with the program. For this part of the unit, you
are asked to provide detailed instructions of how to perform at least three of the following tasks:

Task 1. Track Time

Task 2. Create a Credit Memo

Task 3. Create an Estimate

Task 4. Create a Refund Receipt

Task 5. Add Recurring Transactions

Task 6. Edit the Chart of Accounts

Task 7. Create Expense Reports

Task 8. How fo Setup Products and services

Task 9. How to Customize Invoices and sales Forms

Task 10.  How fo record a Bank Deposit using Undeposited Funds

Your grade for the activity will depend on the level of detail provided. Write your descriptions as
if another student oremployee will be performing the task you have chosen to illustrate.
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CREATING FORMS AND
TEMPLATES

UNIT 15 CREATING FORMS AND TEMPLATES

Manage Templates

ELECT TEMPLATE PREVIEW

%Imuit Packing Slip : Template Name

Intuit Product Invoice

flmun Professional Invoice P Invoice
Intuit Senice Invoice Tom Stire Way T .
| & [ ozeamr [ |

=
S e e o T
Total
Copy Delete
Help Download Templates... “ Cancel
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USE AND CUSTOMIZE FORM TEMPLATES

I ————
QuickBooks comes with a variety of templates for you to use for yourinvoices, estimates, credit

memos, sales orders, purchase orders, sales receipts, statements, and packing slips. You can
customize these templates to control how they look and what information is included.

A template is the foundation of the forms you use fo frack your company's purchases and sales.

It defines what shows onscreen when you fill out the form and what shows on the form when you
print it. It also determines the structure of the form, such as which fields and columns are on the
form. And it determines how the form looks—the visual elements of the form, such as the fonts
that are used, and any graphics, lines, or borders.

CONVERTING TO QUICKBOOKS
You will find the following files in your Student files for UNIT 15.

e Ul5al Mookie The Beagle Spa
To complete the first lesson exercises, RESTORE the ul5al Mookie The Beagle Spa company file
from the UNIT 15 folder.

Password: Cuesta123

RENAME THE COMPANY

o
=

e
—r

e
—r

e
—r

it

e e
—r —r

After you have followed the instructions to restore your data files, you will find the company file

you have restored contfains sample data for a company called Rock Castle Constfruction. Your
first activity is to personalize that name to meet your needs follow these instructions:

Step 61. From the Menu bar, select Company

Step 62. Select MY COMPANY

Step 63.  Select EDIT

Step 64. Update the Company Name Field to: YourName Mookie The Beagle Spa
Step 65. CLICK on OK

Step 6. Close the My Company window.

THE TEMPLATE LIST

o
=

o
e

o
e

o
e

o
e

The Templates list contains all the templates for your different forms. Initially, the list contains a set
of QuickBooks standard and predefined templates that you can use as a starting point for using
or customizing your forms as well as duplicating and/or importing previously saved templates.

o
e

s
==

In this list, you can select the femplate and then use it as is or customize it for your needs. Since
it's easier to change an existing template than to start from scrafch, choose the template that's
closest to how you want your form to look.

Step 1. To access the list, go to the QuickBooks Lists menu and select Templates.

CUSTOMIZE FORM TEMPLATES

=

e

e

e e
B B oS- S S L A S AL S S L S S S S S SR S S e S S o
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The basic customization window serves as a good starting point for customizing your femplaftes.
There are two ways fo access it:

Step 2. From the Templates list, double click the template you need to customize.
Step 3.  Inthis case, we will modify 01 Service Date Invoice

Step 4.  Click Templates > Edit Template

Step 5.  Inthe Logo & Fonts section, Click on Use Logo

SELECTED TEMPLATE PREVIEW
01 Service Date Invoics Manage Templates...
Invoice
LOGO & FONTS
¥ Use logd Select Logo...
Select Color Scheme:
Please Select.. = Apply Color Scheme
Change Font For.
Title = Change Font...
Company Name '
CompanyAddress
Labels
v
COMPANY & TRANSACTION INFORMATION Do em type: JPG File
P UNIT 15BACKUPS  SpaLog| D. 11:44 AM
¥ Company Name Phone Number Update Information... T : Pets; Beauty Treatment; Leisure Activity; Wellbeing;
G oothie; Spa Treatment; Drunk; Han
| Company Address E-mail Address Lib R:
ibraries
Di x 1449
Fax Number Web Site Address - 5
L Ti
Print Past Due Stamp This PC
Selact only when you want to include Past Due information Stamp
| Print Status Stamp @
Network
Selactto include the status on the form. Various statuses are, Paid, Pendi
Received, Void, and s on
How do | apply a design across multiple forms? E
File name e 1
Help Additional Customization... Files of type: All Image Files

Step 6.  Navigate to the UNIT 15 folder and select the Spa Logo

Step 7.  Click Open

Step 8. You will then be prompted to copy the logo to the QuickBooks Company file.
Click OK.

Step 9.  The logo will appear next to your address on the invoice preview. Next, we will
change the color scheme. Inthe Logo & Fonts section, Click the drop-down to
Select Color Scheme

Step 10.  Select Maroon

Step 11.  Click Apply Color Scheme

Step 12. Inthe Change Font For section, Click Title = Change Font. ..

Step 13.  Select Bernard MT, Condensed, 21 Points

Step 14. Click OK. Notice the title of the invoice changes.

Step 15. Inthe Change Font For section, Click Company Name = Change Font. ..

Step 16.  Select Rockwell, Bold, 12 Points

Step 17.  Click OK.

Step 18. Inthe Change Font For section, Click Company Address = Change Font. ..

Step 19.  Select Rockwell, Regular, 12 Points

Step 20. Click OK.

Step 21.  Inthe Change Font For section, Click Labels - Change Font. ..

Step 22. Select Rockwell, Bold, 10 Points

Step 23. Click OK.
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ADDITIONAL CUSTOMIZATION

B o o o o St St St
Step 1. In the Basic Customization Screen, Select Additional Customization. . .
SELECTED TEMPLATE PREVIEW

01 Service Date Invoice Manage Templates...
YourName Moalde The Beagle Spa Invoice
LOGO & FONTS m}fﬁfﬂfﬁﬂw R
# Use logo  Spalogojpg Select Logo... [ |
File size: 1,042 58 KB
Select Color Scheme: —
Maroon X Apply Color Scheme
Change Font For:
Title = Change Font... [rome | mems | Tramee
Company Name l | |
e e T i

Company Address
Labels

v
COMPANY & TRAN SACTION INFORMATION
¥ Company Name [ Phone Number
¥ CompanyAddress [ | E-mail Address
[7] Fax Number

[ Print Past Due Stamp

[ Print Status Stamp

Received, Void, and so on.

[7] Web Site Address

Select only when you want to include Past Due information Stamp.

Select to include the status on the form. Various statuses are, Paid, Pending,

How do | apply a design across multiple forms?

Help Additional Customization...

Update Information...

Additional
Customization

Total

Print Preview...

Layout Designer... Cancel

Step 2.

Header Screen
‘ Print
Default Title
Date
Invoice Number
Bill To
Ship To
P.O. No.
S.0 No.
Terms v
Due Date
Rep
Account Number
Ship Date
FOB
Project/Job
Other

AVRNEANIRN
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Change the following settings
NOTE: As you change the terms for the title, QuickBooks will prompt you to accept the change.
Make sure you accept all changes.

Print Title

v Service

v Date

v Service #

v Dog Owner
v Terms

v Account #
v Doggie




Columns Screen Print Order Title

ServiceDate v v 1 Appointment Date
ltem 4 2 ltem

Description v v 3 Description

Mfr Part

Number

Quantity

Rate v v 4 Rate

Amount v 5 Amount

Other 1

Other 2

Step 3. When prompted to Use the Layout Designer fo reposifion the overlapping fields.
Click OK - Continue

Footer Screen Print Title
Message v v Thank You
Total v v Total
Payments and Credits

Customer Total

Balance

Job Total Balance

Long Text v Thank you for giving us the opportunity to enjoy
your doggie. We hope to see you again soon.
Step 4. Click on the Layout Designer

SELECTED TEMPLATE PREVIEW
01 Service Date Invoice [T Template is inactive

YouNameModkie The Beagle Spa Service
Header  Columns  Footer Print peh, [T R —

@ Use Invoice printer settings from Printer Setup

) Use specified printer settings below for this Invoice

# Print page numbers on forms with more than 2 pages

Layout Designer

Print Preview...

= e e PV SN Sy N ey e

Step 5. Notice that some of the informating is overlapping, Click on the Account # field
and move it under the service # field

When should | check Screen or Print? Default

Help
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RESIZE THE FIELDS

R

e

e

Step 1. Select the following fields:
a. Service #
b. Account #
c. Date

NOTE: This can be done by drawing animaginary box around all of the fields with your mouse

e

e N Y Y Y Y Y Y Y Y Y Y Y
SRR S R R R R R A e S R R A S S S e S e e e R A e e SR R S S S

?"/////////.D’////////.p’ ////////ﬂ/////////eﬁ

;{//J/// /ﬂg)}/////é/g /5/‘}}2&5///&/,#//
R s FE ////////nf/// Y

11/16:2018 Sample | 3
e /‘4 AR R e
e e

Accouit =

jf//////////.l’//////v’///
//f/////////ﬂr"////ff/f// 3

Sampls ||

i///////////r/x///zl/////i

\W—-ﬁ-}"\
X

Step 2. Tap your left arrow on your keyboard several times. This will move the fields inside
the margin line

Step 3.  Click on the area where the content of the invoice will appear to resize the box
displaying the Appointment Date, Description, Amount and Rate.
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Step 4.  Grab the handles on both the right and left of the boxto reduce the size of the
area and bring the edges of the invoice inside the margin line.

= Handle with

E move alrow

=

Step 5. Draw an imaginary box around the Terms & Doggie fields fo select them.

Step 6. Nudge them fo the right using your left arrow key on your keyboard

Step 7. Click on the box that says “This is sample text” to select it.

Step 8. Hover over the box until you see a four-pronged arrow. This selects the box. Click
and drag the box to the area above the space where the terms and doggie
fields reside

Move handle

Step 9. Resize the box so it fits in the blank area without any overlapping fields
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New Location

Step 10.  With the message box selected, Click on Properties

Step 11.  In the Text option, Click Font

Step 12.  Change the font to Script MT

Step 13.  Font Style: Bold

Step 14.  Size: 16

Step 15.  Click Ok

Step 16.  Notice the Appointment Date title is not showing. This can be easily fixed by
enlarging the tifle area. Click on the box surrounding the words and
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Step 17.  Drag the handle down to resize the boxes for the ftifles.

Click and drag
handle

Step 18.  Draw your imaginary box around the total atthe bottom of the invoice template
Step 19.  Align the fotal area to the margin line using your left arrow key

Step 20.  Select the Appointment Date fitle

Step 21.  Click on Properties

Step 22.  Click on Background

Step 23.  Click the Fill option

Step 24.  Click on Background color

Step 25.  Select the third color in the fourth column (Dark Teal)

Basic colors:

EEEN]
EEENTT

Step 26.  Click OK

Step 27.  Click OK again to confirm

Step 28.  With the Appointment Date still selected, Click on Properties
Step 29.  Click on Text

Step 30. Click on Font

Step 31.  Click on Color White

Step 32. Click OK

Step 33.  Click OK to confirm your selection
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Step 34.  With the Appointment Date still selected, Click on Copy Format

MAKE SAME CENTER UNDG/REDO ZOOM
& o ] »[l¢ 4 Y N
hd
Properties... Add Copy Format Horz Undo C In Out

A

Step 35. With your mouse click on the titles for Description, Amount and Rate to copy the
format you created.

Step 36.  Click on End Format

MAKE SAME CENTER UNDO/REDC ZooM
= L =
& ) O o4 H & g,
-
Properties... Add i Remove End Format { vidt Horz Undo Redc In Out
bbb b b b e g Lo Bt b Lo Bt S ‘-|!|?\|I|||\mln||'?|\I||||mlm|T||I\||ImIulu‘?lulmlmhl‘

41

Sample

Step 37. Click OK to end the Layout Designer
Step 38. Click OK fo close the customization screen

INVOICE 45.PDF

Step 1. Open the Customer center p—— .

Step 2. Under Kari, Tracey, find invoice 45 and " e
open it.

Step 3. Use the new 01 Service Date invoice

Step 4. Click Print

Step 5. Preview your Invoice

Step 6. Save as a PDF
Step 7. Navigate to the Unit 15 Folder
Step 8. Save as Invoice 45

Total

o WL W S L L VI, o S W W Vo Vo L VPPN

DOWNLOAD A PREDEFINED TEMPLATE

R

e

e

e

e

e

You can copy customized templates from one company file to another. This saves your time in
personalizing tfemplates for your estimates, invoices and other forms in case you have multiple
company files, oryou need to start a new company in QuickBooks Desktop. Exporting then
importing the template also helps prevent damaged templates when sending portable files or
converting your company files. Be reminded, however, of the following limitations:

=
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e You cannot import customized templates created in newer versions of QuickBooks intfo
older versions.

e You cannot import templates created in one regional version of QuickBooks info
another. For example, the Canadian version of QuickBooks can't export templates to the
U.S. version.

e Youcannot export templates created in QuickBooks for Mac to other company files.
They are confined to the company file in which they were created. You cannot copy or
import templates in QuickBooks for Windows intfo QuickBooks for Mac. All customized
templates that were created in QuickBooks for Windows must be recreated in
QuickBooks for Mac.

Step 1. Click on Lists

Step 2. Select Templates
Step 3. At the bottom left corner click on Templates again to view additional options
Templates

Attorney's Invoice Invoice
Fixed Fee Invoice Invoice
Intuit Packing Slip Invoice
Intuit Product Invoice Invoice
Intuit Professional Invoice Invoice
Intuit Service Invoice Invoice
Intuit Standard Pledge Invaice
It New Cirl+N Invoice
1 EditTemplate CHr+E e
¢ Delete Template Cri+D P
F  Duplicate Credi
€ Make Template Inactive Sales
C Sales
It Customize Columns... Sales Ba
It ymport g -
¢ Ezport Estimate
¢ Create Form 5|gn Estimate
B Use Ctri+U Estimate
¢ Findin Transactions... Sales Order
' Pring List... Cirl+P sEEoun

Templates v Open Form

Step 4. Click Download Templates.
QuickBooks will open asource of templates available online. Nofice they range from a variety
of areas: Credit Memo, Donation, Sales Order, Purchase Order, Estimate, Invoice, Statement and
Sales Receipt

Step 5. Select Invoice

Step 6. Scroll down the list

Step 7. Click on Sports Inv.DES

Step 8. Click Download

Step 9. QuickBooks will prompt you to save oropen. Click Open
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Step 10.  Notice the Invoice Basic customization screen appears on your screen.

SELECTED TEMPLATE PREVIEW
Sports Inv Manage Templates:
ookl The Beagle $pa
LOGO & FONTS
"] Use logo Select Logo... Manage
Select Color Scheme: : : S
o — Aply Color Seheme Templates
Sh
Change Font For:
} e O
Title Change Font...
Company Mame l
Company Address
Labels Vag
i
v | S
COMPANY & TRANSACTION INFORMATION
+ Company Name ] Phone Mumber Update Information...
¥ CompanyAddress [ | E-mail Address
|| Fax Number || Web Site Address
|| Print Past Due Stamp = W
Select only when you want to include Past Due information Stamp. Payments/ Credits gL
Balance Dus 30.00
[+ Print Status Stamp
Selectto include the status on the form. Various statuses are, Paid, Pending,
Received, Void, and so on.
How do | apply a design across multiple forms? Print Preview...
Help Additional Customization... Layout Designer... “ Cancel

Step 11.  Click on Manage templates
Step 12. Change the name fo 02 Mookie Invoice

PREVIEW

Template Name 02 Mookie Invoice

YourNames Mockls The Beagle $pa

432 Prosnican Way
Mountain Viaw, CA 24043

Bill To

[Fowe [ tem: [ousoas [ acow:

aey

Step 13.  Click OK

Step 14. Click Additional Customization
NOTE: When you check and uncheck the options, QuickBooks may add an additional prompt.
Accept the changes as you make your changes.

Header Screen Print Title
Print
Default Title v v Spa Service
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Header Screen Print Title
Print

v Date
v Service #
v Dog Owner

Date

Invoice Number
Bill To

Ship To

P.O. No.

S.0 No.

Terms

Due Date

Rep

Account Number
Ship Date

FOB

Project/Job v Doggie
Other

AN

Columns ~Screen Print Order Title

ServiceDate v v 1 Spa Date
ltem v 2 ltem
Description v v 3 Description
Mfr Part

Number

Quantity

Rate v v 4 Rate
Amount v 5 Amount
Other1

Other 2

Footer Screen Print Title

v v Thank You
Total v v Total
Payments and Credits

Customer Total

Balance

Job Total Balance

Long Text v Thank you for giving us the opportunity to enjoy
your precious doggie. We hope to see you again
soon.

Step 15.  Click Layout Designer

Step 16. Inthe Layout Designer, click on the balls in the upper right of the screen.

Step 17.  Click Properties

Step 18.  Click Browse to view the images in your Unit 15 folder.

Step 19.  Select Spa2.jpg from your Unit 15 folder

Step 20.  Click Open

Step 21. Confirm your choice by clicking on OK

Step 22.  Click OK again. The sports equipment has now been replace with the new
Spa2.jpg image.
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Step 23.  Click on the background image
Layout Designer - 02 Mookie Invoice
&l ] Ea| P4 b4 <l<1
Properties... Add & Copy Remaove Horz Undo
A ‘!|I|||I||-I|||I|‘\\‘\‘\I||2I|||I|||I|||I||3I|||I||\M‘\\||4I|||I|||I|||I||5I|||I||\\\‘\\\|r:‘l|||I|||I|||I||?I|||I|||\\‘\\\lsll||ll Ll &
'
Dog Owner |
This is sample text. JER
Y
e e
& iy
Thiz i= sample text. ‘
Doggie
Sample
Spa date Description Amount Rate :
i 1172018 This is sample text 123.45 1.00 ‘
Total $12345
"/;;;;/;;; S giving vs the OPPOURILY to snjoy Your pracious Soggis. Wa hops to 522 ToU
N
]
mage oom: 100% 0.47 @47 r/ B
Step 24.  Click on Properties > Browse
Step 25. Open your Unit 15 folder and clik on the file called Spa3.jpg
Step 26.  Click OK
Step 27. Next you are going to change the background color for the headings.
the green label entitled Doggie o select it.
Step 28.  Click Properties > Background
Step 29.  In the last column, choose the fourth color (Periwinkle Blue)
Step 30. Click OK to choose the color
Step 31.  Click OK to confirm your selection
Step 32.  With the label still selected, Click Properties - Font
Step 33.  Color White
Step 34. Font: Comic Sans MS
Step 35.  Font Style: Bold
Step 36.  Size: 12
Step 37.  Click OK
Step 38.  Click OK to confirm
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Step 39. Click Copy Format

Step 40. Click on the following labels to change the format:
a. Spa date
b. Description
c. Amount = e e
d. Rate e e el e e [
e. Date ER Spa Service:
f. Service # 3 |
Step 41.  Click End Format 3
Step 42. Change the size of the 3
message box at the bottom of E
the invoice to fit in the space E
next to the Total at the bottom =
of the invoice . |
Step 43.  With the message selected, 3
Click Properties -> Font 3
Step 44. Color: Blue =
Step 45.  Font Style: Bold
Step 46.  Size: 14 E Mok
Step 47.  Click OK 4 —— -
Step 48.  Click OK to confirm | s e i
Step 49.  Click OK fo exit the Layout q = i
Designer ) | e T
Step 50.  Click OK to close the — i R
Additional Customization
Screen
Step 51.  In the Basic Customization screen Select Color Scheme
Step 52. Choose Beige
Step 53.  Click Apply Color Scheme
Step 54.  Click OK to confirm the change

INVOICE 44.PDF

Step 1. Open the Customer center

Step 2. Under Petit, Mimi, find invoice 44 and open it.

Step 3. Change the template to the new 02 Mookie
invoice

Step 4. Click Print

Step 5. Preview your Invoice

Step 6. Save as a PDF

Step 7. Navigate to the Unit 15 Folder

Step 8. Save as Invoice 44

CREATE A CUSTOM LETTER

R &= &= &=

QuickBooks 2020 integrates with MS Word, Excel and Outlook.
Mac users must have the Windows version of MS Office to
perform the integration with QuickBooks. Follow these steps
to create your own Word documents for Mookie Beagle Spa:

-
=

Step 1.
Step 2.

Open the Customer Center

icon.
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e, Spa Service

Moakie

Thank you for giving us the | Tom
oppertunity to enjay yeur precious
doggie. We hope to see you again

on

i

5
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A_.‘A’\'__/\J“-\/\,f‘\:;;‘./\,/w“d’w

S
g
i

At the top of the Customer Center click on the down triangle next to the Word




Step 3. Click Customize Letter Templates

Eile Edit View Lists Favorites Accountant Company Customers Vendors Employees Banking Reports Window Help

&y Hew Customer&Job ¥ 5] New Iransactons * (&) pPrint v [F] Excetv [ word v @& income Tracker

Prepare Letter to Bebe

Customers & Jobs (R J Ob | nfor Prapave CuslomerLsters

Prepare Collection Letters

Active Custo
~ S SRy Customize Leiter Templates. foie 415-555-2160

stomer Name  Petit, Mimi

pe Medium Pet

[ Statement Writer T

Home

4® vy Company

® Income Tracker

ADD YOUR COMPANY LOGO TO THE
LETTER

R

© Kari, Tracey 1,644.00 sl
BiTo Mimi Petit
+0din 1,644.00 220 Asace Avenue
« Wartini, Graziella 162.00 BamiaciRiee
eMario 162.00
o Pelit, Mimi 144.00 Map | Directions
+Bebe 144.00
- Rafael, Sofia 225.00
+Mazda 225,00
Transactions Contacts Sent Email

All Transactions

Step 4. You may receive a pop-up menu asking you fo Find Letter Templates. Click Copy
Step 5. Click View or Edit Existing Letter Templates
Step 6. Noftice that QuickBooks has many templates to choose from. With the Customer

option still selected, scroll down the list and choose the template called Thanks
for Business (service).
Step 7. Click on Next o
Step 8. It may take a
few minutes for

Customer Name  Petit, Mimi

Letters and Envelopes

([Dercromnie

Quick K il lypress HilRd | Choose a Letter Template to View or Edit
vickBooks to 1] fre CA 94326
Types of Letters Letters templates available
generate the s
s iriatw Aberd = : A
|eﬂ'er. C heCk = & Customer MNonprofit Fundraising Letter

Nonprofit Thank You

Scheduled delivery notice

O Invoice

your task bar

. . O Estimate
to see if Word is & vendor Special order arrival natice
open Once 2 Emmwee Thanks for business (product)
the letter © Other Names Thanks for business (senvice) '

Time & Materials Agreement

opens, save it

as 01

Certificate. The

letter will SO
. «MyCompanyAddrBlock»

automatically

be saved in ——

your oo : §
QuickBooks Add:Blocko 4
Com pany letters to be used Dear «<MeMsMrs» «FirstName» «LastName», #

P

‘When you click Next:

«LetterDates

|OTer. We Ore nOW going TO Thank vou for choosing to do business with us
edit the letter to meet your s e
n eed S. Thank you again for selecting us. It48 ouggfivilega®o work with you.
Step 9. Next to the Salutation (Dear) Sincercly.
is afield that is not used in
your database. We want to g

My CompanyName»

remove that field. Delete
«MrMsMrs»

e

o
o

Rttt e
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Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.

Step 7.
Step 8.
Step 9.

Step 10.
Step 11.

Step 12.

In the word document, Click the Insert ribbon

In the lllustrations group, Click Pictures

Navigate to your Unit 15 folder click on Spa Logo.jpg

Click Insert

Click on the Image to select if.

Notice the Picture Tools ribbon appears when you click on the image. Click on
Format

In the arrange group, select Wrap Text = Behind Text

With the picture still selected, in the adjust group select Recolor > Washout
Click and drag the picture down on the page to display as a watermark behind
the text.

Save the Letter. CTRL+S

Close the Word document and return to your QuickBooks company file.

MyCompanyNamesn
«MyCompanyAddeBlocks

letterDater

«AddrBlock]

Dear «MrMsMrs» «FirstNames «LastNames,

bility. If we ever disappoint you, we hope
0 make things right

«Signature»

«Title»
«MyCompanyName»

If the template window is still open in QuickBooks, Click Cancel

CUSTOMER LETTERS.PDF

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.
Step 6.
Step 7.

Step 8.
Step 9.
Step 10.
Step 11.
Step 12.

Step 13.

Page | 357

From the customer center, click on Word again.

Select Prepare Customer Letters

Mark All Customers

Click Next

Select the 01 Certificate

Click Next

Type the following:

a. Name: Your Name

b. Title: Happy Groomer

Click Next

The Lefters will automatically generate in Word.

Save as Adobe PDF

Save in the Unit 15 folder as Customer Letters.pdf

After you save the letters, you will be prompted to print the envelopes. Click
Cancel

Click Cancel again the exit the Letters and Envelopes opftions




APPENDIX A

BACKUP AND RESTORE QUICKBOOKS COMPANY FILES
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The two most common QuickBooks files you will use are the following:

v .QBW File - This is referred to as the QuickBooks working file in which you can enter
accounting data and transactions.

v .QBB File — The QuickBooks backup file used to move a QuickBooks file to another
computer orif the working file (.QBW) fails. The data files provided for you with this text
.QBB files. These files have been restored to the .QBW format for your convenience.
Unlike Excel files, .QBB files cannot be opened by clicking on the file. Because .QBB files
are compressed, the .QBB file must be restored (unzipped) using the QuickBooks
software.
The .QBW file is the only QuickBooks file in which you can enfer data and fransactions. When
you enter tfransactions into a .QBW file, the information is automatically saved. The typical
workflow for a business is to use the .QBW file to record transactions and periodically back up to
a .QBB (backup) file.

A sound disaster recovery planincludes a backup system. For example, a good backup system
is to have a different backup for each business day: Monday backup, Tuesday backup,
Wednesday backup, and so on. Then it is necessary to use the backup file and the Wednesday
backup, for example fails, the company has a Tuesday backup to use. Furthermore, itis
recommended that a business store at least one backup at a remote location.

Typically, the backup file is used only if the company's working file (.QBW) fails. Then the backup
file (.QBB) can be restored and used. It isimportant that the backup copy is as up to datfe as
possible in case it must be used to replace lost company data. The backup file (.QBB) is

compressed and must be restored to a working file (.QBW) before you can use it to enter data
or fransactions.

CREATE A BACKuUP
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Throughout the text you will be insfructed to backup your QuickBooks Company file. Follow
these steps to perform a backup:

Step 1. With your QuickBooks file (*.QBW) open, from the menu bar CLICK on the File
option

Step 2. CLICK on CREATE LOCAL BACKUP option

Step 3. When the following windows appears, SELECT the Local backup option
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Step 4. CLICK on NEXT

Create Backup

Make a backup copy of everything you need to recreate your company file in case of
accidental loss or damage to your data.

"

Do you want to save your backup copy online or locally?

© Online backup

Get automatic, online backup for your QuickBooks data and other important documents
using Intuit’'s online backup solution (fees may apply).

Try now or learn more

Save locally to a removable storage device (such as a CD or USB flash drive) or to
a folder on your network_

Options Click Options to change your current backup settings.

Help Cancel

Step 5.

If asked where to save your files, to make it easier to find your backup files, CLICK

the BROWSE button. Each unit you have for this class has a folder labeled

Step 6.
Step 7.

Step 8.

Step 9.

Step 10.
Step 11.

UNIT xx BACKUPS (xx represents the unit number).
NAVIGATE to the BACKUPS folder for the current unit.
CLICK on OK to close the Browse for Folder window.

Backup Options

Use this window 1o set defaull options for your manuzl and automalic backups.

Backups folders are
in each unit

Restored_Project 01 Files
UNIT D1 BACKUPS

Unito2 '
Unit 03

Unit04

LOCAL BACKUP ONLY
Tell us where to save your backup copies (required)

FD 20 uesta\Credit C

& Addthe date andtime of the backup 10 the file name (recgg

& Limitthe number of backup copies in this folgge®

ONLINE AND LOCAL BACKUP

& Remind me to back up clase my company file every

WCCT 2520

Unit 05
Unit 05 h

Select an option tg that your company data is OK (thatis. not corrupted) when

you save.

Plete verification (recommended)

Quicker verinication

@ Mo verification

Help me choose

Cancel

Browse to the Backups

folder for this unit

CLICK on OK again to close the Backup Options window
window appears, select Use this location.

CLICK on SAVEITNOW

CLICK on NEXT

. If a QuickBooks waring

Notice that QuickBooks has dated, and time stamped the backup file you are

creating. CLICK on SAVE
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WHY CREATE AND RESTORE A BACKUP FILE?

There are several reasons to restore a backup file. These are a few o consider:

v

ACCOUNTANT - An account offen works with either an accountant file or a customer
backup file. QuickBooks makes it easier for accountants to work with client data files.
Consider this scenario: You have a client who needs help finishing the year's accounting
period. You have two choices. First, you can drive over to his shop, probably getting
stuck in traffic along the way, and find yourself wondering whether you can bill the
client $150 for your travel time. Second, you can have the client use the Accountant’s
Copy feature of QuickBooks to send you a copy of the QuickBooks data file. You can
review this accountant’s copy of the data file, make whatever fixes or changes are
appropriate, and then send the changes to be made back to the client. The client can
easily import these changes into his existing QuickBooks file and go off on his merry way.
SWITCHING COMPUTERS — QuickBooks saves multiple files in the .QBW database.
Creating a backup file and then restoring it to a new computer is a more efficient
option.

CORRUPT or INNACURATE FILE - You may realize you have an error that you are unable
fo frack and fix. In this case, if you have a .QBB (backup file), you wouldroll b ack to
the most recent backup.

IMPORTANTNOTE REGARDING PASSWORDS:

v REQUIRED TO CREATE A PASSWORD — When restoring a QuickBooks .QBB file, you may be

required fo create a password to continue. Record any password you create in a secure
location. There are also password manager programs such as Dashline, Keeper, Sticky,
RoboForm or Password Boss that are excellent secure sources to store passwords and
personal information.

PASSWORD REQUESTED - If a password is requested. Try using Admin and leave the
password blank. If that does not work, fry contacting your insfructor.
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APPENDIX B

CHANGE THE COMPANY NAME
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Changing the company name is not something to take lightly. A company name change is a
delicate process that must be handled properly. These are some famous examples of
companies that have changed their name:

e

e e

v Google was once Back Rub.
Yahoo! Was originally Jerry's Guide to the World Wide Web.
Before it was Best Buy, itwas Sound of Music.

Accenture was originally Arthur Andersen.
Pepsi Cola started out as Brad's Drink.

AN NN

For the activities in this fext, you will need to change
the company name for every unit activity. This isa

YourName Chapter 2 Rock Castle Construction

process designed to show how it isdone and to ¢
include yOUr nqme On The repOrTS Thcf Qre Contact Name & Address \‘r:}iussn;z%g:%;;:nmcms Legal Name & Address gé;ééééac:%sé:mn,m :FI“ v -M 1

generated throughout the text. Please follow these
instructions:

650-555-1234 N 00-7904153
650-555-5678

rockcastie@samplename com

Product Name  QUIckBoo|
Pro 2019

Farm 11208 (S Corporatian) Liconse # 5412-904

Asan Sun, CFO
650-555-1234 No.of Seats 1
Actvation ACTIVATE|

ebsita wurw samplename com

Step 1. From the Menu bar, select
Company

Step 2. Select MY COMPANY

Step 3. Select EDIT

Step 4. Update the Company Name Field to:
YourName xxxx (xxxx represents

the name of the current company you are working oni.e. Rock Castle
Construction)

NS ot seeing all your servicas?

Company Information

Legal Information

Company Identification

Report Information

Phone No. 650-555-1234

Fax No. 650-555-5678

E-mail rockcastie@samplename cc

Web Site wuw.samplename.com

Step 5. CLICK on OK
Step 6. Close the My Company window.
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APPENDIX C

EXPORT REPORTS TO EXCEL

B
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You can export Customer, Vendor, Payroll lists and fransactions, as well as ltems list into an Excel
spreadsheet. If you need to change a report’'s appearance or contents in ways that are not

available in QuickBooks, you can also export reports and customize it in Excel without affecting
your QuickBooks data.

The reports that can be exported to Excel have an Excel option in the fitle bar of the report.
Open your desired report and follow these instructions to export the report.

Step 1: Select Create new Workshee
Customize Report Share Template Memeorize Print | E-majl * Excel » Hide Header llapse
Dates [EETTLCN - rom 03012014 = To
1:08 AM Cent
Step 2: When the Send Report to Excel window appears, select Replace an existing
worksheet.

Step 3: Click the Browse button

In the UNIT XX folder, SELECT the Excel file named UNIT_XX_REPORTS.

NOTE: XX Represents the number of the unit file you are exporting the file fo.

Step 4: From the drop-down list, select the sheet you plan to export info. The illustration is

showing CH1 TB. Each exercise is a different sheet. Pay close attention o the

Send Report to Excel

WHAT WOULD YOU LIKE TO DO WITH THIS REPORT?

@ Create new worksheet
© Update an existing worksheet How it works

® Replace an existing worksheet

Select workbook

C:\Users\Owner\Desktop\QuickBooks\QB-REPO... Browse...

CH1TB =

1 Create a comma separated values (_.csv) file

Advanced...

sheet tab name the exercise is referencing.
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Step 5:
Step 6:
Step 7:
Step 8:
Step 9:
Step 10:
Step 11:

Step 12:
Step 13:
Step 14:

Click the Advanced button.

Uncheck Space between columns.

Uncheck Include QuickBooks Export Guide worksheet with helpful advice
Select On printed report and screen

Click OK

Click Export

When the following Export Report Alert window appears, select Do not display this
message in the future.

Select Yes
Review the report exported to Excel.

Save and close the Excel File. You will use it again.

EXPAND COLUMNS IN THE EXCEL REPORT

e

o e
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e

&

e e

e

If you are not familiar with MS Excel, there are a few easy steps that should be followed to view
your exports for accounts:

Step 1.
Step 2.

Step 3.

File Home Insert

A Cut
LD [ cepy -
Paste

- <¥ Format Painter

Clipboard

A53

With your Excel worksheet in view, hold down your CTRL key and Hitf the letter A
(CTRL+A). This keystroke combination selects the entire worksheet.

Be careful not to select any of the individual cell in the worksheet and click on
the Home ribbon band. In the cells group, Click on the more option for Format
Select AutoFit Column Width

13 Share 2 Comment

A

Ay O
Sort & Find &
Filter ~ Select ~

QuickBooks

B B P &=

Insert Delete Format

Formulas Review View Developer Help Acrobat 2 Tell me what you want to do

Page Layout

@ | X Autosum -

Fin-
& Clear~

Cell Size

Text
$-%9 |RBR

Number

25 Wrap Text
Conditional Formatas Cell
Formatting = Table~ Styles -

styles

1] RowHeight...

A
1 |YourName Rock Castle Construction
2 |Income Tax Preparation
3

January through December 2022

i
4
Eo Recer 4 Hide & Unhide ¥ ! pl—
k1 p Organize Sheets
p2 > BR Rename Sheet
gned-

Grey sheet color
= indicates all cells
=3 have been selected

Move or Copy Sheet...

Tab Celor

.| Protection
BE Protect Sheet

B tockcen

)
.
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APPENDIX D

RECORDING DEBITS AND CREDITS
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Five different types of accounts are listed below along with the effects that debits and credits
have on them.

Account Type Debit Credit
Asset Increase Decrease
Liability Decrease | Increase
Equity Decrease | Increase
Revenues (Income) Decrease | Increase
Expenses Increase Decrease

The following adjusted journal entry displays a depreciation expense record. Notice how the

number of the depreciation expense are in the expense costs category (60900). The account
number for the Accumulated Depreciation is in the asset category (17000).

Make General Joumal Entries I
Man  Reporls i

“«» B E RBerwsow ¢ & § © ®

Fing New Sawe Deicie @Bumemonze Reverse | Print  Aftach  Hide  Send
o e

pere (123112021 B ewwvio [FAM2010

coouNT oEBIT cRED MO
60900 - Depreciation Expense 4243501 Record 2010 Depreciation

17000 - Accumulated Depreciation

4443501 Recora 2010 Depreciation

Expense
(increase)

(decrease)

Totals 4443591 4443501

List of Sel oumal Enfries:  LastFiscal Year

123112021
123112021
120112021
1302021
1012021
103172021

62100 - Insurance 62120 - Liabilily Insurance

July allocalion of prepaid rider policy
50000 - Depreciation Expense 2 al

i Record 2010 Depreciation
13100 - Fre-paid Insurance
62100 - Insurance:62120 - Liability Insurance

[ July allocation of prepaid rider policy
13100 - Pre-paid Insurance
62100 - Insurance:62120 - Liability Insurance

| July allocation of prepaid rider policy

Save & Close

ACCOUNT NUMBERS

B
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.=
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==

Account numbers are used to uniquely identify accounts. Usually account numbers are used as
a coding system to also identify the account type. For example, a typical numbering system for
accounts might be as follows:

10000 - 19999 Assets

20000 - 29999 Liabilities

30000 - 39999 Equity

40000 - 49999 Income or Revenue

50000 - 59999 Job Costs/Cost of Goods Sold
60000 - 69999 Overhead Costs or Expenses
70000 - 79999 OtherIncome

80000 - 89999 Other Expense
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The five digits provide some growing room when new accounts need fo be sandwiched into the
list in the right order. The five digits are used as follows:

v' First Digit—the first digitis the high-level account type (asset, liability, etc.)
v Second Digit—the second two digits are used in account numbering
v' Last Two Digits—the last two digits are used in subaccount numbering

You can sfill override the standard numbering system to any system you'd like or avoid account
numbers altogether.
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